
 

 

 

 

 
 
 
 
 

KOVÁCS BALÁZS – SZANYI JÁNOS 
 
 
 

Hidrodinamikai és transzportmodellezés 

(Processing MODFLOW és Surfer for 
Windows környezetben) 

II. 

 

 

 

 

 



 

 

 
„The human mind is inherently visual. Converting 

numeric data to a visual model greatly improves 
our understanding of the problem domain.” 

(Dan Smith, a Surfer megalkotója) 

 
 
 
 
 

KOVÁCS BALÁZS – SZANYI JÁNOS 
 
 
 

Hidrodinamikai és transzportmodellezés 

(Processing MODFLOW és Surfer for 
Windows környezetben) 

II. 

 

 

 

 
Miskolci Egyetem, Műszaki Földtudományi Kar 

Szegedi Tudományegyetem, Ásványtani, Geokémiai és Kőzettani Tanszék 
GÁMA-GEO Kft. 

2005



 

 

Lektorálták: 
Rózsa Attila hidrogeológus 

és 
dr. Völgyesi István hidrogeológus 

 

A tankönyv megjelenését támogatták: 
AGRUNIVER Holding Kft., Gödöllő 

Békés-Drén Kft., Békés 
BGT Hungária Kft., Budapest 

Biokör Kft., Budapest 
Magyar Mérnöki Kamara Geotechnikai Tagozata, Budapest 

GEOHIDROTERV Kft., Budapest 
GEOSERVICE Kft., Miskolc 
INTERGEO Kft., Budapest 

REWOX Hungária Kft., Szeged 
Miskolci Egyetem, Műszaki Földtudományi Kara, Miskolc 

Oktatási Minisztérium Posztdoktori Ösztöndíja 
Országos Tudományos Kutatási Alap (OTKA) 

Pórusvíz Mérnöki Iroda Bt., Budapest 
Völgyesi Mérnökiroda Kft., Budapest 

 
ISBN 963 661 636 1 Ö 
ISBN 963 661 638 8 

 
Első kiadás, 2005 

© Kovács Balázs és Szanyi János, 2005 
 

A kiadásért felel a GÁMA-GEO Kft. ügyvezetője  
3519 Miskolc, Bencések útja 111.  

Megrendelhető: www.gama-geo.hu 
 

Nyomdai munkák: 
Páskum Nyomda, Szekszárd  

Felelős vezető: Farkas János ügyvezető igazgató 
 

A Surfer™ for Windows a Golden Software Inc, Golden, Colorado védjegye. © Copyright Golden Software Inc., 1993-
2002 ©Processing MODFLOW Wen-Hsing Chiang és Wolfgang Kinzelbach, 1991-2001. All rights reserved. ©PMPATH 
for Windows Wen-Hsing Chiang és Wolfgang Kinzelbach, 1994-2001. All rights reserved. © DWG Converter Edwin 
Giezeman 2000 © DXF2XYZ Copyright 1999-2004, Guthrie CAD/GIS Software Pty. Ltd. All rights reserved. 
©A9Converter Copyright 2004-2005, A9Tech Inc. All rights reserved. ©VarioWin 1993-1998. Yvan Pannatier. All rights 
reserved. A Microsoft, a Windows, az MS, az Excel és az Access a Microsoft Corporation, Redmond, USA bejegyzett 
védjegye. A AutoCAD© az AUTODESK, Inc bejegyzett védjegye. All rights reserved. 



1 

10. Bevezető gondolatok 

A könyv, a közel egy éve azonos címmel megjelent mű folytatása (KOVÁCS, 2004). 
Azért írtuk, hogy a modellezéssel foglalkozók számára minél több gyakorlati segítsé-
get adjunk. A kötetben ezért elméleti jellegű részek csak elvétve találhatók, miközben 
a Processing MODFLOW környezet transzport-modellezéssel kapcsolatos részeit, to-
vábbá a Surfer for Windows térképrajzoló és számos egyéb hasznos segédprogram 
ismertetését több fejezeten keresztül tárgyaljuk. Megpróbáljuk a szakirodalmi adatokat 
tartalmazó táblázatokkal, a „mit tegyünk, ha valami nem megy” típusú fejezetekkel és 
nem utolsó sorban a kidolgozott példákkal segíteni a modellezést tanulókat, és persze 
azokat is, akik már gyakorlottabbak, mégis a munkájuk során valahol elakadtak. Taná-
csokat és tippeket adunk, egyszóval mentőövet dobunk a „bajba jutottaknak”, és be-
mutatjuk, hogy mi mit, hogyan csinálnánk. Hangsúlyozzuk, ez csak egy út a megoldá-
sok dzsungelében, számos más, rövidebb vagy gyorsabb (netán mindkettő egyszerre) 
is létezik; mi ezt az ösvényt „tapostuk ki”. 
Az első kötethez a Processing MODFLOW alkotójától Wen-Hsing Chiang-tól kértünk 
egy mottót, most a Surfer alkotóit, Pat Madison-t és Dan Smith-t kértük fel erre. Vé-
leményük szerint a problémák megértését a számok térbeli megjelenítése nagymérték-
ben elősegíti, mivel az emberi agy alapvetően képekben gondolkodik. A Surfer és a 
Processing MODFLOW alkalmazásának összekapcsolása ezt valósítja meg. A tanulás 
további könnyítése érdekében valamennyi a könyvben bemutatott példa adatrendszere, 
továbbá térképei és a futtatható modellek – CD vagy DVD melléklet hiányában – a 
http://www.gama-geo.hu honlapról letölthetők. 
Felhívjuk a felhasználók figyelmét, hogy a Processing MODFLOW, könyvben bemu-
tatott, teljes, 5.3 verziója ingyenessé vált, szabadon letölthető a http://www.pmwin.net 
honlapról. A könyvben bemutatott szoftverek többsége is ingyenes, kivéve a Surfer for 
Windows-t, amely kereskedelmi forgalomban könnyen beszerezhető. 
A kötet témája a szennyezőanyagok elmozdulásának szimulációja Processing 
MODFLOW segítségével. Ezen anyagok talajba való beszivárgása, majd abban való 
migrációja komplex folyamat. Feltételezzük, hogy egy váratlan esemény következté-
ben nagy mennyiségű szennyezőanyag ömlik a talaj felszínére. Kezdetben, a talajba 
jutva, lefelé kezd szivárogni a telítetlen zónában a gravitációs erő hatására, de a kapil-
láris erők hatására a szennyezőanyag oldalirányban is elmozdul. Az anyag párolgása 
következtében a szennyező csóva közelében gázburok is kialakul. Ha elég nagy meny-
nyiségű a szennyezés, elérheti a talajvízszintet, ahol a szennyeződés vízzel vegyülő 
része a talajvíz-rendszer részeként (advektív-diszperzív transzport), míg a vízzel nem 
vegyülő része elkülönült fázisként, saját nyomásgradiense hatására mozog. 
A kapilláris erők miatt a szennyeződés részben befogva maradhat a telítetlen zóna pó-
rusaiban. Ez a befogott fázis további szennyezést okozhat a beszivárgó csapadék vagy 
a talajvízszint-emelkedés hatására. A beszivárgó csapadékvíz ezentúl a gáz halmazál-
lapotú szennyezést elnyelheti, ami további szennyezés forrása lehet. 
A szabad fázisban mozgó, nem keveredő, nem vegyülő anyagok hidrodinamikai visel-
kedése eltérő attól függően, hogy sűrűségük kisebb vagy nagyobb a víz sűrűségénél. A 
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könnyebb (kisebb sűrűségű) folyadék nyílt tükrű vízadó esetén a talajvíz-domborzat, 
zárt tükrű rendszer esetén a fedő geometriája által meghatározott irányban szivárog. A 
víznél nagyobb sűrűségű, nem-vegyülő folyadékok (pl. klórozott-szénhidrogének) 
migrációja azonban nem függ a talajvízszint helyzetétől. Ezek addig mozognak lefelé, 
amíg el nem érnek egy kisebb permeabilitású réteget, ahol szétterülnek vagy csapdá-
zódnak. Mivel az ilyen szennyezőanyag mozgását uralkodóan a közeg geometriája, és 
nem a szivárgás hidraulikája határozza meg, ezért migrációját nagyon nehéz előre 
meghatározni.  
Tovább bonyolítja a helyzetet, ha több szennyező komponens van egyszerre jelen, 
mert a közöttük lejátszódó kémiai reakciók és fizikai folyamatok a transzportot jelen-
tősen befolyásolják.  
Ha a különböző viszkozitású folyadékok mozgását vizsgáljuk, szivárgási tényező he-
lyett a permeabilitás  fogalmát kell használni az áramlási sebességek számításánál. 
Szemléltessük ezt a víz és a triklóretilén példáján. A triklóretilén viszkozitása azonos 
hőmérsékleten harmada a vízének, ezért azonos hidraulikai feltételek mellett a 
triklóretilén szabad fázisban háromszor gyorsabban mozog, mint a víz (SZANYI – 
MARTON, 2002). 
Az elmondottakból is látszik, hogy a szennyezőanyagok felszín alatti vizekben történő 
elmozdulása komplex folyamat, mely nem mindig vezethető le a hidraulikai viszo-
nyokból, ezért modellezése olykor speciális szoftvereket és nagy körültekintést igé-
nyel. Ebben a kötetben a szennyezőanyagok advektív-diszperzív transzportjának szi-
mulációjával foglalkozunk, az önálló fázisban való elmozdulást csak érintőlegesen 
tárgyaljuk. 
Ajánljuk a könyvet minden érdeklődőnek, gyakorlati és elméleti szakembernek, a mo-
delleket építőknek éppúgy, mint az azokat bíráló hatóság képviselőinek, vagy azoknak 
a megrendelőknek, akik a hidrodinamikai vagy transzport-számításokkal a mindennapi 
életben találkoznak. Reméljük, hogy hasznos segédeszközt tudtunk a „barikád” mind-
két oldalán állók kezébe adni. Kérjük, hogy fogadják meg az első kötet mottóját: 
„Whether modeling or real life, never give up easily !” Ne adják fel; megéri! 
Végül megköszönjük kollégáink tanácsait, továbbá támogatóink erkölcsi és anyagi 
segítségét. Hozzájárulásukkal nemcsak a könyvet, hanem ezen keresztül a magyar fel-
sőoktatást is támogatták. 
Hálásak vagyunk a lektorok, Rózsa Attila és dr. Völgyesi István lelkiismeretes és apró-
lékos munkájáért, javító szándékú kritikai észrevételeiért. 
 
Miskolc-Szeged, 2005. december 6. 

Jó szerencsét! 
a szerzők 
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11. A transzportmodellezés Processing MODFLOW for Windows 
(PMWIN) környezetben 

A könyv első kötetének 8. fejezetében bemutattuk a Processing MODFLOW for 
Windows (PMWIN) környezetet (CHIANG – KINZELBACH, 1999, 2001), továbbá 
a felhasználó rendelkezésére álló talajvíz-áramlási (hidrodinamikai) modellezési esz-
közöket. Tekintettel arra, hogy a környezetet egységes szemlélettel készítették, szá-
mos, a 8. fejezetben leírt eszköz, programmodul a transzportmodellezés során is ren-
delkezésre áll, alkalmazható. Terjedelmi korlátok miatt az ismétlődő modulok leírá-
sát ez a kötet nem tartalmazza, azok az 1. kötet megfelelő részében olvashatók. 
A PMWIN környezet transzportmodellezéshez összesen négy eszközt kínál, melye-
ket a Models menün keresztül érhetünk el (1. ábra). Mivel közülük valamennyit tel-
jes terjedelmében ismertetni szinte lehetetlen, ezért a programok közül a legelterjed-
tebb MT3D és MT3DMS nevűeket mutatjuk be részletesebben. Az itt közölt leírás-
nál részletesebb, angol nyelvű PDF dokumentumot készített a PMWIN szerzője, 
Wen-Hsing Chiang, ami a programot tartalmazó lemezen megtalálható. Amennyiben 
valaki az apró részletekre vagy a számításokhoz használt programrutinokra kíváncsi, 
akkor azokat a programlemezeken található közel 5000 oldalas dokumentációban 
lelheti meg.  
 

 
1. ábra 

A Models menü 
 

A négy, rendelkezésre álló transzportmodell a következő: 
A MOC3D (KONIKOW et al., 1996) transzportmodell a karakterisztika módszeré-
nek segítségével oldja meg a transzport egyenletet. A karakterisztika módszerének 
alkalmazásához a Grid menüben definiált elemosztást használja fel. 
Az MT3D (ZHENG, 1990,1992, 1996) és az MT3DMS (ZHENG – WANG, 1998) 
programok a MODFLOW-hoz fejlesztett transzportmodellek. A két program abban 
különbözik egymástól, hogy az MT3DMS többkomponensű (kompetitív) transzport 
számítására alkalmas. A programban többfajta módszer alkalmazására van lehetőség 
(véges differencia módszer, karakterisztika módszerének több változata). A megol-
dás során lehetőség van az advektív-diszperzív transzport, a lineáris és nem lineáris 
adszorpció, valamint a bomlás figyelembe vételére is. 
A PMPATH (CHIANG – KINZELBACH, 1993, 1994, 1998) programot hidrodi-
namikai vonatkozásai miatt már a 8.6. fejezetben részletesen bemutattuk. Már akkor 
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is említettük, hogy a program egy részecskeszemléletű szimulációs eljárást használó, 
advektív transzportmodell. Mivel a PMPATH modellnek szinte valamennyi jellem-
zőjét már bemutattuk, a továbbiakban nem foglalkozunk vele. 
 

11.1. A transzportmodellezés helye a PMWIN rendszerben 

A PMWIN környezet az említett transzportmodellek pre- és posztprocesszora. A 
transzportmodellek MS-DOS környezetben futó, többnyire FORTRAN valamelyik 
nyelvjárásában írt programok, melyeknél az adatbevitel nehézkesen szerkeszthető, 
általában hosszú szöveges állományokkal történik, és az eredményeket is hosszú, 
akár több 10 MB (nagyobb modellnél akár az 500 MB-ot is meghaladó) méretű szö-
veges, ritkábban bináris állományokban kapjuk meg. Mivel ezekkel a szöveges állo-
mányokkal nehéz dolgozni, ezért szükségesek azok a pre-processzor programok (pl. 
PMWIN), melyekben a szimulált rendszer megtervezhető, majd a program elkészíti a 
szükséges input szövegfájlokat a FORTRAN program részére. A programmal elvé-
gezhető egy DOS ablakban a transzportmodell futtatása, de van lehetőség az előre 
elkészített adatállományokkal később, a PMWIN környezeten kívül is elvégezni azt. 
Az eredményként kapott állományokat pedig egy posztprocesszor feldolgozóprog-
rammal (pl. PMWIN) jelenítjük meg és értékeljük ki (2. ábra). 
 

Preprocesszor
(Adatbevitel és

adatfeldolgozás)

Grid Editor

Field Interpolator

Field Generator

Programok
futtatása

MODFLOW

MT3D

MT3DMS

MOC3D

PEST

UCODE

Kalibráció

DOS

Posztprocesszor
(Eredményfeldolgozás, 

megjelenítés)

PMPATH

Water Budget
 Calculator

Presentation

Graph Viewer

Result Extractor

Windows

Processing MODFLOW keretrendszer

 
2. ábra 

A Processing MODFLOW környezet felépítése 
 

Ahhoz, hogy bármely transzportmodellel számításokat lehessen végezni, előbb el 
kell készíteni és le kell futtatani a vizsgált területrész hidrodinamikai modelljét. A 
hidrodinamikai modellel számított szivárgási sebességvektor komponensek, a hézag-
térfogat értékek a transzportmodellezés bemeneti paraméterei, ezért ezeket a transz-
portmodellnek ismernie kell. A hidrodinamikai és a transzportmodell közötti kapcso-
latot egy interfész állomány képzi, melynek kiíratását a MODFLOW futtatása során 
elő kell írni. Az interfész állomány készítésén túlmenően célszerű a hidrodinamikai 



5 

modellt a transzportmodellezésnek megfelelő módon felépíteni, amit a következő 
alfejezetben mutatunk be.  
A PMWIN környezetben végzett transzportmodellezésnek van egy további sajátos-
sága is. A rendszerben több programmal végezhetjük el ugyanazokat vagy az egy-
máshoz nagyon hasonló feladatokat: pl. ismert hidrodinamikai környezetben egy 
adott hatásra, ismert peremfeltételek mellett kialakuló koncentrációk időbeli változá-
sának számítását. A dolog természetéből adódik, hogy a számításokhoz részben azo-
nos adatokat kell felhasználni, pl. a kezdeti feltételek, mindig egy adott időpontban 
észlelt koncentráció-eloszlások. Mivel ezek az adatok a problémára jellemzők, és 
nem transzportmodell-specifikusak, ezért a rendszerben bármelyik transzportmodell 
használatakor is adjuk meg ezeket a bemeneti paramétereket, azok az összes többi 
programban azonnal alkalmazhatóvá válnak. Az ismertetetett megoldás egyik előnye, 
hogy azonos problémát tudunk gyorsan több rendszerrel megoldani, a másik pedig, 
hogy van lehetőség egy egyszerű, egykomponensű MT3D modell gyors továbbfej-
lesztésére, pl. egy többkomponensű MT3DMS transzportmodellé. 

11.2. A hidrodinamikai modell felkészítése a transzportszámításokra 

A transzportmodellezés legfontosabb előzménye egy korrekt, a releváns folyamato-
kat jól leíró, stabil, gyors, már a szennyeződés-terjedés szempontjait is figyelembe 
vevő hidrodinamikai modell. Sajnos sokszor a hidrodinamikai modellezés és a 
transzportmodellezés céljaira leginkább alkalmas modell csak közelítően azonos, 
ezért sokszor két modell párhuzamos építésére kényszerülünk. Az elsőt azért fejleszt-
jük, hogy azzal pontos hidrodinamikai számításokra legyünk képesek, a másikat pe-
dig azért, hogy az első modellhez nagyon hasonló, de a transzportmodellezésre ideá-
lis modellel is rendelkezzünk. Például a pontos hidrodinamikai modellek általában a 
kutak környezetében erősen besűrített rácshálót használnak. A sűrített rácsháló 
ugyanakkor a transzportmodellezés során használt időlépcső extrém csökkenéséhez 
vezet, ami nemcsak hosszú programfutást, hanem erősen megnövekvő numerikus 
hibákat is okoz. Ilyenkor érdemes az áramvonalakat, az elérési idő izokrón görbéit a 
pontos hidrodinamikai modellel, a szennyeződés-terjedést pedig egy minél inkább 
izometrikus elemeket tartalmazó modellel számolni. 
A transzportmodellnek tehát szüksége van egy permanens vagy nem-permanens ál-
lapotot leíró hidrodinamikai modellre, melyből a transzportmodell a szivárgási se-
besség-komponensek nagyságát, a felvett rétegek geometriáját alapadatként használ-
ja fel. A felhasználás eszköze egy olyan adatállomány (MT3D.FLO), amit a hidrodi-
namikai modellprogram állít elő a futása közben (MCDONALD – HARBAUGH, 1988, 
HARBAUGH - MCDONALD, 1996a, 1996b), és amit a transzportprogram beolvas a 
futás kezdetén. Mindebből az is következik, hogy bármiféle módosítást eszközlünk a 
hidrodinamikai modellen, előbb azt le kell futtatni, és el kell készíteni az új állo-
mányt, amit ezután a transzportprogram beolvashat (3. ábra). 
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MT3D.FLO

MODFLOW
hidrodinamikai modell

MT3D vagy MT3DMS
transzportmodell

 
 

3. ábra 
A hidrodinamikai és a transzportmodellezés kapcsolódása 

 
Gyakori hiba, hogy ez az állomány nem készül el, és akkor a transzportmodellt nem 
lehet futtatni. Az MT3D/MS programok részére az MT3D.FLO interfész állomány 
létrehozását a Models → MODFLOW → Output Control... paranccsal lehet elérni 
(4. ábra). Az ablakban az Interface file to MT3D doboz bejelölésével biztosíthatjuk 
az MT3D.FLO állomány elkészítését. Ugyanitt megadható, hogy a számítás során 
használt mely részeredményeket (Nyomásszintek – Hydraulic Heads, Depressziók – 
Drawdown, Cellák közötti hozamok – Cell-by-cell Flow Terms, Felszínsüllyedések 
(IBS1 csomag) – Subsidence, Egyes rétegek összenyomódása (IBS1 csomag) – 
Compaction of Individual Layers, Előkonszolidációs nyomás (IBS1 csomag) – 
Preconsolidation Heads) és a bemeneti adatokat (Echo Print of Input Values) tar-
talmazza az eredményállomány.. 
 

 
4. ábra 

Az MT3D interfész állomány kiíratásának beállítása 
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Függetlenül attól, hogy a hidrodinamikai modell eredendően permanens vagy nem 
permanens állapotú, azt a transzportmodellhez kell alakítani. Ezek közül a legfonto-
sabb a már említett MT3D.FLO állomány létrehozása. A másik alapvető dolog az 
időlépcsők beállítása a transzportmodellezés igényeinek megfelelően. 
Az időlépcsők beállítása akkor is fontos, ha a hidrodinamikai modell permanens ál-
lapotú volt, függetlenül attól, hogy emiatt a program az interfész állományba ugyan-
azokat a sebesség-komponenseket írja ki az időlépcsők darabszámának megfelelő 
számban. Amennyiben a modell permanens, az 5. ábra bal oldalán látható lehet pl. az 
időbeliség definíciója. Amennyiben a permanens állapotban 5 db 5 éves periódus 
transzport-szimulációjára készülünk, akkor szükséges az 5 db időlépcsőt a perma-
nens hidrodinamikai modellen belül is definiálni (5. ábra jobb oldala). Amennyiben a 
hidrodinamikai modell nem permanens állapotú rendszert szimulál, akkor célszerű 
mindkét rendszerben azonos időlépcsőket használni. 
 

  
5. ábra 

A hidrodinamikai modell időlépcsőinek módosítása 
 a transzportmodellezés igényeinek megfelelően 

 

Feltételezve, hogy egy rendszerben a hidrodinamikai állapot kétszer, a transzport-
szempontból fontos jellemzők (pl. szennyezőforrás intenzitása) háromszor változnak, 
akkor a 6. ábra szerinti öt időlépcső definiálása lehet a megoldás. 
Fontos, hogy a nem permanens hidrodinamikai modell által szimulált teljes időtar-
tamnak és a transzportmodell által szimulált időtartamnak azonos hosszúnak kell 
lenniük. A transzportmodellezésre történő felkészülés során ezért szükséges az idő-
beli szakaszolás módját átgondolni. A túl sok számítási időlépcső hosszas futáshoz 
vezet, továbbá mivel minden időlépcsőhöz külön bemeneti állományok tartoznak, 
ezért nagy, akár a 100 MB-os méretet is meghaladó, bemeneti és kimeneti állomá-
nyok kezelését teszik szükségessé. Érdemes tehát a munka megkezdését megelőzően 
átgondolni, hogy hogyan alakítható ki egy, a rendszert kellő mértékben leíró, de még 
kezelhető nagyságú és bonyolultságú számítási rendszer. Könnyebbséget jelent, hogy 
– főképpen a talaj- és talajvízszennyezések esetén a szennyezőforrások kialakulásnak 
pontos ideje nem ismert, ezért lehetőség van a 6. ábra szerinti, különböző transzport 
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állapotok  kezdeti és esetleg végső időpontjának kisebb tartományon belül mozgatá-
sával az összes időlépcsők számát lecsökkenteni. 
 

1. hidrodinamikai állapot 2. hidrodinamikai állapot 3. hidrodinamikai állapot

1. transzport állapot 3. transzport állapot 4. transzport állapot2. transzport állapot

Idő 1. időlépcső

5. időlépcső

4. időlépcső

3. időlépcső

2. időlépcső

 
6. ábra 

A hidrodinamikai és a transzportmodellezés időlépcsőinek harmonizálása 
 

Már a hidrodinamikai modell transzportszámításra alkalmas változatának elkészítése 
közben gondolkozni kell a transzportmodell működési koncepcióján. A transzport-
modell a szennyezőanyag mérleg számítását fogja elvégezni. Három eset lehetséges:  
– a szennyezőanyag a kezdeti állapotban már a rendszerben van (pl. egy szennye-

zett terület természetes szétterjedésének szimulációja esetén); 
– a szennyezőanyag a modellezés során jut be a rendszerbe (pl. egy aktív 

szennyezőforrás hatásának vizsgálata); 
– a leggyakoribb azonban a kettő kombinációja, amikor már van a rendszerben 

szennyező anyag, de a szimulációs időszakban további szennyezés is történik. 
A szennyezőanyag a rendszerbe vízbetáplálással együtt kerülhet csak kívülről be (pl. 
injektálókutakkal, beszivárgással, szennyezett folyadék elszikkasztásával, stb.), mely 
elemeknek már a hidrodinamikai modellben is benne kell lenniük. Ennek megfelelő-
en a hidrodinamikai modellt úgy kell felépíteni, hogy abban mindazok a „források” 
(vízbetáplálások) szerepeljenek, amelyeken keresztül a szennyezőanyag a transz-
portmodellben a rendszerbe be tud lépni.  
Amennyiben például van egy felszínközeli szennyezés, ahol a talajvíz a felszín felől 
a csapadékból történő beszivárgás hatására szennyeződik el, akkor az ennek vizsgá-
latára készített hidrodinamikai modellben még akkor is szimulálni kell beszivárgást, 
ha a beszivárgásból eredő hozamok a rendszer egészének vízmérlege szempontjából 
teljesen elhanyagolhatók. Mindezt azért, hogy a transzportmodellezés során legyen 
lehetőség a „vízbelépéseknek” szennyezőanyag-forrásként való használatára. 
Bármilyen módosítást végzünk a hidrodinamikai modellen, azaz a MODFLOW be-
meneti adatain, a Models → MODFLOW → Run paranccsal el kell végezni a futta-
tást, miközben a megváltozott helyzetnek (források és nyelők, időlépcsők, stb. meg-
változása) megfelelő szivárgási sebességteret a program kiszámolja, majd ezt köve-
tően a módosult MT3D.FLO interfész állományt is kiírja. Amíg a futtatás meg nem 
történik, addig a transzportmodell a korábbi hidrodinamikai helyzetet tételezi fel. 
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11.3. A peremfeltételek megadása 

A transzportmodell peremfeltételeit a Grid → Boundary Condition → ICBUND 
(MT3D/MT3DMS) paranccsal lehet megadni (7. ábra).  

 
7. ábra 

A hidrodinamikai és a transzportmodellezés peremfeltételeinek megadása 
 

A transzportmodellezésnél aktív (időben változó) és állandó koncentrációjú cellákat 
lehet a rendszerben definiálni. Inaktív cellák definíciójára azért nincs szükség és le-
hetőség, mert minden időlépcső elején a program áttekinti azokat a cellákat, melyek-
nél koncentráció-változás nem lehetséges (állandó koncentrációjú, forrás- és 
nyelőmentes területrészek) és ezekre a számítást nem végzi el.  
Az állandó koncentrációjú cellákat –1-gyel, a változó koncentrációjú, aktív cellákat 
1-gyel jelöljük a rendszerben. Amennyiben a modellezett terület kellően nagy, a 
szennyeződés kizárólag a modellezett területen belül található, továbbá a háttér-
koncentráció zérusnak tekinthető, készíthető olyan modell, ahol az összes cellát ak-
tívnak tételezzük fel. 
Amennyiben az MT3D/MT3DMS programrendszert használjuk, a peremfeltételek 
megadása kötelező, annak hiányára hibaüzenet hívja fel a felhasználót. 

11.4. Az MT3D program bemeneti adatainak megadása 

Az MT3D program adatait a Models → MT3D parancs segítségével adhatjuk meg. A 
menürendszerben a kiindulási koncentrációértékeket az Initial Concentration, az 
advektív transzportszámítás jellemzőit az Advection..., a diszperzív transzportot a 
Dispersion..., a szorpciós folyamatokat a Chemical Reaction menüpontok alatt adhat-
juk meg. A hidrodinamikai modellbe épített forráselemek által bejuttatott folyadékok 
koncentrációját a Sink/Source Concentration menü alatt definiálhatjuk. A kiírandó 
paramétereket és azok gyakoriságát az Output Control menüben határozhatjuk meg, 
végül a Run paranccsal történhet a készített MT3D modell futtatása (8. ábra). 

11.4.1. A kiindulási koncentrációk megadása 
Az MT3D program egy ismert állapotból kiindulva képes a koncentráció-változások 
számítására, ezért az abszolút koncentráció-értékek megadásához szükség van vala-
mennyi aktív cellában egy ismert állapotbeli koncentráció-eloszlás adataira, melyek a 
számítás kezdeti feltételeit képezik. A kiindulási koncentráció-eloszlás megadása a 
Models → MT3D → Initial Concentration parancs segítségével történik. Az itt 
megadott koncentráció-eloszlásokat a többi transzportmodell is felhasználhatja. 
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8. ábra 

Az MT3D program adatrendszerének megadása 
 

11.4.2. Az advektív transzport jellemzőinek megadása 
Az advektív transzport jellemzőit definiáló dialógusablakban (Models → MT3D → 
Advection) többféle megoldási mód (Solution Scheme) és részecske követési algo-
ritmus (Particle Tracking Algorithm) közül választhatunk. A kiválasztott megoldás-
tól és algoritmustól függően azok paramétereit az alsó táblázatban állíthatjuk be. A 
transzportmodellezés kezdeti fázisában nem célszerű a megadott alapértelmezett ada-
toktól eltérni, később, indokolt esetben és főként gyakorlottabb modellezők viszont 
bátran változtathatják ezeket a gyorsabb futás, a kisebb numerikus hibák, vagy más 
előnyök élvezése érdekében. Kezdő modellezőknek csak akkor javasoljuk az alapér-
telmezett paraméterek megváltoztatását, ha a modell nem fut, vagy ha erre a modell 
által készített szöveges kimeneti állomány (OUTPUT.MT3) kifejezetten utal, vagy 
javaslatot tesz.  
Az MT3D program négy megoldási módot alkalmaz: az előrelépéses véges differen-
cia módszert (Upwind Finite Differences), a karakterisztika módszerét (MOC), a 
módosított karakterisztika módszerét (MMOC) és a hibrid karakterisztika módszerét 
(HMOC). 
A véges differencia módszerrel történő megoldást az előző kötetben már röviden is-
mertettük.  
A karakterisztika módszere azon alapul, hogy a transzportegyenletet nem helyhez, 
hanem a mozgó vízrészecskékhez kötött koordináta-rendszert feltételezve írják le, 
így az eredetileg másodrendű deriváltakat tartalmazó transzport egyenlet ordináris, 
első rendű differenciálegyenletté alakul. Másképpen megfogalmazva a módszer a 
koncentrációk változását nem álló helyzetből, hanem az áramló folyadékkal együtt 
mozogva szemléli. Tekintettel a transzportegyenlet ordináris differenciálegyenletté 
való egyszerűsödésére a karakterisztika módszere (többnyire együttesen a véges dif-
ferencia módszerrel alkalmazva) kiküszöböli numerikus hibák nagy részét. Kiindulá-
si adatként szükséges az áramlási sebességtér jellemzőit, azaz a sebességvektor irá-
nyának és nagyságának térbeli és időbeli változását ismerni, amit többnyire véges 
differencia módszerrel határozzuk meg. Ezt követően olyan pontokat (részecskéket) 
helyezünk el az áramlási térben, amelyek az áramló vízzel együtt mozognak az 
áramvonal (=karakterisztikus vonal – innen az elnevezés!) mentén. A részecskék 
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helyzetét egy fix rácshálóhoz, praktikusan egy véges differencia hálóhoz viszonyít-
juk. Időlépcsőnként meghatározva a részecskék útját, meghatározhatóvá válnak a 
koncentrációk, melyek alapját képezik a következő időlépcsőben a részecskék térbeli 
„szétosztásának”. A módszer alkalmazása során az egyes részecskék megadott, de az 
időben, pl. a bomlás hatására változó szennyezőanyag-tömegeket jelképeznek. 
(KONIKOW és BREDEHOEFT, 1978). 
 

 
9. ábra 

Az advektív transzport megadása  
 

11.4.2.1. A megoldási módszerek 
A négy megoldás közül a feladat ismeretében célszerű választani. A karakterisztika 
módszerének hagyományos formája nagyon előnyös, mert gyakorlatilag teljesen ki-
küszöböli a numerikus hibákat, ugyanakkor hátránya, hogy nagy modellméret, illetve 
sok aktív cella esetén rengeteg részecske figyelembevételével kapható megfelelően 
reprezentatív eredmény, ami lassú számításhoz, illetve óriási memóriaigényhez ve-
zet.  
A módosított karakterisztika módszere (MMOC) a részecskék számát csökkenti azál-
tal, hogy minden aktív cellához csak egy, cellánként eltérő mennyiségű szennyező-
anyagot jelképező részecske hozzárendelését engedélyezi meg. A módszer csak ak-
kor használható, ha a modellezett térrészen belül a koncentrációk területi változása 
kicsi, mert alkalmazása éles frontok és kiugró koncentrációcsúcsok esetén jelentős 
numerikus diszperzióhoz vezet.  
A hibrid módszer megpróbálja a két ismertetett módszert ötvözni. A területen a szá-
mítás során mindkét módszert alkalmazza. Ahol jelentős koncentráció-változások 
vannak, ott a hagyományos MOC megoldást használja sok részecskével, míg a ke-
vésbé változó koncentrációkkal jellemezhető helyen az MMOC módszert használja 
fel. Azt, hogy mikor tekinthető a koncentráció változása nagynak, azt a felhasználó 
által megadott DCHMOC paraméter határozza meg. Ezzel a paraméterrel tudja a 
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modellező egyben a szükséges részecskék számát, illetve a használt memória méretét 
is befolyásolni. 
A véges differencia megoldás alkalmazása csak olyan esetekben javasolható, ahol az 
advektív transzport a diszperzív transzporthoz képest alárendelt. Ebben az esetben a 
numerikus oszcillációból és a numerikus diszperzióból származó hibák még általá-
ban nem zavarják az eredmények kiértékelését. 

11.4.2.2. A számítási algoritmusok 
A program az elsőrendű Euler (First-order Euler) vagy a negyedrendű Runge-Kutta 
(Fourth-order Runge-Kutta) algoritmust, illetve a kettő kombinációját alkalmazza.  
Az elsőrendű Euler algoritmus hibája, hogy általában jelentős numerikus hibákhoz 
vezet még kis időlépcsők esetén is.  
A negyedrendű Runge-Kutta algoritmus alkalmazásakor a szivárgás átlagsebességét 
három érték súlyozott átlagaként számítja a program. Az áramvonal kezdő és becsült 
végpontbeli sebességét egyszeres súllyal a becsült középső pontbeli sebességet dupla 
súllyal veszik figyelembe. Az alkalmazott megoldással a numerikus hibák jelentősen 
csökkenthetők még nagyobb időlépcsők esetén is, miközben jelentősen megnő a 
számítás hardver és időigénye. 
A két megoldás együttes alkalmazásával lehet a leggyorsabb számításokat elvégezni. 
Ekkor a források és nyelők közelében a negyedrendű Runge-Kutta algoritmust, attól 
távolodva az elsőrendű Euler algoritmust használjuk.  
Általánosságban célszerű a megoldási módszert és a számítási algoritmust úgy meg-
választani, hogy az alkalmazott időlépcső minél nagyobb lehessen, mert ekkor a leg-
kisebbek a numerikus diszperzióból és általában az oszcillációból eredő hibák. 

11.4.2.3. Az advektív transzportcsomag egyéb paraméterei  
A táblázatban szereplő egyéb paraméterek jelentése a következő. Az MXPART pa-
raméterrel a megengedhető legnagyobb részecskeszámot adhatjuk meg. Vigyázni 
kell, hogy a számítás által igényelt memóriaméret ne haladja meg rendelkezésre ál-
lót. A PERCEL paraméter a Courant-szám nevű, numerikus invariáns. A szám nagy-
sága határozza meg, hogy a szennyezőanyag a cellán belül milyen irányokba moz-
dulhat el. Értéke 0,5 és 1 közötti általában. 

A Courant-szám határozza meg a maximális időlépcsőt (∆t) a számítás során. Az 
MT3D programban a maximális időlépcsőt az R késleltetés, a cellaméret (∆x, ∆y, ∆z) 
és a szivárgási sebesség (vx, vy, vz)hányadosának irányszerinti minimuma, valamint a 
Courant-szám függvényében az alábbi módon határozhatjuk meg: 


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WD a koncentráció súlyszám értéke 0 és 1 közé esik, általában 0,5 értéket haszná-
lunk, azonban ez növelhető, amennyiben az advektív transzport a domináns transz-
portfolyamat.  
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A DCEPS paraméter határozza meg, hogy mekkora részecskeszámmal történjék a 
szimuláció. Amennyiben a DCEPS értéke nagyobb, mint a DCCELL koncentráció-
változási irányszám, akkor egy NPH paraméterrel megadott nagyobb, amennyiben 
annál kisebb, akkor egy NPL paraméterrel meghatározott kisebb részecskeszámmal 
történik a szimuláció. A DCEPS értékét 10-5 érték körülinek szokták választani. A 
DCCELL koncentráció-változási mutatószám a cella közvetlen környezetében mért 
legkisebb és legnagyobb koncentrációk (CMINjik és CMAXjik) különbségének és a 
teljes modellezett térrészben mért minimális és maximális koncentrációk (CMIN és 
CMAX) különbségének hányadosa: 

CMINCMAX
CMINCMAX

DCCELL jikjik
kij −

−
=,,       (11.2.) 

A paraméter tehát megmutatja, hogy a cella környezetében a koncentráció-változás 
mekkora hányada a teljes modellben észlelt koncentráció-változásoknak. 
A korábban említett NPL paraméter a megadja a részecskék minimális számát. A 
program ezt akkor alkalmazza, ha kicsik a koncentrációkülönbségek a modell éppen 
aktuálisan vizsgált térségében. Az NPL paraméter minimális értéke zérus, ami nyu-
godtan alkalmazható, mert kis koncentrációváltozások, koncentráció-gradiensek ese-
tén az advektív transzport elhanyagolhatóvá válik (amennyi szennyezőanyag távozik, 
ugyanannyi érkezik egy kiválasztott térrészbe). Az NPH paraméterrel azt állíthatjuk 
be, hogy hány részecske induljon azokból a cellákból, ahol a koncentráció-
változások DCEPS küszöbértéknél nagyobbak. Az alkalmazandó részecskeszámot a 
modellező szabadon választhatja meg, azonban a részecskeszám felesleges emelése a 
számítás memória és időigényének ugrásszerű növekedéséhez vezet. Általánosság-
ban akkor kell nagyobb részecskeszámmal dolgozni, ha a szivárgási sebességtér erő-
sen inhomogén. CHIANG és KINZELBACH (2001) szerint síkmodellek esetén cel-
lánként 16-nál, térmodellek esetén 32-nél több részecskével dolgozni ritkán szüksé-
ges. Amennyiben az NPL és NPH értékét azonosnak vesszük, akkor a részecskeel-
osztás a teljes modellezett térben homogénné válik. 
Az NPLANE paraméter a részecskék cellán belüli elhelyezését szabályozza. A ré-
szecskék szétosztása az NPLANE paraméternek megfelelő számú síkon történik. 
Amennyiben az NPLANE paramétert zérusnak választjuk, akkor véletlenszerűen 
helyezi el a program a részecskéket a cellában. Ez utóbbit elsősorban homogén szi-
várgási térben érdemes alkalmazni, egyéb esetekben célszerűbb a részecskéket síkok 
mentén elhelyezni. Síkszivárgás esetén a paramétert 1-re érdemes választani. Térmo-
delleknél a paraméter értékét ugyan lehet bármekkorára választani, de általában két 
sík mindig elegendő. 
NPMIN és NPMAX a cellában az időlépcső végén megengedhető részecskék mini-
mális és maximális száma. A nem homogén sebességtérben a részecskék egyes cel-
lákból teljesen eltávozhatnak, másutt összegyülekeznek a számítás során. Amennyi-
ben egy adott cellában az NPMIN paraméterben megadottnál kevesebb részecske 
marad, akkor a program ott újabb részecskéket helyez el, ahol pedig az NPMAX ér-
téknél több van, onnan elvesz. Ezzel a rendszerben található részecskék darabszáma 
egy racionális tartományon belül tartható. 
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Az SRMULT paraméterrel a szennyezőforrásként működő cellákban szabályozhat-
juk a részecskék számát. Az SRMULT szorzótényező, értékét általában 1-re választ-
ják, ugyanakkor az érték emelésével a források környezetében a koncentráció-
eloszlás finomabb változásait is számítani lehet.  
Az NLSINK paraméter az MMOC megoldás esetén a részecskék kezdeti eloszlásá-
nak sémáját mutatja be. Megállapodás szerint azonos módon osztjuk szét a részecs-
kéket a MOC és MMOC megoldásoknál, ezért az NLSINK értéke megegyezik az 
NPLANE értékkel. Az NPSINK paraméter adja meg a részecske számot az MMOC 
számítás során, értékét az NPH értékkel azonosan szokás felvenni. 
A DCHMOC paraméter mutatja meg, hogy mekkora az a koncentráció-gradiens, ami 
felett a hagyományos, ami alatt pedig a módosított karakterisztika módszerét hasz-
nálja a hibrid módszer. A program cellánként összeveti a DCHMOC paramétert a 
DCCELL értékkel, majd ennek alapján határozza meg az alkalmazandó számítási 
megoldást (CHIANG – KINZELBACH, 1993). 

11.4.3. A diszperzív transzportjellemzők megadása 
A diszperzív transzportjellemzőket a Models → MT3D → Dispersion parancs se-
gítségével adhatjuk meg. A szennyezőanyag diffúzióját az effektív molekuláris dif-
fúzió-állandó (DMCOEF paraméter), a makro- és a hidrodinamikai diszperzió miatti 
szóródását a hidrodinamikai diszperzió-állandó határozza meg. A diszperzió-
állandót, mint a szivárgási sebesség és a diszperzivitás szorzatát definiáltuk. Tekin-
tettel arra, hogy a szivárgási sebességek komponenseit az MT3D program a 
MODFLOW számítás eredményeiből ismeri, ezért a programnak csak a 
diszperzivitás értékeit kell megadni.  
A diszperzivitás szivárgási iránytól függő: három komponense a longitudinális 
diszperzivitás, a vertikális transzverzális és a horizontális transzverzális diszper-
zivitás. Az MT3D programmal közvetlenül csak a longitudinális diszperzivitás érté-
keit lehet elemenként megadni, a transzverzális diszperzivitásokat csak a longitudi-
nális diszperzivitáshoz képest felvett arányszámokkal lehet definiálni. 
A TRPT szám megmutatja a horizontális transzverzális és a longitudinális diszper-
zivitások, míg a TRPV szám a vertikális transzverzális és a longitudinális 
diszperzivitások arányát jellemzi.  
A diszperziós csomag elindításakor a program előbb az arányszámokat és a diffúzió-
állandót kéri (10. ábra), majd ezt követően egy Grid Editor ablakban megadható ele-
menként a longitudinális diszperzivitás. 
A diszperziós csomag az explicit középponti differenciák módszerét használja, ezért 
a megoldás stabilitása érdekében az időlépcsőt korlátozni kell. A megengedhető ma-
ximális időlépcső arányos a késleltetési tényezővel és az elemek méretével, fordítot-
tan arányos a diszperzió- és diffúzió- állandóval. 
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10. ábra 

A diffúzió-állandó és a diszperzivitási arányok rétegenkénti megadása 
 

11.4.4. A szorpció és a bomlás jellemzőinek megadása 
A szorpció és bomlás jellemzőit a kémiai reakció csomagban (Chemical Reaction 
Package) lehet definiálni. A programhoz mellékelt MT3D csomagban csak rétegen-
ként adhatók meg a paraméterek (Layer-by-layer), az MT3D96 és MT3D99 fejlet-
tebb változatokban azonban már elemenként (Cell-by-cell). A Models → MT3D → 
Chemical Reaction → Layer-by-layer parancs kiválasztásával egy dialógusablakot 
nyitunk meg (10. ábra). 
Itt először kiválasztandó egy legördülő menüből a szorpció és bomlás leírási módja: 
Van mód a szorpciót figyelmen kívül hagyására (No sorption), lineáris szorpció 
(Linear equilibrium isotherm), Langmuir (Langmuir nonlinear equilibrium 
isotherm) vagy Freundlich (Freundlich nonlinear equilibrium isotherm) izotermák 
figyelembevételére. Függően attól, hogy a szorpciót milyen módon vesszük figye-
lembe egy vagy több paramétert nem szükséges megadni, ekkor ezek az oszlopok 
beszürkülnek. 
Valamennyi réteghez megadandó a talaj száraz állapotra vonatkozó térfogatsúlya 
(RHOB paraméter). Amennyiben lineáris szorpciót tételezünk fel, akkor a Kd meg-
oszlási együtthatót, Freundlich izoterma esetén az izoterma két paraméterét a KF 
konstans értéket és az A hatványkitevőt, Langmuir izoterma esetén a KL Langmuir 
állandót és az SC maximális szorpciós kapacitást kell megadni. 
A radioaktív bomlást, illetve a biodegradációt a pórusbeli és a megkötött fázisra vo-
natkozó RC1 és RC2 bomlási állandókkal vehetjük figyelembe, ha a megfelelő jelö-
lőnégyzet kiválasztásával engedélyeztük a bomlás figyelembevételét (Simulate the 
radioactive decay or biodegradation) 

11.4.5. A források és nyelők megadása 
Mint azt korábban említettük  a szennyezőanyagok bevitele a modellezett térrészben 
a hidrodinamikai modellben definiált forrásokon keresztül történhet. Azt, hogy mek-
kora szennyezőanyag-mennyiség jut az egyes forrásokon keresztül a rendszerbe azt 
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az egyes forrásokon bejutó folyadékok koncentrációjával adhatjuk meg, a hidrodi-
namikai modellel számított hozamok mellett. A koncentrációkat a Models → MT3D 
→ Sink/Source Concentration menüparanccsal adjuk meg. 

 
11. ábra 

Források és nyelők hozamának megadása 
 

A menüben három módon jelennek meg az egyes lehetséges források (11. ábra): 
A szürkével jelzett inaktív csomagok a hidrodinamikai modellben nem definiáltak, 
ezért azokon keresztül nem történhet szennyezőanyag-bevitel sem. A feketével meg-
jelenített elemek szerepelnek a számításhoz felépített hidrodinamikai modellben, 
ezért ezek alkalmazhatók a szennyezőanyag bevitelre. 
Amely elemek mellett egy kis pipa is megjelenik, azok a csomagok aktívak, azaz 
ezeken keresztül történik az adott modellben a szennyezőanyagok bejutása (pl. a 11. 
ábra szerint a Recharge csomagon keresztül). 
A megfelelő csomag kiválasztása után a Grid Editor ablak felhasználásával minden 
cellában a bejutó folyadékok koncentrációját megadhatjuk. 
A rendszer mértékegység konzekvens, azaz figyelni kell arra, hogy amennyiben a 
koncentrációt a talajvizekben mg/l, azaz g/m3 egységekben mérjük, akkor a tömeget 
g-ban kell megadni, azaz a talajok sűrűségét is g/m3-ben, a megoszlási együtthatót 
m3/g-ban kell megadni.  
A nyelők által kivett folyadékok koncentrációját értelemszerűen nem kell megadni, 
hiszen a kitermelt folyadék koncentrációja megegyezik az adott elemre aktuálisan 
számított koncentráció értékével. 

11.4.6. A kimeneti fájl beállításai (Output Control) 
Az MT3D program mindig készít egy OUTPUT.MT3 nevű kimeneti állományt, 
amibe a modellező által kiválasztott paramétereket menti a program. Az állomány 
igen nagy lehet, mivel egy terjengős szövegfájl, amelyiknek hossza pl. az időlépcsők 
számától, a modellcellák darabszámától és természetesen a kiírandó paraméterek 
mennyiségétől is függ. A kimeneti állomány beállításai a Models → MT3D → Out-
put Control (MT3D/MT3DMS) menüvel érhetők el (12. ábra).  
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12. ábra 

Az MT3D kimeneti paramétereinek beállításai 
 

Az Output Terms lapon választhatók ki a kiírandó paraméterek és eredmények: a 
koncentráció értékek bináris és ASCII szövegállományba, a részecskeszám, a késlel-
tetési tényező és a diszperzió-állandó cellánkénti számított értéke ASCII szövegál-
lományba menthetők. 
Az Output Times lapon a kiírás gyakoriságát lehet megadni. Alapértelmezetten ele-
gendő minden időlépcső (Period) végén a koncentrációk és a kijelölt paraméterek 
kiíratása (NPRS=0), de előírhatjuk, hogy minden hányadik időlépés után történjék a 
kiíratás (NPRS>0), esetleg a lapon található táblázat kitöltésével a kiírási gyakorisá-
got időintervallumonként is változtathatjuk. 
Az egyebek (Misc.) lapon az inaktív cellákhoz rendelt értéket (CINACT) állíthatjuk 
be, a minimális telített rétegvastagság értékét (THKMIN), illetve azt, hogy milyen 
gyakorisággal írja a program ki a szennyezőanyag-mérleg elemeit egy MT3D.MAS 
nevű állományba (NPRMAS). Sajnos a THKMIN opció csak a fejlettebb MT3D ver-
ziókban található meg, ezért a tradicionális, a programhoz adott MT3D verzió ezt 
nem veszi figyelembe (CHIANG – KINZELBACH, 1993). 

11.4.7.  Az MT3D program futtatása 
A programot a Models → MT3D → Run paranccsal lehet lefuttatni (13. ábra). A 
dialógusablakban kiválaszthatjuk a futtatni kívánt MT3D programállományt (elérési 
úttal együtt), továbbá láthatjuk a modellben szereplő összes modellcsomagot, vala-
mint azokat, melyek az utolsó futtatás óta megváltoztak. Ez utóbbiakat a Generate 
oszlopban található kereszt alakú jelölés mutatja.  
A program alapértelmezésben csak a megjelölt csomagokat készíti el újra. Amennyi-
ben valamennyi csomagot frissíteni szeretnénk, akkor ezt a Regenerate all input files 
for MT3D paranccsal tehetjük meg. Amennyiben a Generate input files only, don’t 
start MT3D parancsot adjuk ki, akkor az összes MT3D állomány elkészül, és azokat 
később az aktuális modellkönyvtárban található MT3D.BAT nevű állomány végre-
hajtásával lehet futtatni. 
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13. ábra 

Az MT3D és MT3DMS futtatása 
 

11.4.8. Teendők, ha valami nem sikerül... 
Az MT3D egy régóta tesztelt program, ami alapvetően működik, azaz általában nem 
a programban van a hiba, ha valami nem működne... 
Ha a futtatás parancs után a gép elkészíti az MT3D bemeneti állományait, majd leáll 
és kilép a PMWin környezetből, akkor ez egy kompatibilitási hiba, ami egyes Win-
dows beállítások esetén előfordul. Egyes gépeken ugyanaz az adatrendszer produkál-
ja a hibát, máson nem, esetleg a jelenség újabb, a PMWin-től független programok 
installálása után jön elő. A jelenség oka ismeretlen, de a megoldás egyszerű... Ilyen-
kor a futtatás során mindig be kell jelölni a Generate input files only, don’t start 
MT3D négyzetet, és külön az MT3D.BAT állomány segítségével kell elvégezni a 
számolást ! 
Ha a program nem kezdene el futni, és a DOS ablakban hibaüzenet jelenik meg, ak-
kor először nézzük meg a gép által készített OUTPUT.MT3 nevű, kimeneti állo-
mányt, mely egy szövegfile, ami tetszőleges szövegszerkesztővel (Jegyzettömb, 
WordPad, Word, stb. olvasható). Olvassuk végig a szöveget, mert tartalmazza mind-
azt, ami a számítás során történt. A szöveg végén az End of Model Output szöveg 
olvasható (14. ábra), ha sikeresen futott le a program. Amennyiben nem, akkor a hiba 
okára utaló sort olvashatunk, ami segíthet a probléma megoldásában. 
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14. ábra 

Az OUTPUT.MT3 állomány vége 
 
Ha mégsem találjuk a hiba okát, akkor figyelmesen nézzük végig a megadott állo-
mányokat. A leggyakoribb hibák: 
– A negatív koncentráció értékek megadása során a legtöbb esetben a program nem 

fut le. Előfordul, hogy a koncentráció térképeket térképszerkesztővel vagy a Field 
Interpolatorral készítettük el és ekkor a számított állományokban lehetnek negatív 
számok. Az állapotot a Value → Search and Modify paranccsal lehet a 
legegyszerűbben megszüntetni, a negatív számok keresésével, és zérus vagy a 
háttérnek megfelelő koncentrációkra való átírásával (Replace opció). 

– Túl kicsi vagy szeszélyesen változó rétegvastagságok esetén gyakran divergenssé 
válik a modell. Ez igen nehezen vehető észre, mert a rétegvastagságok pozitívak, 
így a MODFLOW nem jelez hibát. A szennyezőanyag mérleg számításakor 
azonban ezek a cellák egyrészt az időlépcső erős sűrűsödéséhez, másrészt sokszor 
a numerikus számító algoritmusok divergenciájához vezetnek. Megoldás, ha el-
készítjük az egyes rétegek vastagsági térképeit és a néhány cm vastag területeken 
kissé kivastagítjuk azokat. Ezt különösen olyankor lehet nyugodtan megtenni, 
amikor a rétegek extrém elvékonyodását nem az alapadatok indokolják, hanem az 
alkalmazott inter- és extrapolációs algoritmusok. 

 

– Javasolható hibakeresési lehetőség, amikor a transzportmodell nem fut, vagy ext-
rém eredményekhez vezet, hogy az egyes csomagokat egyenként futtatjuk, azaz 
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olyan modelleket készítünk, melyekben csak a korábban felsorolt csomagok 
(advekció, diszperzió, kémiai reakció, forrás és nyelő) közül csak egyetlen aktív. 
Általában ilyenkor gyorsan kiszűrhető, hogy melyik csomag az, ami a helyes 
számítást akadályozza, ezután lehet a kiszűrt, nem korrektül működő csomagot 
tovább vizsgálni. 

– Általános és sokszor elkövetett hiba, amikor nem konzekvensen alkalmazzuk a 
mértékegységeket. Pl. a sűrűséget gyakorta használjuk kg/m3, régebben g/cm3 
egységben, a modellben pedig sokszor mg/m3 vagy g/m3 egységben kell dolgoz-
ni. Javaslom, hogy az eredmények dimenziója alapján történjék a tömeg mérték-
egységének megválasztása, mert általában sok koncentráció-eloszlást számolunk, 
majd publikálunk. Célszerű, hogy ezeket a megfelelő és általánosan használt mg/l 
vagy µg/l egységben kapjuk meg, mert egyébként az eredményeket kell később 
átszámolni, aminek elfelejtése vagy eltévesztése komoly problémákat okozhat. 
Ugyancsak fontos az idő dimenzióját értelmesen megválasztani, mert pl. másod-
perc esetén a számítási időt – ami sokszor akár 50-100 év – másodpercben kell 
megadni, ami azt jelenti, hogy általában tíz hatványaival dolgozunk. Sajnos ezek 
a számábrázolások annyira nem megszokottak, hogy azonnal szembeötlő volna 
bármilyen tévesztés, hiszen senki sem tudja fejből, hogy például mennyi 10 vagy 
15 év másodpercekben. Ezek a hibák csak módszeres és kimondottan a mérték-
egység átszámolásra koncentráló hibakereséssel szűrhetők ki. 

11.5. Az MT3DMS program használatának specialitásai 

Az MT3DMS program az MT3D program egy módosított és továbbfejlesztett válto-
zata. A program nevében található MS betűk a multi-species, azaz több komponens 
szóra utalnak, tehát a programmal többkomponensű szennyezőanyag transzport szá-
mítása válik lehetővé. A program felépítése és koncepciója teljesen megegyezik az 
MT3D programéval: a működéséhez szükséges hidrodinamikai rendszert ebben az 
esetben is az MT3D.FLO állomány írja le. 
Mivel többkomponensű a transzport, ezért a kezdeti koncentrációkat a komponensek 
számának megfelelő mátrixban kell tárolni, és az eredményeket is komponensenként 
kapjuk meg. Valamennyi komponensnek van egy sorszáma, neve, továbbá a rendszer 
nyilvántartja, hogy az aktuális adatokkal a mátrix fel van-e töltve (Data: szürke vagy 
fekete üres négyzet), illetve, hogy a következő szimuláció során az adott komponens 
transzportjával kell-e számolni (Active: üres vagy bejelölt négyzet, 15. ábra). 
A transzport csomagok az MT3D programnál megszokottak, de néhány esetben 
részben továbbfejlesztettek. Az advektív transzport megadásánál a véges differencia 
megoldást továbbfejlesztették, lehet az explicit és a teljesen implicit megoldási algo-
ritmus közül választani, továbbá bevezettek egy új, TVD nevű megoldási módszert 
is. A TVD megoldás előnye, hogy a numerikus diszperzióból és oszcillációból eredő 
hibákat jelentősen csökkenti.  
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15. ábra 

A többkomponensű transzport kezdeti koncentrációinak megadása 
 
A diszperzív transzport csomag újdonsága az explicit középponti differenciák mód-
szerének és az implicit előrelépéses differenciák alkalmazásának választhatósága. A 
lehetőség egyes modelladat-rendszereknél segít a numerikus hibák nagyságának le-
csökkentésében. 
A kémiai reakció csomag tartalmazza az egyensúlyi szorpciót, illetve az irreverzibilis 
kémiai folyamatokat (radioaktív bomlás és biodegradáció) gyakorlatilag azonos mó-
don, mint ahogy azt az MT3D program is teszi. Megjegyzendő, hogy az MT3DMS 
program az irreverzibilis reakciók tekintetében komponensenként számol a bomlás-
sal, a kompetitív transzportot más, ilyen tekintetben fejlettebb program, mint pl. a 
Processing MODFLOW Pro program által is támogatott RT3D képes számítani. A 
reakció csomag MT3DMS-beli újdonsága az első-rendű kinetikájú szorpció és a ket-
tős porozitású tömegáram funkció. 
Az első rendű kinetikájú szorpciót az alábbi egyenlet írja le (BEAR-VERRUIJT, 1987): 
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ahol a C a pórusbeli, C a megkötött anyag koncentrációja, Kd a megoszlási együttha-
tó, ρb a száraz állapotban mért talajsűrűség és β az első rendű megkötődési sebesség-
állandó a pórusban és a felületen tárolt anyag között.  
Amennyiben a folyadék mozgása lassú, akkor elegendő idő áll rendelkezésre ahhoz, 
hogy a szorpció végbemenjen, ekkor a hagyományos, a szorpciót leíró egyenletekhez 
jutunk. 
A kettős porozitású rendszereket az MT3DMS program csak korlátozott mértékben 
tudja figyelembe venni. A rendszer porózus közegből és az azokat szabdaló repedés-
hálózatból áll. Mivel a repedésekben a víz mozgását gyorsnak tételezik fel (nyitott 
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vetők), a pórusokban pedig a szivárgás lassú, a két rendszerben eltérő jellegű anyag-
transzport zajlik: a repedések környezetében az advektív, a porózus közegben a 
diffúzív transzport a domináns. 
Az MT3D programmal való kompatibilitás érdekében a gyorsan mozgó, mobilis vi-
zeket a Parameters → Effective Porosity menüben definiált pórusok tartalmazzák, 
az immobilis vizet az MT3DMS program kémiai reakció (Chemical Reactions) dia-
lógus-ablakában kell megadni. Az itt megadott porozitás és a paraméterek között 
megadott szabad hézagtérfogat összege adja a teljes porozitását a kettős porozitású-
nak feltételezett rendszernek. 
A mobilis és az immobilis vizet tartalmazó térrészek közötti anyagtranszportot az 
alábbi egyenlettel közelítjük: 
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ahol nim a szekunder porozitás (immobilis vizet tartalmazó hézagtérfogat), Cim az 
immobilis, Cm a mobilis térrész pórusainak koncentrációja és ζ az első-rendű tömeg-
áram sebesség-állandó a mobilis és az immobilis pórusok között. 

Amennyiben nagy a ζ sebesség-állandó, akkor a rendszer viselkedése egyre inkább 
hasonlít a hagyományos porózus rendszerek viselkedésére, ha közelít a zérushoz, 
akkor az immobilis fázis egyre kevésbé vesz részt a folyamatokban, az így tárolt, 
illetve a pórusokba jutó szennyezőanyag áramok egyre inkább elhanyagolhatóvá vál-
nak. A sebesség-állandó nem vagy alig mérhető, ezért elsősorban a koncentrációk 
alapján végzett kalibrációval állítható be. 
Az MT3DMS utolsó újdonsága a GCG megoldó algoritmus, amely az MT3D megol-
dó algoritmusához képest számos kényelmi funkciót ajánl. A GCG algoritmusnál 
nincsenek stabilitást szolgáló állandók, melyek változtatása a megoldás gyorsaságá-
nak és stabilitásának változásával járna.  
Az MT3D program futtatása a Run paranccsal történik teljesen hasonlóképpen az 
MT3D programhoz. 
A könyvünkben az MT3DMS program teljes leírására nem törekedtünk, mivel azt 
számos mű részletesen megteszi, illetve a PMWIN programhoz a teljes program-
dokumentációt is mellékelik. Itt csak a kiindulási alapként szolgáló MT3D program-
tól való legfontosabb és legjellemzőbb eltéréseket tárgyaltuk. 
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12. Interpoláció, térképek szerkesztése, térképi műveletek Surfer for 
Windows programmal 

A Surfer for Windows (GOLDEN SOFTWARE, 1997, 1999, 2002) egy 2.5 dimenziós 
felületszerkesztő program, amelyik számos egyéb alkalmazása révén a hidrodinami-
kai és transzportmodellezés során a modellező igen hasznos segítője lehet. A prog-
ram v8 verziója legfontosabb részeinek ismertetését jelen fejezet tartalmazza, a prog-
ramnak a modellezés során történő használatát a további fejezetek mutatják majd be. 
A Surfer for Windows a Golden Software Inc. által gyártott kereskedelmi szoftver, 
melyet Magyarországon számos szoftverkereskedő is forgalmaz. A szoftverrel kap-
csolatos információk, segédprogramok, mintaállományok a fejlesztők honlapján a 
http://www.goldensoftware.com lapon találhatók meg. 
Amint azt korábban említettük, a program 2.5D térmodellező program, ami annyit 
jelent, hogy a valódi 3D megjelenítés ugyan nem lehetséges, mégis a kétdimenziós-
nál „térbelibb” ábrázolásra van lehetőség. Az alkalmazás során ugyanis minden „tér-
felület” esetén egy x,y koordinátapárhoz egyetlen z érték rendelhető hozzá, azaz, 
például egy gömbfelületet csak két felület (egy alsó és egy felső félgömb) együttes 
alkalmazásával ábrázolhatunk. A valóságban sokszor elegendő a 2.5 D megjelenítés, 
például, ha egy réteg szivárgási tényező, fedő- vagy feküszintvonalas térképét akar-
juk megszerkeszteni. Van azonban, amikor még ilyen esetekben is egy x,y 
értékpárhoz több z érték tartozik, pl. amikor egy vízadó réteg szivárgási tényező-
térképét szerkesztjük meg és a réteget harántoló fúrásokból fúrásonként több szivár-
gási tényező értéket is meghatároztak. Az ilyen helyzeteket a program képes kezelni, 
miközben az igazi 3D térmodellezésre nincs lehetőség. 

12.1. A program működése, állományai 

A Surfer program több lépésben képes izovonalas térképek és térfelületek megszer-
kesztésére.  
Kiindulásként olyan adatállományokra van szükség, melyekben minimálisan három 
oszlopban vannak adatok: az egyik oszlopban az x, a másikban az y, a további oszlo-
pokban az izovonalas térképek és felületek szerkesztéséhez használt z1, z2, ..., zi ko-
ordináták találhatók. A program adatállományai ASCII szövegállományok vagy táb-
lázatkezelő állományok (pl. MS Excel, Sylk, stb.) is lehetnek (MS Access), melyek 
az egyes pontokhoz tartozó információt soronként tartalmazzák (rekordok). 
Az adatállományok alapján a program először egy rácsháló-állományt, – a program 
nomenklatúráját követve – grid fájlt hoz létre. A grid állomány egy a felhasználó 
által meghatározott területrészre fektetett, az alkalmazott koordinátarendszer tengely-
irányainak megfelelő tájolású, irányonként egyenközű rácsháló rácspontjaira, az 
adatállomány alapján számított legvalószínűbb interpolált vagy extrapolált értékeket 
tartalmazza, melynek számításához számos matematikai és geostatisztikai eszköz áll 
rendelkezésre. A grid állomány ennek megfelelően – kivételes esetektől eltekintve – 
nem tartalmazza az eredeti adatpontoknak megfelelő értékeket, csak az azokból szá-
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mított „legvalószínűbb” értékeket, melyek a Surfer által számított, az alapadat-
pontokra fektetett térfelületet írják le. 
A grid állományt a felhasználó többféle módon használhatja fel: van mód a térfelület 
izovonalas térképként vagy térfelületként történő megjelenítésére, de lehetséges a 
felületet leíró pontok felhasználásával, a térképekkel történő tetszőleges matematikai 
műveletek – beleértve a felületek deriválását és integrálását (pl. térfogatszámítás) is – 
elvégzése. A grid állományok és az azokkal végezhető matematikai műveletek sokfé-
lesége biztosítja a program sokrétű felhasználhatóságát. 
Összefoglalva a program alkalmazásának főbb lépéseit elmondható, hogy a felhasz-
nálónak először egy olyan adatállományt kell létrehoznia, melynek oszlopai tartal-
mazzák a koordinátákat, illetve a térfelület kiindulási adatpontjait, sorai egy-egy pont 
jellemzőit tartalmazzák. Az adatfájlból egy a felhasználó által definiált rácsháló 
csomópontjaira valamilyen kiválasztott matematikai eljárással, az adatpontokkal leg-
inkább összhangban álló értékeket számítunk, melyek az adatpontok által jellemzett 
területi eloszlást a legjobban leírják, és ezeket az adatokat egy grid állományba men-
tik el. A grid állományokkal további műveletek végezhetők, illetve a grid állomány-
ban tárolt adatok grafikus térképi és térbeli megjelenítése rajzállományokba is 
megtörténhet. A Surfer a rajzállományokat SRF kiterjesztésű állományokba menti el. 

*.SRF
surfer rajzállományok

*.DAT, *.XLS, *.CSV, *.SLK
adatállományok

*.GRD
grid (rácsháló) állományok

Matematikai mûveletek grid-
állományokkal térképek összeadása, 

kivonása, osztása, szorzása,
logaritmizálás, integrálás, deriválás, stb.

Síkbeli ábrázolás:
izovonalas, színskálás 
vektoros ábrázolású 

térképek szerkesztése, stb.

Térbeli ábrázolás:
egyes térfelületek, térfelület 

rendszerek ábrázolása, 
dróthálós térbeli ábrázolás, stb.

Rasztergrafikák
*.BMP, *.TIFF, *:JPG, stb.

Koordinátákhoz történõ
 hozzárendelés

Megjelenítés 
és nyomtatás

Adatgyûjtés, értékelés
feldolgozás

Szkennelés

Vektorgrafikák
*.DXF, *.BLN, *.BNA, stb.

Digitalizálás

 
16. ábra 

A Surferrel történő munkavégzés folyamata 
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12.2. A program menü-rendszere 

A program elindítása a SURFER.EXE állomány futtatásával lehetséges, ami alapér-
telmezetten a Program Files könyvtár Golden Software alkönyvtárának Surfer vagy 
Surfer8 könyvtárában található, de elindítható a program a Start menüből is. 
A program ezek után egy rajzablakot nyit meg, ami először üres, majd ide kerülnek a 
térképek és térfelületek. A Surfer három típusú ablakot használ: az említett rajz-
ablakot (Plot Window), amiben ábrákat (térképeket és térfelületeket, illetve ezek tet-
szőleges kombinációit) lehet szerkeszteni, a táblázatkezelő ablakot (Worksheet 
Window), amelyben az adatállományokat lehet létrehozni, szerkeszteni, módosítani, 
végül a szöveg-ablakot (Document Window), amelyben a program általában infor-
mációkat közöl a felhasználóval, illetve ezeket az információkat a felhasználó hasz-
nálhatja, módosíthatja, stb. (17. ábra). 

 
17. ábra 

A Surfer táblázatkezelő és rajzablaka 

12.2.1. A File menü parancsai 
A program File menüje a hagyományos parancsokat használja (18. ábra): 
File → New: Új ablak létrehozására szolgál, mind üres táblázatkezelő, mind üres rajz-

ablak készíthető vele.  
File → Open: Állományok megnyitására szolgál. Valamennyi ismert állománytípust 
ezzel a paranccsal lehet megnyitni, a rendszer az adatállomány kiterjesztésétől füg-
gően azt rajz-, vagy táblázatkezelő ablakba nyitja meg. Amennyiben a kiterjesztés 
ismeretlen, akkor azt a megnyitás során a felhasználónak kell megadnia (19. ábra). 
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18. ábra 

A File menü parancsai 
 

 
19. ábra 

Az ismeretlen kiterjesztésű állomány formátumának megadása 
 
File → Close: Az aktuális ablak becsukása. 
File → Save: Az aktuális ablak tartalmának elmentése a korábbi nevén. 
File → Save As: Az aktuális ablak tartalmának elmentése új néven. 
File → Import: A paranccsal számos ismert formátumú grafikát lehet a rajz- vagy a 
táblázatkezelő ablakba behívni. Fontos, hogy a grafikák rajzablakba történő importá-
lása során nem történik meg a vonalak koordinátákhoz rendelése, csak a kép megje-
lenítése. Ezért a parancs alkalmas pl. egy logo megjelenítésére, de nem alkalmas pl. 
egy szkennelt alaptérkép koordinátahelyes felhasználására. Amennyiben szükséges a 
koordinátahelyes ábrázolás, akkor a Map → Base Map parancsot kell használni. Ha 
a parancsot aktív táblázatkezelő ablaknál hajtjuk végre, akkor a program az adatokat 
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hívja be. Ennek megfelelően egy vonal importálásánál a rajzablakban a vonal, a táb-
lázatkezelő ablakban pedig a törésponti koordináták jelennek meg.   
File → Export: A parancs csak aktív rajzablakból érhető el és segítségével az aktuá-
lis ablak tartalmát vagy a kijelölt objektumokat a felhasználó által 21 lehetséges op-
ció közül választott, külső formátumba lehet elmenteni. Van lehetőség a készített 
térképek és felületek raszter-grafikaként (BMP, TIFF, stb.) és vektor-grafikaként 
(WMF, EMF, SHP, stb.) történő kiíratására, továbbá koordinátahelyes kiíratásra is 
van mód AutoCAD DXF formátum használatával. 
File → Page Setup: A munkalap beállítására szolgál. Beállítható a lap mérete (Page 
Size), tájolása (álló: Portrait, fekvő: Landscape) és a margók mérete (Margins). A 
lap beállításai a munka folyamán bármikor megváltoztathatók.  
File → Print: Nyomtatási parancs. A hagyományos nyomtatástól való eltérés a 
nyomtatási mód (Print Method) paraméter, ahol a levágás (Trunchate), lapmérethez 
igazítás (Fit) és a darabolás (Tile) módszerek közül választhatunk. Amennyiben a 
készített térkép nagyobb, mint a nyomtatási méret, akkor a lelógó részt a program 
levágja, a grafikát a lap méretéhez igazítja, vagy eredeti méretben több darabban 
(több lapra) nyomtatja ki. Ez utóbbi esetben a darabok átfedését (Overlap) is beállít-
hatjuk. A teljes lapot (All) vagy egy kijelölt részét (Range) is nyomtathatjuk. 
File → Preferences: A Preferences menü a program testreszabását teszi lehetővé. 
Érdemes a beállításoknál elidőzni, mert értelmes használatával a munkaidő jelentő-
sen lerövidíthető. A parancs végrehajtásakor egy négy lapból álló ablak jelenik meg, 
melyek közül a fontosabbak jelentését adjuk csak meg (20. ábra).  
Általános beállítások (General) között adható meg a visszavonási szintek száma 
(Undo Levels), illetve az utoljára szerkesztett állományok (Recent Files) száma, ami 
a File menü alján közvetlenül menüből elérhető. Be lehet állítani a munkakönyvtárat 
is (Default Path), amit célszerű is megtenni, mivel egyébként mindent a programál-
lományok közé ment el a rendszer. 
A rajzbeállítások (Drawing) oldalán adható meg a mértékegység, amit centiméterre 
érdemes átállítani. Itt adhatók meg az egyes elemek alapértelmezett beállításai 
(Default Attributes). A Line gomb a vonalak tulajdonságait, a Fill gomb a kitöltése-
ket, a Symbol gomb a szimbólumkészletek, a Font a betűtípusok alapértelmezését 
adja meg. Célszerű egy saját stílus előzetes kialakítása, hogy a betűk az ábrákon azo-
nos betűtípussal jelenjenek meg. Amennyiben valakinek nem tetszik az alapértelme-
zett betűtípus, betűméret stb., akkor azt itt átállíthatja, egyébként viszont minden 
egyes objektumnál újra meg kell adnia. Célszerű az alapértelmezett 0 cm vastagságú 
hajszálvonalat is megvastagítani, mert csak nyomtatáskor fog kiderülni, hogy az áb-
rán a legtöbb vonal nem látszik. A program a láthatóság érdekében a hajszálvonala-
kat a képernyőn megjeleníti, azokat is, melyek később a nyomtatáskor esetleg nem 
látszanak már! 
A vonalzók és rácsháló lapon (Rulers and Grid) célszerű az ábrán bemutatott beállí-
tásokat használni, ekkor minden oldalon egy cm skálájú, mm osztású vonalzó jelenik 
meg. Van lehetőség egy rácshálónak is a lapra fektetésére (Grid), de ez általában 
csak zavarja a munkát.  
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20. ábra 

A Preferences menüablakok 
 

A legfontosabb beállításokat a dialógusablak beállítások (Dialog Defaults) lapja tar-
talmazza. A program indulásakor beolvas egy SURFER.SET nevű állományt, ami-
ben a program legtöbb ablakában megadandó paraméterek alapbeállításai találhatók. 
A Dialog Defaults ablakban egyrészt ezeken a beállításokon módosíthatunk, ami 
erősen javasolható, másrészt egy saját beállítás-állományt is szerkeszthetünk és be-
hívhatunk. Az aktuális állomány nevét a Current Setting File ablakrészben adhatjuk 
meg. 
A Surfernél valamennyi programváltozó háromféle tulajdonsággal vértezhető fel, 
amit a Setting Persistence (beállítás érvényessége) gördülőmenünél adhatunk meg. 
Amennyiben egy változó Allways Reset, azaz mindig újradefiniált típusú, akkor 
bármikor is van rá szükség, a Setting Value (beállítási érték) kockában meghatáro-
zott értéket veszi fel, ami lehet egy a program által számított érték (Internal Default) 
vagy a felhasználó által megadott érték. Amennyiben pl. egy térkép területének ha-
tárkoordinátáit Allways Reset típusúra és a beépített alapértéket (Internal Default) 
használóra választjuk, akkor a térképet mindig a rajta szereplő objektumokra illesz-
tett téglatestbe foglalja. Ez nagyon zavaró, mert ha pl. egy vonalat nem ábrázolunk a 
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térképen mert az ott felesleges, lehet, hogy teljesen más terület fog az eredménytér-
képen szerepelni.  
Amennyiben a változó Current Session Only (aktuális folyamatra vonatkozó) típusú, 
akkor a változó beállításai mindaddig érvényben maradnak, amíg a felhasználó a 
programot ki nem kapcsolja, vagy újra nem indítja. Ha a korábbi példa esetében a 
változó Current Session Only típusú, akkor csak egyszer kell a térkép határainak 
koordinátáit megadni, és mindaddig, amíg a programot ki nem kapcsoljuk, azonos 
területet ábrázol a program.    
Ha a változó All Sessions típusú, akkor mindig a Setting Value értékbe írt változóér-
téket használja a program. Ez persze gondot jelenthet, mert ha pl. a térkép határát 
ilyen változóként definiáljuk, akkor egy másik területre készített térkép mindaddig 
nem ábrázolható, amíg ezt a beállítást meg nem változtatjuk, és a Setting Value érté-
két nem aktualizáljuk. 
A beállítható paramétereket menübeli előfordulási sorrendben adja meg a program, 
és minden változó magyarázatát a dialógusablakban mutatja. Néhány célszerű beállí-
tást tartalmazó SURFER.SET állomány a www.gama-geo.hu honlapról letölthető. 
Az eredeti SURFER.SET állományt célszerű biztos helyre elmenteni, mert ahogy a 
jó beállítások segítik, úgy a rosszak akadályozzák a hatékony munkát. A beállítások 
persze visszaállíthatók, ha tudjuk mit rontottunk el, de az Undo (visszavonás) gomb 
itt nem alkalmazható!!! Előfordul, hogy a beállítások hatására néha hibaüzenetet ka-
punk, ettől ne rettenjünk meg, mert néhány hibaüzenet árán sok felesleges kattintást 
spórolhatunk meg. Más beállításokkal viszont éppen ellehetetlenítjük a program mű-
ködését, ezért ha ilyet tapasztalunk, térjünk vissza az eredeti és idejekorán elmentett 
SURFER.SET használatához. 
File → Exit: Kilépés a programból 

12.2.2. Az Edit menü  
Az Edit menü (21. ábra) a Windows konvencióit követi. 
Edit → Undo: Utolsó lépés visszavonása (Undo), amíg semmi sem történt, vagy ha 
elértük a visszavonások maximális számát, akkor a Can’t Undo (visszavonás nem 
lehetséges) szöveg jelenik meg. 
Edit → Redo: Utolsó visszavonás visszavonása (Redo), amíg nem történt visszavo-
nás, akkor a Can’t Redo (visszaállítás nem lehetséges) szöveg jelenik meg. 
Edit → Cut: Hagyományos kivágás parancs 
Edit → Copy: Hagyományos másolás parancs 
Edit → Paste: Hagyományos beillesztés parancs 
Edit → Paste special: Hagyományos beillesztés másként parancs 
Edit → Delete: Hagyományos törlés parancs, ami a kijelölt objektumra vonatkozik. 
A törlési parancs visszavonható (Undo). Csak rajzablak esetén használható. 
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21. ábra 

Az Edit menü parancsai rajz és táblázatkezelő ablak esetén 
 
Edit → Select All: Az ablakban található összes objektum kijelölése, csak rajzablak 
esetén használható. 
Edit → Deselect All: Az ablakban található összes kijelölt objektum kijelölésének 
megszüntetése, csak rajzablak esetén használható. 
Edit → Invert Selection: Az ablakban található összes objektum kijelölésének meg-
változtatása, a kijelöltek megszüntetése, a jelöletlenek kijelölése, csak rajzablak ese-
tén használható. 
Edit → Object ID: Az aktuális objektum nevének megadása, megváltoztatása. Csak 
rajzablak esetén használható. 
Edit → Reshape: Az aktuális rajzobjektum alakjának megváltoztatása. Csak rajzab-
lak esetén használható. 
Edit → Properties: Az aktuális objektum valamennyi tulajdonságának a megjelení-
tése, szerkesztése és egyenkénti megváltoztatása. Csak rajzablak esetén használható. 
Edit → Clear: Az aktuális cella, sor vagy oszlop tartalmának törlése. Csak táblázat-
kezelő ablak esetén használható. 
Edit → Insert: Az aktuális cella, sor vagy oszlop mellé újabb beszúrása. Csak táblá-
zatkezelő ablak esetén használható. 
Edit → Delete: Az aktuális cella, sor vagy oszlop törlése. Csak táblázatkezelő ablak 
esetén használható. 

12.2.3.  A View (Nézet) menü 
A View menü a képernyőre, nézetre vonatkozó beállításokat tartalmazza (22. ábra). 
A menü csak rajzablak esetén érhető el. 
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22. ábra 

A View (Nézet) menü 
 
A menü segítségével beállíthatjuk, hogy a rajz kitöltse az ablakot (Fit to Window), a 
teljes lapot mutassa, függetlenül a rajz méretétől (Page), eredeti méretben jelenítse 
meg (Actual Size), teljes képernyősen mutassa (Full Screen). A Zoom lehetőséggel 
nagyíthatunk (Zoom In), kicsinyíthetünk (Zoom Out), vagy egy kiválasztott téglalap 
alakú részre koncentrálhatunk (Zoom Rectangle). A Pan Realtime módban a lapot 
az egér segítségével minden irányban mozgathatjuk. 
A Redraw parancs újrarajzolja a képernyő tartalmát. Az Autoredraw (automatikus 
újrarajzolás) kiválasztásával minden művelet után a térkép vagy felület újrarajzoló-
dik. Ezt a lehetőséget általában érdemes kihasználni, ugyanakkor célszerű kikapcsol-
ni mindig, ha sok időt vesz igénybe az újrarajzolás. Ekkor több beállítás megváltoz-
tatása után a Redraw paranccsal lehet az újrarajzolást kérni. Amennyiben a Windows 
memóriája megtelt, az automatikus újrarajzolás nem működik, ilyenkor a kijelölt 
műveleteket a program végrehajtja, de nem ábrázolja. Ebben az esetben a munkát 
célszerű elmenteni, majd a programot, sokszor az egész operációs rendszert is újra-
indítani. Erre csak ritkán kerül sor, de főleg nagy DXF állományok kirajzolásánál 
(pl. nagyszámú áramvonal kirajzolása a PMPATH programmal) megtörténhet. 
A View menü alsó részén kiválaszthatjuk a képernyőn megjelenítendő elemeket a 
vonalzókat (Rulers), a rácshálót (Drawing Grid), az eszköztárakat (Toolbars), az 
alsó állapotsort (Status Bar) és az Objektumszervezőt (Object Manager) Ez utóbbit 
célszerű mindig bekapcsolva tartani, mert nagyon megkönnyíti a munkát. 

12.2.4. A Format (formázás) menü 
A Format (formázás) menüpont (23. ábra) csak a táblázatkezelő ablakból érhető el, 
és célja a bemeneti adatok formátumának megadása. A Cell Properties paranccsal a 
kijelölt cellákban található számok formátumát, az igazítási rendet (jobbra, balra, 
középre és általános alak), illetve a cellák háttérszínét lehet beállítani. A Coloumn 
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Width menü az oszlopszélességek, a Row Height menü pedig a sorok magasságának 
beállítására szolgál. 

 
23. ábra 

A Format (formázás) menü 

12.2.5. A Data (adatműveletek) menü 
 

A Data (adatműveletek) menüpont (24. ábra) a bemeneti adatok szerkesztésére és 
számítások elvégzésére szolgál. A Surfer nagy előnye, hogy az általa kezelhető adat-
állomány igen nagy méretű lehet, az elvileg maximális méretű táblázat utolsó elemé-
nek koordinátája (CFDGSXL, 1 000 000 000), azaz akár egymilliárd rekord feldol-
gozása is lehetséges (25. ábra), valójában azonban a rendelkezésre álló memória mé-
rete határozza meg a maximális adatállomány-méretet. 

 
24. ábra 

A Data (adatműveletek) menü 
 

  
25. ábra 

A táblázatkezelő ablak jobb alsó része 
 
A Surfer táblázatkezelője alapvetően hasonlít a megszokott táblázatkezelőkhöz (MS 
Excel, Quattro Pro, Sylk, stb.), azonban jelentős különbség, hogy a Surfer feltételezi, 
hogy az adatok oszlopokba rendezetten állnak rendelkezésre, ezért oszlopon belüli 
módosításokra, számolásokra nincs szükség. Ennek megfelelően a műveleteket a 
Surfer oszlopokkal végzi el, melyeket A...CFDGSXL oszlopoknak nevez. A 
Surferben nincs lehetőség egyes cellákkal való munkavégzésre, ezért ha ilyen jellegű 
problémát kell megoldani, akkor azt egy másik táblázatkezelővel célszerű elvégezni. 
A táblázatkezelők közül az MS Excel valamennyi formáját jól értelmezi a program, 
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de vigyázni kell arra, hogy a program csak egy munkalapból álló állományokat tud 
menteni. Tehát egy több munkalapos Excel állomány megnyitható, de ha módosítás 
történik, akkor csak az aktív munkalapot képes elmenteni, miközben a többi munka-
lap tartalma elvész! Az adatvesztésre angol nyelvű hibaüzenet figyelmeztet. A napi 
gyakorlatban általában elég a szövegformátumba való adatmentés, ezért azt javasol-
juk, hogy a felhasználó mindent lehetőleg Golden Software ASCII XYZ adatformá-
tumba mentsen, mert így az adatvesztés elkerülhető.  
A Data → Sort menüvel az adatok növekvő vagy csökkenő sorrendbe rendezése 
végezhető el, három oszlop adatai alapján. A sorba rendezés előtt ki kell jelölni a 
rendezendő sorokat vagy oszlopokat, de a táblázat bal felső sarkára kattintva egy lé-
pésben az egész táblázat is kijelölhető. 
A Data → Transform menüvel az oszlopokkal végezhetünk műveleteket számos 
aritmetikai, trigonometriai, logikai és egyéb függvény segítségével (26. ábra). Az 
egyes függvények neve sokszor eltér a megszokottól ezért célszerű a függvénytárat 
egyszer előzetesen átnézni. A Transform Equation mezőbe lehet beírni az egyenle-
tet, ami a matematikai műveletet leírja. A sorok kezdő és végző sorszámát, mellyel a 
művelet elvégzendő a First row: és Last row: mezők tartalmazzák. A függvényeket 
a Function name mező tartalmazza, mely alatt megtalálható a függvény rövid leírása 
is. Az üres és szövegmezőket a számítás figyelmen kívül hagyja, kivéve, ha bejelöl-
tük a Treat text and empty cells as 0.0 dobozt, mert akkor azokat zérusnak tekinti a 
rendszer. 

 
26. ábra 

A Transform menü dialógusablaka 
 
A Data → Statistics menüvel az adatsorok egyszerű statisztikai jellemzőit 
határozhatjuk meg (27. ábra). A dialógusablakban megadhatók a számítandó 
paraméterek, melyeket egy külön ablakba vagy a táblázat egy üres részébe 
menthetünk el. 
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27. ábra 

Az adatok statisztikáját számító dialógusablak és a számítás eredményei 
 

12.2.6. A Draw (rajzolás) menü 

 
28. ábra 

A Draw (rajzolás) menü 
 
A Draw menüpont csak a rajzablakban érhető el. A célja egyszerű objektumok: 
poligonok (Polygon), törtvonalak (Polyline), jelek (Symbol), téglalapok (Rectangle), 
lekerekített sarkú téglalapok (Rounded Rect), valamint körök és ellipszisek (Ellipse) 
rajzolása, szöveges feliratok (Text) készítése. A Draw menüvel készített objektumok 
legfontosabb tulajdonsága, hogy a laphoz és nem térképi koordinátákhoz rögzített 
helyzetűek. Ha egy térképen egy feliratot a Draw → Text paranccsal készítünk és a 
megfelelő helyre elhelyezzük, az elcsúszik, amennyiben a térkép léptékét megváltoz-
tatjuk. Az objektumokat ezzel a paranccsal nem lehet koordinátákhoz kötni, csak a 
Map → Post Map paranccsal. 
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12.2.7. Az Arrange (igazítás) menü 

 
29. ábra 

Az Arrange (igazítás) menü 
 
Az Arrange menüvel a rajzablakokon található objektumokkal (térképek, szöveg- és 
rajzobjektumok, stb.) lehet műveleteket végezni. Az objektumok egymáshoz viszo-
nyított helyzetét az Order Objects paranccsal lehet megváltoztatni, a kijelölt objek-
tumot lehet legelőbbre hozni (Move to Front), leghátulra vinni (Move to Back), elő-
rébb hozni (Move Forward) és hátrébb vinni (Move Backward). 
A térképi objektumok több fedvényt tartalmazhatnak (pl. egymásra fektetett térké-
pek, koordinátákhoz rendelt feliratok, szkennelt alaptérkép, stb.), melyeket a Map 
paranccsal lehet létrehozni. A térképen belül a fedvények (Overlays) sorrendjét az 
Order Overlays paranccsal lehet megváltoztatni, a felülre (előre) hozott fedvény 
teljesen látszik, és részben takarja az alatta (hátrébb) található fedvényeket. A moz-
gatás az objektummozgatás parancsainak megfelelő módon történik a kijelölt 
fedvényt lehet legelőbbre hozni (Move to Front), leghátulra vinni (Move to Back), 
előrébb hozni (Move Forward) és hátrébb vinni (Move Backward). 
Az Align Objects paranccsal az objektumokat vízszintesen balra (Left), középre 
(Center) és jobbra (Right), továbbá függőlegesen felülre (Top), középre (Middle) és 
alulra (Bottom) rendezni.  
Az objektumokat csoportba lehet rendezni a Combine paranccsal,  és a csoportokat 
szét lehet bontani a Break Apart menüpont segítségével. Sajnos a csoportba foglalt 
objektumok nem módosíthatók mindaddig, amíg a csoportot szét nem bontottuk. 
A kijelölt objektumok a felhasználó által megadott fokkal elforgathatók (Rotate), 
vagy kézzel szabadon forgathatók (Free Rotate). A Transform menüvel a kijelölt 
objektum megadott hosszúságegységnyit X és Y irányba eltolható (X és Y Offset), 
iránytól függő mértékben nagyíthatók (X és Y Scale), továbbá mindkét irányban vál-
tozó mértékben torzítható (X és Y Share). 
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12.2.8. A Grid (rácshálóműveletek) menü 

 
30. ábra 

A Grid (rácshálóműveletek) menü 
 
A Grid menü a térképszerkesztés legfontosabb lépéseit vezérli, ezért egyes részeit 
később részletesen ismertetjük. Itt csak az egyes menüpontok célját, és röviden a 
használat módját adjuk meg.  
A grid file funkciója a paraméterek síkbeli (térkép) vagy térbeli (térfelület) eloszlá-
sának reprezentálása: ezek az állományok hordozzák magukban azt az információt, 
amivel a felületek szöveges vagy bináris formában leírhatók. Kezdetben a felületek 
szakadásokat nem tartalmazhattak, ekkor két formátuma volt a rácshálóknak: egy 
terjengősebb ASCII szöveg formátum (GS ASCII (*.grd)) és egy tömörebb bináris 
formátum (GS Binary (*.grd)). Mindkét formátum azonos adatokat tartalmazott, 
egyrészt definiálta a készített rácshálót, majd soronként tartalmazta alulról felfelé a 
rácshálóban a térfelület értékeit. A bárki által előállítható szöveges formátumú grid 
file formátuma a következő: 
DSAA Az ASCII szövegfile azonosítója 
NX, NY A rácsháló csomópontjainak száma X és Y irányban 
XMIN, XMAX A rácsháló első és utolsó oszlopának koordinátája 
YMIN, YMAX  A rácsháló első és utolsó sorának koordinátája 
ZMIN, ZMAX A térfelület minimuma és maximuma 
Z11, Z21, ...., Zn1 A rácsháló utolsó (alsó) sorában található csomópontok értékei 
Z12, Z22, ...., Zn2 A rácsháló alulról második sorában található csomópontok értékei 
...  
Z1n, Z2n, ...., Znn A rácsháló első (felső) sorában található csomópontok értékei 
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Később a felületek már szakadásokat (pl. vetők) is tartalmazhattak, ezért egy újabb 
bináris formátumot (Surfer 7 (*.grd)) vezettek be. Az új bináris formátumot csak 
vetődéses szerkezetek ábrázolásánál kell használni, a többi esetben valamennyi for-
mátum használható. 
A grid műveleteknek több csoportjuk van. Az egyik csoport célja a korábban emlí-
tett, irányonként különböző mértékben egyenközű rácsháló (téglarács-háló) csomó-
pontjaira értékek előállítása, a másik csoportba a már korábban készített grid állomá-
nyokkal műveletek, átalakítások végrehajtása újabb grid vagy más adatállományok, 
esetleg szöveges eredmény-állományok létrehozása céljából. 
A Grid → Data paranccsal egy véletlenszerűen elhelyezkedő pontokban a szerkesz-
tendő térkép adatait tartalmazó adatállományból grid állományt hoz létre. Kiindulási 
adatként  legegyszerűbb ASCII szövegfájlokat használni, melyet a Surfer ASCII 
XYZ (*.dat) állományoknak nevez. Ezek formátuma: 
X1, Y1, Z11,..., Z1n 
X2, Y2, Z21,..., Z2n 
... 
Xn, Yn, Zn1,..., Znn. 
Az elválasztó karakter lehet szóköz, tabulátor, vessző, de elvileg más karakter is, 
ezért a Windows Clipboard formátuma is tekinthető egy Surfer adatállománynak. 
A bemeneti adatállomány lehet továbbá számos ismert táblázatkezelő formátum is. 
A Grid → Data parancs kiadását követően a program kéri az adatállomány nevét, 
majd beolvassa azt, és a 31. ábra szerinti dialógusablak jelenik meg.  
Az ablakban be kell állítani az adatokat tartalmazó oszlopokat (Data Coloumns me-
ző). Az X:, Y: és Z: rovatokba a legördülő menüből kiválasztandó a megfelelő osz-
lop. Itt hívjuk fel a figyelmet arra, hogy a Surfer a hagyományos Descartes koordiná-
ta-rendszert használja szemben pl. a jobbsodrású EOV koordinátarendszerrel, ennek 
megfelelően a Surfer  X koordinátáit az EOV Y koordinátákat tartalmazó oszlop tar-
talmazza és fordítva.  
A Filter Data gombbal a felhasználó az adatállomány általa megadott feltételeknek 
megfelelő adatait kizárhatja (Data Exclusion Filter), és rendelkezhet az azonos 
ponthoz rendelt több adat (Duplicate Data) sorsáról is. Először definiálandó az azo-
nos pont fogalma egy X és egy Y irányú toleranciaérték (X Tolerance, Y Tolerance) 
segítségével (ha a két pont távolsága a toleranciaértékeknél kisebb, akkor a két pont 
helyét azonosnak tekinti a rendszer). Az azonos helyen található pontokhoz rendelt 
értékek sorsáról a To Keep mezőben dönthet a felhasználó: megtarthatja az elsőt, az 
utolsót, átlagolhat, összegét képezheti, a minimális vagy maximális X vagy Y koor-
dinátához tartozó értéket használhatja, stb. 
A View Data gombbal az adatokat egy kis táblázatkezelő ablakban megnézheti a fel-
használó. A Statistics gombbal, pedig az adatok egyszerű statisztikai jellemzőit szá-
míthatja ki, melyek egy szövegablakban jelennek meg Data Statistics Report címmel 
(32. ábra). 
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31. ábra 

A Grid → Data dialógusablak 
 

 
32. ábra 

Az adatállomány statisztikai jellemzői 
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A Grid Report mező kijelölésével a grid állomány készítésének adatait írathatjuk ki 
egy szövegablakba. Kezdetben érdemes ezt a lehetőséget használni, később az állo-
mányok számának csökkentése érdekében nyugodtan kikapcsolhatjuk ezt az opciót. 
A Grid Line Geometry mezőben definiáljuk a téglarács-hálót. Meg kell adni a mind 
X, mind Y irányban (X Direction, Y Direction) azt a koordináta tartományt, amely 
területet a rácshálóval le kívánunk fedni, továbbá meg kell határozni vagy a téglalap-
ok oldalának méretét (Spacing) vagy a rácsháló vonalainak számát (# of Lines). A 
két utóbbi közül értelemszerűen csak az egyik adandó meg, a másik már a többi 
adatból számítható. A rendszer a szükséges vonalak számát kérdezi, ezért 100 m-es 
osztásköz választásakor 1000 m-es területhossz esetén 11 vonalat kell megadni! 
Az eredményállomány nevét és formátumát az Output Grid mezőben kell megadni. 
Van lehetőség nemcsak grid, hanem adatformátumba történő kiíratásra is, amit pl. a 
modelladat-rendszer előállítása során jól ki lehet használni. 
A Gridding Method ablakban kell azt a módszert és annak paramétereit kiválasztani, 
mellyel a rendelkezésre álló, véletlen eloszlású adatokból a rácsháló csomópontjaira 
a legvalószínűbb értékeket ki lehet számolni. Mivel a módszerek különösen fontosak 
az eredmény szempontjából, azért ezzel külön fejezetben foglalkozunk. Itt csak any-
nyit említünk meg, hogy bár vannak alapértelmezett beállítások, azok használata 
csak különösen erős indokok esetén célszerű. A program minden adatállományból 
képes eredményt számítani, azonban annak minősége és helyessége a felhasználó 
felelőssége. 
A Grid → Variogram paranccsal az adatállományból a krigelés nevű interpolációs 
módszer használatához szükséges félvariogramot lehet kiszámítani. Alkalmazását az 
interpolációt bemutató fejezetben részletezzük. 
A Grid → Function paranccsal egy térfüggvény jeleníthető meg (33. ábra): egy 
megadott x, y intervallumban (Minimum, Maximum) az Increment mezőben meg-
adott távolság-lépésenként a program számítja a z(x,y) térfüggvény pontjait és elké-
szíti azokból a grid állományt (Output Grid File). 

 
33. ábra 

A Grid Function dialógusablak 



40 

A Grid → Math paranccsal egy vagy két grid állománnyal (Input Grid File A és 
Input Grid File B) matematikai műveleteket (Enter a function of the form 
C=f(A,B) mező) végezhetünk, majd az eredményt egy harmadik gridállományba 
(Output Grid File C) írhatjuk ki (34. ábra). Fontos megkötés, hogy a két bemenő 
állomány azonos területről, azonos rácsháló alkalmazásával készült állomány kell, 
hogy legyen. A dialógusablakban a Surfer valamennyi beépített matematikai függvé-
nyét szabadon használhatjuk, akár egymásba ágyazva is. A parancs alkalmas térké-
pek összeadására (pl. összvastagsági térkép), összeszorzására (pl. transzmisszivitás 
térkép a szivárgási tényező és a rétegvastagsági térkép felhasználásával), stb.. 

 
34. ábra 

A Grid Math dialógusablak 
 

A Grid → Calculus paranccsal a számos a térfelület deriválásával kapcsolatos mű-
veletet hajthatunk végre, melyek közül csak néhány fontosabbat mutatunk be. Vala-
mennyi esetben meg kell adni a deriválandó felületet (Input Grid File) és az ered-
mény állomány nevét és formátumát (Output Grid File). 
Az irány szerinti deriváltak képzésénél (Directional Derivative) első (First 
Derivative) és második (Second Derivative) deriváltakat, illetve a felület görbületét 
(Curvature) számíthatjuk az Angle mezőben megadott iránynak megfelelő szögben. 
A Terrain Modeling utasítások között jól használható a lejtőhajlás számítás (Terrain 
Slope) és a kitettség számítása (Terrain Aspect). A lejtő hajlását 0 és 90 fok közötti 
szöggel, a kitettséget az északi iránytól mért szögekkel (azimut) adja meg a program. 
A Plan Curvature számítás során a kapott negatív értékek azokat a területeket jelö-
lik, ahonnan a felszíni vizek szétterülnek, a pozitív értékek pedig, ahol a vizek össze-
gyülekeznek.  
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35. ábra 

Irány szerinti deriváltak számitása Grid Calculus paranccsal 
 

A Grid → Filter paranccsal a felhasználó által definiált vagy más előre beépített 
szűrővel történhet meg a térfelület adatainak szűrése. A szűréssel elérhető a felület 
simítása, a kiugróan magas vagy alacsony értékek kiszűrése (36. ábra). 

 
36. ábra 

A Grid Filter dialógusablak 
 

A Grid → Spline Smooth paranccsal a térfelület spline interpolátorral történő simítá-
sát lehet elvégezni vagy a teljes rácsháló újraszámolásával (Recalc Grid), vagy a rács-
pontok közé beillesztett újabb rácspontok (Insert Nodes) alkalmazásával (37. ábra). 
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37. ábra 

A Spline Smooth dialógusablak 
 
A Grid → Blank paranccsal a térkép egy részének törlését lehet elvégezni. A törlés-
hez szükséges egy bemenő grid file, egy a törlendő területet meghatározó törlő állo-
mány, amit a Surfer blank állománynak nevez, és készül egy új törölt eredmény 
gridfile. A program valójában nem töröl adatokat a grid állományból, hanem a tör-
lendő területre eső pontoknál az ábrázolható legnagyobb számot, 1.70141+e38 érté-
ket ír be, amelyeket a program szoftveresen kezel.  
A törléshez használt *.BLN blank állomány egy szövegállomány, mely tartalmazza a 
kijelölendő terület körülzárásához szükséges pontok számát, illetve a pontok koordi-
nátáit: 
N, 0 vagy 1 
X1, Y1 
X2, Y2 
... 
XN, YN 
A törléshez zárt alakzatra, poligonokra van szükség, ezért az első és utolsó pont ko-
ordinátájának meg kell egyeznie. Ennek megfelelően egy háromszög alakú területet 
négy, egy négyszöget öt pont ír le, stb.. A pontok száma melletti 0 vagy 1 szám azt 
jelenti, hogy a program a poligonon belül (1) vagy kívül (0) töröljön.  
Amennyiben több területrészt kell törölni, akkor a BLN állományban egymás után 
több poligon adata is szerepelhet sorkihagyás vagy bárminemű elválasztás nélkül, de 
megadható egy a 38. ábra szerinti területrész is. 
A BLN állomány vonalak rajzolására is alkalmas, ebben az esetben az első és az 
utolsó koordináta nem azonos, így a vonal nem záródik be, továbbá a 0 vagy 1 para-
méter alkalmazása is felesleges.  
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38. ábra 

Több részből álló területrész törléséhez használható poligon vázlata 
  

A Grid → Convert parancs a grid állományok valamennyi formátumának egymásba 
alakítására, konverziójára szolgál. 
 A Grid → Extract paranccsal a meglévő grid állomány egy részét ki lehet vágni, 
illetve a készítendő eredmény állományban a rácsháló pontjait ritkítani lehet (39. 
ábra). A megnyíló dialógusablakban a bemeneti állomány adatai olvashatók az Input 
File mezőben. A ritkított eredmény file nevét az Output File mezőben kell megadni, 
definiálva az eredeti állomány első (First) és utolsó (Last) sorát (Rows (X)) és oszlo-
pát (Cols (Y)), amelyet az eredmény állománynak tartalmaznia kell. Megadandó, 
hogy minden hányadik rácspont értékét (Read Every) tartalmazza a kimeneti állo-
mány. A mező jobb oldalán olvashatók eközben a készítendő állomány fontosabb 
adatai segítve az önellenőrzést. 
  

 
39. ábra 

A Extract Grid dialógusablak 
 
A Grid → Transform paranccsal a rácsháló adatokat lehet módosítani (40. ábra). 
Lehetőség van a felület X és Y irányba történő eltolására (Offset: paraméterei X és Y 
Offset), a lépték változtatására a rácsháló bal alsó sarkának helybentartása mellett 
(Scale: paraméterei X és Y Scale), 90 fokkal és többszöröseivel való elforgatására 
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(Rotate: paramétere forgatási szög (Angle)), illetve X és Y irányú tükrözésre (Mirror 
X és Mirror Y). 

  
40. ábra 

A Grid Transform dialógusablak 
 

A Grid → Mosaic parancs több, eltérő területet lefedő grid állomány felhasználásá-
val képes újabb, az addigiaktól eltérő területre rácsháló állományt készíteni. A hasz-
nálathoz definiálni kell a forrásadatokat tartalmazó rácsháló állományokat (Input 
Grid Files) és azt hogy átfedéses területeken hogyan képezze az új értékeket 
(Overlap Method): átlagolással (Average), első (First) vagy utolsó (Last) érték, eset-
leg a legkisebb (Minimum) vagy legnagyobb (Maximum) érték elfogadásával. Vé-
gül definiálni szükséges a készítendő rácsháló állomány geometriáját (Output Grid 
Geometry) a Grid → Data parancsnál megadottakhoz hasonlóan. 

 
41. ábra 

A Grid Mosaic dialógusablak 
 
A Grid → Volume paranccsal két felület közötti térfogat számítása végezhető el. A 
használatkor definiálandó egy „felső” felület (Upper Surface) és egy „alsó” felület 
(Lower Surface), természetesen a két felület egymást metszheti, ahol a felső felület 
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alsó felületté válik! A vizsgált felületek lehetnek vízszintes síkok (Constant Z=) 
vagy tetszőleges grid állományok (Grid File) által meghatározott felületek. A prog-
ram az eredményeket három módon számítja (trapéz szabály: Trapezoidal Rule, 
Simpson-szabály: Simpson’s Rule, és 3/8-os Simpson-szabály: Simpson’s 3/8 Rule), 
továbbá azokat egy Grid Volume Computations című szövegablakban megjeleníti 
(42. ábra).  

   
42. ábra 

A Grid Volume dialógusablak és a számítás eredményei 
 
Az eredményben a program leírja a vizsgált felületeket és megadja a következő ada-
tokat: 
Térfogatértékek (Volumes): 
– pozitív térfogat (Positive Volume [Cut]): Annak a térfogatnak a nagysága, ahol a 

„felső” felület az „alsó” felett van (bevágás); 
– negatív térfogat (Negative Volume [Fill]): Annak a térfogatnak a nagysága, ahol 

a „felső” felület az „alsó” alá metsz (feltöltés); 
– nettó térfogat (Net Volume [Cut-Fill]). A pozitív és negatív térfogat előjeles ösz-

szege; 
– teljes térfogat (Total Volume). 
Felületértékek (Areas): 
A síkvetületek területe (Planar Areas): 
– Pozitív területek (Positive Planar Area [Cut]): Annak a területnek a nagysága, 

ahol a „felső” felület alatt található az „alsó”; 
– Negatív területek (Negative Planar Area [Fill]): Annak a területnek a nagysága, 

ahol a „felső” felület az „alsó” alá metsz; 
– Törölt területek (Blanked Planar Area); 
– Összes terület (Total Planar Area). 
Felületek (Surface Areas), azaz a térfelület mentén mért területek: 
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– Pozitív felületek (Positive Surface Area [Cut]): Annak a felületnek a nagysága, 
ahol a „felső” felület alatt található az „alsó”; 

– Negatív felületek (Negative Surface Area [Fill]): Annak a felületnek a nagysága, 
ahol a „felső” felület az „alsó” alá metsz. 

A Grid → Slice paranccsal egy térfelület Z értékeit egy tetszőleges törtvonal mentén 
meghatározhatjuk. A számításhoz szükséges a térfelületet leíró rácsháló állomány 
(Input Grid File), a vonalat leíró *.BLN vonalállomány. Az eredményeket a program 
egy ASCII XYZ *.DAT adatállományba írja ki (43. ábra). 
Az adatállomány felhasználásával grafikonként megszerkeszthető a metszete a felü-
letnek, amivel akár szelvények szerkesztése is lehetségessé válik. A 44. ábra bemutat 
egy felületet és azt a nyomvonalat, ami mentén a felület értékeit leolvastuk.  
A Grid → Residuals paranccsal az eredeti adatpontok és az azokra a pontokra a 
Surfer által számított értékek különbségét lehet meghatározni.  
A Grid → Grid Node Editor paranccsal bármely rácsháló állomány megjeleníthető 
és a rácspontbeli értékek megváltoztathatók. Alapvetően vizualizációs eszköz, a 
rácspontokat egyenként átírni gyakorlatilag értelmetlen dolog, ha rossz a szerkesztett 
grid állomány, akkor a számítási módon kell változtatni, és nem az állományba „be-
lebarkácsolni”, de azért előfordulhat, amikor „a cél szentesíti az eszközt”. 
 

 
43. ábra 

A Grid Slice dialógusablak és a számítás eredményei 
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44. ábra 

Egy térfelület és a Grid Slice paranccsal számított szelvény 
 

12.2.9. A Map (térképszerkesztés) menü 

 
45. ábra 

A Map (térképszerkesztés) menü 
 

A Map menü segítségével lehet az elkészített grid állományokból térképet készíteni, 
illetve a térképeken digitalizálni, és a térképi elemekkel műveleteket végezni. 
A Surfer számos térképtípust ismer: 
Az izovonalas térképek (Contour Maps) az azonos értékeket összekötő vonalakkal 
(izovonalakkal) ábrázolják a vizsgált paraméter eloszlását. A térképek alá – a jobb 
tájékozódás érdekében – lehetséges alaptérképeket (Base Map) behívni, ami lehet 
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raszteres és vektoros grafikai állomány is. A térképre helyhez kötött objektumokat, 
pl. fúrások jele, illetve helyhez rögzített szövegeket, fúrások neve, a kutakban mért 
vízszint, koncentráció, stb. adatpont (Post Map) típusú térképekkel rakhatunk fel. 
Készíthetünk színskálás térképeket, amiket a program Image Map-nek nevez, és elő-
állíthatunk árnyékolt térszín (Shaded Relief) térképeket is. A változások irányait 
vektor-térképekkel (Vector Map) lehet szemléltetni, pl. egy vízadóban a víz szivár-
gási irányát, a szivárgás lokális irányát és sebességét jelző vektorokkal ábrázolhatjuk. 
A térfelületeket mind kitöltött felületekként (Surface Map), mind dróthálós ábrázo-
lással (Wireframe Map) szemléltethetjük. 

12.2.9.1. A térképszerkesztés ablak és objektumrendszere 
A program ablakrendszere a rajz-ablakból és az objektum managerből (Object Ma-
nager) áll (46. ábra). A munkalap bal szélén található objektum manager a jobb olda-
li ábrán található különálló objektumokat és azok részeit ábrázolja, felülről lefelé, 
láthatósági sorrendben. Az ablakban bármely objektum kiválasztható, majd a tulaj-
donságai a jobb egér gombbal történő klikkeléssel megtekinthetők és módosíthatók.  
Több objektum a Windowsban megszokott módon a Ctrl vagy a Shift billentyűk 
megnyomása közben történő klikkeléssel jelölhető ki. Több objektum kijelölése ese-
tén csak azok közös tulajdonságai módosíthatók (Edit → Properties parancs). Az 
objektumok egy része önálló, mint pl. a legfelülre rendezett szövegek (Text), mások 
csoportba foglaltak a korábban bemutatott Arrange → Combine paranccsal. Ezeket 
a manager, mint kompozit (összekapcsolt) objektumokat (Composite) mutatja, me-
lyeket csak a csoport szétbontása után lehet megváltoztatni vagy szerkeszteni. 
A munkalapon egy vagy több térkép objektum (Map) lehet megtalálható. A térkép 
objektum kezdetben minimálisan öt elemből áll: a négy koordináta tengely (Left, 
Right, Top és Bottom Axis) és az a térképelem, amit ábrázolunk. Az ábrán itt most 
ugyan csak egy térképobjektum található, azonban annak számos eleme van: 
izovonalas térképek, adatpont-térképek és alaptérképek. Ezeket a térképi elemeket 
fedvényeknek nevezzük. A térképi elemek mellett található egyrészt az elem típusát 
jelző ikon, másrészt egy jelölőnégyzet, ami az adott elem láthatóságát, aktuális meg-
jelenítettségét jelzi. Az objektum manager szolgál nemcsak a fedvények egymáshoz 
viszonyított helyzetének megjelenítésére és azoknak az egérrel fel-le történő mozga-
tására, hanem az elemek megjelenítettségének vezérlésére is. 
A kijelölt térképi objektumok az Edit menü parancsaival tetszés szerint másolhatók, 
törölhetők, stb.. 
A térképi objektumok külön-külön koordináta rendszerrel rendelkeznek akkor is, ha 
ezeket nem jelenítjük meg, vagy pontosan egymásra mozgatjuk. A térképek egy ko-
ordináta rendszerbe szervezését, egyben fedvényekké alakítását a térképobjektumok 
kijelölésével, majd a Map → Overlay Maps paranccsal lehet elérni. A 
fedvényeknek a térképobjektumról történő leszakítását egyben új térképobjektummá 
alakítását a Map → Break Apart Overlay paranccsal tehetjük meg, ekkor az új ob-
jektumhoz új koordináta tengelyek rendelődnek. A térbeli ábrázolások (térfelület, 
dróthálórajz) egymáshoz rögzítésére a Map → Stack Maps parancs szolgál. 
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46. ábra 

A Surfer térképszerkesztéshez használt munkaterülete 
 

12.2.9.2. A térképobjektumok főbb tulajdonságai: nézet, méretarány és térképhatárok 
A térképobjektum tulajdonságait és beállításait – az objektum kijelölése után – az 
Edit → Properties parancs kiadásával vagy a jobb egérgombbal elérhető helyi menü 
Properties parancsával tekinthetjük meg (47. ábra). Az ablakok alján három gomb 
található: az OK gomb a beállításokat elfogadja és bezárja az ablakot, a Cancel 
(mégse) gomb elveti a módosításokat, az Apply (alkalmaz) gomb az ablak bezárása 
nélkül menti a megváltozott beállításokat. Mivel általában több lapon szeretnénk a 
módosításokat elvégezni, ezért az Apply gomb használatával sok időt takarítunk meg, 
nincs szükség állandóan az ablakok becsukására és megnyitására. 
A View (nézet) lapon a térbeli elhelyezkedést látjuk, amire azért van szükség , mert a 
térképobjektum síkbeli és 2.5D ábrázolást is tartalmazhat. Izovonalas térképnél ter-
mészetesen elforgatás nélkül 90°-os szögből nézzük az objektumot. 2.5D ábrázolás 
esetén a perspektivikus (Perspective) és ortogonális (Orthogonal) ábrázolás (Pro-
jection) közül választhatunk, miközben a nézőpontot is három csuszka segítségével  
megváltoztathatjuk.  
A Scale (lépték) lapon a térkép méretarányát változtathatjuk. Fontos tudni, hogy bár 
lehet, de nem tanácsos a térkép méretét a Windowsban megszokott módon egérrel 
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megváltoztatni. A térkép lényege az ismert méretarány, amit a Scale lapon adunk 
meg. A lépték eltérő lehet tengelyirányonként, azaz hossz-, oldal- és magassági torzí-
tást is alkalmazhatunk, ami speciális felhasználási lehetőségeket nyújt. Általánosság-
ban a lépték X és Y irányban (X Scale, Y Scale) azonos, amit a Proportional XY 
Scaling jelölőnégyzet használatával biztosítunk. Amíg a térkép csak síkelemeket 
tartalmaz, a Z irányú lépték (Z Scale) megadására nincs szükség és lehetőség. A lép-
téket úgy definiáljuk, hogy a kiválasztott alap mértékegységhez (nálunk cm, más or-
szágokban inch) felhasználó által megadott egy térképi egységet (Map units) rende-
lünk. Ha  a térképünk EOV rendszerben készült, akkor az egység méter, ebben az 
esetben, ha 1 cm pl. 80 m, akkor a térkép méretaránya 1:8000. A program azonnal 
számolja a megadott méretarány esetén a térkép méretét (Length) is.   

  

  
47. ábra 

A térképobjektumok tulajdonságai 
 

A Limits lapon a térképen ábrázolt terület határait adjuk meg. Van mód az adatokkal 
lefedett térrészre szerkeszteni térképet (Use Data Limits), de megadhatjuk az ettől 
eltérően megválasztott határokat is. 
A Background lapon a háttér tulajdonságait állíthatjuk be. 

12.2.9.3. Az izovonalas térképek 
A Map → Contour Map → New Contour Map parancs elindítását követően a 
program kéri a térfelületet leíró rácsháló állomány nevét, majd az alapértelmezett 
beállításokkal megjeleníti annak izovonalas térképét. Az izovonalas térkép beállításai 
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(48. ábra) két lapon találhatók, és értelemszerűen egy izovonalas térképfedvény kivá-
lasztásával, és a helyi menüvel vagy a korábban bemutatott paranccsal érhető el. Mi-
vel a fedvény része a térképobjektumnak is, ezért a korábban bemutatott térkép-
tulajdonságokat tartalmazó egyéb lapok (View, Scale, Limits és Background) innen 
is elérhetők. 
A General lapon az izovonalas térkép általános jellemzői találhatók: melyik grid ál-
lományból készült (Input Grid File), az izovonalak közötti tér színezett legyen-e 
(Fill Contours), és ha igen, akkor a térképen a színskála megjelenjék-e (Color 
Scale). Megtörténjen-e az izovonalak simítása (Smooth Contours), és ha igen, akkor 
csak kicsit, közepesen vagy nagyon (Low, Medium, High) simítsa ki az algoritmus a 
vonalakat. A Blanked Regions mezőben formázhatjuk a Grid → Blank paranccsal 
kitörölt területek helyét, és megadhatjuk a szakadási vonalak, földtani vetőket jelölő 
vonalak (Fault Line Properties) tulajdonságait is. 

  
48. ábra 

Az izovonalas térkép tulajdonságai 
 

A Levels lap az izovonalak formázását szolgálja. Rengeteg lehetőség van, melyek 
közül csak a legfontosabbakat mutatjuk be. A lapon egy táblázat mutatja be az aktuá-
lisan kirajzolt izovonalakat. A táblázat mellett található gombokkal a táblázatba új 
sort szúrhatunk be (Add) vagy törölhetünk (Delete), a táblázat értékeit elmenthetjük 
(Save) vagy a korábban mentett táblázatot betölthetjük (Load). Valamennyi oszlop-
azonosító egyben parancsgomb is (49. ábra). 
A Level felirat megnyomásával az izovonalak kezdő (Minimum) és záróértékét 
(Maximum), illetve a lépésközt (Interval) is megadhatjuk.  
A további gombok esetén izovonalakhoz rendelt tulajdonságokat lehet változtatni. 
Az aktuálisan változtatandó izovonalakat az érintett szintek (Affected Levels) mező-
ben választjuk ki. Az első izovonal sorszámát amit érint a változtatás a First mezőbe 
írjuk be. A Set mezőben megadott számú ezt követő izovonalat ugyanilyen tulajdon-
sággal ruházzuk fel, míg a következő, Skip mezőbe írt számú izovonalat a beállítás 
nem érinti, ezeket átugorja a formázás. 
A Line gomb segítségével az izovonalakat formázhatjuk: a vonalvastagság (Line 
Width), a vonal színe (Color) és stílusa (Style) szerint. A vonalak lehetnek egyformák 
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(Uniform) vagy tendenciaszerűen változók (Gradational). Amennyiben ez utóbbit 
választjuk, akkor egy színskálát és egy vastagság-tartományt is meg kell adni. 

   

  
49. ábra 

Az izovonal-formázás dialógusablakai 
 
A Fill gombbal az izovonalak közötti tér kitöltését szabályozhatjuk, végül a Label 
gombbal az izovonalak feliratait lehet formázni. Az izovonal-feliratok egymástól 
való távolságát a Label to Label Distance, a térkép szélektől mért minimális távolsá-
gát a Label to Edge Distance határozza meg. Azt, hogy mennyire görbe szakaszokra 
kerülhet felirat, azt a Curve Tolerance érték határozza meg: minél közelebb van az 
érték 1-hez, annál egyenesebb izovonal-szakaszokra kerülhet csak felirat. Az Orient 
Labels Uphill jelölőnégyzettel elérhetjük, hogy a feliratok mindig az izovonalak nö-
vekvő irányába nézzenek, ami segít bonyolult esetekben a tájékozódásban. 
A Map → Contour Map → Edit Labels parancs csak aktív izovonal fedvény ese-
tén működik, és hatására az izovonalak cimkéi körül kis téglalapok jelennek meg, 
melyeket tetszés szerinti helyre mozgathatunk vagy akár törölhetünk is. A feliratok 
formázása az izovonal-szerkesztés legutolsó lépése, mert az itt végzett formázások 
minden további módosítás esetén azonnal elvesznek, amire hibaüzenet figyelmeztet. 
A Map → Contour Map → Export Contours parancs az aktív izovonalas 
térképfedvényt vektorgrafikus formában exportálja egy AutoCAD DXF állományba.  
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12.2.9.4. Alaptérképek 
Alaptérképeket a Map → Base Map paranccsal lehet előállítani. Alaptérkép készül-
het vonalrajzból is (vektorgrafika), de éppúgy használható egy beszkennelt térképlap 
(rasztergrafika) is alaptérképként. Az alaptérképként használt vektor- vagy 
rasztergrafikát az különbözteti meg a rajzobjektumoktól, hogy azokhoz koordinátá-
kat rendelünk, így a grafika minden pontja egy-egy konkrét, ismert helyet jelent a 
vizsgált térségben. Amennyiben egy szkennelt térképet alaptérképként hívunk be, 
azonnal hozzárendelődik egy koordinátarendszer, melynek bal alsó sarka az origó és 
egységei alapértelmezetten a grafika képpontjai (pixeljei), amit az objektum 
managerben a térképobjektumhoz rendelt koordinátatengely-objektumok is jeleznek. 
Amennyiben egy koordinátákat tartalmazó vonalrajzot hívunk be, pl. dxf vagy bln 
állományt, akkor a valós koordináták jelennek meg. 
Amennyiben az alaptérkép vektorgrafikus, akkor a vonalak színét és vastagságát a 
Line, a poligonok kitöltését a Fill, a szöveges objektumokat a Font gombbal módo-
síthatjuk a Properties mezőben (50. ábra). Az állomány nevét az Input File mező, a 
befoglaló téglalap határkoordinátáit az Image Coordinates mező tartalmazza. 
Rasztergrafikus állományok esetén a gomboknak nincs szerepük, ugyanakkor lehető-
ségünk van a kép határoló koordinátáinak (xMin, xMax, yMin, yMax) megadására 
(Image Coordinates mező). 

  
50. ábra 

Az alaptérképek tulajdonságai vektor és rasztergrafikus állományesetén 

12.2.9.5. Az adatpont-térképek 
A Map → Post Map paranccsal a térképekre koordinátákhoz rendelve lehet szimbó-
lumokat és feliratokat elhelyezni, pl. fúrási pontokat jelölni lehet, továbbá a szimbó-
lumok mellé fel lehet írni a fúrás nevét, és egyéb paramétereket, mint pl. a terepszint 
tengerszint feletti magasságát, vagy a fúrásban észlelt vízszinteket, koncentrációkat, 
stb. A Post(adatpont-) térképeknek két alaptípusa van, a hagyományos alappont-
térkép és az osztályozott alappont- térkép (Classed Post Map). A hagyományos 
alappont-térkép esetén valamennyi pont azonos jelölésű, míg az osztályozott alap-
pont-térkép esetén egy változó értékétől függ a pont jelölésének formája (színe, alak-
ja, mérete). Ez utóbbi esetben az adatállománynak tartalmaznia kell egy olyan 
adatoszlopot, amelybe az osztályozás alapjául szolgáló értékek találhatók és a 
program ezen adatok és a felhasználó által megadott érték-intervallumok alapján 
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ezen adatok és a felhasználó által megadott érték-intervallumok alapján határozza 
meg, hogy milyen módon jelöli az egyes pontokat. 

  
51. ábra 

Az adatpont-térképek beállításai 
 
A hagyományos adatpont térkép létrehozásához Map → Post Map → New Post 
Map parancsot kell kiadni, majd megadandó egy adatállománynak a neve, amelyik-
ben az oszlopok bármilyen sorrendben tartalmazzák minimálisan az X és Y koordi-
nátákat, de tartalmazhatják a pontok mellé írandó feliratot és számos további paramé-
tert is. A hagyományos adatpont-térképek tulajdonságait az 51. ábra mutatja be. A 
tulajdonságokat az általános (General) és a feliratok (Labels) lapokon adhatjuk meg. 
Az adatfile nevét a Data Filename mezőben adhatjuk meg, illetve módosíthatjuk. A 
jel helyét a Worksheet Coloumns mezőben az X Coord és Y Coord mezőknél legör-
dülő menüben adhatjuk meg. Az oszlopok jelölését, illetve ha az első sorban az osz-
lopok megnevezése található, akkor azokat is automatikusan beolvassa a program, 
aminek feltétele, hogy szövegmezők legyenek az első sorban, mivel a számmezőket 
nem tekinti a Surfer feliratnak. Van lehetőség arra, hogy az adatpontokat jelölő 
szimbólumokat egyenként definiáljuk, ekkor az adatállomány egyik oszlopában az 
aktuálisan használandó szimbólum sorszámát tartalmazó adatoszlopot a Symbol re-
dőnymenüben kell kiválasztani. Lehet továbbá minden egyes jelet egy megadott 
szöggel egyenként elforgatni, amit szintén az adatállomány egyik oszlopában kell 
megadni, majd azt az Angle menüből kiválasztani. Amennyiben a pontokat jelölő 
szimbólumokat nem adtuk meg külön oszlopokban – ami általában így van – azaz 
Symbol: None, akkor a program az alapértelmezett szimbólumot használja, amit a 
Default Symbol mezőben lehet definiálni. A szimbólum alakját a gombra kattintva 
lehet változtatni, és megadható minden jel azonos mértékű elforgatása (Angle), illet-
ve lehetséges a pontok kiíratási gyakoriságának megváltoztatása (Frequency). Ez 
utóbbi főképpen akkor hasznos, ha nagyon sűrűn vannak a pontok, és ezért zavaróan 
közel kerülnének egymáshoz. 
A jelek mérete lehet azonos (Fixed Size), vagy egy a felhasználó által megadott osz-
lopban (Worksheet Coloumn Containing Height) tárolt értéktől függően változó 
(Proportional). Ez utóbbi esetben megadandó a szimbólum nagysága (Symbol 
Height) két eltérő adatértéknél (at Data Value), és a program a két pontpár alapján 
vagy lineáris (Linear) vagy gyökös (Square Root) függvényillesztéssel inter-, illetve 
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extrapolálva határozza meg a szimbólumok nagyságát. A beállítással lineáris jelek 
(pl. nyilak) hossza arányos lehet valamely jellemző nagyságával, vagy a gyökös ösz-
szefüggés esetén megoldható, hogy a jelek (pl. kör, négyzet) területe arányos legyen 
az ábrázolt mennyiséggel (52. ábra). 

 
52. ábra 

A változó jelnagyság megadása 
 
A feliratok (Labels) lapon megadható a feliratokat tartalmazó oszlop (Worksheet 
Coloumn for Labels), a feliratok helye a jelölő szimbólumhoz képest (Position 
Relative to Symbol), illetve a betűtípus (Font) és a kiírás formátuma (Format) 
(számformátumok). 3D ábrázolás esetén megadható, hogy a feliratokat melyik síkra 
írja a program (Plane), illetve, hogy milyen hosszú (Length) és alakú (Properties) 
vonalak tetejére kerüljön a felirat (3D Label Lines). 
Az osztályozott adatpont-térkép létrehozásához Map → Post Map → New Classed 
Post Map parancsot használjuk hasonlóan a hagyományos adatpont-térképekhez. Az 
osztályozott adatpont-térképek tulajdonságai azonban a Classes (osztályok) tulajdon-
ságlappal bővülnek (53. ábra).  

 
53. ábra 

Az osztályozott adatpont-térképek beállításai 
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A lapon megadandó az eltérő jellel jelölt csoportok, osztályok száma (Number of 
Classes) és az, hogy hogyan határozza meg a program a csoportok határait: közel 
azonos számú adat legyen minden csoportban (Equal Number), azonos nagyságú 
intervallumot fogjanak át az egyes csoportok (Equal Interval) vagy a csoportok ha-
tárértékeit a felhasználó határozza meg (User Defined). A csoportok adatait a táblá-
zat tartalmazza: a csoporthatárok (Minimum és Maximum), az adatok hány százalé-
ka esik az adott csoportba (%), a csoportba tartozó adatok száma (#), a jelölő szimbó-
lum típusa (Symbol) és mérete (Size). A táblázat bármely értékét a felhasználó meg-
változtathatja. 
 

12.2.9.6. A színtérképek 
A Map → Image Map paranccsal a térfelületeket színek átmeneteivel tudjuk ábrá-
zolni (54. ábra). A térkép mellett színskálát is létrehozhatunk (Show Color Scale). A 
színeket a Colors gomb megnyomásával határozhatjuk meg (55. ábra), illetve a tö-
rölt vagy adathiányos területeket eltérő színekkel jelölhetjük (Missing Data) 
A színskálát értékpontokhoz rendelt színekkel adjuk meg a Color Spectrum dialó-
gus-ablakban (55. ábra). A színskála kezdő és végpontján túl a Ctrl billentyű lenyo-
másával bármennyi új pontot és a hozzá tartozó színeket is definiálhatunk. A szín-
skála két végpontját a Data to Color Mapping mezőben adjuk meg (Minimum és 
Maximum). Az elkészített színskálákat a Save gombbal menthetjük el, és a Load 
gombbal tölthetjük be. 
 

 

 

54. ábra 
Egy színtérkép és beállításai 
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55. ábra 

A színskála meghatározása a Color Spectrum dialógusablakban 

12.2.9.7. Árnyékolt térszín-térképek 
A Map → Shaded Relief Map paranccsal árnyékolt térszín térkép készíthető. A tér-
kép ahhoz hasonlít, mint ahogyan a bolygók (Hold, Mars, stb.) felszínének képét szok-
ták ábrázolni. Az ábrázoláshoz megadandó a fényforrás helye (Light Position Angles), 
továbbá a színskála (Colors)  és az adathiányos területek  (Missing Data) színezési 
beállításai. A Relief Parameters menüben az árnyékolás számításához használt beállí-
tásokat adhatjuk meg, melyekre nézve tanácsot nehéz adni. Az árnyékolás célja a mi-
nél jobb láttatás, ezért célszerű a fényforrás helyét és a számítási beállításokat addig 
változtatni, míg az eredmény a leglátványosabb nem lesz. Egy-egy változtatást köve-
tően az Apply gomb megnyomásával azonnal megtekinthető az eredmény, és az Undo 
gombbal a kedvezőtlen változtatásokat rögtön visszaállíthatjuk (56. ábra). 

 
56. ábra 

Az árnyékolt térszín térkép beállításai 
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12.2.9.8. A vektortérképek 
A Map → Vector Map paranccsal vektortérképeket hozhatunk létre. A vektortérké-
pek a rácsháló rácspontjaiba helyezett nyilakkal mutatják a térfelület változásait. Két 
típusa az egy grides (Map → Vector Map → New 1-Grid Vector Map) és a két 
grides (Map → Post Map → New New 2-Grid Vector Map) vektortérkép. Az 
egygrides vektortérkép esetén a felület maximális meredekségének iránya és a mere-
dekség határozza meg az ábrázolandó nyilak irányát és nagyságát. A kétgrides vek-
tortérkép esetén a grid állományok a vektor x és y irányú komponensének nagyságát 
(Cartesian X,Y típus), vagy a nyilak nagyságát és irányát (Polar (Angle, Length) 
típus) tartalmazzák, amiből az eredő vektor irányát és nagyságát ábrázolja a prog-
ram. Polár-koordináták esetén, ha a kezdőpont az északi iránynak megfelelő, és a 
szögek óramutató járásával egyező irányba nőnek, akkor a 0=North, Increases CW 
opció, ha a kezdőpont a keleti iránynak megfelelő és a szögek óramutató járásával 
ellenkező irányba nőnek, akkor 0=East, Increases CCW opció választható (Angle). 

  

  
57. ábra 

A vektortérképek beállításai egy- és kétgrides változat esetén 
 
A vektor tulajdonságait a Symbol lapon állíthatjuk be, ahol megadható a nyilak for-
mája (Style), kitöltése (Properties), esetlegesen a meredekségtől függően változó 
színe (Color Scaling). A Scaling lapon a nyilak mérete szabályozható. A két felület-
meredekség értékhez (Magnitude Data) megadandó a nyíl testének (Shaft Legth) és 
fejének (Head Length) hossza, illetve szélessége (Symbol Width). A nyilak rajzolási 
kezdőpontját a Symbol Origin, a vektor-rajzolási léptéket a Scaling Method mező-
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ben definiáljuk. A vektorokat ellenkező irányba forgathatjuk a Reverse Vector 
Orientation, az ábrához jelmagyarázatot fűzhetünk a Show Scale Legend jelölő-
négyzet bejelölésével. 

12.2.9.9. A dróthálós felületábrázolás 
A Map → Wireframe paranccsal a felületeket a rájuk fektetett, konstans X, Y vagy 
Z irányban haladó „drótokkal” (vonalakkal) ábrázoljuk (58. ábra). A felület paramé-
tereit három dialógusablakban lehet megadni (59. ábra). 

Konstans X Konstans Y

Konstans X és Y Konstans Z

 
58. ábra 

A dróthálós felületábrázolás típusai 
 

A General lapon a szerkesztéshez használandó grid állomány választható ki (Grid 
File), illetve az 58. ábra szerinti ábrázolásmód (Plot Lines of Constant mező). A 
Show Base opcióval a lábazat rajzolása egy adott konstans Z szintig (Elevation) tör-
ténik. Amennyiben nincs lábazat, akkor értelmezhető az alsó (Show Lower Surface) 
és a felső felület (Show Upper Surface) rajzoltatása. Bármelyik mező kijelölése ese-
tén megjelenik a felület alsó és/vagy felső részén ábrázolt vonalsereg. A Remove 
Hidden Lines opció láthatósági ábrázolást tesz lehetővé. 
A Z Levels lapon az ábrázolandó konstans Z értékeket és azok tulajdonságait lehet 
megadni. Értelemszerűen csak abban az esetben van erre szükség, ha a General lap 
Plot Lines of Constant Z mező ki van jelölve.  
A Color Zones lapon a drótháló adott Z értékintervallumba eső szakaszait egy szín-
skálának megfelelően eltérő színekkel jelölhetjük. A színskálát a lapon található táb-
lázatban, míg azt, hogy az X, Y, vagy Z tengellyel párhuzamos vonalakra vonatkoz-
zék-e a formázás az Apply Zones to Lines of Constant mezőben kell megadni. 
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59. ábra 

A „dróthálós” felületek beállításai 

12.2.9.10. Kitöltött felületábrázolás  
A Map → Surface Map paranccsal kitöltött térfelületek rajzolhatók. A beállításokat 
négy ablakban lehet megváltoztatni (60. ábra), itt csak a legfontosabb paramétereket 
magyarázzuk el.  
A General lapon a felület szerkesztéséhez használt gridállományt (Input Grid File) 
változtathatjuk meg, illetve a Material Color mezőben az ábrázoláshoz használt 
színskálát adhatjuk meg. A színskála beállítási módja azonos a Color Spectrum dia-
lógusablakéval (55. ábra). A rácsháló állományok törölt részein (Blanked Nodes) A 
felület rajzolását letilthatjuk (Don’t draw (blank)) vagy egy adott értéknek megfelelő 
színnel ábrázolhatjuk (Remap to:).  
A felületet ábrázolhatjuk oldalkitöltéssel (Show Base) vagy anélkül. 
A Mesh lapon az X vagy Y tengellyel párhuzamos rácshálót fektethetünk a felületre, 
a vonalak sűrűségét a Frequency mezőben állíthatjuk be. 
A Lighting lapon a megvilágítás irányát, míg az Overlays lapon a fedvényekkel 
kapcsolatos jellemzőket állíthatjuk be. 



61 

  

  
60. ábra 

A kitöltött térfelületek beállításai 
 

12.2.9.11. Léptékvonalzó rajzolása 
A Map → Scale Bar paranccsal léptékvonalzó rajzolható a térképre (61. ábra). A 
léptékvonalzó osztásainak számát a Number of Cycles, az egyes osztások hosszát a 
Cycle Spacing, a feliratok számsorának a lépésközét a Label Increment mezőben 
kell megadni. A feliratokat a Labels mezőben lehet formázni: a betűtípust a Font, 
míg a számábrázolás formátumát, a számok elé és után írt szöveget, stb. a Format 
gombbal lehet definiálni. 
A Scale tracks rádiógombokkal annak a tengelynek az irányát határozhatjuk meg, 
aminek alapján a léptékvonalzó készül. A beállítások hatását a készített léptékvonal-
zóra a 62. ábra mutatja be. 

12.2.9.12. Digitalizálás 
A Map → Digitize paranccsal egy kijelölt térkép típusú objektumon határozhatjuk 
meg a kurzor aktuális helyének koordinátáit. A parancs aktiválása esetén a menüben 
a menüpont mellett egy kis pipa jelenik meg jelezve a digitalizáló üzemmód bekap-
csolását, miközben a kurzor célkeresztté alakul. Ebben a helyzetben a képernyő bár-
melyik, akár a térképen ábrázolt térrészen kívül található pontjára kattintva a prog-
ram meghatározza a kiválasztott pont helyzetét és annak koordinátáit, majd azokat 
egy újonnan megnyíló szövegablakba illeszti. A pontok koordinátái mellé további 
szöveget vagy adatokat írhatunk. Egy szövegablakba több pont koordinátáit is rög-
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zíthetjük, majd a pontokat a korábban ismertetett *.DAT adat- vagy *.BLN vonal-
rajz-formátumba menthetjük. Amennyiben *.BLN formátumba kívánjuk az adatokat 
menteni, akkor lehetőség van egy szövegablakon belül több vonaldarab egyidejű di-
gitalizálására és mentésére, ebben az esetben a vonalszakaszokat leíró pontsorozatok 
közé egy-egy elválasztó üres sort kell beilleszteni. 

 
61. ábra 

A léptékvonalzók beállítása 
 

 
62. ábra 

Eltérő beállításokkal készített léptékvonalzók 
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12.2.9.13. A Trackball használata 
A trackball segítségével a térbeli ábra nézetét lehet interaktívan megváltoztatni. Az 
eszköz a Map → Trackball paranccsal aktiváljuk, mire a kurzor alakja megváltozik 
(a parancs csak akkor érhetjük el, ha valamelyik térképi rajzobjektumot korábban 
már kiválasztottuk!).  
A parancs hatására a kiválasztott térkép körül egy befoglaló téglalap (2D) vagy tégla-
test (3D) jelenik meg, majd az egér mozgatásával az objektumot a térben (3D) vagy a 
síkban (2D) elfordíthatjuk. 

12.2.9.14. A 3D objektumok igazítása 
A Map → Stack Maps paranccsal lehetőség van azonosan tájolt egy rajzlapon talál-
ható 3D térfelületek összeigazítására. A parancs használata előtt valamennyi igazíta-
ni kívánt objektumot teljesen azonos tájolásúvá kell tenni, amit a View tulajdonsá-
goknál lehet ellenőrizni.  
Ezt követően a parancs hatására az igazítani kívánt térképek oldalirányban azonos 
helyre rendeződnek (a koordináták alapján), míg a parancs a kijelölt objektumok 
függőleges helyzetét nem befolyásolja. 

12.2.9.15. Térképek közös koordináta rendszerbe foglalása 
A Surfer egyik legalapvetőbb parancsa a Map → Overlay Maps parancs. Amikor 
térképeket, objektumokat készítünk, valamennyi térkép saját önálló koordinátarend-
szerrel rendelkezik, amit az mutat, hogy az objektumhoz négy koordinátatengely is 
tartozik. Amennyiben egy rajzot több térképből állítunk össze, akkor több koordiná-
ta-rendszert is készítünk és célszerű azokat egy térképpé „olvasztani”. Kezdő fel-
használók egymásra „húzogatják” a térképeket, azonban ennek rengeteg hátránya 
van a további szerkesztések során. Ennek elkerülésére szolgál a Map → Overlay 
Maps parancs, amivel több kijelölt térképet egy térképpé alakítunk úgy, hogy a ko-
rábbi különálló térképek az új egységes térkép fedvényeivé válnak. 
A parancs fordítottja a Map → Break Apart Overlay parancs, amivel az egy tér-
képbe foglalt fedvények közül az aktuálisan kijelöltet leválaszthatjuk és egy külön 
térképpé alakíthatjuk. 
 

12.2.10. A Window (ablak) menü 
A Window (ablak) menünél (63. ábra) az ablakkezelő funkciókat érhetjük el. A New 
Window paranccsal egy ablak újabb nézetét kérhetjük, egyszerre több állományt 
nézhetünk úgy, hogy felosztjuk az aktuális ablakot vízszintesen (Tile Horizontal) és 
függőlegesen (Tile Vertical), vagy egymásra helyezve több ablakot (Cascade) né-
zünk. Amennyiben az ablakok ikon formába vannak összezárva, akkor az Arrange 
Icons paranccsal lehetőség van azoknak a lap aljára rendezésére. A menü alján a 
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program az aktuálisan nyitott ablakokat sorolja fel, melyek közül bármelyiket kivá-
laszthatjuk az egérrel. 

 
63. ábra 

A Window (ablak) menü 

12.2.11. A Help menü 

 
64. ábra 

A Help menü 
 
A Help menüben (64. ábra) segítségképpen elérhetjük a program angol nyelvű leírá-
sát (Contents), a tanulórendszert és példákat (Tutorials), a parancsok leírását 
(Menu Commands), illetve a Surfer makróprogramozási lehetőségek leírását 
(Automation Help). Lehetőségünk van a Golden Software honlapján frissítések ke-
resésére (Check for Update), a cég honlapjára ugrásra (Golden Software on the 
Web), és javaslatok küldésére (Feedback) a szerzőknek. Tapasztalat szerint a cég 
valós programhibák esetén gyorsan válaszol és kijavítja azokat. Több javaslatunk az 
újabb verziókba beépült. Az About Surfer menüpontnál a verziószámot, a szerzői 
jogokra vonatkozó adatokat és a szerzőket kapjuk meg. 

12.3. Interpolációs algoritmusok, diszkretizáció  

Mint azt a 6.2.2.2 fejezetben már röviden említettük, a modellezés során fúrási pon-
tokhoz rendelt információk állnak általában rendelkezésre, az alkalmazandó hidrodi-
namikai vagy transzportmodellező programok azonban megkövetelik, hogy vala-
mennyi elemhez egy-egy értéket hozzárendeljünk (diszkretizáció). A hozzárendelést 
általában geostatisztikai eljárásokkal végezzük el, melyeket a következőkben egysze-
rűsítve interpolációnak hívunk. 
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Röviden összefoglalva az I. kötetben leírtakat elmondható, hogy ha ismert a vizsgált 
terület több pontján egy adott paraméter értéke, akkor ezekre a pontokra matematikai 
eljárások felhasználásával folytonos térfüggvényeket lehet fektetni, amelyek a mód-
szertől és az adatok térbeli eloszlásától függő mértékben közelítik a keresett paramé-
ter térbeli eloszlását. Ugyancsak lehetséges a meglévő pontokból interpoláció segít-
ségével közelítő érték meghatározása az adott elemre vagy csomópontra. 
Az eljárás alkalmazása során feltételezzük, hogy bármely kiválasztott pontban a ke-
resett paraméter értéke a legközelebb eső adatokból származtatható, azaz nem vélet-
len jellegű. A számításhoz szükséges n darab pontban, melynek koordinátái (x1,y1), 
(x2,y2),… (xn,yn), az interpolálandó mennyiség értékeit (z1, z2, …, zn) ismerni. 
Egy kiválasztott pontban a legvalószínűbb érték meghatározásához általában a leg-
közelebbi adatpontokat veszik figyelembe. Már az interpoláció kezdetén meghatá-
rozzuk az interpoláció során felhasználandó adatok minimális számát, valamint azt a 
távolságot, melyen belül a paraméterek nagysága közötti kapcsolat feltételezhető 
(hatástávolság). Kiindulva abból a feltételezésből, hogy az egymáshoz közeli helye-
ken a vizsgált paraméterek hasonlítanak egymáshoz, a két pont közötti távolság nö-
vekedésével kell lennie egy olyan távolságnak, amikortól kezdve a két érték függet-
lenné válik, amit hatástávolságnak neveznek. 
A hatástávolságon belüli adatpontokból bizonyos keresési szabályoknak megfelelően 
választjuk ki a számításokhoz ténylegesen használandó adatpontokat. Amennyiben a 
kiválasztott helyhez bármilyen irányból legközelebb eső pontok alapján számolunk, 
azt egyszerű keresésnek (Simple search) hívjuk. Van azonban arra is lehetőség, hogy 
általunk megadott számú térrészenként (Sectors) a legközelebbi n pont adatát (Data 
per Sector) használjuk fel. Amennyiben a vizsgált területet térnegyedekre osztjuk 
akkor kvadráns (Search method: Quadrant), ha térnyolcadokra osztjuk, akkor 
oktáns (Search method: Octant) keresésről beszélünk (65. ábra). 
 

kvadráns kereesés oktáns keresés

 
65. ábra 

A kvadráns és az oktáns keresés elve 
(in ed: CLAUSER, 2003) 
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Az interpolációt több módon is elvégezhetjük: használhatjuk a Surfer programot, de 
van lehetőség a Processing MODFLOW környezetbe épített Field Interpolator hasz-
nálatára is. A leggyakrabban a két megoldást együtt alkalmazzuk.  
A Surfer az ismert, *.DAT állományban tárolt pontokból a Grid → Data paranccsal 
egyenközű rácsháló pontokra tud térfelületet illeszteni. Ez egyenközű rácshálóval 
történt térosztás esetén a modellezés során közvetlenül is alkalmazható, azonban ál-
talában a rácsháló a modellezésnél nem egyenközű. Ilyenkor a legcélszerűbb két lép-
csőben megoldani a feladatot. Első lépésben a Surferrel, kihasználva annak nagytel-
jesítményű és professzionális interpolációs algoritmusait egy a területre illesztett sű-
rű, de egyenközű rácshálóra meghatározzuk az ismert adatok alapján a terület egé-
szére a legvalószínűbb paraméter-eloszlást. Ezt követően a kapott adatokat egy má-
sodik lépcsőben felhasználjuk a Field Interpolator program bemeneti adataiként, 
esetleg hozzáfűzve az eredeti adatpontokat is, aminek segítségével már egy általános 
rácsháló pontjaira számoljuk a kertesett értéket a PMWin kevésbé fejlett interpoláló 
algoritmusai felhasználásával. Ekkor már a felületet jobban leíró, nagyságrendekkel 
több pont alapján végezzük el a számításainkat (66. ábra). 

Kiindulási adatrendszer (x,y,z értékek)

Input adatállomány elkészítése

Surfer *.dat állomány

x1, y1, z1
x2, y2, z2

...
xn, yn, zn

Eredmény:
Surfer ASCII 
adatállomány 

Eredmény:
Surfer Grid 
állomány 

Konverzió Surferrel
Grid - Convert 

paranccsal

Adatkezelés:
max. 5000 adat véletlen kiválasztása

eredeti  adatpontok hozzáfûzése
a pontok számának beírása az 1. sorba

stb.

Field Interpolator állomány
n

x1, y1, z1
x2, y2, z2

...
xn, yn, zn

Interpoláció a Field Interpolatorral

Eredmény:
Processing Modflow 

ASCII mátrx állomány 

Állomány beolvasása
 a PMWin modellbe

Value... Matrix... Load...

általános
rácsháló

egyenközű
rácsháló

Interpoláció a Surferrel
Grid - Data...

 
66. ábra 

Az interpoláció folyamata 
 

 
A modellezés során használt interpolációs eljárásokra jellemző, hogy alkalmasak 
mind inter-, mind extrapolációra, mivel valamennyi modellelemre szükséges az is-
mert értékeken alapuló értékbecslés elvégzése akkor is, ha az összes kiindulási adat a 
modellezendő területen belül helyezkedik el. Nem engedhető meg, hogy a módszer 
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ne számítson értékeket bármely pontra, még akkor sem, ha az extrapolációval kapott 
értékek megbízhatósága erősen megkérdőjelezhető. A Surfer program ezért engedé-
lyezi azt, hogy alulhatározott felületek esetén az interpolációt ne végezze el, míg a 
Field Interpolator minden cellára mindig számít értéket függetlenül annak realitásá-
tól. 
Az interpolációs algoritmusoknak két alapvető típusuk van. A torzításmentes interpo-
lációk egy-egy ismert ponthoz közeledve egyre jobban közelítik annak értékét és az 
ismert pontban az „interpolációval” képzett felület értéke pontosan visszaadja az is-
mert értéket. Az ilyen módszereket torzításmentes közelítésnek nevezzük. A torzí-
tásmentes közelítés legismertebb típusai a lineáris interpoláció vagy a legkisebb gör-
bület módszere. A másik csoport az úgy nevezett torzításos interpolációk csoportja, 
ebben az esetben a számított térfelület egy ismert pontban kisebb-nagyobb mérték-
ben eltér az ismert értéktől. Torzításos közelítést alkalmaz minden súlyozott átlag-
számításon alapuló megoldás, amit könnyen beláthatunk. Amennyiben egy pont ki-
ugróan magas értékű a környezetében, akkor a súlyozott átlagszámítás során a körü-
lötte található alacsonyabb értékű pontokat is felhasználva a magas és az alacsony 
értékű pontok közötti eredményeket kapunk és az átlaggal számított érték sosem ér-
heti el a maximumot, azaz a térfelület a kiugró ponton nem haladhat át. A minimum-
helyek környezetében éppen ezért a számított, „interpolált” érték mindig a mini-
mumnál nagyobb lesz. Mivel az átlagszámítás a maximumhelyeket levágja, a mini-
mumhelyeket pedig „feltölti” (67. ábra), ezért a torzításos interpolációval kapott in-
terpolált térfelület „simább” lesz, mint a torzításmentes interpolációkkal kapott felü-
let.  

valós görbe

interpolált görbe

ismert értékek

z

x  
67. ábra 

A súlyozott átlagszámítás felület-kiegyenlítő hatása 
 
Néhány interpolációs megoldást a következőkben mutatunk be. A módszerek részle-
tes ismertetését az alkalmazott matematikai, geostatisztikai és térinformatikai szak-
könyvek (STEINER, 1990.; de MARSILY, 1986.; DELHOMME, 1976., 
WACKERNAGEL, 1995, TAMÁS 2000a, TAMÁS 2000b ) és a kapcsolódó szoftve-
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rek felhasználói kézikönyvei (KECKLER, 1999., PANNATIER , 1996) részletesen 
tartalmazzák. 
Valamennyi esetben induljunk ki abból, hogy rendelkezésünkre áll a vizsgált térfelü-
letet kellően jellemző n db mért érték a mérési pont koordinátáival. A pontok eseté-
ben törekedni kell arra, hogy a vizsgált (gyakorlatban a modellezett) térrész területén 
kívülre is essenek ismert pontok annak érdekében, hogy a folyamat során minden 
elemre interpolált és ne extrapolált értékeket számítsunk. Valamennyi módszernél 
felhívjuk a figyelmet a módszer hibáira is. 

12.3.1. A háromszögelésen alapuló módszerek 
A megoldás torzításmentes interpolációt jelent, mert az adatpontokban a módszerrel 
visszakapjuk az eredeti értékeket. A háromszögelésen alapuló interpolációs eljárást 
mind a Surfer (Linear Interpolation with Triangulation), mind a PMWin Field 
Interpolatora (Renka Triangulation) alkalmaz. Mindkét megoldás során az adatpon-
tokra a rendszer háromszöghálót illeszt úgy, hogy a lehető legizometrikusabb három-
szögekkel fedje le a területet (háromszögelés), a megoldás ezután tér el egymástól. 

12.3.1.1. A lineáris interpoláció 
A lineáris interpoláció során feltételezzük, hogy két ismert pont között a változás 
egyenletes, azaz, ha pl. A pontban 100 mBf. , B pontban 90 mBf. a terepszint, akkor 
a kettő között félúton 95 mBf., az A ponthoz közelebb eső negyedtávon 97.5 mBf. a 
terepszint várható értéke. Ezután a háromszögek sarokpontban mért értékeire a rend-
szer síkokat illeszt, és a kapott síkok aktuális magassága megadja minden a három-
szög területén belüli pontban az interpolált közelítő értéket. A módszer legnagyobb 
előnye az egyszerűség, hátrányai a következők. Extrapoláció esetén a számítás során 
feltételezzük, hogy az adathiányos külső területrészen a változás tendenciája meg-
egyezik a pontokkal leírt térrész szélén tapasztalt változásokkal, azaz a szélső három-
szögekre fektetett síkokat tetszőleges mértékben meghosszabbítjuk oldalirányban. 
Ennek következménye az, hogy jelentős hibák lehetnek a számítás során, pl. a kon-
centráció a szélső adatpontban 10 mg/l, a hozzá legközelebb, 50 m-re eső pontban 50 
mg/l. Ennek alapján a szélső ponton kívül további 50 m távolságban –40 mg/l-es 
koncentrációt számolunk, ami képtelenség. További hiba, hogy az izovonalak a há-
romszögek határain törnek, ami nem realisztikus közelítés (68. ábra).  
A Surfer használ lineáris interpolációs algoritmust. 

12.3.1.2. A Renka-féle interpoláció 
A Renka-módszer (Renka Triangulation, RENKA, 1984a, 1984b) esetén is egy, az 
ismert pontokra illesztett háromszögrendszer segítségével történik az interpoláció, 
azonban ebben az esetben egy olyan harmadrendű interpolációs-függvényt haszná-
lunk fel, amelyiknek az első deriváltja folytonos térfüggvény. Ez a folytonos tér-
függvény túlhalad a szélső háromszögeken és ez teszi lehetővé, hogy a módszerrel 
extrapolációt is végezzünk. Mint minden extrapoláció esetén, ebben az esetben is 
távolodva a mérési pontoktól egyre kevésbé reprezentatív értékeket kapunk. Mivel a 
függvény első deriváltja is folytonos, ezért a háromszög élei mentén nincsenek töré-
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sek, azaz a függvénnyel származtatott paraméter-eloszlással végzett numerikus szá-
mítás a lineáris interpolációhoz képest stabilabb. A Field Interpolator a Renka-
módszert használja. 
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68. ábra 

A lineáris interpoláció 
 

12.3.1.3. A kétváltozós Akima-féle interpoláció 
A kétváltozós Akima-féle interpoláció (Akima Bivariate Method, AKIMA, 1978a, 
1978b) is az ismert pontokra illesztett háromszögrendszert használja fel, azonban az 
ismert z értékekre az interpolációt a kétváltozós ötödik Hermite-polinom felhaszná-
lásával végzi el a háromszögön belül. Az Akima-féle interpolációt a Field 
Interpolator alkalmazza. 
 

12.3.2. Súlyozott átlagszámításon alapuló interpolációk 
A súlyozott átlagszámításon alapuló interpolációk során a vizsgált pont környezeté-
ben található n db legközelebbi pontban észlelt z értékek súlyozott átlaga alapján 
számítjuk az interpolált értéket.  
Súlyozott átlagszámítás esetén az átlagot az alábbi függvénnyel számítjuk: 
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 ahol wi az adott értékre vonatkozó súly-érték. 



70 

A módszerek a súly meghatározási módjában térnek el egymástól. A súlyozott átlag-
számításon alapuló interpolációs módszerek közül a legismertebbek a Shepard-
módszer, a távolsággal fordítottan arányos súlyozás módszere, a radiális bázisfügg-
vény-módszer, a természetes szomszéd módszer és a krigelés. 

12.3.2.1. A távolság hatványával fordítottan arányos interpoláció, a Shepard módszer 
A távolság hatványával fordítottan arányos interpoláció (Inverse distance to a 
power, Shepard -method) alapelve az a felismerés, hogy minél közelebb van egy 
hely egy ismert ponthoz, annál inkább hasonlít tulajdonságaiban hozzá, azaz a hason-
lóság mértéke fordítottan arányos az ismert, környező adatpontok távolságával. Az 
érték számítása a környező pontokból súlyozott átlagszámítással történik, ahol az 
egyes wi súlyok a távolság reciprokától, illetve a távolság valamelyik, a felhasználó 
által megadott hatványának reciprokától függő érték.  
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ahol N a hatványkitevő, si a vizsgált pont távolsága az i-edik zi értékkel jellemezhető 
ponttól (SHEPARD, 1968). 
Mettől nagyobb az N hatványkitevő, annál kevésbé veszi a módszer a távolabbi pon-
tokat figyelembe. Az N hatványkitevőtől függően az interpolációval kapott térfügg-
vény csúcsosabb vagy simább lesz, Shepard az N=2 értéket találta a legáltalánosab-
ban alkalmazhatónak (69. ábra) 

érték

hely

N=4
N=2

N=1

 
69. ábra 

A különböző hatványkitevők hatása az interpolált értékekre (Shepard-módszer) 
(CHIANG - KINZELBACH, 1993) 

 
A Shepard-módszer hátránya, hogy az ismert értékek közelében koncentrikus 
izovonalakkal jellemezhető térrész alakul ki, amit bikaszem-effektusnak is neveznek. 
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Annak érdekében, hogy ez elkerülhető legyen a kapott térfüggvényt simítani szokták: 
ezt hívják a simított, távolsággal fordítottan arányos súlyozás módszerének. Ekkor a 
súlyokat az alábbi módon számítjuk: 
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ahol δ a simító-tényező. 
A Shepard-módszer hibamentes közelítést ad, mert ahogy közelítünk az ismert pont-
hoz, úgy közeledik a súly 1-hez. Amennyiben azonban a δ a simító-tényezőt is figye-
lembe vesszük (simított, távolsággal fordítottan arányos súlyozás módszer), akkor 
már egyetlen pontban sem válthat a wi súly egységnyivé, azaz az ismert értékkel ren-
delkező pontban az észlelt értéket nem kapjuk vissza az interpoláció során. A simitó-
tényező növelésével egyre jelentősebbé válik a hiba. A módszer előnye a gyorsaság. 
A Shepard módszert a Field Interpolator és a Surfer is alkalmazza. 

12.3.2.2. A módosított Shepard-módszer 
A módosított Shepard-módszer (Modified Shepard Method) egy speciális, a távolság 
hatványának reciprokával történő súlyozott átlagszámítási algoritmust használ az 
interpolációhoz. A módszer használatának előnye, hogy a korábban említett bika-
szem effektust a lehető legjobban kiküszöböli. A hibát úgy küszöböli ki, hogy a szá-
mítások elején az ismert adatpontok környezetében egy másodrendű felületet illeszt a 
pontra, majd ezt követően történik meg a hagyományos súlyozott átlagszámítás. A 
módosított Shepard-módszert a Surfer alkalmazza. 

12.3.2.3. A természetes szomszéd módszer 
A természetes szomszéd módszer (Natural Neighbour Method) is a súlyozott átlag-
számítás elvén alapul. A súlyokat ebben az esetben az egyes pontok köré rajzolható 
ún. hatóterület alapján veszik fel. A hatóterületeket úgy határozzák meg, hogy az 
adatpontokra a háromszögelésnél ismertetettekhez hasonlóan egy háromszöghálót 
illesztenek, mely háromszögek oldalfelező pontjait összekötő egyenesek által kijelölt 
idomok jelentik az egyes adatpontok hatóterületét (70. ábra). A természetes szom-
szédok módszerénél a súlyozott átlagszámítás wi súlyait a számítás során a poligonok 
területével arányosan veszik fel. 
A megoldás mögött az a gondolat húzódik, hogy minden adatpont hatása addig érvé-
nyesül, amíg az van a legközelebb. A megoldással szép, sima és reális érzetet keltő 
izovonalak rajzolhatók, miközben hátrány, hogy a módszer az elvéből fakadóan ext-
rapolációra alkalmatlan, azaz az adatpontokkal határolt térrészen belül kell lenniük a 
modell határainak. 
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70. ábra 

Az adatpontok hatóterületei a természetes szomszéd módszer alkalmazásánál 
(KECKLER, 1999) 

12.3.2.4. A variogramok és a krigelés 
A krigelés a paramétereknek ismeretlen pontban, geostatisztikai alapokon nyugvó 
meghatározására alkalmas környező mérési értékek alapján. A módszer alapvetően 
egy súlyozott átlagszámítás, ahol az alkalmazott átlagszámítási súlyokat 
geostatisztikai alapokon, variogram-függvények segítségével határozhatjuk meg. A 
krigelés nevét kidolgozója, a dél-afrikai Krige után kapta. A krigelésnek több fajtája 
van: a pont-krigelés és a blokk-krigelés. A blokk-krigelés a gridháló elemi celláinak 
átlagértékét határozza meg, ezért kiugró értékek szűrőjeként is szolgál. E miatt azon-
ban a pontonként megfigyelt értéket nem adja vissza. E fejezetben a továbbiakban a 
krigelés alatt a pont-krigelést értjük. 
Tapasztalati tény, hogy a nem véletlenszerű mérési értékek egy bizonyos távolságon, 
az úgynevezett H hatástávolságon belül egymással korrelálnak. Ennek vizsgálatára 
határozzuk meg a teljes adathalmazból kiválasztott 2-2 pontpár hasonlóságának mér-
tékét, a varianciát: 

( ) [ ]221 zzsV i −= ,         (12.4.) 

ahol 2
21

2
21 )()( yyxxsi −+−=  a két pont távolsága, valamint z1, z2 az ismert érték az 

(x1,y1) és (x2, y2) pontokban. 
Majd hasonlóképpen meghatározzuk a rendelkezésre álló adathalmazból a létrehoz-
ható összes pontpár esetére a hasonlóság mértékét leíró varianciát, ami a mért érté-
kek különbségének négyzete. A kapott varianciákat rendeljük hozzá a kiszemelt két 
pont távolságához. Így összesen nV=np(np+1)/2 db távolsághoz rendelt variancia-
értéket kapunk, ahol np az adatok száma. Amennyiben a pontpárokat a köztes távol-
ság szerint csoportokba soroljuk, és a csoportokhoz hozzárendeljük a megfelelő 
variancia-értékek átlagát egy tapasztalati variogramot kapunk.  
A modellezett tér leírására szolgáló tulajdonságok (attributumok) a tér különböző 
irányaiban gyakran nagyon eltérő változékonysággal bírnak. Gondoljunk például egy 
folyóvölgy mederüledékeire, ahol a völgy irányában és arra merőlegesen jelentősen 
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eltér a tulajdonságok változékonysága, azaz az adott attributum tér varianciája irá-
nyonként változhat. Ezt az interpoláció során az adott irányok mentén történő 
variogramok meghatározásával vehetjük figyelembe. (Itt jegyezzük meg, amennyi-
ben mintapontjaink eloszlása nagyon egyenlőtlen, akkor a sűrűn mintázott helyeken 
csoportbontó algoritmusok segítségével csökkenteni kell a mintaszámot, különben a 
túlreprezentált mintaterület torzíthatja becslésünket.) 
Definíciószerűen variogramnak, esetlegesen a nevezőben szereplő kettes osztó miatt 
szemi-variogramnak vagy elméleti variogramnak nevezzük és γ(h)-val jelöljük azt a 
függvényt (71. ábra), amely a h távolság függvényében megadja az értékkülönbségek 
négyzetösszegének felét (STEINER, 1990), azaz  

( ) ( ) [ ]∑
=

+−=
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1

2

2
1 hn

i
hPiPi

V

p

zz
hn

hγ ,       (12.5.) 

ahol Pi az összes olyan mérési pont, amelytől h távolságban még található mért érték, 
amit zPi+h jelöl, míg zPi a jele a mért értéknek Pi helyen, végül nV(h) jelöli az összes 
egymástól h távolságban lévő pontpár száma. 
Az elméleti variogram-függvények típusait 12.1. táblázat és a 72. ábra mutatja be. A 
súlyozott átlagszámítás súlyait pedig az elméleti variogramokból leolvasható, illetve 
számítható kovariancia  

[ ] )(, hCZZCOV
hii PP γ−=

+
        (12.6.) 

értéke adja (73. ábra). 
 

 

71. ábra 
A pontpároktól az elméleti variogramig 

(WACKERNAGEL, 1995) 
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12.1. táblázat 
A variogramok típusai 

Variogram-modell típusa Matematikai függvény Feltétel 
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0 ≤ h ≤ H 
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Összetett modell: 
a lineáris és szférikus modell 

kombinációja 
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A táblázatban C=VAR(Z) az az érték, amelyhez a variogram-függvény a típusától függően nagy távolságok 
esetén közelít, illetve amelyet felvesz. Az exponenciális és a Gauss-típusú modell esetén a H hatástávolság 
definíciójáról (pl. γ(H)=a=0,9÷0,95C) önkényesen dönthetünk. 
 
A variogram-függvények a reális adatrendszerek esetén nem függetlenül indulnak az 
origóból, mert magának az adat-meghatározásnak is van egy szórása. Pl. egy fúrás-
ban és annak közvetlen közelében egy adott rétegsor vastagsága, szivárgási tényező-
je, porozitása, stb. mind-mind változhat, azaz akár ugyanazon a ponton mélyített fú-
rásokban a mért értékek kissé eltérőek lehetnek. Ezt a jelenséget a variogram-
függvényen a h=0 távolsághoz rendelt variancia-érték jeleníti meg, amit Nugget-
hatásnak, vagy magyarosan mag- vagy röghatásnak szoktak nevezni. A krigelés, 
amennyiben a röghatást figyelembe vesszük, semmiképpen sem hibamentes közelí-
tés, de általában röghatás nélkül sem az. Ennek oka a súlyozott átlagszámítás, azaz 
több pontbeli értéknek figyelembevétele. Hiába szerepel maximális súllyal a vizsgált 
pont közvetlen közelében a közeli mért érték, a többi környező, még a hatástávolsá-
gon belüli pont – amennyiben azt is figyelembe vettük – egy kicsit megváltoztatja az 
eredményként kapott értéket. 
A krigeléssel működő interpolációs algoritmusok lehetőséget adnak egy előre meg-
határozott elméleti variogram-függvény alkalmazására vagy akár egyéb programok 
használatára. A variogram-számítás legegyszerűbb eszköze a VarioWin program 
(PANNATIER, 1996). A program a hálózatról letölthető és könyv formában is meg-
jelent a Springer kiadónál. 
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72. ábra 

Az elméleti variogramok típusai  
(PECK et. al., 1988 nyomán) 

 

 
73. ábra 

A kovariancia értelmezése 
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A szoftver Prevar2D része kiszámítja és elmenti a pontpáronkénti variancia-
értékeket, majd a Vario2D programmal a tapasztalati variogramot lehet meghatározni 
a pontpár-adatok alapján. A Model2D programmal ezután van lehetőség a tapasztala-
ti variogramra egy elméleti szemivariogram-függvényt illeszteni, melynek adatai a 
krigelés alapadatait képezik. 
Lehetőség van a Surfer programmal is variogramot készíteni a Grid → Variogram 
→ New Variogram paranccsal (74. ábra). A parancs hatására megnyíló dialógusab-
lakban előbb az adatállomány nevét, majd a variogram paramétereit kell megadni. A 
Data lapon a beolvasott adatok jellemzőit találjuk, és definiálni lehet az adatállo-
mány egyes oszlopainak adattartalmát (Data Coloumns), továbbá az elemzésből egy 
szűrő segítségével kizárhatunk adatokat (Data Exclusion Filter), továbbá a duplikát 
adatok (Duplicate Data) kezelésének módját választhatjuk meg teljesen hasonlóan a 
gridfile készítésnél leírtakhoz. 
A General lapon a variogram irányítottságát, térbeli helyzetét definiáljuk (Angular 
Divisions, Radial Divisions), továbbá a tapasztalati variogram képzésnél használt 
intervallumok szélességét (Max. lag distance). A beállítások hatását az ablakban 
található ábra változásai mutatják. KITAINIDIS (1997) a variogramok készítésénél 
egyes esetekben az adatok előzetes elemzését és az irányfüggőség megszüntetését 
javasolja, amit a Detrend mezőben lehet beállítani. Általában az előzetes elemzés 
nem szükséges (Do not detrend the data), ezen kívül választható a lineáris és a 
négyzetes irányfüggetlenítési mód is. 
Ezután a készített variogramot a Surfer kirajzolja. A kész variogramot a felületszer-
kesztésnél (Grid Data) a krigelés kiválasztása után a speciális beállításoknál 
(Advanced Options), a Get Variogram gombbal lehet beolvasni és alkalmazni. 
 

  
74. ábra 

Variogram készítése Surferrel 
 

Ko-krigelés. A ko-krigelés során korrelációt tételezünk fel a becslendő paraméter és 
egy másik, általában jobban ismert statisztikai jellemzőkkel rendelkező paraméter 
között. A két adatsor felhasználásával azokon a területeken, ahol a becslendő para-
méter interpolálásához szükséges információ hiányzik, keresztkorrelációs számítás 
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alapján a második adatsor segítségével történhet a keresett paraméter becslése. A 
módszert ABOUFIRASSI és MARINO (1984) alkalmazta először a hidrogeológiá-
ban. A vizsgált kaliforniai területen a transzmisszivitás értékét becsülték ko-krigelés 
módszerével a transzmisszivitás és az azzal korreláló tárolási tényező adatok alapján. 

12.3.3. A radiális bázisfüggvény módszer 
A Surfer által támogatott, radiális bázisfüggvény-módszeres (Radial base function 
method) interpoláció az interpolációs eljárások egy külön csoportja.  
A módszerek olyan súlyozott átlagszámítást végeznek el, ahol a wi súlyok a 

( )22 δ+= iii sww  függvényt kielégítik, ahol si a távolság az ismert ponttól és δ a ra-
diális bázisfüggvény módszer simító-tényezője. A leggyakrabban alkalmazott bázis-
függvények: 

Reciprok gyökös függvény: ( )
22

1

δ+
=

i

ii
s

sw      (12.7.) 

Logaritmikus függvény: ( ) ( )22lg δ+= iii ssw      (12.8.) 

Gyökös függvény: ( ) 22 δ+= iii ssw       (12.9.) 

Természetes gyökös spline-függvény: ( ) ( ) 2/322 δ+= iii ssw    (12.10.) 

Vékonyréteges spline-függvény: ( ) ( ) ( )2222 lg δδ ++= iiii sssw    (12.11.) 
 
A módszer a lehető legjobban simított, mégis torzításmentes, azaz az adatpontokon 
tökéletesen áthaladó térfelületeket képez.  
A módszer alkalmazása során egy bázis-függvényt kell előzetesen kiválasztani, ami a 
krigelésnél használt variogramhoz hasonlóan működik, és ez a bázisfüggvény hatá-
rozza meg, hogy a környező, a keresési sugáron belül található pontokat mekkora 
súllyal vegye a szoftver a számításoknál figyelembe. Anélkül, hogy a megoldás ma-
tematikai hátterét vizsgálnánk, javasoljuk, hogy a multikvadráns, gyökös 
(Multiquadratic) vagy a vékony réteges spline (Thin plate spline) algoritmust al-
kalmazzák, mert a gyakorlatban ezek a függvények váltak be a leginkább.  

12.3.4. Egyéb interpolációs és felületszerkesztő algoritmusok 

12.3.4.1. A minimális görbület módszere 
A minimális görbület módszerének alkalmazásakor arra törekszünk, hogy a lehető 
legsimább, azaz a legkisebb görbületű felületet illesszünk az adatpontokra. A megol-
dás ahhoz hasonlít, mintha egy vékony, teljesen rugalmas lemezt illesztenénk az is-
mert helyzetű pontokra. A pontokra feszített rugalmas lemez helyzete jelenti a térfe-
lület számított legvalószínűbb helyzetét. A legkisebb görbület módszerével kapott 
térfelület általában nem torzításmentes illesztéshez vezet, mert a felület minél tökéle-
tesebb simítása közben szükségessé válhat a felületnek az adatpontoktól történő eltá-
volítása. A számított felület valamilyen optimalizáló algoritmus (általában a legki-
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sebb négyzetek elve) szerint legjobban, de nem tökéletesen illeszkedő felületet adja 
eredményül.  
A módszer bizonyos esetekben nagyon jól alkalmazható, mert pl. a vízdomborzat jól 
követi a legsimább felületet, azonban vannak hibái is. A legnagyobb problémája a 
módszernek, hogy extrapoláció esetén gyakran extrém nagy vagy irreálisan kicsi ér-
tékeket számít. 

12.3.4.2. A legközelebbi pont módszere 
A legközelebbi pont módszere (Nearest neighbour method) a szó szoros értelmében 
nem is interpoláció, mivel a megoldás alkalmazása esetén minden pontba számított 
érték felveszi a hozzá legközelebb eső pontban mért értéket. Ez egyenletes pontsűrű-
ség esetén hasonlít a modellezéskor használt zónás adatrendszerhez, azaz ilyenkor a 
„térfelület” azonos értékekkel jellemzett részekből épül fel, aminek határán szakadás 
van. 

12.3.4.3. A csúszó-átlagolás módszere 
A csúszó átlagolásos (Moving average method) felületszámítási módszert kizárólag 
a Surfer tartalmazza. A módszer alkalmazása során a rendszer egy a felhasználó által 
megadott, kör vagy ellipszis alakú területpontok átlagértékét számítja, melyeket a kör 
vagy ellipszis középpontjához rendel. Az alakzatot végigmozgatva a teljes vizsgált 
területen határozza meg a kiegyenlítő felület valamennyi pontját. 
A csúszó-átlagolás módszerével csak akkor jutunk kielégítő eredményhez, ha a terü-
leten nagy számú adatponttal rendelkezünk, egyéb esetekben a számított értékek egy 
igen torz felülethez vezetnek. 

12.3.4.4. A polinomiális regresszió 
A polinomiális regresszió (Polinomial regression) valójában nem egy interpolációs 
módszer, hanem inkább egy térgörbe illesztő eljárás. A használata során a felhaszná-
ló megadja a keresett térfüggvény rendűségét (első-rendű (sík), másod-, harmadren-
dű, illetve a felhasználó által megadott magasabb rendű felület), és a Surfer kiszámít-
ja a pontokra legjobban illeszthető, előre definiált rendű felületet.  
A polinomiális regressziót a gyakorlatban sík vagy négyzetes térfüggvények generá-
lására használhatjuk, pl. egy áramló talajvizű terület átlagos hidraulikus gradiensének 
meghatározására sík felület segítségével, vagy egy nyílt tükrű rendszerre telepített 
galéria körül kialakuló depresszióstér meghatározására négyzetes függvény segítsé-
gével. 

12.3.5. Az interpoláció során elkövetett gyakori hibák 
Az interpoláció elvégzése nem egyszerű probléma. Minden interpolációs algoritmus 
egy-egy elv alapján a legvalószínűbb térfelületet rajzolja meg, azonban az már a fel-
használó dolga, hogy eldöntse, az adott eredmény a modellezés céljából megfelel-e, 
azaz reálisan adja-e vissza a keresett paraméter-eloszlást. Ennek szemléltetésére azo-
nos adatrendszerből kiindulva 12-féle módon határoztuk meg a „legvalószínűbb” 
paraméter-eloszlást (75. ábra). Az ábrán jól látható, hogy eltérő módszerek teljesen 
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másképpen „értelmezik” a tér sajátosságait, ennek megfelelően az interpoláció, mint 
eszköz csak az eredmények értelmezése után fogadható el. 
Általánosságban elmondható, hogy a lineáris interpolációt csak sok és lehetőleg rep-
rezentatív módon elhelyezkedő adatpont léte esetén, illetve közel sík felületek köze-
lítése esetén érdemes alkalmazni. Ilyen lehet egy egyenletesen lejtő talajvízfelszín, 
vagy egy paraméter folytonos átmenete egyik értékből a másikba.  
Lineáris interpoláción alapulnak a digitális terepmodellek (DTM) is, azonban ott a 
pontokat speciális eljárásokkal választják úgy ki, hogy az azok alapján készített térfe-
lület a terep egyenetlenségeit jól tükrözze. A lineáris interpoláció esetén vigyázni 
kell az extrapoláció elkerülésére. A háromszögelésen alapuló Renka-módszert a line-
áris interpolációnál sokkal inkább érdemes alkalmazni, mert bár ez is a háromszöge-
lésen alapul, mégis jó az extrapolációs képessége. Ugyanez mondható el a kétválto-
zós Akima-módszerről is, mellyel közel azonos adatpont-sűrűség mellett, realiszti-
kus, sima térfelületeket kaphatunk. 
A súlyozott átlagszámítási módszerek esetében a bikaszem effektust  kiküszöbölő, 
módosított Shepard algoritmus javasolható, ugyanakkor pl. különálló koncentráció 
csúcsok megjelenítésénél a bikaszem effektus előnyösen használható ki. A távolság-
gal fordítottan arányos súlyozott átlagszámításon alapuló interpoláció főképpen ala-
csonyabb hatványkitevőkkel használható, magasabb hatványkitevők mellett itt is be-
következik az erős „bikaszemesedés”. 
A természetes szomszéd módszerrel nagyon „szép” és simított térfelületeket kapunk. 
Nagy előnye a módszernek, hogy olyan esetekben is jól működik, amikor nagyon 
egyenlőtlen az adatpontok térbeli eloszlása. Jelentős hátrány, hogy a módszerrel ext-
rapoláció elvileg sem lehetséges. 
A legközelebbi szomszéd módszert a gyakorlatban kevéssé használjuk a modellezés 
során sokkal egyszerűbb a zónák alkalmazása, ami azonos eredményhez vezet. 
A krigelés kiváló interpolációs eljárás, azonban a használata főképpen akkor indo-
kolt, ha megfelelő számú adatpont áll rendelkezésre és annak alapján a variogram 
megfelelően megrajzolható. A krigelésnél vigyázni kell arra, hogy a variogram reális 
legyen, mert a krigelés eredményét teljesen elrontja a nem megfelelő variogram 
használata. 
Polinomiális regressziót csak – a módszernél már bemutatott – igen speciális helyze-
tekben lehet alkalmazni. A csúszó-átlagoláshoz több ezer vagy tízezer, közel homo-
gén eloszlású adatra van szükség. A módszer különösképp akkor használható, ha az 
adatrendszerben vannak kiugró értékek, amelyek a többi algoritmus számítási ered-
ményeit túlságosan zavarják. 
Az interpolációt gyakran használjuk a rétegek geometriai viszonyainak megadásánál. 
A modellgeometria triviális felvételi módja a tengerszint vagy relatív magassági ér-
tékekkel a fúrási pontokban megadott alapadatrendszerből krigeléssel, súlyozott át-
lagszámítással, a minimális görbület módszerével vagy egyéb interpolációs algorit-
mussal meghatározni a modell rétegeit elválasztó térfelületet.  
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75. ábra 

Azonos adatrendszerből előállított térfelületek 
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Az interpoláció és szükség esetén extrapoláció során kapott felületek esetében azon-
ban igen gyakori, hogy – főképpen vékony rétegek esetén – az egymáshoz közel eső 
elválasztó felületek (réteghatárok) egymást a fúrási pontoktól távolabb eső területe-
ken metszik, ami elvi és egyben logikai hiba. 
Az említett hibákat elsősorban a minimális görbület módszerénél, ritkábban a súlyo-
zott átlagszámítás esetén észlelhetjük A minimális görbület módszer alkalmazása 
során, interpolációnál a legsimább felület illesztésének kényszere, extrapolációnál 
pedig  a szélső pontok meredekségének különbsége vezethet a felületek metszéséhez 
(76. ábra). A hibát folyamatos ellenőrzéssel lehet elkerülni: a két felület különbségét 
képezzük, majd a kapott vastagságtérképen ellenőrizzük, hogy a réteg vastagsága 
mindenütt pozitív-e.  
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76. ábra 

Jellegzetes interpolációs és extrapolációs hibák a minimális görbület módszerének 
alkalmazásánál 
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77. ábra 

Jellegzetes interpolációs és extrapolációs hibák  adathiányos területeken 
 
További interpolációs problémák forrása lehet az adathiány. Természetes, hogy a 
mélységgel egyre csökken az adatok mennyisége általános esetben, ezért a mélyeb-
ben található elválasztó-felületeket kevesebb ismert pont alapján kell meghatározni. 
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Az adathiány okozta interpolációs hibák szinte minden interpolációs módszernél elő-
fordulnak (77. ábra). 
Hasonlóan elvi hibás modellhez vezet egyes területeken negatív értékek számítása az 
interpolációnál. Jellemzően a minimális görbület módszere és a háromszögelésen 
alapuló módszerek vezetnek ilyen eredményekhez, ami pl. koncentrációk, szivárgási 
tényezők és szabad hézagtérfogat értékek esetében elvi hibás modellt és divergens 
számítási eredményeket okoznak. A súlyozott átlagszámításon alapuló módszerek az 
ilyen hibákra érzéketlenek, miközben a valós térfelületnél simább felületeket kapunk, 
amivel szintén jelentős hibákat követhetünk el (FILEP et al., 2002).  

12.4. Surfer alkalmazások 

A jelen fejezetben néhány, a mindennapi gyakorlatban előforduló lehetséges Surfer 
alkalmazást mutatunk be részben a Surfer szakmai feladatok során történő alkalmaz-
hatóságának bemutatására, részben a modellezési munkafolyamat egyszerűsítése ér-
dekében. A hazai gyakorlatban számos más feladat megoldására is használják (KO-
VÁCS és TAMÁS, 2002)  

12.4.1. Térfogatszámítás és alkalmazásai 

12.4.1.1. Hulladéktérfogat meghatározása (\app\hull könyvtár)  
A Surfer térfogatszámító rutinjainak számos környezetvédelmi alkalmazása lehet. 
Egy ilyen triviális alkalmazás lehet hulladékok, vagy például egy tározóban lerakott 
zagy térfogatának meghatározása. Jelen esetben legyen ismert néhány pontban (F1-
F20 fúrások: ADATOK.XLS) a zagy vastagsága, illetve a lerakó (tározó) körvonala 
(LERAKO.BLN). A tározó peremén a zagy vastagsága zérus, tételezzük fel, hogy az 
ismert pontok között a vastagság lineárisan változik. Készítsük el a zagytér hulladék-
vastagsági térképét lineáris interpolációval, majd határozzuk meg a lerakott anyag 
térfogatát, illetve a tározótér területét… 

1. Készítsük el az ADATOK1.XLS állományt, amiben az F1-F20 fúrások adata-
it, illetve a lerakó határvonalának töréspontjait (zagyvastagság=0) fűzzük 
egybe! A Surfer táblázatkezelő ablakába hívjuk be az ADATOK. XLS állo-
mányt (File → Open parancs), majd az utolsó adatot követő 22. sor B oszlo-
pára állva fűzzük hozzá a File → Import paranccsal a LERAKO.BLN állo-
mányt. Mivel a bln állomány egy zárt poligon, azért első és utolsó sora azo-
nos, így a hozzáfűzött rész első pontját, továbbá a bln állomány első sorát 
(azaz az új állomány 22. és 23. sorát) töröljük: kijelöljük a két említett sort, 
majd végrehajtjuk a Edit → Delete parancsot. Ekkor egy összesen 38 sorból 
álló adatrendszert kapunk, ahol a 22-38. sorokban találhatók a határvonal tö-
réspontjainak koordinátái. Ez utóbbi pontok mellé a rétegvastagságot a Data 
→ Transform paranccsal írhatjuk be: „Transform Equation: D=0”. A ka-
pott állományt elmentve az ADATOK1.XLS névre a számítás alapadat-
állományát kaptuk. 
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78. ábra 

A zagytérfogat-meghatározáshoz használt adatrendszer 
 

 
79. ábra 

A térfogatszámításhoz használt rácsháló adatai 
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2. Ezután képezzük a zagyvastagságot leíró felületet a Grid → Data paranccsal 
(79. ábra) úgy, hogy a felületet lineáris interpolációval határozzuk meg a te-
rületet lefedő 25x25 m osztású rácshálóra, az EOV Y= 548500-560775 és az 
EOV X=198800-207200 tartományra (ZAGYVAST.GRD, 80. ábra). 

3. A térfogat- és terület-meghatározáshoz használjuk a Grid → Volume paran-
csot (81. ábra). A 0 vastagság és a ZAGYVAST.GRD állományban számított 
vastagságok közötti „térfogatot” számítva a lerakott zagy mennyiségét kapjuk 
meg. A parancs segítségével számított felületeket, területeket és térfogatokat 
a ZAGYVAST.RTF állományba írjuk ki. 

Eredmények: A számított terület (Positive Planar Area) 86,34 km2, míg a lerakott 
zagy számított térfogata 230 millió m3. Nagyságrendileg ellenőrizzük, hogy helye-
sek-e a kapott értékek: A 230 millió m3 86,34 millió m2 területen átlagosan  2,6 m 
vastagságot jelent. A térképet megtekintve a 2,6 m-es átlagvastagság megfelelőnek 
látszik. 
Megjegyzés: A példában szereplő 86 km2 nagyságú területet a megadott 20 fúrási 
pont a gyakorlatban nem reprezentálja. A bemutatott térfogatszámítás csak akkor 
fogadható el a valóságban, ha a pontok által lineáris interpolációval meghatározott 
felület a valóságot jól tükrözi, azaz, ha a bemutatott vastagsági- térkép (80. ábra) 
megfelel a valóságnak. 

 

 
80. ábra 

A lineáris interpolációval szerkesztett zagyvastagsági térkép 
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81. ábra 

A zagytérfogat meghatározása Grid → Volume  paranccsal 
 

12.4.1.2. A kitermelhető statikus vízkészlet meghatározása (\app\stat könyvtár) 
A vízadó rétegben található kitermelhető statikus vízkészlet meghatározására a 
Surfer kiválóan alkalmazható. A gravitációsan kitermelhető statikus készlet a vízadó 
m rétegvastagságtól, illetve h telített vízoszlopmagasságától függő, telített térfogatá-
nak és a szabad hézagtérfogatnak a szorzata, azaz 

∫
∫

⋅⋅=

⋅⋅=

.

,

0

0

vízadóbantükrűnyíltdxdynhV

közegbentelítettdxdynmV

stat

stat
,    (12.12.) 

A problémát az jelenti, hogy mind a szabad hézagtérfogat, mind a rétegvastagság 
változhat a térben (TAMÁS et al., 2002).  
Példánkban legyen a területen 20 db feltárófúrás (F1-F20 jelűek), amiben a zárt tükrű 
vízadó m vastagsága és a képződmény n0 szabad hézagtérfogata fúrásonként ismert 
(82. ábra). Meghatározandó a képződményben egy 8x4 km-es területrészen (EOV 
X=201000-205000, EOV Y=551000-559000) belül található kitermelhető víztérfo-
gat. Esetünk annyiban szerencsés, hogy a fúrások által közbezárt térrész teljesen le-
fedi a vizsgált területet, ezért az interpolációs algoritmusok közül a természetes 
szomszéd módszer alkalmazható.  

1. Először határozzuk meg a rétegvastagság és a szabad hézagtérfogat térbeli el-
oszlását leíró térfelületet az ADATOK.XLS állományban található alapadat-
rendszer, 50 m osztású rácsháló és a természetes szomszéd módszerének se-
gítségével, a Grid → Data paranccsal (M_NATNEIGH.GRD és 
N0_NATNEIGH.GRD állományok, 83. ábra). 

2.  Számítsuk ki a rétegvastagság és a szabad hézagtérfogat szorzatát a Grid → 
Math paranccsal (84. ábra). A számított M_X_N0.GRD állományban „a 
szemcsék eltávolítása” után maradó vízoszlopmagasságok térbeli eloszlását 
kaptuk, ami a vizsgált területen integrálva adja a keresett térfogatot. 



86 

550000 552000 554000 556000 558000 560000
200000

202000

204000

206000

0.17

0.15

0.18

0.23

0.26

0.15

0.21

0.11

0.27

0.120.28

0.24

0.16

0.27

0.12

0.25

0.22

0.23

0.27

0.18

6.4

7.9

5.9

5.2

5.5

6.3

5.3

6.0

5.6

5.95.4

5.0

5.3

5.5

6.1

6.3

5.3

5.8

7.0

6.3

F1

F2

F3

F4

F5

F6

F7

F8

F9

F10F11

F12

F13

F14

F15

F16

F17

F18

F19

F20

 
82. ábra 

A mért rétegvastagság és szabad hézagtérfogat értékek a területen 
 

  
83. ábra 

A rétegvastagság és a szabad hézagtérfogat-eloszlás meghatározása 
  

3. Számítsuk ki a Grid → Volume paranccsal a z=0 és a M_X_N0.GRD állo-
mány által kijelölt felületek közötti térfogatot! A kapott térfogat adja a teljes 
víz mennyiséget. A jelentést a TÉRFOGAT_M_N0_VÁLTOZIK.RTF állo-
mányba mentettük! 
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84. ábra 

A statikus vízkészlet meghatározása „térfogat”-számítással 
 

Az eredmény: 3.526·107 m3. Próbáljuk meg ellenőrizni: A terület 32 km2. A területen 
7 m körüli a rétegvastagság, és a szabad hézagtérfogat átlagosan 0,15 nagyságú. En-
nek alapján m·n0 magasságú, azaz átlagosan 1,05 m vízoszlop szükséges a réteg fel-
töltéséhez. Ez 3.2·107 m2 területen 1,05 m vízoszloppal számolva 3,36·107 m3 vizet 
jelent, azaz az eredmény elfogadható. 
Jelentősen egyszerűsödik a helyzet, ha vagy a szabad hézagtérfogat, vagy a rétegvastag-
ság állandónak tekinthető. Ha a szabad hézagtérfogat állandónak tekinthető a területen, 
akkor egyszerűen számítjuk a 0 és a M_NATNEIGH.GRD állomány által leírt felület 
közötti „térfogatot” majd a kapott térfogatértéket szorozzuk a konstans szabad hézagtér-
fogat értékkel. Ha a rétegvastagság tekinthető állandónak, akkor hasonlóan eljárva, elő-
ször számítjuk a 0 és a N0_NATNEIGH.GRD állomány által leírt felület közötti „térfo-
gatot”, majd a kapott „térfogatértéket” szorozzuk a konstans rétegvastagsággal. 

12.4.1.3. Szennyezőanyag-mennyiség és egy területen mért átlagkoncentráció meg-
határozása (\app\szenny könyvtár) 

A környezetvédelmi vizsgálatok egyik alapvető feladata annak meghatározása, hogy 
egy adott környezetszennyezés esetén mekkora szennyezőanyag-mennyiség jutott a 
talajba vagy a talajvízbe. 
Esetünkben legyen ismert a nyílt tükrű talajvízadóban néhány fúrás adata alapján 
meghatározott szennyezőanyag-koncentráció. Az ismert koncentráció-adatok alapján 
szerkesszük meg a koncentráció-eloszlás térképét, illetve határozzuk meg a talajvíz-
be jutott szennyezőanyag mennyiségét a változó vastagságú vízadóban. A vízadóban 
a telített vízoszlop magasságokat ismerjük, melyek a vízadó feküjének lokális válto-
zásai miatt különbözőek, tekintettel arra, hogy a területen a potenciálfelület vízszin-
tesen síknak tekinthető. 

1. A kiindulási adatok az ADATOK.XLS állományban találhatók. Ismertek a fú-
rási pontok koordinátái, továbbá a feküszintek tereptől számított mélysége. 
Mivel a talajvíz a mérések szerint a terep alatt 1.2 m-re található, a fekü és a 
talajvízszint különbségeként megkaptuk a talajvízadóban a telített vízoszlop 
magasságát. 
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2. Az akkreditált laboratóriumban meghatározták a 20 db vízminta benzoltartal-
mát µg/l mértékegységben. Az alkalmazott mérési eljárás és mérőeszköz ese-
tén a kimutathatósági határ 0,1  µg/l volt. A vízminták közül 8 esetben a ben-
zoltartalom a kimutathatósági határ alatt volt. Mivel a benzolmennyiség meg-
határozásához térfelület szerkesztését kell elvégeznünk, melyhez minél több 
adatra van szükség, ezért tételezzük fel, hogy a kimutathatósági határérték 
alatti minőségű vizekben a koncentráció a határérték fele, azaz 0,05 µg/l volt, 
amit az ADATOK.XLS állomány külön oszlopába írjunk be. 

3. Határozzuk meg a koncentráció-eloszlást és a telített vízoszlop-magasság 
izovonalas térképét a természetes szomszéd módszerrel, elkészítve a területre 
a grid állományt a Grid → Data paranccsal (85. ábra) a területet lefedő 5x5 m 
osztású rácshálóra, az EOV Y= 550000-550500 és az EOV X=200000-
200300 tartományra (BENZKONC.GRD és TELVAST.GRD,86. ábra). 
A szennyezőanyag M tömegét a következőképpen számíthatjuk: 

∫ ⋅⋅⋅= dxdynhcM 00 ,       (12.13.) 

ahol c a koncentráció, h0 a telített vízoszlop magassága és n0 a szabad hézag-
térfogat. 

4. A megoldáshoz képezzük a két eloszlás szorzatát, és szorozzuk be a területen 
állandónak tekinthető szabad hézagtérfogattal (n0=0,15) a Grid → Math pa-
rancs segítségével (87. ábra). A kapott állomány neve legyen 
BENZMENNY.GRD. 

5. Számítsuk ki a Grid → Volume paranccsal a z=0 és a BENZMENNY.GRD 
állomány által kijelölt felületek közötti térfogatot! A kapott térfogat adja a ta-
lajvízben található teljes benzol mennyiségét µg/l · m3, azaz mg/m3 · m3 vagyis 
mg mértékegységben. A jelentést a BENZOLMENNYISÉG_TALAJVIZ-
BEN.RTF állományba mentettük! 

  
85. ábra 

A benzol-koncentrációk és a telített vízoszlop magasság eloszlásának számítása 
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86. ábra 

A benzolkoncentráció ([µg/l], szaggatott vonal) és a telített vízoszlopmagasság ([m], 
folytonos vonal) izovonalas térképei 

 

 
87. ábra 

A benzolmennyiségre jellemző „felület” számítása 
 

Eredmények: A számítás szerint a teljes „térfogat” 2060000 egységnyi, azaz a szeny-
nyezőanyag mennyisége 2060000 mg, vagyis 2060 kg. Feltételezve, hogy a benzol 
sűrűsége 880 kg/m3, a talajvízbe jutott benzolmennyiség 2340 liter. 
Határozzuk meg a területen az átlagos benzolkoncentrációt. Ehhez tudnunk kell a 
terület nagyságát, illetve az ott található benzol mennyiségét. 
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F

dxdyhc
c ∫ ⋅⋅
=

0 ,        (12.14.) 

ahol c az átlagkoncentráció és F a vizsgált terület nagysága. 
A képletben a számlálóban szereplő tagot számítani tudjuk a Grid → Volume pa-
ranccsal (88. ábra) a z=0 és a BENZKONC.GRD állomány által kijelölt felületek 
között térfogatként, és a nevezőben található területet is megkapjuk a számítás során 
(Positive Planar Area). Végezzük el a számítást és mentsük a jelentést a 
ÁTLAGBENZOLKONC_TALAJVIZBEN.RTF állományba! 
Eredmények: A „térfogat”: 4,81·106 mg/m3 · m2, a felület 118900 m2, ami alapján az 
átlagos koncentráció a teljes vizsgált területen (a szélső fúrási pontok által határolt 
területen belül) 40,4 mg/m3 = 40,4 µg/l. Ez utóbbi már vizuális becsléssel ellenőriz-
hető: a térképre tekintve a 40 µg/l átlagos benzolkoncentráció elfogadhatónak tűnik. 

 
88. ábra 

„Térfogatszámítás” átlag-koncentrációk számításához 

12.4.1.4. Szennyezett terület nagyságának meghatározása (\app\szenny könyvtár) 
A térfogat- és felületszámító algoritmus alkalmas egy adott koncentrációnál szeny-
nyezettebb területrész nagyságának meghatározására is. Kiindulva az előző fejezet-
ben meghatározott benzolkoncentráció-eloszlásból, határozzuk meg, hogy mekkora 
területrészen magasabb a koncentráció 25, 50, 100, 150 és 200 µg/l-nél. 
A térfogatszámítás során nemcsak térfogatokat, hanem felületeket is számít a program. 
A felületek lehetnek a térfelület mentén mértek, vagy azok síkvetületei (12.2.8. feje-
zet). A rendszer pozitív síkvetületnek (Positive Planar Area) hívja azt a területrészt, 
ahol a két megadott felület közül az előbb definiált van magasabban (két koncentráció-
eloszlás esetén, ahol nagyobb a koncentráció) és negatívnak, ahol fordítva. A 
BENZKONC.GRD állomány által leírt koncentráció-eloszlásokat vessük hát össze a 
c(z)=25, 50, 100, 150 és 200 vízszintes síkfelületekkel a Grid → Volume parancsot 
használva. A kapott jelentéseket mentsük el a BENZOLKONC_XXXFELETT.RTF 
állományba, ahol XXX a viszonyítási koncentrációk értéke. 
A kapott értékeket (89. ábra)  az alábbi táblázat foglalja össze: 
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12.2. táblázat 

Szennyezett területek számítása 
Koncentráció 

[µg/l] 
Terület, ahol ennél magasabb 

[m2] 
Terület, ahol ennél alacsonyabb 

[m2] 
25 55160 63780 
50 35050 83890 
100 15400 103540 
150 5055 113885 
200 700 118240 
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89. ábra 

Adott koncentrációt meghaladó mértékben szennyezett terület változása 
 

12.4.2. Surfer DXF alaptérkép gyártása Processing MODFLOWban történő al-
kalmazáshoz (\app\dxfgyartas) 

A modellezés során alapvető térképi elemek átvitele a Processing MODFLOW kör-
nyezetbe elengedhetetlen. Lehetőség van fontosabb tájékozódási pontok (utak, tele-
pülések, tavak, stb.) átvitelére, de szükség lehet fúrási pontok vagy kútadatok megje-
lenítésére is. A megjelenítésre alapvetően DXF állományokat javaslunk alkalmazni, 
mert ezeket sok program ismeri, így a kétirányú adatátvitel (PMbe és PMből) általá-
ban egyszerűen biztosítható. 
A DXF állományok megjelenítését az I. kötet 8.4. fejezetében a Munkakörnyezet 
beállítása cím alatt tárgyaltuk. Ebben a fejezetben azt mutatjuk be, hogy hogyan lehet 
olyan DXF állományokat a Surfer segítségével előállítani, melyeket azután a 
Processing MODFLOW fogadni tud. 
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Legyen a példánkban két épület, mely köré 6 db mentesítőkutat terveznek telepíteni 
(ADATOK.XLS, 90. ábra). Az A jelű épület bonyolult szerkezetű, összesen 14 sarok-
kal rendelkezik, a B jelű épület egy hagyományos csarnoképület 4 db sarokponttal.  

 
90. ábra 

A vizsgált térség vázlata 
 
Először az adatállományból állítsunk elő olyan vonalrajz állományt, amivel az épüle-
tek körvonalai megrajzolhatók. Használjuk a Golden Software BLN formátumát. A 
BLN formátum tartalmazza a poligonok töréspontjainak számát, majd a töréspontok 
koordinátapárjait. Tekintettel arra, hogy zárt alakzatokról van szó, ezért a törésvona-
lak első és utolsó pontjának meg kell egyezniük, ezáltal a két épület vonalrajza 15, 
illetve 5 töréspontból áll majd. 

1. A szerkesztést legegyszerűbben a Surferben végezhetjük el, megnyitva az 
alapadat.xls állományt, majd törölve az első nyolc, a fejléceket és kútadatokat 
tartalmazó sort (sorok kijelölése, majd Edit → Delete parancs). 

2. Töröljük az A és D oszlopokat is, melyek a pontok jeleit és a megnevezéseket 
tartalmazzák (oszlopok kijelölése és Edit → Delete parancs)! 

3. A 15. sort jelöljük ki, és szúrjunk be a meglévő üres sor mellé még egyet (sor 
kijelölése és Edit → Insert parancs)! 

4. Állítsunk elő olyan pontsorokat, ahol az első és az utolsó koordinátapár azo-
nos! Ehhez a 15. sorba másoljuk át a második sorban található koordinátákat, 
és ugyanezt tegyük a 18. sorban található koordinátákkal is, amiket a 22. sor-
ba másolunk (Másolás: a koordináták kijelölése, majd Edit → Copy parancs, 
azután a célcellák kijelölése és Edit → Paste parancs). 
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5. Írjuk be a koordinátapárok darabszámát! Az A1 mezőbe 15-öt, az A17 mező-
be 5-öt írjunk. 

6. Mentsük el a kész BLN állományt EPULETEK.BLN néven (File → Save 
As). A figyelmeztető ablakot, miszerint a BLN állományba történő mentéssel 
a formátum beállítások (pl. betűtípus, betűméret, stb.) elvesznek, hagyjuk fi-
gyelmen kívül (OK gomb megnyomása). 

Rajzoljuk ezután meg a már korábban bemutatott térképet (90. ábra)! 
7. Nyissunk egy új rajzablakot: File → New → Plot document ! 
8. Rajzoljuk meg az épületek határvonalait: Map → Base map…, ahol hívjuk 

be az EPULETEK.BLN állományt. A Blanking Options figyelmeztető abla-
kot hagyjuk figyelmen kívül (OK gomb megnyomása). 

9. Rajzoljuk meg az adatpontok térképét: Map → Post map… → New post 
map…, az ADATOK.XLS állomány felhasználásával (91. ábra). Az adatpont 
térkép tulajdonságainál állítsuk be, hogy az X koordináták a B, az Y koordiná-
ták a C, a feliratok az A jelű oszlopban vannak. A tulajdonságok megjeleníté-
séhez a képernyő bal oldali részén jelöljük ki a Post nevű objektumot, majd 
kettős klikkeléssel nyissuk meg a tulajdonság-ablakot. 

  
91. ábra 

Az adatpont-térképek tulajdonságai 
 

10.  Állítsuk be a térkép határait a 92. ábra szerint! 
11. Fektessük egymásra a két fedvényt, amihez először jelöljük ki mindkét objek-

tumot (Edit → Select All), majd egyesítsük azokat (Map → Overlay Maps)! 
12. A térképre írjuk fel az épületek nevét! Draw → Text parancs hatására a kur-

zor alakja megváltozik és a térképen a szöveg helyére klikkelve, egy dialó-
gusablakban adhatjuk meg a szöveget és tulajdonságait. Írjuk be, hogy „A jelű 
épület” és „B jelű épület” a megfelelő helyekre! 
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92. ábra 

A térkép határainak beállítása 
 
A térképet próbáljuk meg DXF formátumba exportálni. Ehhez a következőket jó 
tudni: 

– A Processing MODFLOW csak AutoCAD 13 verzió előtti DXF formátumo-
kat és kizárólag ASCII szöveg-alakban képes importálni! 

– A DXF állományt célszerű minél kisebbre készíteni, mert azt minden képer-
nyőváltáskor a modellező program beolvassa, amikor kirajzolja. Ha túl nagy a 
DXF állomány, akkor a rajzolásra akár 20-30 másodpercet is várni kell, ami 
nagyon lelassítja a munkát. A DXF állomány a vonalakat kevés információ 
segítségével tárolja, azonban a betűket, főképpen, ha azok speciális fontokkal, 
pl. árnyékolt vagy speciálisan kitöltött betűkkel készültek, apró vonalak ezrei-
vel készíti el, ami igen helyigényes. Sokszor a betűk felületének kitöltését is 
sűrűn egymás mellé írt vonalakkal oldja meg, ami kevés információ esetén is 
hatalmas állományokat eredményez. Ennek érdekében mindig használjunk 
egyszerű, vonalszerű fontokat, pl. Arial vagy a Surfer GS típusú fontjai. 

– Amennyiben mégis nagy DXF állománnyal dolgozunk, két lehetőségünk van: 
vagy megszakítjuk a DXF kirajzolását egy ESC gomb lenyomásával (a rajzo-
lás közben a PMWin a képernyő bal alsó részén felirattal közli a megszakítás 
lehetőségét) vagy az Options → Maps parancsnál minden olyan esetben, 
amikor felesleges a vonalrajz, kikapcsoljuk a láthatóságot. 

– A DXF önmagában nem kezeli tökéletesen a magyar ékezetes betűket. A 
program a nem ismert betűk helyét kihagyja. Ilyen esetben van lehetőség arra, 
hogy a betűket egyesével, kitöltött poligononként rajzoljuk meg.  

– A DXF állományba kizárólag a SURFERben helyhez rendelt objektumokat 
célszerű átvinni… A példánkban a térképi fedvények EOV koordinátákhoz 
kötöttek, míg a két felirat a lapi koordináta-rendszerhez kötött (a gép azt „tud-
ja”, hogy a felirat a bal alsó saroktól jobbra és felfelé mekkora távolságban 
van!). Az ilyen vegyes állományokat a Surfer automatikusan lapkoordináták-
ban írja ki DXF formátumba, azaz ekkor az EOV koordináták elvesznek! Ezt 
el kell kerülni úgy, hogy csak a térképi fedvényeket kell exportálni a DXF ál-
lományba, ezzel a feliratok elvesznek… Ha szükségesek a feliratok, akkor 
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azokat EOV koordináta rendszerhez illesztve, jelölőszimbólum nélküli adat-
pont (Post)-térképpel lehet megvalósítani, amit már át lehet vinni az EOV he-
lyes DXF állományba. 

Ezután készítsük el a DXF állományt!  
13. Először tegyük láthatatlanná a tengelyeket, ezáltal a felesleges számokat és 

vonalakat nem rajzoltatjuk ki, ezzel csökkentve az állomány méretét. Ehhez 
az objektumoknál a négy tengely (Right, Left, Top és Bottom Axis) melletti 
pipát klikkeléssel töröljük ki! 

14. Jelöljük ki a térkép (Map) objektumot a képernyő bal oldalán egy klikkeléssel 
úgy, hogy a két szöveg (Text) objektum ne legyen kijelölve! 

15. Válasszuk a File → Export parancsot! A File típusa legördülő menüben vá-
lasszuk az AutoCAD DXF (*.dxf) formátumot és adjunk nevet az állomány-
nak (DXFTERKEP.DXF). Adjuk meg, hogy a kiválasztott térképi objektu-
mot a fedvényeivel együtt szeretnénk exportálni (Selected objects only mező 
kipipálása). Ezzel biztosítjuk, hogy az EOV koordináta-rendszerben történjék 
a file kiírása. 

16. Ezután megjelenik az AutoCAD DXF Export dialógusablak (93. ábra), ami-
nél a következőkre érdemes figyelni. A Page Rectangle mező sorolja fel a 
program az exportálandó objektumok határait „lapi koordinátákban”. A DXF 
Rectangle mezőben ugyanezen határok exportált koordinátái szerepelnek, 
ahol az EOV koordinátákat kell látnunk! Ha nem így van, akkor nem jelöltük 
ki a térképi objektumot vagy nem állítottuk be a Selected objects only mezőt. 
Ekkor a kétszer négy szám azonossá válik (94. ábra): az így kapott állományt 
DXFTERKEP_ROSSZ.DXF néven mentettük el tanulságképpen. A Scaling 
Source mezőt Application-ra, a formátumot ASCII-ra, a File Compatibility 
mezőt AutoCAD DXF 13 (or earlier)-re kell állítani a korábban említettek 
miatt. Magyar ékezetes betűk esetén célszerű az All text as areas mezőt kipi-
pálni, ezáltal a betűket poligonokkal kirajzoltatni. Sok szöveg esetén ez meg-
gondolandó. Mivel a PMWin mindent azonos típusú vonallal rajzol ki ezért a 
többi mező beállításának itt nincs jelentősége. 

17. Az elkészített DXF állomány ezután behívható a PMWin rendszerbe az edi-
tor-ablakban az Options → Maps paranccsal. 

12.4.3.  DXF és DWG állományok konvertálása Processing MODFLOWban törté-
nő alkalmazáshoz  

Az AUTOCAD DXF formátum folyamatosan fejlődik, újabb és újabb képességekkel 
ruházzák fel, azonban ezek az újabb képességek a különböző verziószámú progra-
mok inkompatibilitását eredményezték. Ennek megfelelően, ha egy DXF állomány 
nem jelenik meg a modellező környezetben, annak több oka lehet, melyek közül ér-
demes kipróbálni azt is, hogy az állományt egy korábbi AUTOCAD DXF formátum-
ba konvertáljuk, majd újra megkíséreljük az állományt behívni a modellező rend-
szerbe.  
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93. ábra 

AutoCAD DXF állomány exportálása 
 

 
94. ábra 

Rosszul (EOV koordináta-vesztéssel) exportált DXF állomány 
 

Tegyük ezt akkor is, ha a szoftver nem küldött hibaüzenetet, azaz szabályosan beol-
vasta az állományt, de mégsem jelenítette meg azt. 
Ha nem jelenik meg a képernyőn az állomány, akkor a legvalószínűbb hiba az, hogy 
a DXF állomány által kirajzolt tartomány és a képernyőn a modellben ábrázolt terü-
letrész nincs egymással fedésben. A hiba lehet triviális pl. az egyik esetben az X ten-
gelyre került az EOV X koordináta, a másikban pedig az Y tengelyre, de lehet beállí-
tási probléma is (a Grid Editor ablakban Options → Environment parancs 
Coordinate System lap).  
Az ellenőrzéshez a DXF állomány által lefedett koordináta tartományt a legegysze-
rűbben a Surferbe való beolvasással lehet megnézni. A beolvasást követően a ten-
gelyfeliratok mutatják a DXF állományban tárolt koordináták nagyságát. Amennyi-
ben a DXF állományon ábrázolt térrész legalább részben átfedésben van a Grid Edi-
tor ablakban Options → Environment parancs Coordinate System lapján az X1, 
Y1, X2, Y2 koordinátákkal lefedett térrésszel, akkor a beállítások jók, azaz a hiba 
nem itt keresendő. Ebben az esetben nagyon valószínű, hogy a DXF állomány olyan 
bejegyzéseket (Entites) tartalmaz, amit a szoftver nem tud értelmezni, ekkor a meg-
felelő formátumúra kell alakítani (konvertálni kell) a DXF állományt.  
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12.4.3.1. Konvertálás Surferrel DXF-ről DXF-re 
A konvertálás legegyszerűbb módja, ha beolvassuk az állományt a Surferbe a Map 
→ Base Map paranccsal, majd az előző fejezetben bemutatott módon – a most már 
megfelelő formátumú állományt – egy másik nevű állományba exportáljuk. Az új 
állományt, ha jól csináltunk mindent, a Processing MODFLOW olvasni és értelmez-
ni fogja. 

12.4.3.2. Konvertálás DWG Converter programmal AutoCAD DXF és DWG formá-
tumokról a Processing MODFLOW által értelmezhető DXF-formátumba 

A szoftverpiacon számos DWG-DXF konverter program található. Mi egy olyan 
freeware programot ajánlunk használni, melynek használata igen egyszerű, mond-
hatni triviális. A program ingyenesen használható, de ennek ellenére nagy tudású. A 
DWG Converter nevű programok közül azt kell letölteni, aminek alkotója EDWIN 
GIEZEMAN (2000), és ami a leírás szerint „Michael John Smyth of The Drafting 
Shop” ötletén alapul. A program egy 1 MB alatti ZIP tömörítésű állományban 
(CONVERT.ZIP) tölthető le több szerveroldalról (saját honlapja nincs!). Célszerű a 
DXF, DWG, convert szavakra és az alkotó nevére keresni és előbb-utóbb megtalál-
juk a keresett állományt a világhálón. 
A program telepítő nélkül indul (CONVERT.EXE) és a 95. ábra szerinti ablakkal 
dolgozik.  

 
95. ábra 

A Dwg Converter program 
 
A program futtatásához a File List mezőben meg kell adni a konvertálandó állomá-
nyokat, melyek szinte valamennyi mostani és korábbi AutoCAD programmal ké-
szülhettek. Az állományokat az Add gombbal a listára felvenni, a Remove gombbal 
eltávolítani lehet. Az Output Setting mezőben kell kiválasztani a készítendő állo-
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mány formátumát: általában az AutoCAD release 9, 11 vagy 12 formátumokat szok-
tuk használni. A Destination Folder mezőben állítandó be az a könyvtár, ahova a 
készített állományokat a program elmenti, ezt megváltoztatni a Change Destination 
gombbal lehet. A Convert gombbal megtörténik a kijelölt állományok konverziója a 
megadott formátumra. A Cancel és Close gombokkal megszakíthatjuk a futást és 
bezárhatjuk a programot. 
A Dwg Converter egy remek program, de sajnos egyelőre a frissítése nem készült el, 
ezért a legújabb AutoCAD állományokkal nem tud megbírkózni. Az AutoCAD 
2004-2006 verziók konvertálására a szintén ingyenes A9Converter program haszná-
latát ajánljuk. A programot a www.a9tech.com honlapról is letölthetjük, de megtalál-
ható letöltőszervereken is. A működése egyszerű, a DWG/DXF Input File List me-
zőbe egérrel „áthúzzuk” a konvertálandó állományokat, majd megadjuk a kimeneti 
formátumot (Output File Format: DWG vagy DXF), és a mentett állomány prog-
ramverzióját (Output File Version). A Convert gomb megnyomására elkészülnek a 
megadott állományok. 

 
96. ábra 

AutoCAD állományok konvertálása az A9Converter programmal 

12.4.4.  DXF állományokban tárolt xyz koordináták kinyerése 
A DXF állományok Surferben történő használatának hasznos segédeszköze a 
DXF2XYZ nevű freeware program, amit a GUTHRIE CAD/GIS LTD. nevű ausztrál 
cég fejleszt, és letölthető a http://www.guthcad.com.au honlapról. A program telepí-
tése a SETUPDZ.EXE állomány futtatásával történik. 
A program képes DXF állományokból a töréspontok koordinátáinak visszafejtésére, 
amennyiben ezek mellett a z irányú koordináta is tárolt, akkor azok kigyűjtésére és a 
DXF állományok Golden Software BLN formátumba történő elmentésére is. 
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97. ábra 

A DXF2XYZ program nyitóablaka 
 
A program felépítése itt is egyszerű (97. ábra): A konvertálandó DWG vagy DXF 
állományt az ablak bal felső részében a Windows konvencióknak megfelelően kell 
kiválasztani. A Filters mezőben található gombok ötletes használatával a rajzolandó 
állomány méretét radikálisan lehet csökkenteni. A fájl felépítését ismerve lehetőség 
van az AutoCAD egyes objektumcsoportjainak (Entities), fedvényeinek (Layers), 
illetve rajzoló tollainak (Pens) kikapcsolására, vagy egyes részterületek (Region) 
kiválasztására (98. ábra). Ez utóbbi alkalmas egy nagy területet lefedő rajzból egy a 
modellnek megfelelő kisebb, ezért méretben is kisebb állományba való rajzolásához. 
Az Output Format gomb a kimeneti formátum megadására alkalmas (98. ábra). 
A Raw formátum egyszerűen kiírja a megtalált térbeli pontok xyz koordinátáit vesz-
szőkkel elválasztva. Az ID XY(Z) formátumnál az egyes elemek koordinátái elé a 
programban tárolt azonosítójuk is kiírásra kerül. A Blanking (Surfer .BLN) opció-
val a konvertálás az említett formátumra történik. A kiíratás a Decimal Places mező-
ben megadott számú tizedesjegyekkel történhet. Ha a 2D (ignore Z values) mezőt 
bejelöljük, akkor a program csak az XY koordinátákat írja ki.  
A konvertálás a Save XXXXXXX.EXT gombbal vagy a Save As gombbal történik, 
ez utóbbi esetén az állomány nevét  a felhasználó adhatja meg. 

12.4.5. Térképi adatok átvitele a Processing MODFLOWba (\app\srf2pm5 könyvtár) 
A munkánk során sokszor találkozhatunk azzal, hogy egy kész paraméter-eloszlás 
adatait kell (vagy sokszor lenne célszerű) a Processing MODFLOW modellben hasz-
nálnunk. Ilyen helyzet áll elő például, ha Surferrel elkészítettük  
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98. ábra 

A DXF2XYZ kimeneti formátumának és a kivágatának megadása 
 

– a rétegek fedő és feküszintvonalas térképeit, 
– a horizontális és vertikális szivárgási tényező-térképeket vagy a szabad hézag-

térfogat-eloszlás térképét, 
– a beszivárgás területi eloszlását jellemző térképeket, 
– a folyók vízszintjeinek térképét, 
– a szennyező komponensek adott időpontban jellemző koncentráció térképét, 
– stb.. 

és ezeket a paraméter-eloszlásokat kívánjuk a modellszámítások során használni. 
Az említett a térképeket több céllal szerkesztjük meg: egyrészt ezek a térképek tá-
mogatják a modellszámításokat, a megelőző munkák során (pl. egy környezeti álla-
potfelmérés folyamán) a döntéseinket, másrészt felhasználhatjuk azokat a készülő 
modell dokumentálásához, ezáltal a modell adatrendszer bemutatásához is. 
Sajnos a Surfer és a MODFLOW kompatibilitása az eltérő felhasználói célok miatt 
korlátozott, ezért egy a gyakorlatban bevált eljárást a térképek PM rendszerbe történő 
átvitelére a következőkben mutatunk be. 
Adott egy szennyezett terület, ahol a szennyezőanyag koncentrációját fúrásos víz-
mintavételezéssel és akkreditált laboratóriumban történt kémiai elemzéssel tárták fel, 
majd ebből megszerkesztették Surferrel a koncentráció eloszlás térképét (99. ábra). A 
munka során kihasználták a Surfer sokoldalú interpolációs és térfelület szerkesztő 
sajátságait, ugyanakkor a Surfer korlátainak megfelelően egy ÉD-KNy oldalúan tá-
jolt térrészre, oldalanként egyenközű rácsháló segítségével rajzolták meg a koncent-
ráció térképeket.  
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99. ábra 

A szennyező-komponens koncentráció-eloszlása [µg/l] 
 
A Processing MODFLOW környezetben készült modell ezzel szemben egy általános 
(nem ÉD-i) tájolású térrészt ábrázol, ráadásul a rácsháló a távlati tervek szerint vál-
tozó elemeloszlású lesz. A munka első fázisában a jelenlegi koncentráció-eloszlás 
természetes tovaterjedését még egy egyenközű rácshálóval vizsgáljuk, azonban a 
feltételezhetően szükségessé váló víztermeléshez kötött kármentesítés hatásának mo-
dellezését a tervezett kutak és szivárgók környezetében történő sűrítéssel előállított 
rácshálós modellel kívánjuk a későbbiekben vizsgálni.  
Itt jegyezzük meg, hogy a PMWin környezet elvben képes ASCII GRD állományo-
kat a Surferből importálni, azonban a program nem vizsgálja sem a terület orientá-
cióját, sem a rácsháló osztását. A beolvasás során egyszerűen az első (egyben alsó) 
sor bal oldali rácspontjára Surferrel számított értéket hozzárendeli az 1,1 koordinátá-
jú cellához, a második értéket az 1,2 koordinátájúhoz és így tovább. Ennek hatására a 
modellben sokszor X tengelyre tükrözötten és irányban változóan torzítottan jelenik 
meg a paraméter eloszlása. A tükörkép megjelenésének az az oka, hogy a Surfer 1,1 
koordinátájú rácshálópontja a bal alsó sarokban, a PMWin első cellája a bal felső 
sarokban található. A PM GRD beolvasó rutinját változtatták, egyes verziók esetén 
fellép az X tengelyre történő tükrözés, máshol nem.  
Amennyiben a GRD állomány beolvasásának csak a tükrözés volna az akadálya, ak-
kor azt megtehetjük a Surferben a Grid →Transform paranccsal, ahol a tükrözendő 
állomány nevének beadása után a dialógusablakban az Operation mezőben válasszuk 
a Mirror X (X tengelyre való tükrözés) opciót (100. ábra). 
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100. ábra 

A gridállomány tükrözése Surferrel 
 
A Surfer ASCII GRD beolvasását csak abban az esetben szabad elvégezni, ha a mo-
dell É-D i tájolású és olyan egyenközű rácshálóval készített, amelynek középpontjára 
esik a Surfer Grid rácsvonala. 
Visszatérve az alapfeladathoz végezzük el a koncentrációtérkép adatainak a PM kör-
nyezetbe való átvitelét: Az adatátvitel X, Y, Z adatpontok átvitelén alapul, azonban a 
Surfer grid állomány rengeteg, a modellezett területen kívül található adatpontot is 
tartalmazhat. Ennek érdekében először kiválasztjuk és kitöröljük a grid állomány 
modellezett térrészen kívüli pontjait, majd csak a modellezett területen belül találha-
tó pontokat exportáljuk további felhasználásra. 

1. Nyissuk meg az \APP\SRF2PM5\PM\M1.PM5 modellt! 
2. Az általánosan tájolt modell határát általában pontosan nem tudjuk, ilyenkor 

célszerű a PM Tools → Digitizer parancsával meghatározni a sarokpontok 
koordinátáit. Itt a digitalizáló gomb ( ) megnyomása után a modell négy 
sarkára – tetszőleges irányban körbejárva a területet – kattintva digitalizáljuk 
a sarokpontokat (101. ábra). A koordinátákat a Value → Points → Save As 
paranccsal mentsük ki MODELLSAROK.XYZ néven. 

3. Nyissuk meg a Surferben a készített XYZ kiterjesztésű fájlt a File → Open 
paranccsal úgy, hogy a Fájltípus mezőben az összes állományt lássuk (All 
Files (*.*), 102. ábra).  

4. A sarokpontokat tartalmazó adatállományból készítsük el a 
HATARONTULTOROL.BLN állományt úgy, hogy az adatsort zárt poligonná 
alakítjuk azzal, hogy a második sorban található koordinátákat a 6. sorba má-
soljuk át (kijelölés egérrel, Edit → Copy, A6 mezőre lépés az egérrel, Edit 
→ Paste). Ezután az adatok számát négyről ötre módosítsuk, illetve az B1 
mezőbe írjunk 0-t, amivel azt jelezzük, hogy a poligonon kívül töröljük az ér-
tékeket. Végül töröljük a C oszlopot (kijelöljük egérrel és delete gomb), majd 
a kész állományt a korábban említett HATARONTULTOROL.BLN névre 
mentjük a File → Save As paranccsal. 

5. File → Close paranccsal zárjuk be a kész BLN állományt tartalmazó ablakot! 
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101. ábra 

A modell sarokponti koordinátáinak meghatározása a Digitizer paranccsal 
 
 

  
 

 
102. ábra 

A MODELLSAROK.XYZ állomány megnyitása a Surferben 
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6. Töröljük a koncentráció-értékeket tartalmazó állományból a modellen kívül 
található értékeket! Válasszuk a Grid → Blank parancsot, majd törlendő ál-
lományként nevezzük meg a korábbi koncentráció-térkép alapját képző 
KONC_TERKEP.GRD állományt. A törléshez használjuk a HATARONTUL-
TOROL.BLN állományt és a készülő új gridet nevezzük KONC_TERKEP–
_BLN.GRD-nek. 

7. Alakítsuk át a kapott, törölt GRD állományt ASCII XYZ adatformátumúvá a 
Grid → Convert paranccsal! A bemeneti állomány KONC_TERKEP–
_BLN.GRD legyen, a készített állomány pedig KONC_TERKEP–_BLN.DAT 
(ne feledkezzünk meg kiválasztani a Fájl típusa mezőben az ASCII XYZ 
(*.DAT) formátumot!, 103. ábra). Ezt a lépést ki lehet kerülni azzal, ha az 
előző lépésnél a kimeneti állomány formátumát ASCII XYZ (*.DAT)-ra 
változtatjuk! Ekkor a köztes GRD állomány nem készül el. 

8. Nyissuk meg a készített adatállományt (File → Open), majd töröljük tényle-
gesen is az adatpontokat. Erre azért van szükség, mert a grid állományból tör-
ténő törlés nem tényleges törlés, hanem a törölt pontok átírása az ábrázolható 
legnagyobb értékre (12.2.8. fejezet)! A tényleges törléshez előbb jelöljük ki a 
teljes adatállományt az A oszlopfelirattól balra, az 1 sorszám felett levő üres 
mező (gomb) megnyomásával, ekkor a mezők fekete alapszínűvé válnak. Ez-
után válasszuk a Data → Sort parancsot, amivel rendezzük sorba a C oszlop 
szerint csökkenő sorba az adatokat (Sort First By: Coloumn C és 
Descending, 104. ábra). Jelöljük ki egérrel az első kb. 10530 sort, ahol az ada-
tok C oszlopában az 1.701e+38 értéket látjuk (Grid → Blank paranccsal „tö-
rölt” pontok!), majd az Edit → Delete paranccsal töröljük azokat (Shift Cells 
Up opcióval). Ne használjuk a delete gombot a klaviatúrán! A megmaradt kb. 
54400 pont a modellezett területen található. 

 

 
103. ábra 

A grid állomány konvertálása 
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104. ábra 

Adatok sorbarendezése Data → Sort paranccsal 
 
A maradék pontok között azonban lehetnek, és általában vannak is hibás értékek. Az 
adott állományban például érdemes negatív számokat keresni, mert a megfelelő leha-
tárolás érdekében célszerű olyan interpolátor megoldást alkalmazni, amelyik 0 
izovonal rajzolására is képes, azaz ahol lehetségesek negatív értékek, miközben ne-
gatív koncentrációk a valóságban nem lehetségesek.  
A C oszlop szerint sorba rendezett állományban látható, hogy a több, mint 54000 
értékből alig több, mint 2400 darab pozitív. Ezek az értékek esnek a szennyezett te-
rületre a többi érték pedig a szennyezetlen területrészeket írja le.  

9. Ezek után cseréljük le a negatív értékeket zérusra. Jelöljük ki az egyik oszlo-
pot, majd hajtsuk végre a Data → Transform parancsot. Ellenőrizzük, hogy a 
kezdő és zárósor értéke megfelel az adatállománynak, majd a Transform 
Equation mezőbe írjuk be a logikai függvényt: D=IF(C<0, 0, C), ami annyit 
jelent, hogyha a C oszlop értéke kisebb, mint 0, akkor a D oszlopba 0-át ír, ha 
nem, akkor a C oszlopbeli értéket. A D oszlopba ezek után a negatív értékek 
helyén 0, a többi sorban pedig a korábbi érték jelenik meg. Ezután töröljük a 
C oszlopot (kijelöljük az egész oszlopot, majd Edit → Delete parancs Shift 
Cells Left opcióval). 

10. A PMWin interpoláló rutinjai verziószámtól függően maximálisan 2000 vagy 
5000 értéket tudnak kezelni, ugyanakkor számunkra több, mint 54000 pont áll 
rendelkezésre, ebből célszerű a legfontosabb 2000 vagy 5000 adatpontot fel-
használnunk. Ebben az esetben készítsünk egy olyan 2000 adatpontos állo-
mányt, melyben használjuk fel minden második zérusnál nagyobb értéket, 
hogy minél pontosabban le tudjuk írni a szennyezett területrészeket, és a to-
vábbi pontokkal közel egyenletesen elosztva fedjük le a zérus koncentrációk-
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kal jellemezhető területrészeket. A pontok kiválasztása történjen véletlensze-
rűen, amihez használjuk fel a RANDU egyenletes eloszlású véletlenszám-
generátor függvényét a Surfernek.   
A most már 0-ra változtatott koncentrációértékeket jelöljük ki a C oszlopban 
és ismét hajtsuk végre esetünkben a 2429. sortól az 54383. sorig a Data → 
Transform parancsot. A Transform Equation mezőbe pedig írjuk be, hogy 
D=RANDU(1), amivel egy egyenletes eloszlású véletlenszámot generáltunk 0 
és 1 között az adott sorokban.  
Az első 2428 sorba pedig generáljunk 1 és 2 közötti véletlenszámot (Data → 
Transform parancs, Transform Equation: D=1+RANDU(1)). 

11. Jelöljük ki ismét az egész adatsort (mind a négy oszlopot) majd a Data → 
Sort paranccsal rendezzük a D oszlop adatait csökkenő sorrendbe (Sort First 
By: Coloumn D és Descending).  

12. A kapott adatrendszer első 2428 sorában véletlenszerűen keverve találhatók 
meg ezután a szennyezett terület koncentrációértékei, a további sorokban pe-
dig szintén véletlenszerűen keverve a nem szennyezett területek zérus kon-
centrációi. Mivel a szennyezett terület 2428 értéke közül minden másodikat 
szeretnénk felhasználni, ezért töröljük a adatállomány 1215-2428 sorait, majd 
a törlés után előállt adatállomány 2000 sort követő sorait is. Végül a D oszlop 
adatait töröljük az állományból. 

13. Az első sorba szúrjunk be egy üres sort, amihez az Edit → Insert parancsot 
használjuk (első sor kijelölése, Edit → Insert parancs, Shift Cells Down op-
ció). Az A1 mezőbe (az üressé vált sorba) írjuk be az adatok számát: 2000, 
majd mentsük el az állományt PM_KONC_TERKEP_BLN.DAT névre. 

 
105. ábra 

Az elkészített PMWin input állomány 
 

14. A Processing MODFLOWban a koncentráció-eloszlást a 2000 ponttal leírt 
térfelület jellemzi (105. ábra). A programba történő felhasználás előtt a 2000 
pontból álló adatsort át kell alakítani ASCII mátrix formátumra a Field 
Interpolator programmal. A Tools menüből válasszuk a Field Interpolator 
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menüpontot. A modell a korábban is említett M1.PM5, az input állomány a 
most készített adatállomány, míg a kimeneti állományt nevezzük el 
PMX_KONC_TERKEP_BLN.DAT néven. A Grid Position fülön ellenőriz-
zük az értékeket, a Search/gridding Method lapon adjuk meg, hogy a legkö-
zelebbi négy pontból (térnegyedenként 1-1 pont: Search Method: Quadrant, 
Data Per Sector:1), és használjunk egy torzításmentes interpolátort (Shepard-
módszer, Gridding Method: Shepard’s Inverse Distance). A Go gombbal in-
dítsuk el a számítást (106. ábra) ! 

15. A számított PMX_KONC_TERKEP_BLN.DAT állomány már beolvasható, 
mint kezdeti koncentráció a PMWin környezetbe. Válasszuk ki a Models → 
MT3D → Initial Concentrations menüpontot. A Grid Editorban a Value → 
Matrix menüvel megjelenő Browse Matrix dialógusablakban a Load gomb-
bal történhet meg a koncentráció-értékek behívása (107. ábra).  

A végén célszerű egy további ellenőrzést is végrehajtani. A Field Interpolatorral 
végzett számítás során előfordulhat, hogy újra negatív értékek kerülnek a mátrixba, 
főképpen az extrapolációval jellemezhető területrészeken. Bármely mátrixban talál-
ható értékek minimumát és maximumát a legegyszerűbben az izovonalas térképraj-
zolásnál találjuk meg az Option → Environment parancs dialógusablakának 
Contours lapján. Esetünkben ilyen nem fordult elő, az adatértékek 0 és kb. 20000 
között változtak (108. ábra). Amennyiben más esetben maradtak volna negatív érté-
kek, azokat nullára például a Value → Search and Modify parancsával cserélhetjük. 

 

   

 
 106. ábra 

Javasolt beállítások a Field Interpolator használatához 
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107. ábra 

A számított mátrix értékeinek behívása a PM környezetbe 
 

 
108. ábra 

A koncentráció-eloszlás megjelenítése a PM környezetben 
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12.4.6. PMWin alapadatok és eredmények ábrázolása Surferben (\app\pm52srf 
könyvtár) 

Ebben a fejezetben röviden áttekintjük, hogy hogyan lehet a számítások alapadatait 
megjeleníteni, és a modellel számított eredményeket a Surferbe átvinni, azaz, hogy 
milyen új lehetőségek nyílnak a Surferrel történő ábrázolás és megjelenítés terén.  
A megadott könyvtárban egy korábban készített modell állományai találhatók. Egy 
völgyi (fővölgy és mellékvölgy) területen a talajvízadóra telepített négy kutas 
vízműtelep üzemel (109. ábra), a feladat ennek a relatíve egyszerű hidrodinamikai 
rendszernek a modellezése volt. A modell alapadat-rendszerét felépítettük, a számí-
tásokat a MODFLOW → Run paranccsal elvégeztük. A végső feladat az alapadatok 
és az eredmények megjelenítése volt. 
Az adatok Surferben történő megjelenítésének legnagyobb előnye, hogy lehetőség 
van egy alaptérképre, mint nem átlátszó alapra újabb fedvények illesztésére.  
Itt jegyezzük meg, hogy célszerű a későbbi egyszerűbb megjelenítés érdekében min-
den objektumot külön állományba menteni. Amennyiben később szükségünk van a 
rácsháló, vagy bármely paraméter eloszlásának megjelenítésére, törekedjünk arra, 
hogy minden állomány csak egy objektumot tartalmazzon. Amennyiben egy állo-
mányba mentettük a rácshálót és a kezdeti nyomásszinteket, a későbbiekben csak 
olyan ábrázolásokat készíthetünk, amelyiken mindkettő rajta van, vagy éppen mind-
kettő hiányzik! 

 
109. ábra 

A vizsgált terület térbeli képe 
 

12.4.6.1. A rácsháló megjelenítése  
A modell rácshálójának megjelenítése a legegyszerűbben egy DXF állomány létre-
hozásával lehetséges. A Grid Editor ablakban bármely paraméter szerkesztésénél 
(kivéve a rácsháló szerkesztést (Grid → Mesh Size menü)) lehetőség van a rácsháló 
kizárólagos megjelenítésére. Ehhez 

– töröljünk minden DXF alaptérkép megjelenítést az Options → Maps pa-
rancsnál (lásd 8.4.1 fejezet), 
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– töröljünk minden elem-megjelenítést az Options → Environment parancs 
Appearance lapján kivéve a Rácshálót (lásd 8.4.2.1 fejezet) a láthatóság 
(Visibility) jelölőnégyzetek segítségével, 

– állítsuk át a rácsháló (Component: Grid) színét a szürkéről egy jól látható 
színre, például feketére, 

– töröljünk minden izovonalas térképi megjelenítést az Options → 
Environment parancs Contours lapján a láthatóság (Visible) mező esetleges 
korábbi kijelölésének megszüntetésével. 

Ezután ellenőrizzük, hogy a megjelenítés lokális üzemmódú-e (Options → Display 
Mode → Local, lásd 8.3. fejezet), majd adjuk ki a File → Save Plot As parancsot 
(110. ábra), és mentsük a képernyőképet M2_HALO.DXF névre. 

12.4.6.2. Paraméter-eloszlások és eredmény állományok mentése 
Minden olyan modelladatot, melyeket a rendszer mátrixok formájában tárol, függet-
lenül attól, hogy ezek alapadatok vagy számítási eredmények, többféleképpen lehet a 
Surferbe átvinni.  

 
110. ábra 

A rácsháló mentése 
 

Az egyik megoldás a paraméter-eloszlás izovonalas vagy színskálás képének átvitele, 
amihez célszerűen a DXF állományon keresztül történő átvitelt alkalmazzuk. A má-
sik lehetőség maguknak az adatoknak az átvitele a Surfer programba, majd a Surfer 
interpoláló algoritmusai  (Grid → Data parancs, lásd 12.2.8. és 12.3. fejezetek) se-
gítségével elvégezni a térképi ábrázolást.  



111 

A két megoldás közötti alapvető különbség az, hogy a DXF adatátvitel esetén csak a 
megjelenítés kerül át a Surferbe, ezért azon módosítások vagy változtatások már nem 
hajthatók végre: például egy izovonalas térképen vonalak nem törölhetők és újak 
nem hozhatók létre. Amennyiben az adatokat visszük át, akkor általában többlet-
munkát kell végeznünk, mire esztétikus megjelenítést érünk el, de a példánál marad-
va az izovonalakat formázhatjuk, törölhetjük, sűríthetjük, akár vektortérképes ábrá-
zolást is készíthetünk az adatokból, stb., így egy sokkal rugalmasabb ábrázolási lehe-
tőség marad a kezünkben. Hogy ki, mikor, melyiket alkalmazza, az egyéni döntés 
dolga, de a gyakorlat azt mutatja, hogy egyszerűbb a későbbiekben a Surfer állomá-
nyokban az adatoknak utánanézni, esetleg más célú felhasználáshoz módosított ábrá-
kat készíteni, mint a modellt újra előszedni, és újabb ábrákat exportálni. Ez utóbbi-
hoz általában a teljes modellezési adatépítési folyamat előzetes áttekintése szükséges, 
azaz a korábbi modell részletes áttekintése. Sajnos a modellek építése során felmerült 
problémák hamar feledésbe merülnek, így sokszor néhány perces munka is több na-
pos munkává válik néhány hónap elteltével. 

12.4.6.2.1. Izovonalak DXF átvitele 
Az izovonalak DXF állományok formájában való átvitele nagyon hasonlít a rácsháló 
adatainak átviteléhez. Példaképpen exportáljuk az 1. modellréteg kezdeti nyomás-
szintjeit DXF állományba. Válasszuk ki a PM környezetben a Parameters → Initial 
Hydraulic Heads menüt, ekkor a megfelelő Grid Editor ablakba jutunk. 
Célszerű mindig egy olyan képernyőképet előállítani, ahol csak a paraméternek az 
izovonalas térképe látható minden vonalrajz vagy modellezési objektum nélkül, ehhez 

– töröljünk minden DXF alaptérkép megjelenítést az Options → Maps pa-
rancsnál (lásd 8.4.1 fejezet), 

– töröljünk minden elem-megjelenítést az Options → Environment parancs 
Appearance lapján (lásd 8.4.2.1 fejezet) a láthatóság (Visibility) jelölőnégy-
zetek segítségével, 

– készítsük el a paraméter izovonalas térképi megjelenítését az Options → 
Environment parancs Contours lapján a láthatóság (Visible) mező kijelölé-
sével és a 8.4.2.3 fejezetben leírtak felhasználásával. Mindenképpen állítsuk át 
az izovonalak színét egy jól látható színre, például sötétkékre vagy feketére. 
Kerüljük az izovonalak közének kitöltését (Fill Contours), mert kitöltés ese-
tén a DXF állomány alatt az alaptérkép nem lesz látható. A beállításainkat a 
111. ábra mutatja be 

Ezután ellenőrizzük, hogy a megjelenítés lokális üzemmódú-e (Options → Display 
Mode → Local, lásd 8.3. fejezet),  majd adjuk ki a File → Save Plot As parancsot 
és mentsük a képernyőképet M2_KEZDETI_VSZ.DXF névre. 

12.4.6.2.2. Színtérképek DXF átvitele 
A színtérképek átvitelének bemutatására készítsük el a horizontális szivárgási ténye-
zők színtérképét a 2. rétegre és mentsük egy DXF állományba. Válasszuk ki a PM 
környezetben a Parameters → Horizontal Hydraulic Conductivity menüt, ekkor a 
vízszintes szivárgási tényezők szerkesztésére alkalmas Grid Editor ablakba jutunk. 
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111. ábra 

A kezdeti nyomásszintek beállításai DXF állományba történő exportáláshoz 
 

Célszerű most is egy olyan képernyőképet előállítani, ahol csak az adott paraméter-
nek, esetünkben a szivárgási tényezőnek a színtérképe látható, minden további vonal-
rajz vagy modellezési objektum nélkül, ehhez 

– töröljünk minden DXF alaptérkép megjelenítést az Options → Maps pa-
rancsnál (lásd 8.4.1 fejezet), 

– töröljünk minden elem-megjelenítést az Options → Environment parancs 
Appearance lapján (lásd 8.4.2.1 fejezet) a láthatóság (Visibility) jelölőnégy-
zetek segítségével, 

– készítsük el a paraméter izovonalas térképi megjelenítését az Options → 
Environment parancs Contours lapján a láthatóság (Visible) mező kijelölé-
sével és a 8.4.2.3 fejezetben leírtak felhasználásával. Töltsük ki az izovonalak 
közét (Fill Contours), azonban legyünk tudatában, hogy ezzel az alaptérkép 
láthatóságát a Surferben elveszítjük! Válasszunk például egy szürkeárnyalatos 
színezést, ahol a kis szivárgási tényezők szürkébbek, mint a nagy szivárgási 
tényezők, ezzel párhuzamosan a feliratok és vonalak színét válasszuk meg 
úgy, hogy a kis értékek világosabbak, a nagyok sötétebbek legyenek. A beállí-
tásainkat a 112. ábra mutatja be. 
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112. ábra 

A színskálás térkép beállításai 

12.4.6.2.3. Alapadatok átvitele *.DAT formátumban 
Minden Grid Editor ablakban van lehetőség az adatok ASCII XYZ (*.dat) formá-
tumba történő mentésére. Példaképpen bemutatjuk a kezdeti nyomásszint-adatok ex-
portálását DAT állományba. Válasszuk ki a PM környezetben a Parameters → 
Initial Hydraulic Heads menüt, ekkor a megfelelő Grid Editor ablakba jutunk. 
Az ablakban válasszuk a Value → Matrix parancsot, majd a megjelenő dialógusab-
lakban nyomjuk meg a Save gombot. A megjelenő mezőbe adjuk meg az 
M2_KEZDETI_VSZADATOK.DAT fájlnevet, illetve válasszuk a Surfer files (Real 
world, *.*) fájltípust (113. ábra)! 
Ekkor az állomány elkészül, amit a Surferben a Grid → Data paranccsal grid-
állománnyá alakíthatunk, amit a Map → Contour Map menüben izovonalas térkép-
ként, a Map → Vector Map menüben vektortérképpé, esetleg térfelületté (Map → 
Surface) alakíthatunk a 12.2.9 fejezetben leírtak szerint. 
Itt jegyezzük meg, hogy a Surfer files (Real world, *.*) fájltípus az elemek közép-
pontjainak valós (pl. EOV) koordinátáit, a Surfer files (*.*) fájltípus esetén pedig a 
modell bal alsó sarkához viszonyított relatív koordinátáit rendeli. A program kiter-
jesztést nem fűz az állománynévhez, ezért a DAT kiterjesztést célszerű a névhez 
hozzáfűzni. Ha ezt elfelejtjük, akkor a Surfer automatikusan nem találja meg az ál-
lományt, mivel annak kiterjesztése nem szabványos, azaz hiányzik. 
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113. ábra 

Alapadatok mentése Surfer *.dat állományba 

12.4.6.2.4. Eredmények DXF átvitele 
Az eredmények megjelenítésére a Tools → Presentation menü alkalmas (későbbi 
verziókban Tools → 2D-Visualisation). A Presentation ablakban látható mátrix a 
modell eredményeinek beolvasására fenntartott mátrix, mely alapértelmezetten üres. 
A mátrixba adatokat a Value → Result Extractor paranccsal lehet behívni.  
Példánkban az M2 modellel permanens helyzetre, a 2. modellrétegre számított üzemi 
nyomásszinteket hívjuk be az ablakba.  

1. Válasszuk ki a Result Extractor ablakban a kívánt munkalapot, annak függ-
vényében, hogy melyik programmal állítottuk elő az eredményeket. A poten-
ciál és depresszió adatokat a MODFLOW, a koncentráció-értékeket a megfe-
lelő transzportprogram lapjával hívhatjuk be. Most maradjunk a MODFLOW 
lapon. Mivel permanens a modell, ezért egy periódus van 1 időlépcsővel 
(Stress period: 1, Time Step: 1).  

2. Válasszunk ki a 2. réteget (Plan View, azaz felülnézeti ábrázolás és Layer: 2) 
és nyomjuk meg a Read (beolvasás) gombot (114. ábra). A mátrixban ekkor 
megjelennek a számítási értékek. Ne ijedjünk meg a -999.99 értékektől, ezek 
az inaktív cellákat jelzik, értéküket a Models → MODFLOW → Output 
Control menüjében a Predefined Head Values mezőben adtuk meg (For No-
Flow Cells: -999.99).  

3. Ezután nyomjuk meg az Apply (alkalmaz) gombot, ezáltal a beolvasott 
mátrixértékeket a program átadja a Grid Editor ablaknak, majd a Close 
(bezárás) gombbal térjünk vissza a Result Extractor eredmény-beolvasó 
rutinból a Presentation menü Grid Editor ablakába. 
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114. ábra 

Az eredmények beolvasása a Presentation ablakba 
Ettől kezdve az izovonalas megjelenítés vagy színskálás ábrázolás módja megegye-
zik az előző fejezetekben leírtakkal. Ezután a File → Save Plot As paranccsal a vo-
nalrajzot az M2_UZEMI_VSZ. DXF állományba mentettük.  

12.4.6.2.5. Eredmények átvitele *.DAT formátumban 
Már az eddigi ismeretek is lehetővé teszik a DAT formátumba történő mentést, hi-
szen az eredmények Presentation ablakba történő behívása után a korábbiakban be-
mutatottak szerint – a 12.4.6.2.3.fejezetben bemutatott módon – az adatok *.DAT 
formátumba menthetők.  
Van azonban egy egyszerűbb, másik mód is. A Tools menüből válasszuk közvetlenül 
a Result Extractor parancsot. Olvassuk be a megfelelő eredmény-állományokat – a 
12.4.6.2.4 fejezetben ismertetettek szerint – a Read gombbal. Ezután nyomjuk meg a 
Save gombot, és a megjelenő mezőben adjuk meg a mentendő állomány nevét, illet-
ve válasszuk a Surfer files (Real world, *.*) fájltípust (115. ábra). Mentsük ki az 
üzemi vízszinteket az M2_UZEMI-VSZADATOK.DAT nevű állományba! 

12.4.6.2.6. Alapadat- és eredménytérképek mentése *.BMP formátumba 
A munka során folyamatosan van lehetőségünk a képernyőképek Windows Bitmap 
(*.BMP) formátumba történő mentésére. Míg a DXF állományok mentése lokális 
koordináta-rendszerben lehetséges csak, addig bitmap állományok mentésére mind 
lokális, mind globális megjelenítési módban (Options → Display Mode → Global 
vagy Real-World) van mód. 
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115. ábra 

Adatok mentése közvetlenül a Results Extractor felhasználásával 
 
A Windows Bitmap állományok mentéséhez válasszuk a File → Save Plot As pa-
rancsot, ha szükséges válasszuk ki a Windows Bitmap (BMP) formátumot, és adjuk 
meg a grafikát tartalmazó állomány nevét. Ezután a program a merevlemezre menti a 
kért állományt. Sajnos a kapott állományok a Surferben csak korlátozottan használ-
hatók, ezért ezekkel a továbbiakban nem foglalkozunk. 

12.4.6.2.7. Ábrázolás Surferben 
A Surferben történő ábrázolás bemutatásához beszkenneltük a terület EOV 
M=1:10 000 alaptérképét (ALAPTERK.JPG). A szkennelt terület az EOV 
Y=705000-707680 és az EOV X=292000-294730 területet ábrázolja. A határkoordi-
nátákat az eredeti térképről olvastunk le. 

1. Először készítsük el a koordináta-helyes alaptérképet Surferben! Olvassuk be 
a szkennelt térképet a Map → Base Map paranccsal! Ekkor a térkép egy fur-
csa koordináta-rendszerben jelenik meg, ami a képpontok sorszámát mutatja a 
tengelyek mentén. 

2. Jelöljük ki az objektumok közül a Base objektumot, és kettőt klikkelve néz-
zük meg a tulajdonságait! A Base Map lapon az Image Coordinates mezőbe 
írjuk be a szkennelt kép koordináta-határait: xMin: 705000, xMax: 707680, 
yMin: 292000 és yMax: 294730 (116. ábra). Ha jól adtuk meg a koordinátá-
kat, akkor a 293000, 706000, stb. tengelyosztásoknál az EOV térkép km-es 
osztású rácshálója pontosan illeszkedik! 
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116. ábra 

A térkép határainak megadása 
 

3. Ábrázoljuk a kutakat egy adatpont-térképen. A kutak adatait a KU-
TAK_KOORDINATAI.XLS állomány tartalmazza. Használjuk a Map → 
Post Map → New Post Map parancsot, adjuk meg az Excel állomány nevét. 
Ne lepődjünk meg azon, hogy a térképen a pontok nem jelennek meg, mert 
az állományban az első oszlopban a kutak neve, a másodikban az EOV Y, a 
harmadikban az EOV X koordináták találhatók, a program pedig alapértel-
mezetten a koordinátákat az első két oszlopban keresi. Jelöljük ezért ki a 
Post objektumot és kettős klikkeléssel adjuk meg a tulajdonságait: a 
General lapon: X Coord: Coloumn B, Y Coord: Coloumn C és a Labels la-
pon Worksheet Coloumn for Labels: Coloumn A. Ekkor a kutak helye meg-
jelenik a térképen (117. ábra). 

 
117. ábra 

Kutak helyének ábrázolása adatpont-térképen 
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4. Illesszük egy objektumba a két térképet: előbb jelöljük ki mindkét térképet 

(Edit → Select All) majd illesszük őket közös koordináta-rendszerbe (Map 
→ Overlay Maps). Ekkor a szkennelt alaptérképen megjelennek a kutak és 
jelölésük. 

5. Ábrázoljuk a kezdeti vízszinteket a korábbi fejezetben gyártott DXF állomány 
segítségével! Hajtsuk végre a Map → Base Map parancsot, amihez használ-
juk fel az M2_KEZDETI_VSZ.DXF állományt. A DXF Import Options dia-
lógusablaknál használjuk az alapértelmezett beállításokat, és nyomjunk meg 
az OK gombot! Mivel ekkorra két Base nevű objektum lesz a lapon, jelöljük 
ki az újonnan létrehozott Base objektumot egy klikkeléssel, majd még egyet 
klikkeljünk rá, ekkor a nevét változtassuk meg kezdetivsz-re. 

6. Illesszük egy objektumba a két térképet: előbb jelöljük ki mindkét térképet 
(Edit → Select All) majd illesszük őket közös koordináta-rendszerbe (Map 
→ Overlay Maps). Ekkor a szkennelt alaptérképen megjelennek a kutak és 
jelölésük, továbbá a kezdeti vízszintek. 

7. Ábrázoljuk a rácshálót is a térképen! Hajtsuk végre a Map → Base Map pa-
rancsot, amihez használjuk fel az M2_HALO.DXF állományt. A DXF Im-
port Options dialógusablaknál használjuk az alapértelmezett beállításokat és 
nyomjunk meg az OK gombot! Az újonnan létrehozott Base objektumot ne-
vezzük át rácsháló-ra. 

8. Illesszük egy objektumba a két térképet: jelöljük ki mindkét térképet (Edit → 
Select All), majd illesszük őket közös koordináta-rendszerbe (Map → 
Overlay Maps). Ekkor valamennyi fedvény egy objektumba kerül. 

9. Ábrázoljuk a horizontális szivárgási tényezők színtérképét is! Hajtsuk végre a 
Map → Base Map parancsot, amihez használjuk fel az M2_KH_2RTG.DXF 
állományt. A DXF Import Options dialógusablaknál használjuk az alapér-
telmezett beállításokat, és nyomjunk meg az OK gombot! Az újonnan létreho-
zott Base objektumot nevezzük át kh-ra. hasonlóképpen nevezzük át a Post 
objektumot kutak-ra és a Base objektumot térkép-re! 

10. Illesszük egy objektumba a két térképet: jelöljük ki mindkét térképet (Edit → 
Select All), majd illesszük őket közös koordináta-rendszerbe (Map → Overlay 
Maps). Ekkor valamennyi fedvény egy objektumba kerül. Ekkor már jól látszik 
a színtérkép hátránya, hogy elfedi az alatta levő fedvényeket. Az objektumlista 
egyben a fedvények sorrendjét is jelenti: az egyes fedvények az egérrel fel-le 
mozgathatók, így alakítsuk ki a következő sorrendet: felül a négy tengely, alatta 
a kutak, kezdetivsz, rácsháló, kh és végül a térkép (118. ábra). 

11. Készítsük el az üzemi vízszintek térképét az M2_UZEMI_VSZADA-
TOK.DAT állomány felhasználásával. A Grid → Data paranccsal a természe-
tes szomszéd módszerrel számítsuk egy 20x20 m-es osztású rácshálóra a tér-
felület elemeit (119. ábra). 
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118. ábra 

Az alaptérkép a DXF állományokból készített fedvényekkel 
 

 
119. ábra 

Az interpolációs beállítások 
 

12. Korábban bedigitalizáltuk a teraszréteg határvonalát és beállítottuk, hogy az 
állománnyal való törlés esetén a poligonon kívüli pontok törlődjenek. Az ál-
lományt a TERASZTORLO.BLN állományba mentettük el. Használjuk a 
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TERASZTORLO.BLN állományt az M2_UZEMI_VSZADATOK.GRD állo-
mány dombi területre eső részének törlésére a Grid → Blank parancs segít-
ségével. A készített új állomány neve legyen M2_UZEMI_VSZADATOK_-
BLN.GRD. 

13. Ábrázoljuk az üzemi vízszintek izovonalas térképét (Map → Contour Map 
parancs, Input file: M2_UZEMI_VSZADATOK_BLN.GRD). Formázzuk az 
izovonalakat tetszés szerint, és nevezzük el a Contour fedvényt „üzemi”-nek. 

14. Hívjuk be a teraszhatár vonalrajzát a Map → Base Map paranccsal (input 
file: TERASZTORLO.BLN) és nevezzük át a Base objektumot „határ”-ra. 
Formázzuk a vonalat tetszés szerint! 

15. Készítsük el az üzemi szintek egygrides vektortérképét is! Használjuk a Map 
→ Vector Map → New 1-Grid Vector Map parancsot! Formázzuk a vekto-
rokat tetszés szerint! 

16. Illesszük egy objektumba az összes térképet: jelöljük ki az összes térképet 
(Edit → Select All), majd illesszük őket közös koordináta-rendszerbe (Map 
→ Overlay Maps). Ekkor valamennyi fedvény egy objektumba kerül. A kész 
térképet mentsük el PM52SRF.SRF névre (120. ábra)! 

 
120. ábra 

A kész térkép egyik nézete (üzemi vízszintek a vektorokkal) 
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13. A modellparaméterek meghatározása 

A modellezés során a megoldandó egyenletrendszer felírásához szükség van vala-
mennyi paraméter megadására, ami akkor jelent különösen nagy nehézséget, amikor 
a vizsgált terület ismeretességi szintje alacsony (KOVÁCS et al., 2004). Ilyen esetek-
ben becsült vagy származtatott adatokat használunk fel, szakirodalmi adatok alapján 
veszünk fel paramétereket, esetleg empirikus összefüggéseket használunk. A követ-
kező fejezetrészekben a hidrodinamikai és transzport-modellezéshez szükséges ada-
tokra vonatkozó szakirodalmi ismereteket foglaljuk össze, illetve az egyes képződ-
ményekre legjobban jellemző értékeket soroljuk fel. 

13.1. Internetes adatbázisok 

Az internet megjelenésével az adatokhoz való hozzáférés drámaian megváltozott.  
Az ismertebb keresőmotorokba (Google, Yahoo, Lycos, stb.) néhány kulcsszót beüt-
ve a világ szinte minden tájáról kaphatunk mért vagy becsült vízföldtani vagy transz-
portparamétereket. Ezekkel a munka lehetséges, de sokszor lassú.  
Léteznek nyilvános, illetve fizetés ellenében igénybe vehető adatbázisok, melyekben 
a modellezéshez szükséges adatokhoz lehet hozzáférni. A legismertebb és talán a 
legegyszerűbben használható adatbázis, az egykor még teljesen ingyenes 
EnviroBrowser adatbázis, melyet ma 100-150 USD-nek megfelelő áron kínálnak 
különböző cégek. Az EnviroBrowser ugyanakkor on-line verzióban a mai napig in-
gyenesen használható: http://www.envirobrowser.com vagy a készítő GEOREF, Inc. 
honlapjáról is (http://www.georef.com). Amennyiben rábukkanunk a világhálón az 
Envirobrowser-Lite verzióra, azt is ingyenesen lehet használni. 

 
121. ábra 

Az EnviroBrowser Online honlapja 
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122. ábra 

Vízföldtani és szorpciós paraméterek keresése az EnviroBrowser adatbázisban 
 
Az EnviroBrowser a talajparaméterek (Soil parameters) közül a k szivárgási tényező 
(Hydraulic conductivity), az n hézagtérfogat (Porosity), az Sy fajlagos hozam 
(Specific yield), az Ss fajlagos tárolási tényező (Specific storage) értékeit tartalmaz-
za, ezen kívül szorpciós jellemzőket (Kd megoszlási együtthatók, Adsorption menü), 
α diszperzivitás (Dispersivity menü) értékeket és T felezési időket (Half-life menü) 
is kereshetünk az adatbázisban. Amennyiben a keresett paraméter szennyezőanyag 
specifikus, akkor a szennyezőanyagok közül, amennyiben médium-specifikus, akkor 
a különböző geológiai képződmények közül kell választanunk.  
Az adatbázis a legjobb értéket Best Estimate néven adja meg, és kiírja a referált cikk, 
könyv vagy más publikáció adatait is (szerző, cím, megjelenés helye és ideje, stb.). 
Amennyiben az adatbázist nem sikerülne elérni, Próbáljuk meg egy másik 
internetböngészővel is a letöltést, mert a hibának sokszor az az oka, hogy a használt – 
általában JAVA alapú – programokat a böngészők nem értik meg, esetleg félreértik. 

13.2. Általános vízföldtani paraméterek és megadásuk 

13.2.1. A szivárgási tényező és a transzmisszivitás 
A szivárgási tényezők meghatározásának számos módja ismert, sajnos a pontosságuk 
jelentősen eltérő. A szivárgási tényező meghatározási módok közül előnyben kell 
részesíteni azokat a megoldásokat, melyek egy nagyobb területrészre vonatkozó ér-
tékeket szolgáltatnak, illetve amelyek in situ mérések az eredeti települési környe-
zetben érvényesek. Ennek megfelelően a leggyakrabban a próbaszivattyúzások alap-
ján meghatározott szivárgási tényező értékeket használjuk, ritkábban a szemcseelosz-
lás alapján vagy laboratóriumban permeabiméterrel határozzuk meg annak értékét, 
végül más ismeretek hiányában szakirodalmi adatokra is támaszkodhatunk. A szivár-
gási tényező értékét – szükség esetén – a kalibrálás során tovább pontosíthatjuk.  
Megjegyezzük, hogy a hidrodinamikai modellek jelentős része (így pl. az összes 
MODFLOW verzió) általában a transzmisszivitással számol a szivárgási tényezők 
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helyett, kivéve azokat a rétegeket, amelyek egyaránt lehetnek nyílt- és zárttükrűek és 
a transzmisszivitás értéke nem tekinthető állandónak. Ennek a megoldásnak a követ-
kezményeként gondoskodni kell arról, hogy az esetlegesen a modellezési folyamat 
közben megváltoztatott szivárgási tényező értékekből a szimulációs környezetben 
megtörténjék a megváltozó transzmisszivitások számítása is. 
A következő táblázatban a teljesség igénye nélkül néhány szakirodalmi adatot köz-
lünk (13.1. táblázat). A táblázatot áttekintve látható, hogy a leggyakrabban modelle-
zett laza porózus képződmények átlagos szivárgási tényezői a következők: agyagok 
0,003-0,0001 m/d, agyagos iszapok 0,005-0,008 m/d, iszapok 0,008-0,05 m/d, isza-
pos homokok 0,03-0,1 m/d, finom homokok 0,1-0,3 m/d, közepes homokok 0,5-1,2 
m/d, durva homokok 1-5 m/d, kavicsos homokok 3-50 m/d, homokos kavicsok 10-
130, kavicsok 100-300 m/d. Amennyiben a képződmény iszapos vagy agyagos frak-
ciót tartalmaz, akkor a szivárgási tényező ugrásszerűen lecsökkenhet, és akár egy 
alapvetően homokos kavics szivárgási tényezője is  1 m/d alá eshet. 

13.2.2. A hézagtényező, a hézagtérfogat és a szabad hézagtérfogat 
Az n hézagtérfogat a talajmintában található pórusok térfogatának az aránya a minta 
teljes térfogatához viszonyítva. Az e hézagtényező a pórusok térfogatának és a szem-
csék térfogatának az aránya. A két mennyiség nem független egymástól: 

.
1

;
1 e

en
n

ne
+

=
−

=          (13.1.) 

A hézagtényező és hézagtérfogat meghatározása laboratóriumban történhet. Egy V 
térfogatú mintát kiszárítunk, és a száraz állapothoz tartozó M0 tömegét lemérjük. Fel-
tételezve, hogy a szemcsék sűrűsége ρs, a hézagtérfogat és a hézagtényező számítha-
tó: 
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= .        (13.2.) 

A szemcsék átlagos sűrűségét KÉZDI (1972) alapján a 13.2. táblázatban adtuk meg.  
A pórustérnek azt a részét, melyből a vizet gravitációs úton ki lehet termelni, szabad 
hézagtérfogatnak nevezzük. A szabad hézagtérfogat közelítő laboratóriumi meghatá-
rozása kavics és homok képződmények esetében egyszerű: nedves, de telítetlen ta-
lajmintát alulról felfelé emelkedő vízzel lassan telítjük, majd a telítéshez szükséges 
víz mennyiségét mérjük. A telítéshez szükséges víztérfogat és a minta térfogatának 
aránya adja a szabad hézagtérfogat értékét. Szakirodalmi hézagtérfogat és szabad 
hézagtérfogat értékeket a 13.3. táblázat foglalja össze. Egy, a gyakorlatban használ-
ható szabad hézagtérfogat meghatározásra alkalmas összefüggést a 123. ábra mutat 
be. A fajlagos hozam értékek mindig kisebbek, mint a szabad hézagtérfogat értékei. 
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13.1. táblázat 

A szivárgási tényező tapasztalati értékei egyes szerzők szerint 
Szivárgási tényező [m/s] Képződmény 

Juhász (1987) Verruijt (1970) Morris – Johnson (1967)
mállott gránit   3.3÷52 ⋅ 10-6 
mállott gabbró   0.5÷3.8 ⋅ 10-6 

Bazalt   0.2÷4250 ⋅ 10-10 
metamorf pala   0.002÷1130 ⋅ 10-8 

homokő (finom)   0.5÷2270 ⋅ 10-8 
Agyagpala   0.1÷142 ⋅ 10-10 

agyag  <1 ⋅ 10-9 0.1÷47 ⋅ 10-10 
iszapos agyag 1÷5 ⋅ 10-8   

homokos agyag  1÷10 ⋅ 10-9  

agyagos iszap 1÷500 ⋅ 10-8   

tőzeg  1÷100 ⋅ 10-9  

iszap  1÷10 ⋅ 10-8 0.09÷7090 ⋅ 10-9 
kőzetliszt, homokliszt  1÷10 ⋅ 10-6  

homokos kőzetliszt 1÷50 ⋅ 10-6   

kőzetlisztes homok 1÷20 ⋅ 10-5   

finomhomok  1÷10 ⋅ 10-5 0.2÷189 ⋅ 10-6 
közepes homok 1÷4 ⋅ 10-4  0.9÷567 ⋅ 10-6 
durva homok  1÷10 ⋅ 10-4 0.9÷6610 ⋅ 10-6 

kavicsos homok 2÷10 ⋅ 10-4 1÷10 ⋅ 10-3  

homokos kavics 5÷30 ⋅ 10-4   

Kavics  >1 ⋅ 10-2 0.3÷31.2 ⋅ 10-3 

 
 

13.2. táblázat 
Az egyes képződmények szemcséinek sűrűsége 

(KÉZDI, 1972) 
Képződmény Szemcsék sűrűsége [kg/m3] 
Kavics, homok 2650 

Lösz, homokliszt, homokos iszap 2670 
Iszap 2700 

Sovány agyag 2750 
Agyag 2800 
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13.3. táblázat 
 A hézagtérfogat és szabad hézagtérfogat tapasztalati értékei néhány szerző szerint [%] 

(a szabad hézagtérfogat értékek zárójelben szerepelnek) 
Képződmény Morris-

Johnson 
(1967) 

Davis-
DeWiest 
(1966) 

Freeze-
Cherry 
(1979) 

Kézdi 
(1972) 

Ubell 
(1962) 

Busch-
Luckner 
(1973) 

Driscoll 
(1986) 

Linsley-
Franzini 
(1979) 

ép gránit  0,3 0-10    0-10 1 
mállott gránit 34-57        
mállott gabbró 42-45        

bazalt 3-35 0,8-11,4 5-50    15-50  
tufák  14-40       

metamorf pala 4-49 5,2-21,1     0-10 5 
mészkő 7-56 4,6-21,6 0-20    1-20 5 
márvány  0,3       
dolomit  0,4-27,8 0-20    1-20  
homokő 
(finom) 

14-49 11,2-
27,45-30 

5-30    5-30 15 

tőzeg         
agyagpala 21-41 9,7 0-10      

agyag 34-57 33,3-58,8 40-70 30-70   45-55 45 
iszapos agyag      45-65 

(2-5) 
  

homokos agyag         
agyagos iszap      40-55 

(3-8) 
  

iszap 34-61 33,7-50 35-50 30-50   35-50  
kőzetliszt, 
homokliszt 

   35-55     

homokos 
kőzetliszt 

    (<13) 35-45 
(5-10) 

  

kőzetlisztes 
homok 

    (13-15) 33-40 
 (8-12) 

  

homok   25-50    25-40 35 
finomhomok 26-53 40-50  33-48     

közepes homok  35-40  25-45 (17-19) 30-38 
(10-15) 

  

durva homok 31-46 25-35  25-45     
kavicsos 
homok 

 10-30   (22-25) 28-35 
(15-20) 

10-35 20 

homokos 
kavics 

 10-30  18-42  25-35 
(20-25) 

10-35 20 

kavics  20-30 25-40    25-40 25 
durva kavics 25-38        
finom kavics 24-36        
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ln(n0) = 0.1363671237 * ln(k[m/d]) - 1.971624126

 
123. ábra 

Empirikus összefüggés a szivárgási tényező és a szabad hézagtérfogat között 
 

13.2.3. A fajlagos tárolási tényező és a fajlagos hozam 
A nem permanens folyamatok követéséhez szükséges a fajlagos tárolási tényező és a 
fajlagos hozam ismerete. A tárolási tényezővel – mivel az a fajlagos tárolási tényező 
és a rétegvastagság hányadosaként számítható – külön nem foglalkozunk.  
A fajlagos hozam az a vízmennyiség, amit a kőzet a gravitációval szemben képes 
visszatartani, ezért a teljes porozitás a fajlagos hozam és a kőzetek vízvisszatartó ké-
pességének összege (124. ábra).  
A fajlagos hozam mérése éppen az ellenkezője a szabad hézagtérfogat mérésének, 
azaz a telített mintát hagyjuk szabadon leürülni, majd a leürülés közben kifolyó víz 
térfogatát vagy tömegét mérjük. A kifolyt vízmennyiség és a minta térfogatának a 
hányadosa a fajlagos hozam. A mérés iszapos és agyagos képződmények esetében 
nehezebb, ebben az esetben a víz távozását szűrőkövön keresztül gyenge vákuummal 
való szívással segítik elő, ami a mérés pontosságát erősen csökkenti (HUDAK, 
1994). Néhány képződményre vonatkozó fajlagos hozam értékeket a 13.4. táblázat 
mutat be. 
A fajlagos tárolási tényező megmutatja, hogy egységnyi térfogatú vízadó mennyi 
vizet képes leadni egységnyi potenciálcsökkenés hatására. A fajlagos tárolási ténye-
zőt laboratóriumi körülmények között nehéz meghatározni, ezért a gyakorlatban nem 
permanens próbaszivattyúzások eredményeiből vagy kutak egymásrahatás-vizsgálati 
eredményeiből számítják értékét ki. A fajlagos tárolási tényezők szakirodalomban 
található, mértékadó értékeit a 13.5. táblázatban foglaltuk össze. 
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124. ábra 

A hézagtérfogat, a fajlagos hozam és a képződmények vízvisszatartó képességének 
kapcsolata (BEAR-VERRUIJT, 1987) 

13.4. táblázat 
Tapasztalati fajlagos hozam értékek egyes szerzők szerint [%] 

Képződmény Hudak 
(1994) 

Morris – Johnson 
(1967) 

Linsley – Franzini 
(1979) 

Walton 
(1970) 

Raghunath 
(1982) 

Agyag 2 1-18 3 1-10 1-10 
Homokos agyag 7     

Iszap 18 1-49    
Homok   25 10-30 10-30 

Finomhomok 21 1-46    
Közepes homok 26 16-46    

Durvahomok 27 18-43    
Homokos kavics   16 15-25 15-25 

Kavics   22 15-30 15-30 
Apró kavics 25 13-40    

Középszemcsés kavics 23 17-44    
Durva kavics 22 13-25    

Lösz  14-22    
Eolikus homok  32-47    
Glaciális üledék      

Homokkő   8 5-15 10-20 
Homokkő (finom)  2-40    

Homokkő (közepes)  12-41    
Mészkő és dolomit  0-36 2 0,5-5 1-10 

Agyagpala   2 0,5-5 1-10 
Repedezett kristályos 

kőzet   0,5   
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13.5. táblázat 

A fajlagos tárolási tényező tapasztalati értékei néhány szerző szerint [1/m] 
Képződmény Istok (1989) nyílt tükrű 

képződményekre 
Istok (1989) zárt tükrű 

képződményekre 
Domenico (1972) 

Sodorható agyag   2.6÷20 ⋅ 10-3 
Merev agyag   1.3÷26 ⋅ 10-3 

Közepesen kemény agyag   9.2÷13 ⋅ 10-4 
Laza homok   4.9÷10 ⋅ 10-4 

Tömör homok   1.3÷2 ⋅ 10-4 
Tömör homokos kavics   4.9÷10 ⋅ 10-5 
Repedezett, hasadékos 

kőzet 
  3.3÷69 ⋅ 10-6 

Ép kőzet   < 3.3 ⋅ 10-6 
Kavics 0,1-0,3 0,0001-0,003  
Homok 0,1-0,4 0,0001-0,004  
Iszap 0,2-0,4 0,0002-0,004  

Agyag 0,05-0,2 0,00005-0,002  
Homokkő 0,01-0,2 0,00005-0,002  
Agyagpala 0,01-0,2 0,00001-0,002  

Metamorf pala 0,01-0,08 0,00001-0,0008  
Járatos mészkő 0,01-0,05 0,00001-0,0005  

Nem üreges mészkő 0,01-0,2 0,00001-0,002  
Repedezett magmás és 

metamorf kőzet 
0,01-0,05 0,00001-0,0005  

Nem repedezett magmás 
és metamorf kőzet 

≈0 ≈0  

Repedezett bazalt 0,01-0,2 0,00001-0,002  
Nem repedezett bazalt ≈0 ≈0  

Tufa vagy breccsia 0,01-0,05 0,00001-0,0005  

 

13.2.4. A források és nyelők megadása (kutak, galériák) 
A források és nyelők megadása különösebb gyakorlati problémákat nem okoz. A 
modellnek azon eleméhez, amelyikhez a forrás vagy nyelő tartozik, az elembe eső 
összes vízkivétel előjeles összegét kell hozzárendelni.  
A végeselem módszernél ez nem jelent különösebb gondot, mert általában a háló 
csomópontjait úgy vesszük fel, hogy az egyes kutak éppen valamelyik csomópontba 
essenek. Így a csomópontra számított nyomásszint egyben a kútra – nyomásveszte-
ség nélkül – számított vízszintet is jelenti.  
A véges differencia módszernél azonban ez másképpen van. Tekintettel arra, hogy a 
modellszámítások egysége az elem, így valamennyi elemre egy átlagos vízszint szá-
mítható, illetve egy-egy elemhez – függetlenül az elemhez tartozó kutak számától – 
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egy hozamérték rendelhető. Ez a kutak hatásának összevonásához vezethet, ameny-
nyiben az egyes elemek túl nagyok. A modellezés során törekedni kell arra, hogy 
lehetőleg minden elembe csak egy-egy kút essen a rácsháló megfelelő sűrítése után. 
Amennyiben egy elemen belül egy darab termelő vagy injektáló kút van, akkor is 
csak az elem átlagos víz- vagy nyomásszintjét kapjuk eredményül, ugyanakkor a 
modell kalibrációjához a kutak ismert és számított vízszintjeire van szükség. Az átla-
gos, he elemi nyomásszintből a kutakra érvényes – nyomásveszteség nélkül számított 
– h0 nyomásszinteket ANDERSSON és WOESSNER (1992) szerint az alábbi össze-
függésekkel számíthatjuk ki: 

Zárt tükrű vízadóban: 

0
0 ln

2 r
r

T
Qhh e

e π
−= ,          (13.3.) 

ahol he a cella átlagos nyomásszintje, h0 a kútra számított nyomásszint, Q a kút ho-
zama, T a transzmisszivitás, r0 a kút sugara és re az effektív kútcellasugár. 

Az effektív kútcellasugár ∆x=∆y szabályos rácsháló esetén 
yxre ∆⋅=∆⋅= 208,0208,0 .        (13.4.) 

Amennyiben a rácsháló egyenletesen sűrített, ahol a sűrítés mértéke N=∆xx+1,j/∆xx,j , 
akkor 

( )NC
x

r ji
e π

,∆
= ,         (13.5.) 

ahol C(N) az N függvényében a 13.6. táblázatból kiolvasható konstans. 

Amennyiben a háló szabálytalan de állandó osztásközű, ahol ∆x≠∆y és α a cella 
anizometriájának maximális értéke (∆x/∆y vagy ∆y/∆x), akkor 

( )α
π

Eyxre
∆∆

= ,         (13.6.) 

ahol E(α) a 13.6. táblázatból kiolvasható konstans 
Nyílt tükrű vízadóban: 

0
0 ln

2 r
r

k
Qhh e

e π
−= ,         (13.7.) 

ahol a jelölések és a konstansok megegyeznek a korábbiakkal. 
A kutakkal kapcsolatos másik probléma az összeszűrőzött rétegek esete. Ebben az 
esetben két vagy több modellrétegbe szűrőzött szakasz van, ugyanakkor csak a ki-
termelt összhozamot ismerjük. A hozam viszont modellrétegekre, azaz az érintett 
elemekre osztandó szét. 
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13.6. táblázat 

Az effektív kútcellasugár számításhoz szükséges állandók 
(PRITCHETT-GARG, 1980) 

N C α E 
0 0,606531 1,1 1,002 

0,1 0,606024 1,2 1,008 
0,2 0,604518 1,3 1,017 
0,3 0,602035 1,4 1,028 
0,4 0,598614 1,5 1,041 
0,5 0,594302 1,75 1,077 
0,6 0,589156 2 1,118 
0,7 0,583235 2,5 1,204 
0,8 0,576603 3 1,290 
0,9 0,569323 3,5 1,375 
1 0,561457 4 1,456 

1,1 0,553068 4,5 1,535 
1,2 0,544214 5 1,610 
1,3 0,534953 6 1,754 
1,4 0,525338 7 1,887 
1,5 0,515420 8 2,012 
1,6 0,505246 9 2,129 
1,7 0,494862 10 2,240 
1,8 0,484308   
1,9 0,473623   
2 0,462843   

2,2 0,441125   
2,4 0,419385   
2,6 0,397814   
2,8 0,376572   
3 0,355786   

3,5 0,306432   
4 0,261541   
5 0,186447   
6 0,129980   
7 0,089093   
8 0,060262   
9 0,040327   

10 0,026751   
 
Ebben az esetben több megoldás létezik a teljes kúthozam rétegekre való szétosztá-
sának. A legjobb és legegyszerűbb eset, ha létezik a kútnak reométerezési görbéje. 
Erről a grafikonról egyértelműen megállapítható az egyes szűrőzött szakaszok által 
szolgáltatott vízmennyiség aránya (125. ábra). 
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125. ábra 

A Tiszadada 1/b kút reométerezési görbéje 
 

Amennyiben reométerezési görbével nem rendelkezünk, akkor célszerű lehet a víz-
adó réteg transzmisszivitásával, mint súlyokkal történő súlyozott szétbontás. Ha az 
egyes rétegek vastagsága mi, szivárgási tényezője ki, transzmisszivitása Ti, a kút ho-
zama Q, akkor az i-edik rétegre számolt hozam: 
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mkQ
T

TQQ

11

.        (13.8.) 

A MODFLOW program használatánál van még egy harmadik lehetőség is, ehhez 
szükség van a HFB1 (Horizontal Flow Boundary) csomag használatára. Ebben az 
esetben bármely termeltetett réteghez hozzárendeljük a Q hozamot, és a kútelem he-
lyén a legalsó szűrőzött szinttől a legfelsőig irreálisan magas (pl. 1000 m/d) függőle-
ges szivárgási tényezőket adunk meg. A legfelső szűrő teteje és a legalsó szűrő alja 
közötti szakaszon a nem szűrőzött szakaszokat pedig a HFB1 csomag segítségével 
kizárjuk úgy, hogy minden irányban horizontálisan a cellaperem k/m átszivárgási 
tényezőjét erősen lecsökkentjük (pl. 10-10 s-1). A megoldással a nyomásszintek auto-
matikusan kiegyenlítődnek a kútcellán belül, és az egyes rétegekből a transzmisszivi-
tással súlyozott hozamarányok jutnak a kútba. A megoldás esetén célszerű a kútelem 
méreteit a lehető legjobban lecsökkenteni. 
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13.2.5. A felszíni vízfolyások paramétereinek megadása 
A folyóvizek paramétereinek megadásával csak érintőlegesen foglalkozunk. Ennek 
az az oka, hogy a folyók hatását mindenesetben célszerű a helyi adottságoknak meg-
felelő helyszíni vizsgálatokkal kimérni.  
A folyók vízrajzi adatait, mederkereszt szelvényeket a VITUKI által – általában saj-
nos többéves késéssel – kiadott Vízrajzi Évkönyvek tartalmazzák. Az utóbbi időben 
számos vízfolyás aktuális vízállását és a vízállás-változásokat az internetről is le le-
het tölteni. Az egyik ilyen legjobb honlap a FETIKÖVIZIG oldaláról elérhető infor-
mációs rendszer (http://www.fetikovizig.hu, Vízrajz lapon a Távadat mérőrendszer). 
Egyes folyószakaszokon nagyberuházásokhoz kapcsolódóan (pl. Bős-Nagymaros 
Vízlépcsőrendszer építése, egyes távlati vagy működő partiszűrésű ivóvízbázisok 
diagnosztikája) sokkutas megfigyelőrendszer is kiépült, melyek mérése rövidebb-
hosszabb ideig folyt.  
Elsősorban a Dunán, de rövid Tisza szakaszokon is rendelkezésre áll a meder térké-
pe, részben papíralapú térképeken, részben sekélyszeizmikus geofizikai mérések 
formájában. 
A kolmatációval kapcsolatosan RÁKÓCZI (1997) végzett vizsgálatokat. A meder-
kapcsolati hatásfok meghatározása tekintetében VÖLGYESI (1993) közölt egy, a gya-
korlatban is jól használható metodikai tanulmányt. A mederben alkalmazható 
beszivárgás-viszgálati módszert RÓZSA (2000) mutatott be. 
Amennyiben a modellezés hidrogeológiai adatrendszerének megalapozásához szak-
mai ismeretekre van szükségük javasoljuk a felsorolt, magyar nyelvű irodalom átta-
nulmányozását, melynek segítségével kidolgozhatják a saját céljaiknak legjobban 
megfelelő vizsgálati rendszert, kútelrendezést. 

13.2.6. A függőleges vízforgalom (beszivárgás, párolgás) megadása 
A hidrodinamikai modellezés egyik legnehezebben meghatározható paramétere a 
maradó beszivárgás. Ennek meghatározása liziméteres mérésekkel, empirikus össze-
függésekkel és terepi kútcsoportos vizsgálattal lehetséges.  
A liziméteres vizsgálatokhoz a berendezés megépítésére és a vizsgálatok elvégzésére 
ritkán van lehetőség. A mérésekhez legalább egy év szükséges, de minimálisan a 
teljes téli hidrológiai félévben szükséges az észleléseket elvégezni.  
A kútcsoportos vizsgálat során több kútban észleljük a vízszintek változásait és 
ezekből következtetünk a függőleges vízforgalom mértékére. A legismertebb ilyen 
módszer a Major-féle ötkutas vizsgálat (MAJOR, 1981a, 1981b). 
A vizsgálathoz egy középponti (0 jelű) és négy irányban 1-1 külső kútra (1-4 jelű 
kutak) van szükség. A külső kutak középponti kúttól mért távolsága l1, l2, l3 és l4. A 
középponti és a külső kutakat összekötő vonalak felezőmerőlegesei egy általános 
négyszöget határoznak meg, melynek oldalhosszai a1, a2, a3 és a4. Ez a négyszög a 
differencia elem (126. ábra). 
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Legyen ∆H a kutak adatai és geometriája alapján számított – a differencia elem víz-
szintes vízforgalmával arányos – érték: 

( ) ( ) ( ) ( ) ( )∑
=

−=−+−+−+−=∆
4

1
004

4

4
03

3

3
02

2

2
01

1

1

i
i

i

i hh
l
a

hh
l
a

hh
l
a

hh
l
a

hh
l
a

H  (13.9.) 

akkor a függőleges vízforgalom: 
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ahol ∆h0 a középső kút vízszintjének változása a ∆t=t2-t1 időintervallum alatt, T a 
talajvízadó transzmisszivitása, S a tárolási tényező, F a differencia-elem területe, h0, 
h1, h2, h3 és h4 a kutak vízszintjei egy adott viszonyítási sík fölött. A képlet alapján 
definiáljuk, hogy a vertikális vízforgalom a teljes vízmérleg-változás és a vízszintes 
vízforgalom különbségeként kapható meg. Amennyiben a kapott szám pozitív egy 
adott időszakra, akkor a beszivárgás, ha negatív akkor a párolgás volt az uralkodó. A 
feldolgozást számítógéppel 3-6 napos időszakok sorozatára szokták elkészíteni. 
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126. ábra 

Kútcsoport-elrendezés a Major-féle beszivárgási vizsgálathoz, és az általuk meghatá-
rozott differencia elem (MAJOR, 1981a) 

 
Ha hosszabb adatsorok állnak rendelkezésre, akkor van lehetőség a T/S érték inverz 
meghatározására olyan időszak alapján, ahol a vertikális vízforgalom zérus (vf=0), 
vagy két olyan időszak alapján, amikor a vertikális vízforgalom azonos nagyságú 
(vf1=vf2) volt. 
Ha a vertikális vízforgalom zérus (pl. téli félév csapadékmentes időszaka után), ak-
kor 
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Amennyiben a talajvízadó nyílttükrű, akkor a tárolási tényező megegyezik a jól be-
csülhető szabad hézagtérfogattal, és akkor  
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T és S vagy n0 ismeretében a vf függőleges vízforgalom számítható. 
Ha a vizsgált területen nem áll rendelkezésre a megfelelő kútcsoport, akkor egy 
szomszédos azonos adottságú területen végzett észlelések alapján is elvégezhető a 
számítás. Ebben az esetben fontos, hogy a meteorológiai, beszivárgási viszonyok 
azonosak legyenek, azonos legyen a növénytakaró is. A talajvízadó fedőrétege víz-
földtani tulajdonságainak azonosaknak kell lenniük, de nem szükséges, hogy a víz-
adó jellemzői is megegyezzenek. 
A fedőrétegek azonossági kritériuma a két területre (I, II.):  
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ahol a fedőréteg vertikálisan n részre osztható és mi az egyes rétegek vastagsága, dhi 
az egyes rétegekre jellemző, felületegyenlőség alapján számított hatékony szemcse-
átmérő. 
A függőleges vízforgalom meghatározása. A maradó beszivárgás általában a téli fél-
évben domináns, ugyanakkor a nyári evapotranszspiráció hatására a talajvíz ekkorra 
olyan mélységbe kerül, hogy a téli félévbeli csökkent intenzitású párolgás a transz-
spiráció nélkül a talajvízkészletet nem fogyaszthatja. Mivel a gyökérzóna a téli fél-
évben csak a beszivárgás kis részét kötheti le, a téli félévben a maradó beszivárgást a 
talajvízszint mélységétől függetlennek lehet tekinteni. 
A talajvízből történő párolgást a vadózus zóna kapilláris vízemelő képessége erősen 
meghatározza. A növényzettel nem fedett területrészeken a párolgás a talaj legfelső 
részéből történik, ahova a víz a talajvízből kapilláris úton juthat fel. Ennek követ-
kezménye, hogyha a talajvíz nem áramlik, akkor a talajvíz szintje nem süllyedhet 
mélyebbre, mint a felszínközeli párolgási zóna alatti legnagyobb kapilláris emelőma-
gasság. Azt a legnagyobb mélységet, ahonnan párolgás még történhet, párolgási ha-
tármélységnek nevezzük. Amennyiben a felszín csupasz, akkor a párolgási határ-
mélységet a felszíni párolgási zóna és a kapilláris emelőmagasság, amennyiben nö-
vényzettel borított, akkor a gyökérzóna mélysége és a maximális kapilláris emelő-
magasság összege adja meg.  
A tapasztalatok szerint a párolgás a mélységgel erősen csökken, ugyanakkor a ko-
rábbi gondolatmenet alapján a maradó beszivárgás nem változik a mélységgel. 
Liziméteres kísérletekkel MAJOR (1981a) megállapította, hogy egy „0” referencia 
szinten és az alatt h mélységben lévő szinten lévő talajvíz párolgásának aránya: 
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ahol P0 a referencia szinten mért párolgás, Ph a referenciaszint alatt h mélységben 
mért párolgás, hk2 a maximális kapilláris emelőmagasság (127. ábra). 
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127. ábra 

A talajvízpárolgás mélységfüggvénye 
A 0 referencia szint meghatározására a sokéves talajvízszint adatok alapján másik 
mód is nyílik. Ismerve a sokéves legalacsonyabb talajvízállást, ehhez hk2 értékét hoz-
záadva közelítően megkapjuk a „0” szintet, feltéve, hogy nincs talajvízáramlás). 
A maximális kapilláris emelőmagasságot a talajtanban a Jurin-képlettel számítják: 
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ahol rp a pórus sugara.  
Amennyiben mind a maradó beszivárgást, mind a párolgás mélységfüggvényét is-
merjük, akkor ezek összegzésével a függőleges talajvízforgalom mélységfüggvényét, 
vagyis a talajvíz-háztartási jelleggörbét kaptuk meg (128. ábra). 
Egyes számítógépes rendszerek a talajvíz-háztartási jelleggörbe egyszerűsített formáját 
használják a függőleges vízforgalom meghatározására. A görbe három egyenes sza-
kaszból áll, amit négy paraméter ír le: a maximális párolgás, a felszínközeli párolgási 
zóna vastagsága, a maximális maradó beszivárgás és a párolgási határmélység. 
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128. ábra 

Egy talajvíz-háztartási jelleggörbe 
(MAJOR, 1981b) 
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129. ábra 

A sematikus talajvíz-háztartási jelleggörbe 
(HALÁSZ-SZŐKE, 1997) 
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Egyéb programok esetében a maradó beszivárgást szükséges megadni paraméterként.  
Bármilyen módon is történjék a függőleges vízforgalom felszínközeli részének a 
megadása, megállapítható, hogy ez a folyamat – a szokásos rövid időszakokra és kis 
vizsgált területekre vonatkozó számításoknál – elsősorban csak a talajvízadók víz-
háztartása tekintetében játszik fontos szerepet, ugyanakkor egy nagy hidrogeológiai 
egység, pl. az Alföld rétegzett tároló rendszerének vizsgálatánál már ugyancsak nem 
elhanyagolható. Ugyanez mondható el a hosszú időtartamra végzett szimulációk, 
előrejelzések esetén is. Itt kell megjegyezni, hogy a permanens helyzetre történő 
számítás valójában egy végtelen időpontra történő nyomásszint meghatározás, ezért 
egyes permanens számításoknál a rosszul felvett talajvíz-háztartási jellemzők zavart 
okozhatnak. 

13.2.7. A peremfeltételek meghatározása 
A peremfeltételek jelentik a modellszámítások Achilles-sarkát. A rosszul megválasz-
tott peremfeltételek egyébként teljesen jó adatrendszer esetén is meghiúsíthatják a 
számításokat. A peremfeltételek felvételének legfontosabb alapelve, hogy csak ott 
szabad használni azokat, ahol feltétlenül szükségesek, és olyan módon, hogy a víz-
mérleget a lehető legrugalmasabban és legkevésbé változtassák csak meg. 
Amennyiben a peremfeltételeket osztályozzuk, megkülönböztethetünk kemény és 
puha peremfeltételeket. A kemény peremfeltétel az aktuális vízföldtani, 
geohidrológiai helyzettől függetlenül működik, és ezáltal módosítja az egyes elemek 
vízmérlegét (SZANYI, 2004). Kemény peremfeltétel az állandó nyomásszintű és az 
állandó vízhozamú határ. A puha peremfeltétel vízmérleg-módosító hatása nyomás-
szint függő, ilyen puha peremfeltétel a folyó jellegű vagy GHB perem. 
Az állandó hozamú, Neumann-típusú peremfeltételek két fajtája a vízzáró és a nem 
vízzáró határ. A nem vízzáró határ okozza a legtöbb gondot, főképpen permanens 
helyzetre történő számítások esetén. Amennyiben túl sok a peremen beáramló ho-
zam, akkor az a számítás divergenciáját okozza, ugyanis a peremi cellában a folya-
matosan betáplált, túlméretezett hozam hatására a vízmérleg állandóan szufficites, 
ezáltal a vízszintek folyamatosan emelkednek. A nyomásszintek olyan mértékben 
növekedhetnek meg, hogy a számítás a számítógépes számábrázolás során túlcsordu-
lás miatt szakad meg. Ha a betáplált vízmennyiség deficites vízmérleget okoz, akkor 
a termeltetett rétegekben lecsökken a vízszint, majd egy idő múlva akár ki is szárad a 
teljes modellezett térrész, és ezért szakad meg eredménytelenül a számítás. A tapasz-
talatok szerint a permanens modellek érzékenyebbek erre a hibára, mint a nem per-
manens modellek. A nem permanens modellek esetében megmarad annak a lehető-
sége is, hogy az első sikertelen, divergens számítás után akár ezredmásodpercre 
csökkentve a szimulált időtartamot, megtaláljuk az eredmények grafikus feldolgozá-
sa során az anomália térségét, azaz a hiba helyét. 
Az állandó hozamú határ speciális fajtája, a vízzáró határ ritkán okoz problémákat, 
alkalmazásuk csak valóban vízzárónak tekinthető képződményekkel jellemzett térré-
szeknél indokolt. 
Az állandó nyomásszintű, Dirichlet-típusú peremfeltételek a modell eredményeiben 
elsősorban torzulásokat okoznak. Az alkalmazás csak akkor okozhat divergenciát, ha 
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bár kijelöltük az elemet állandó nyomásszintűnek, de nem adtuk meg a nyomásszint 
értékét, vagy ha egymás mellett, vagy túl közel egymáshoz két nagyon eltérő nyo-
másszintű Dirichlet elem található. Az ilyen divergenciák elkerülése végett felszíni 
vizeket, szivárgókat, kutakat és galériákat stb. szimuláló cellák közvetlen közelében 
definiáljunk az állandó nyomásszintű cellákat.  
A Dirichlet-típusú cellák általánosságban a konvergenciát segítik elő, sok esetben 
hibás adatrendszer esetén is konvergens a számítás, mert a rossz modellkoncepció, a 
hibás adatbevitel stb. okozta vízmérleg-hibákat a peremi cellák agresszív vízutánpót-
lással vagy szükség esetén intenzív víztelenítéssel korrigálják. Ez egyben a hibája az 
állandó nyomásszintű celláknak, hogy túlságosan megkötik a rendszer viselkedését. 
A leginkább javasolt a puha, ún. GHB (General Head Boundary) peremfeltételek 
alkalmazása. Ez a peremfeltétel típus a peremi cellákban szükség esetén nyomás-
szint-változást is megenged, a cellának a vízmérlegét az ott kialakuló depresszióval 
arányos mértékben változtatva meg. Tekintettel arra, hogy így a peremi cellákban 
depresszió kialakulása lehetséges, ezért a peremek a legkisebb mértékben befolyásol-
ják csak a vizsgált térrészen belül kialakuló nyomásszinteket. A GHB perem puhasá-
gát-keménységét, egy konstanssal lehet változtatni. Ha a konstans nagy, akkor a 
GHB cella állandó nyomásszintű határként viselkedik. 
A puha peremfeltételek használatán túl célszerű arra törekedni, hogy minél kevesebb 
peremi cella vízmérlegét befolyásoljuk. Például egy rétegzett tárolórendszerben az 
egymástól eltérő nyomásszintű vízadók közötti féligáteresztő rétegekben nem célsze-
rű peremfeltételeket alkalmazni, mivel bennük a szivárgás uralkodóan vertikális, így 
a peremeken a vízkilépés minimális.  
Ugyancsak nem szoktunk peremfeltételeket felvenni áramló talajvízben a modellnek 
a szivárgás irányával párhuzamos oldalain, csak a szivárgásra merőleges oldalak pe-
remi celláinak vízmérlegét befolyásolva.  
Valójában minden esetet felsorolni, ahol peremfeltételek alkalmazása nem szüksé-
ges, nem lehet, csak javasolható a modell vízforgalmának végiggondolásával az el-
hanyagolható vagy zérus vízforgalmú helyeken a peremfeltételek elhagyásával a 
rendszer szabadsági fokának emelése, mert a szükségtelenül használt peremfeltételek 
az eredmények sokszor alig észrevehető, máskor viszont jelentős hibát okozó torzu-
lását okozhatják. 

13.3. A transzport modell adatrendszerének kialakítása 

A következő fejezetrészben a transzport-modellezéshez szükséges adatok meghatá-
rozási módjait mutatjuk be, illetve az egyes képződményekre legjobban jellemző ér-
tékeket soroljuk fel. 

13.3.1. Az effektív diffúzió-állandó a hidrodinamikai diszperzió-állandó, diszperzi-
vitás, diszperzió-állandó 

Az effektív diffúzió-állandó, a hidrodinamikai diszperzió-állandó, a diszperzivitás és 
a diszperzió-állandó a szennyezőanyag szóródásának mértékét meghatározó ténye-
zők. A diffúzió által szállított anyagmennyiséget a vizes oldatban mért diffúzió-
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állandó és az azzal arányos közeg- és szennyezőanyag-specifikus effektív diffúzió-
állandó határozza meg. A diffúzió-állandó meghatározásának legegyszerűbb módja 
Fick 2. törvényének szivárgásmentes közegre felírt alakján alapul: 
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ahol Deff az effektív diffúzió-állandó, z a távolság, t az eltelt idő és c a koncentráció, 
ami az oldott anyag tömege a diffúzió részére rendelkezésre álló pórustérfogathoz 
viszonyítva. A megoldás (KOHLER – HEIMERL, 1995): 
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A diffúzió-állandó meghatározása során ezt a függvényt illesztik az ismert z mély-
ségben a mért koncentráció-idősorra. A megoldás hibája, hogy egyszerre határozza 
meg a diffúzió és szorpció hatását, ezért csak elhanyagolhatóan adszorbeálódó kom-
ponensekre (pl. klorid, lítium) vagy elhanyagolható szorpciós kapacitással jellemez-
hető közegre (pl. kvarchomok) ad pontos effektív diffúzióállandót. 
Az effektív diffúzió-állandó és a vizes közegben mért diffúzió-állandó közötti kap-
csolatot egy szorzótényezővel (impedancia-faktor) is figyelembe vehetjük (13.7. táb-
lázat). Ennek a szorzónak a nagyságát tapasztalati úton határozták meg néhány 
anyagra: (LEGE et al., 1996) 

0D
Deff

i =γ           (13.18.) 

Amennyiben a diffúzió-állandó az adott szennyezőanyagra ismeretlen, akkor 
KINZELBACH (1986) a 10-9 m2/s érték felvételét tartja ajánlatosnak. Néhány szakiro-
dalmi adatot az effektív diffúzió-állandókra a 13.8. táblázat, a vizes közegben mért 
diffúzió-állandókra a 13.9. táblázat foglal össze. 

13.7. táblázat 

Az effektív és a vizes közegben mért és diffúzió-állandó aránya néhány képződ-
mény esetén (LEGE et al., 1996) 

Impedancia-faktor Képződmény, anyag Forrás 

0,02 > γi > 0,5 kezeletlen agyagok DGEG-GDA (1993) 

0,01 > γi > 0,5 konzervatív szennyezőanyagok 
kezeletlen közegben 

Fetter (1988) 

0,3 > γi > 0,5 laza képződmények Wienberg-Förstner (1994) 

γi > 0,1 Erősen tömörített agyagok Wienberg-Förstner (1994) 

0,002 > γi > 0,03 Speciális tömítőanyag 
résfalazáshoz 

Wienberg-Förstner (1994) 
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13.8. táblázat 
Néhány jellegzetes komponens effektív diffúzió-állandója 

Deff [m2/s] Vizsgált közeg Megjegyzés, szerző 
Komponens : Cl- 

3⋅10-10 Átlagérték jó agyagszigetelőrétegekre Burkhardt és Eggloffstein, 1995 
1,4-1.6⋅10-10 Agyagpala (Queenstone shale) Barone, Rowe, Quigley, 1990 

4,7-10,6⋅10-10 Kaolinit Shackelford és Daniel, 1991 
4,7⋅10-10 Agyag (Lufkin clay) Shackelford és Daniel, 1991 

6,4-8,3⋅10-12 Rétegzett agyag (Badener Tegel) Bartl és Czurda, 1991 
5-7⋅10-10 Glaciális agyag (till) Rowe és szerzőtársai, 1993 

Komponens : I- 
3,5-14,7⋅10-10 Kaolinit Shackelford és Daniel, 1991 

5,3⋅10-10 Agyag (Lufkin clay) Shackelford és Daniel, 1991 
Komponens : Br- 

4,9-9,9⋅10-10 Kaolinit Shackelford és Daniel, 1991 
1,82⋅10-9 Agyag (Lufkin clay) Shackelford és Daniel, 1991 

Komponens: Na+ 
5⋅10-10 Kezelt Na-bentonit pogácsák (átlag) Lai és Mortland, 1962 

6,15⋅10-10 Na-bentonitos pogácsák 7,8% bentonit 
tartalommal 

Lai és Mortland, 1962 

5,7⋅10-10 Na-bentonitos pogácsák 8,9% bentonit 
tartalommal 

Lai és Mortland, 1962 

4,47⋅10-10 Na-bentonitos pogácsák 12,9% bentonit 
tartalommal 

Lai és Mortland, 1962 

3,6⋅10-10 Na-bentonitos pogácsák 15,2% bentonit 
tartalommal 

Lai és Mortland, 1962 

Komponens: K+ 
1,17-1,77⋅10-9 Kaolinit Shackelford és Daniel, 1991 

1,96⋅10-9 Agyag (Lufkin clay) Shackelford és Daniel, 1991 
Komponens: Ca2+ 

2,36⋅10-10 Na-bentonitos pogácsák 17,9% bentonit 
tartalommal 

Lai és Mortland, 1962 

1,95⋅10-10 Na-bentonitos pogácsák 23,9% bentonit 
tartalommal 

Lai és Mortland, 1962 

1,75⋅10-10 Na-bentonitos pogácsák 28% bentonit 
tartalommal 

Lai és Mortland, 1962 

Komponens: Cs+ 
10,4-6,3⋅10-12 Rétegzett agyag (Badener Tegel) Bartl és Czurda, 1991 

Komponens: Sr2+ 
6,1-4,4⋅10-12 Rétegzett agyag (Badener Tegel) Bartl és Czurda, 1991 

7,25⋅10-10 Na-bentonitos pogácsák 9,8% bentonit 
tartalommal 

Lai és Mortland, 1962 

5,81⋅10-10 Na-bentonitos pogácsák 12% bentonit 
tartalommal 

Lai és Mortland, 1962 

4,62⋅10-10 Na-bentonitos pogácsák 14,6% bentonit 
tartalommal 

Lai és Mortland, 1962 

4⋅10-10 Na-bentonitos pogácsák 16,6% bentonit 
tartalommal 

Lai és Mortland, 1962 
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Komponens: Co2+ 
8,2-7⋅10-12 Rétegzett agyag (Badener Tegel) Bartl és Czurda, 1991 

Komponens: Cr2+ 
2⋅10-11 Karbonátmentes plasztikus agyag (Eisenberg) Czurda, Böhler és Wagner, 1989 
1⋅10-12 Meszes, harmadidőszaki, tengeri agyagmárga 

(Wiesloch) 
Czurda, Böhler és Wagner, 1989 

1,5⋅10-13 Kvarter, szalagos agyagmárga (Ravensburg) Wagner, 1992 
Komponens: Cd2+ 

2⋅10-11 Karbonátmentes plasztikus agyag (Eisenberg) Czurda és Wagner, 1988 
4,8-7,6⋅10-10 Kaolinit Shackelford és Daniel, 1991 

10-9 Agyag (Lufkin clay) Shackelford és Daniel, 1991 
5⋅10-12 Kvarter, szalagos agyagmárga (Ravensburg) Wagner, 1992 
10-11 Meszes, harmadidőszaki, tengeri agyagmárga 

(Wiesloch) 
Wagner, 1992 

Komponens: Zn2+ 
10-11 Karbonátmentes plasztikus agyag (Eisenberg) Czurda és Wagner, 1988 

2⋅10-11 Karbonátmentes agyagos iszap, édesvizi 
molassz  (Hinterschlagen) 

Czurda és Wagner, 1988 

2-6⋅10-12 Kvarter, szalagos agyagmárga (Ravensburg) Czurda és Wagner, 1988 
0,9-1,2⋅10-11 Meszes, harmadidőszaki, tengeri agyagmárga 

(Wiesloch) 
Czurda és Wagner, 1988 

8,2-10,3⋅10-10 Kaolinit Shackelford és Daniel, 1991 
2,54⋅10-9 Agyag (Lufkin clay) Shackelford és Daniel, 1991 

7-9,8⋅10-12 Rétegzett agyag (Badener Tegel) Bartl és Czurda, 1991 
2⋅10-11 Illites-szmektites öntésagyag Wagner, 1992 

Komponens : Cu2+ 
6,3⋅10-11 26% illit és 27% montmor, tartalmú agyag Kohler és Heimerl, 1995 
2,5⋅10-11 Illites-kaolinites agyag Kohler és Heimerl, 1995 

10-12 Kaolinites-szmektites agyagmárga Kohler és Heimerl, 1995 
4⋅10-13 Szmektites agyagmárga Kohler és Heimerl, 1995 

2,5⋅10-11 Karbonátmentes plasztikus agyag (Eisenberg) Wagner, 1992 
10-12 Kvarter, szalagos agyagmárga (Ravensburg) Wagner, 1992 

4⋅10-13 Meszes, harmadidőszaki, tengeri agyagmárga 
(Wiesloch) 

Wagner, 1992 

Komponens : Pb2+ 
4⋅10-11 Illites-kaolinites agyag Kohler és Heimerl, 1995 

8,5⋅10-12 Kaolinites-szmektites agyagmárga Kohler és Heimerl, 1995 
3,5⋅10-12 Szmektites agyagmárga Kohler és Heimerl, 1995 

10-12 Illites-szmektites öntésiszap Kohler és Heimerl, 1995 
4⋅10-12 Karbonátmentes plasztikus agyag (Eisenberg) Czurda és Wagner, 1988 

0,7-1⋅10-11 Kvarter, szalagos agyagmárga (Ravensburg) Czurda és Wagner, 1988 
0,6-4⋅10-11 Meszes, harmadidőszaki, tengeri agyagmárga 

(Wiesloch) 
Czurda és Wagner, 1988 

10-12 Illites-szmektites öntésagyag Wagner, 1992 
Komponens : nehézfémek általában 

6,3-0,04⋅10-11 Átlagérték jó agyagszigetelőrétegekre Burkhardt és Eggloffstein, 1995 
1⋅10-16 Geomembrán 5 mm vastagságú fólián vizsgálva, 

Kohler és Heimerl, 1995 
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Komponens : tetraklór-etilén 
2⋅10-13 Geomembrán Burkhardt és Eggloffstein, 1995 

Komponens : diklór-metán 
8-8,5⋅10-10 Glaciális agyag (till) Rowe és szerzőtársai, 1993 

Komponens : metanol 
7,5⋅10-14 Geomembrán Burkhardt és Eggloffstein, 1995 

Komponens : apoláros szerves szennyezőanyagok általában 
>⋅10-10 Megfelelő agyagszigetelőrétegek Burkhardt és Eggloffstein, 1995 

1-0,01⋅10-14 Geomembrán Poláros szennyezőanyagokra is, 
Burkhardt és Eggloffstein, 1995 

 
13.9. táblázat 

Néhány szerves vegyület és a nehézfémek diffúzió-állandói 
(MÜLLER-KIRCHENBAUER, et. al. , 1997) 

Anyag csoport Anyag Diffúzió-állandó 

Közeg Híg vizes oldat 
(10-10 m2/s) 

A szigetelő réteg pórusvize 
(10-10 m2/s) 

HDPE  
geomembrán
(10-12 m2/s) 

Alkohol Metanol 14,5 4,8 0,8 
Keton Aceton 10,2 3,4 0,6 

 Etilmetilketon 9,0 3,0 0,55 
Szerves savak Ecetsav   0,15 

 Propinsav   0,15 
Észter Ecetsav-etilészter 8,4 2,8 0,15 

Aldehid Formaldehid-oldat 17,8 5,9 0,8 
Klórozott szénhidrogének Kloroform 9,2 3,1 0,25 

 Széntetraklorid 8,7 2,9 0,25 
 Triklóretilén 8,4 2,9 0,25 
 1,2-Diklóretán 9,1 3 0,25 
 Tetraklótetilén 7,6 2,5 0,25 
 1,2-Diklórpropán 8 2,7  
 Klórbenzol 8,1 2,7 0,25 

Aromás szénhidrogének Benzol 9,0 3,0 0,2 
 Etilbenzol 6,8 2,3 0,2 
 Xilol 7,2 2,4 0,2 
 Toloul 8 2,7 0,2 
 Naftalin 7 2,3  

Alifás szénhidrogének Pentán 8 2,7 0,2 
 Hexán 7,2 2,4 0,2 
 Heptán 6,6 2,2 0,2 
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A hidrodinamikai diszperzió-állandó és a diszperzivitás – mint azt az 5.1.2.3. feje-
zetben tárgyaltuk – egymásból származtatható mennyiségek, a különböző számítási 
rendszerek – eltérő megfontolások alapján – mindkettőt gyakran használják. A két 
paraméter határozza meg a szennyezőanyagnak a lokális sebességvektor irányának és 
nagyságának hatására bekövetkező szóródásának, a hidrodinamikai diszperziónak 
mértékét. A hidrodinamikai diszperzió fogalmába ugyanakkor nem fér bele a diffú-
zió miatti anyagvándorlás. Mivel a hidrodinamikai diszperzió-állandó a szivárgási 
sebességgel kapcsolatos mennyiség, és a szennyezőanyagok terjedésének mértéke 
eltérő a szivárgás sebességére merőlegesen és azzal azonos irányban, ezért megkü-
lönböztetünk longitudinális és transzverzális hidrodinamikai diszperzió-állandót, il-
letve longitudinális és transzverzális diszperzivitást. 
KINZELBACH (1986) – BEIMS (1983) adatai alapján végzett – elemzése korreláci-
ót mutatott ki a modellezett terület kiterjedése (léptéke) és a jellemző longitudinális 
diszperzivitás értéke között. Hasonló eredményre jutott az amerikai WATER SCIENCE 
AND TECHNOLOGY BOARD OF THE NATIONAL RESEARCH COUNCIL (1990), amikor a 
porózus és repedezett közegbeli transzportmodell-vizsgálatokat elemző, összegző 
jelentést készített. Megállapították, hogy a modell léptéke és a longitudinális 
diszperzivitás értéke között általában 10:1 – 100:1 arány jellemző. Ellenőrzésképpen 
néhány hazai modellvizsgálat adatait is feltüntettük az ábrákon. (130. ábra)  
 

1. Borsodchem Rt. ammónium-szennyezése 
2. NaCl szennyezés az Alföldön
3. BVM Budapesti telephelyeinek szennyezései
4. A Sajóládi Vízmű veszélyeztetettségi vizsgálata

5. BVM Garéi telepének klórbenzol-szennyezése
6. A 2.sz. Regionális Hulladékégetőmű szuhogyi lerakójának vizsgálata 
7. Peremartoni Vegyipari Vállalat lerakójának ártalmatlanítása átdeponálássa

Saját modellvizsgálatok:

8. A zsanai fúrási iszaptároló környezeti hatásvizsgálata

1 100 10 000
A modellezett terület kiterjedése [m]

0,01

1

100 12

  3
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  8

A nemzetközi szakirodalomban ismert
modellkísérletek adatai Beims és 
Kinzelbach nyomán

101 100 1000
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7

 8
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 4

 3

2
 1

Laza kőzetek (saját modellvizsgálatok)

[ ]α L m [ ]αL m

a, b,

 

130. ábra 
A longitudinális diszperzivitás és a modell léptéke közötti összefüggés, 

KINZELBACH (1986) és WATER SCIENCE AND TECHNOLOGY BOARD 
(1990) nyomán 

Saját tapasztalatunk szerint a longitudinális diszperzivitás értékét az alábbi, a Gauss-
féle közelítés alapján meghatározott empirikus összefüggéssel közelíthetjük: 

( )24,8lg1,0332 L
L e−⋅=α ,        (13.19.) 
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ahol L a modell léptéke (kiterjedése) [m]. A megadott összefüggés meredeksége 
(L/αL arány) mintegy 10 m-es modell-léptékig közel 10:1, de nagyobb léptékek ese-
tén akár 100:1 fölé is növekedhet. 
A diszperzió állandó kis léptékek esetén laboratóriumban mérhető: ilyen berendezé-
seket PONGRÁCZ (1981) és ÚJFALUDI (1985) is szerkesztett, de számítható osz-
lopkísérlet során mért áttörési görbék érintőjének meredekségéből is (RIFAI et. al. 
1956). A szerzők levezették, hogy a longitudinális diszperzió-állandó 

2
*

4 E
vLDL π

=            (13.20.) 

összefüggéssel számítható, ahol v a folyadék lineáris szivárgási sebessége, L az osz-
lop magassága és E az áttörési görbe érintőjének meredeksége egységnyi pórustérfo-
gatnyi effluens esetén. (KREMPER, 1998) 
PERKINS és JOHNSTON (1963) a DL

* longitudinális diszperzió-állandót vízrekesz-
tő képződmények esetén az alábbi formulával javasolják kiszámítani: 

[ ] 



⋅⋅+=








a
mvmdD

a
mD effL 50

2
* 75,1 ,       (13.21.) 

ahol d50 az átlagos szemcseátmérő. 
BRUCH ÉS STREET (1967) szerint durvahomokok esetén a  

205,1
50

* Re8,1 ⋅⋅= νLD          (13.22.) 
7,0

50
* Re11,0 ⋅⋅= νTD          (13.23.) 

összefüggés érvényes, ahol  

ν
%50

50Re vd
= ,          (13.24.) 

ahol v a szivárgás Darcy-féle sebessége, d50% az 50%-os szemcsemérethez tartozó 
szemcseátmérő és ν a folyadék kinematikai viszkozitása (BOUWER, 1978). 

13.3.2. A szorpciós izotermák jellemzői, megoszlási együttható és a késleltetés 
A szorpciós izotermákat laboratóriumi mérésekkel lehet a vizsgált szennyezőanyagra 
és közegre meghatározni. A laboratóriumi vizsgálat menetét a megfelelő talajtani 
szakkönyvek és szakcikkek (CZINKOTA et al., 2002; KONDA et al. 2002; 
FÖLDÉNYI et al. 2004) részletesen leírják. Olyan területen, ahol sok talaj és talajvíz-
koncentráció mérési adat áll rendelkezésre megkísérelhető a talajvízadó kőzetre és a 
talajvíz szennyezettségére vonatkozó adatpárokból is a szorpciós izoterma felvétele. 
A megoldás ötletes, de sokszor nem áll kellő mennyiségű és pontosságú mérési adat 
a meghatározáshoz rendelkezésre.  
A megoszlási együttható a szorpciós izoterma érintőjének meredeksége, ami a való-
ságban a koncentráció függvényében folyamatosan változik. Amennyiben lineáris 
adszorpciót tételezünk fel, akkor a Kd megoszlási együttható alapján számítható a 
késleltetés: 
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n
KR bdρ+=1 ,          (13.25.) 

ahol ρb a közeg száraz állapotra vonatkoztatott sűrűsége és n a hézagtérfogat. 
13.10. táblázat 

A késleltetés nagysága néhány szerző szerint  
CZURDA-WAGNER (1988), WAGNER (1992), SHACKELFORD (1990), CZURDA-

WAGNER (1991), EGGLOFFSTEIN-BURKHARDT-MAINKA (1996) 
A vizsgált anyag A szennyezőkomponens R 

Karbonátmentes plasztikus agyag (Eisenberg) Zn 3-6 
Karbonátmentes plasztikus agyag, édesvízi 

molassz (Hinterschlagen) 
Zn 5-9 

Kvarter szalagos agyagmárga (Ravensburg) Zn 10-20 
Meszes, harmadidőszaki tengeri agyagmárga 

(Wiesloch) 
Zn 10-20 

Márga (Mühlacker) Zn ~ 10 
Márga (Mühlacker) Cd ~ 7 
Márga (Mühlacker) Pb ~ 70 

Illites-kaolinites agyag (Eisenberg) Cd 6 
Illites-kaolinites agyag (Eisenberg) Cr 23-35 
Illites-kaolinites agyag (Eisenberg) Cu 6 
Illites-kaolinites agyag (Eisenberg) Pb 15-22 
Illites-kaolinites agyag (Eisenberg) Zn 5,2-7,5 

Tömörített agyag (kaolinit) Cl 1 
Tömörített agyag (kaolinit) K 26,3 
Tömörített agyag (kaolinit) Zn 92,7 
Tömörített agyag (kaolinit) Cd 371 

Szalagos agyagmárga (Badener Tegel) Sr 95-145 
Szalagos agyagmárga (Badener Tegel) Cs 48-78 

Iszapos, agyagos talajok Szervetlen és szerves kationok 3-80 
Iszapos, agyagos talajok Szervetlen és szerves anionok 2-5 
Iszapos, agyagos talajok Semleges, poláros szerves vegyületek 1-5 
Iszapos, agyagos talajok Semleges, apoláros szerves vegyületek 1-2 

 
A retardációs faktor (R, késleltetés) a következőképpen is értelmezhető: 

mobil

teljes

c
c

R = ,          (13.26.) 

ahol cteljes a koncentráció pusztán advektív transzport figyelembe vételével, cmobil a 
koncentráció valamennyi transzport-folyamat figyelembe vételével. A késleltetés 
másik definíciója ebből következik, azaz hogy a késleltetés a víz szivárgási sebessé-
gének és a szennyezőanyag-front előrehaladási sebességének az aránya. Az értelme-
zés szerint a késleltetés egy 1-nél nagyobb szám. 

%50c

p

v
v

R =           (13.27.) 

ahol vp a víz pórusbeli, és vc50% az 50%-os relatív koncentrációértékhez tartozó front 
mozgásának sebessége. 
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A késleltetés meghatározása elvégezhető laboratóriumi kísérlettel (SZABÓ et al. 
2001), de sokszor a tapasztalt koncentráció eloszlás és az ismert, a szennyezőanyag 
talajvízbe jutása óta eltelt idő ismeretében becsülhető is. A késleltetésre vonatkozó 
szakirodalmi adatokat a 13.10. táblázat ismertet. 

13.3.3. A bomlási együttható és a felezési idő 
A szennyezőanyagok radioaktív bomlását a felezési idővel írjuk le. Az egyes izotó-
pok T felezési idejét jól ismerjük, ezeket a fontosabb fizikai alapművek tartalmazzák. 
A szerves vegyületek bomlása bekövetkezhet hidrolízis útján és biodegradációval, 
melyeket a λ bomlási állandóval vehetünk figyelembe. A felezési idő és a bomlási 
állandó könnyen átszámítható egymásba: 

T
2ln

=λ
.
          (13.28.) 

13.11. táblázat 

Néhány szerves vegyület hidrolitikus bomlásának  intenzitása (DRAGUN, 1988) 
Vegyület Felezési 

idő Vegyület Felezési 
idő Vegyület Felezési 

idő 
acetamid 3950 év dikloro-acetamid 0,73 év jodometán 110 nap 
atrazin 2.5 óra dikloro-jodometán 275 év 2-jodopropán 2,9 nap 
azirdin 154 nap dikloro-metán 704 év 3-jodopropán 2 nap 

benzol-klorid 16 mp dikloro-metiléter 25 mp izobutil-amid 7700 év 
benzil-bromid 1,32 óra dietil-metilfoszfonát 990 év izopropil-bromid 2 nap 
benzil-klorid 15 óra dimetoxiszulfon 1,2 perc izopropil-etanoát 8,4 év 

benzilidén-klorid 0,1 óra 1,2-dimetil-epoxietán 15,7 nap malation 8,1 nap 
bromo-acetamid 21200 év 1,1-dimetil-epoxietán 4,4 nap metoxi-acetamid 500 év 

bromo-klorometán 44 év difenil-foszfát 20,6 nap n-metil-acetamid 38000 év 
bromo-diklorometán 137 év epoxietán 12 nap metil-kloroetanoát 14 óra 

bromoetán 30 nap 3,4-epoxi-ciklohexén 6 perc metil-dikloroetanoát 38 perc 
1-bromohexán 40 nap 3,4-epoxi-ciklooktán 52 perc metil-epoxietán 14,6 nap 
3-bromohexán 20 nap etion 9,9 nap metil-parathion 10,9 nap 

bromometil-epoxietán 16 nap n-etil-acetamid 70000 év metil-trikloro-
etanoát <3,6 perc 

1-bromo-3-fenil-propán 290 nap etil-acetát 136 nap monometil-foszfát 1 nap 
1-bromopropán 26 nap etil-butanoát 5,8 év paration 17 nap 
3-bromopropán 12 óra etil-transz-butanoát 17 év fenil-dikloroetanoát 3,7 perc 
kloro-acetamid 1,46 év etil-difluoro-ethanoát 23 perc fenil-etanoát 38 nap 

kloro-dibromoetán 274 év etil-dimetil-etanoát 9,6 év foszfonitril-haxamid 46 nap 
kloroetán 38 nap etil-metil-tioetanoát 87 nap propadienil-etanoát 110 nap 

kloro-fluoridometán 1 év etil-fenil-metanoát 7,3 év tetra-klorometán 7000 év 
klorometán 339 nap etil-propanoát 2,5 év tribromometán 686 év 

klorometil-epoxietán 8,2 nap etil-propénoát 3,5 év trikloro-acetamid 0,23 év 
2-kloro-2-metilpropán 23 mp etil-propinoát 17 nap triklorometán 3500 év 

2-kloropropén 2,9 nap etil-piridil-metanoát 0,41 év trikloro-etilbenzén 19 mp 
3-kloropropén 69 nap fluorometán 30 év trietil-foszfát 5,5 év 
ciklopentán-
karboxamid 5500 év 2-fluor-2-metil-

propán 50 nap trietil-tiofoszfát 8,5 év 

dibromoetán 183 év hidroxi-metilpropán 28 nap   
1,3-dibromopropán 48 nap jodoetán 49 nap   
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Néhány szerves vegyület felezési idejét a 13.11. táblázat , bomlási állandóját a 13.12. 
táblázat tartalmazza. 

13.12. táblázat 

A szerves anyag talajban lejátszódó biodegradációjának intenzitása 
(MABEY - MILL, 1978) 

Vegyület Bomlási állandó 
[d-1] Vegyület Bomlási állandó 

[d-1] Vegyület Bomlási állandó 
[d-1] 

Aldrin, dieldrin 0,013 Difenamid 0,123 Parakvát 0,0016 
Atrazin 0,019 Fonofos 0,012 Pikloram 0,0073 

Bromacil 0,0077 Glifoszfát 0,1 Simazin 0,014 
Karbaril 0,037 Heptaklór 0,011 TCA 0,059 

Karbofurán 0,047 Lindán 0,0026 Terbacil 0,015 
DDT 0,00013 Linuron 0,0096 Trifluralin 0,008 

Diazin 0,023 Malation 1,4 2,4-D 0,066 
Dikamba 0,022 Metil-paration 0,16 2,4,5-T 0,035 

13.3.4. A transzportmodellek peremfeltételinek megadása 
A transzportmodellezésnél a peremfeltételek helytelen megadása kevésbé jelent 
problémát. Ennek az az oka, hogy a modellezendő térrészt általában úgy választjuk 
meg, hogy kellően távol essen a szennyezett területrész határaitól, ennek megfelelően 
a gyakorlatban alárendelt a peremek hatása az eredményekre. 
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14. A modellek paraméter-érzékenysége 

A modellezés során alapvető fontosságú annak megismerése, hogy a modellezett 
rendszer az elkövetett pontatlanságokra, esetlegesen a hibákra mennyire érzékeny. A 
modell érzékenységét alapadat-érzékenységi vizsgálattal lehet eldönteni. A vizsgálat 
megkezdéséhez rendelkezni kell egy működőképes és jónak talált modellel.  
A modellben célszerű megvizsgálni az ismert potenciálú vagy koncentrációjú helye-
ken a modell hibáját, melyet az úgynevezett RMS (Residual Mean Square) értékkel 
határozunk meg. Az RMS hiba adja meg a valós (potenciál vagy koncentráció) felület 
és a számított felület közötti átlagos egydimenziós szórás nagyságát. Az RMS hibát a 
következő módon számítjuk ki: 
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i
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,        (14.1.) 

ahol n a vizsgált pontok száma, zi,mért az adott ponton a mért és zi,számított a számított 
érték. 
A Processing MODFLOW környezetben a mért értékeket a Parameters → 
Boreholes and Observations menüben kell megadni, az RMS hiba számított értékét 
pedig a Tools → Graphs → Head-Time menün belül a Scatter diagram megrajzolá-
sánál olvashatjuk le. 
Az alapadat-érzékenységi vizsgálat során egyes paraméterek ismert mértékű megvál-
toztatása esetére vizsgáljuk meg az RMS hiba változását. Példaként egy olyan hidro-
dinamikai modellt mutatunk be, ahol a műszaki ellenőr által előírt RMS hiba, kisebb 
mint 0,1 m, azaz a háromvízadós rendszerben az ismert pontokban a felület átlagos 
hibája nem lehetett nagyobb mint 10 cm. Ez eléggé nagynak tűnik, de ha figyelembe 
vesszük, hogy minden modellnél előfordulnak különlegesen viselkedő modellterüle-
tek, ahol a hiba sokszor elérheti az 1 m-t is, akkor a többi részen igen pontos modellt 
kell előállítani a feltétel teljesítéséhez. 
Ezután megvizsgáltuk, hogy a modellre milyen hatással van ± 1 nagyságrendnyi hiba 
a szivárgási tényezőben, illetve ± fél nagyságrendnyi hiba a szivárgási tényező ani-
zotrópiájában, végül a beszivárgásban (131. ábra). 
Az ábrákról látható, hogy a szivárgási tényezőben egy nagyságrenddel felfelé történő 
tévedés esetén a vízszintek a mérthez képest lecsökkennek (RMS=7.5), ugyanekkora 
lefelé való tévedés esetén a modell teljesen szétesik (RMS=474.3). Az anizotrópia 
kevésbé hat a rendszerre, de látszik, hogy van a modellnek egyfajta irányítottsága, 
mivel az anizotrópia növelése és csökkentése eltérő mértékű hatással van az eredmé-
nyekre. A beszivárgás emelése és csökkentése szinte azonos mértékben emeli, illetve 
csökkenti a vízszinteket a területen, miközben az RMS hiba csak kismértékben vál-
tozik. 
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131. ábra 

Egy hidrodinamikai modellszámítás alapadat-érzékenységi vizsgálatának eredményei 
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A vizsgálat tanulsága, hogy amennyiben a vízszintek átlagos értéke a valós szintek 
közelében van, akkor a beszivárgás becslésében nagy hibát nem követhettünk el. A 
rendszer különlegesen érzékeny a szivárgási tényezőkre. Ezt az okozta, hogy a mo-
dellezett területen a felszín alatti vizek áramlanak, mely áramlást zavarják a nem 
megfelelően meghatározott szivárgási tényezővel jellemzett képződmények. Az ani-
zotrópia irányok megváltoztatásának eltérő mértékű hatása a hibára is az áramlás 
irányára merőleges és azzal párhuzamos irányok eltérő viselkedéséből fakad. 
Transzportmodellek esetén a transzportparaméterekben elkövetett hibák a számítások 
eredményeit eltérő mértékben befolyásolják. Mint azt NACHTNEBEL és 
BÁRDOSSY (1990) megállapítják, a transzportfolyamatok jellemzésénél elsődleges 
fontosságú a peremfeltételek által jelentősen befolyásolt nyomás-eloszlás pontos is-
merete, ugyanakkor a rétegek geometriai jellemzőinek hibái az eredményeket kevés-
bé befolyásolják. Mindez a szivárgási sebességmező lehetőség szerinti legpontosabb 
megismerésének szükségességét jelenti, amely a transzportegyenlet advektív-
diszperzív tagjai pontosságának jelentőségére utal. Ugyanakkor a transzportegyenlet 
diszperzív tagjait a longitudinális és transzverzális diszperzivitás nagysága erősen 
befolyásolja. A transzportegyenletekben szereplő paraméterek hatásának össze-
hasonlító vizsgálatát a szuhogyi veszélyes hulladéklerakó hatásvizsgálata során ké-
szített számítás (SZABÓ - KOVÁCS, 1992) alapján mutatjuk be. A számítást a 
transzportegyenlet egydimenziós, analitikus megoldása felhasználásával végeztük el. 
Először az egyes paraméterek jellemző értékeit határoztuk meg, illetve a meghatáro-
zás lehetséges hibája alapján az adott paraméter előforduló maximális és minimális 
értékét becsültük meg (14.1. táblázat). A koncentráció időbeli és térbeli változását az 
ilyen módon kialakított 10 paraméterkombináció segítségével számítottuk. A kapott 
áttörési görbékről és koncentráció-eloszlásokról látható, hogy a koncentráció-
eloszlás jellegét a diszperzivitás, a szabad hézagtérfogat, valamint a bomlási együtt-
ható változása nem befolyásolja, ugyanakkor a szivárgási sebesség nagyságának, 
valamint a késleltetés értékének megváltozása igen. Mindez azt jelenti, hogy a felso-
rolt első három paraméter okozta hibák összegződnek, hatásuk erősítheti és gyengít-
heti is egymást, de a kapott eredmények jellegükben helyesek maradnak, azaz né-
hány észlelési érték alapján a számított koncentráció-eloszlás a valós helyzethez iga-
zítható, a modell kalibrálható. Nem mondható el ugyanez a késleltetés és a szivárgási 
sebesség okozta hibákról, melyek az áttörési görbéket és a koncentráció-eloszlást is 
jelentősen módosítják. A gyakorlatban előforduló inhomogén áramlási térben ezek a 
hibák nehezen javíthatók (132. ábra).  
A bemutatott érzékenységi vizsgálatsor alapján megállapítható, hogy a transzport-
modellezés egyik sarokpontja a megfelelően reprezentatív áramlási tér kialakítása, a 
hidrodinamikai modell paraméterhibái előfordulási lehetőségének minimalizálása 
(BÍRÓ et al., 1998). Problémát jelent a nem-konzervatív, adszorbeálódó szennyező-
anyagok mozgásának követése. Ilyen anyagokkal a gyakorlatban sokszor találkozha-
tunk, ugyanakkor szorpciós tulajdonságaikat többnyire nem ismerjük, ezért ebben az 
esetben a transzportmodellek kizárólag közelítő becslések számítására alkalmasak.  
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14.1. táblázat 

A transzportparaméterek minimális, jellemző és maximális értékei  
a szuhogyi hulladéklerakó érzékenységi vizsgálatához (1992) 

Paraméter 
Szivárgási 
sebesség 
[m/nap] 

Szabad 
hézagtérfogat 

[-] 

Longitudinális 
diszperzivitás [m] 

Késleltetés 
[-] 

Bomlási 
együttható 

[1/nap] 
Jellemző érték 1,5 0,15 25 1,2 0 

Becsült minimális 
érték 0,75 0,12 20 1 0 

Becsült maximális 
érték 3 0,18 31,5 1,5 10

-4
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132. ábra 

A szennyeződés-terjedési számítások alapadat-érzékenységi vizsgálatának eredmé-
nyei a szuhogyi lerakó adatrendszerének felhasználásával 1D analitikus megoldás 

esetén 
A) A koncentrációk a forrástól mért távolság függvényében t=5 év időpontban 

B) A koncentrációk az eltelt idő függvényében a forrástól mért 2250 m távolságban 
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15. A numerikus hibák kiküszöbölése 

Mint azt az elméleti részben tárgyaltuk (4.2.2.3. és 5.2.2.2. fejezet), négy alapvető 
numerikus hibatípust lehet megkülönböztetni: az instabilitást, az oszcillációt, a nu-
merikus diszperziót és az „Undershoot-Overshoot” (alálövés-fölélövés) típusú hibá-
kat (SZABÓ - KOVÁCS, 1995).  
Az instabilitás leküzdéséhez a gyakorlatban előforduló legfontosabb okokat kell is-
mernünk, ezek: 
– a konvergencia- vagy más néven stabilitási-kritériumnak nem megfelelő időlép-

cső alkalmazása, 
– irreális modelladat-rendszer (lásd 11.4.8. fejezet), azon belül is: 
– mértékegység-hibák, 
– helyiérték hibák, 
– egymást kizáró paraméterek használata. 
 
A megoldás alapvetően akkor válik divergenssé, ha lehetőség van az anyagmérleg 
számításakor arra, hogy egy adott elemből több anyag (víz vagy szennyezőanyag) 
távozzék, mint amennyit abban az elemben az időlépcső elején tároltunk. Tekintettel 
arra, hogy az eltávozó anyagmennyiség az eltelt idővel egyenesen arányos és mind a 
hidraulikus-, mind a koncentráció-gradiens az adott időlépcsőben állandó, ezért az 
időlépcső csökkentése ilyen hibák esetén előbb-utóbb stabilitást eredményez. 
Összefoglalva az elméleti részben leírtakat a hidrodinamikai modellekre érvényes a 
(4.71.) stabilitási kritérium: 
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míg a transzportmodellek akkor válnak stabillá, ha kétdimenziós esetben (5.61.) 
egyenlet teljesül: 
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illetve előrelépéses differenciák esetén :  1≤+ yx CoCo      (15.3.) 

Háromdimenziós transzportmodell-számításoknál a stabilitási kritérium alakja meg-
változik (5.62.): 
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Minden megoldásnál szükséges, hogy az úgynevezett forrás-nyelő kritérium is érvé-
nyesüljön (5.64.), azaz: 
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A jelölések megfelelnek az elméleti részben tárgyaltaknak. 

Általában a megoldás stabillá válik, ha ω ≥ 1/2  értéket veszünk fel a (4.57.) egyen-
letben (LAPIDUS és PINDER, 1982). 
A nagyon kicsi időlépcsővel elért stabilitás azonban „pirruszi” győzelem csak, mert 
az eredmények szinte bizonyosan rosszak, részben a fel nem lelt hibák, részben a 
soklépéses iteráció hatására megnövő numerikus diszperzió miatt. Általában, ha nin-
csen túl nagy méretbeli különbség az elemek között, továbbá fizikailag reális felada-
tot fogalmaztunk meg, akkor a számítás gyors, nincs szükség másodperces vagy per-
ces nagyságrendű időlépcsők alkalmazására. 
A hibák kereséséhez – ennek ellenére – célszerű „bármi áron” egy stabil megoldás-
hoz jutni, mert az már lehetővé teszi a hibakeresést. Amennyiben más mód nincsen, 
úgy végezzünk el egy alaphelyzetből induló nem permanens számítást akár 1 század- 
vagy ezredmásodperces időre, majd összevetve a kapott és az eredeti nyomásszinte-
ket, esélyünk van felfedezni az instabilitás kiindulópontját, azaz azt vagy azokat a 
cellákat, ahol a vízmérleg felborul. Amennyiben ezek a helyek megvannak, akkor 
célszerű az összes adott cellához vagy térséghez tartozó elemhez rendelt paramétert 
ellenőrizni.  
A hidrodinamikai számítások során jó megoldás, ha az adott térség vízmérlegét kü-
lön kiszámítjuk pl. MODFLOW használata esetén a „Waterbudget” programmal, 
majd a vízmérleg komponensei között kiugró értékeket próbálunk keresni. Általában 
egy jól kiválasztott modellrész vízmérlege elárulja, hogy milyen komponensek (pl. 
források és nyelők, felszíni vízből való betáplálás, maradó beszivárgás stb.) körében 
kell az instabilitás okát keresni. 
Amennyiben látszólag minden rendben van, akkor gondoljuk még egyszer végig az 
alkalmazott mértékegységrendszert, hiszen a modellezés során magunk döntünk ar-
ról, hogy mit használunk a hosszúság [L], az idő [T] és a tömeg [M] dimenziójaként, 
amiből azután minden egyéb paraméter dimenziója következik. Sokszor véletlenül 
következetlenül adjuk meg a paramétereket, pl. a maradó beszivárgást mm/évben 
szokták gyakorlati kezelhetőség miatt megadni, de ha ezt akarjuk használni, akkor a 
cellák méretét is mm-ben, a szivárgási tényezők értékét is mm/év dimenzióban, stb. 
kell megadni. Tekintettel arra, hogy a másodperc és a nap között a váltószám 86400, 
ezért a dimenzió-hibáknál sajnos könnyen véthetünk akár 5-7 nagyságrendben is hi-
bákat, ami a rendszer biztos instabilitásához vezet. 
A transzportszámításoknál még könnyebb mértékegység hibát véteni, mert az egyes 
kémiai komponensek határértékei és előfordulási koncentrációi általában nagyság-
rendekkel eltérők. Míg a nitrát, nitrit, ammónium, szulfát, stb. koncentrációit célsze-
rűen mg/l-ben mérjük, addig a vízben oldott szénhidrogéneket általában µg/l-ben 
szokás megadni. Ennek megfelelően, egyazon területen a számítás tárgyát képző 
szennyező komponensek függvényében eltérő lehet a megválasztott M tömegegység, 
azonban ekkor megváltoztatandók (vagyis a megfelelő tömegegységre átváltandók) a 
szorpciós paraméterek, a száraz térfogatsúly, stb. értékei. Ha ez elmaradt, akkor 
nagyságrendi hibát vétünk, ami ugyancsak eredményezhet instabilitást, a számítás 
eredményei pedig értelemszerűen rosszá válnak. 
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Ha minden dimenziót helyesnek találtunk, akkor célszerű izovonalas térképeken 
megjeleníteni a bemeneti modelladatokat; például rétegenként. Ellenőrizzük le, hogy  
– az értékekben észlelt ugrások mind zónahatárhoz kötődnek-e, 
– valamennyi elemhez rendeltünk-e értéket, 
– megfelelő-e az interpolálással kapott adatrendszer eloszlás, 
– az értékek reális tartományban mozognak-e. 
 
Különös figyelmet kell fordítani az állandó nyomásszintű cellákra, mert gyakori, 
hogy tévedésből vagy figyelmetlenségből egy vagy több állandó nyomású cellához 
nem rendelünk potenciál értéket (kezdeti feltétel), amit a legtöbb szoftver zérus érté-
kűnek tekint, és a szokásos magyarországi 80-120 mBf. szintek helyett 0 mBf. érték-
kel számol, ami nagy peremek felé irányuló hozamokat és a rendszer gyors leürülését 
okozza. 
Amennyiben zónákat alkalmazunk, akkor célszerű végignézni, hogy minden cella 
hozzá van-e rendelve valamelyik zónához, mert szinte minden program lehetőséget 
ad általános alakú zónák felvételére, amely zónákhoz rendelt értékeket maga írja be 
az egyes paramétereket tartalmazó mátrixokba. Amennyiben marad olyan elem, ame-
lyik nincsen egy zónához sem rendelve, az egy olyan szingularitás a rendszerben, 
ami okozhatja az iteratív számítás divergenciáját. 
A zónák alkalmazása esetén további hibalehetőség a zónahatárokon fellépő ugrássze-
rű változások kezelése. Példaképpen bemutatjuk a Siroki Talajvízbázis környezeté-
ben a hidrogeológus által megadott szivárgási tényező eloszlási koncepciót (ENGEO, 
1999). A koncepció mérési adatokon alapul, mégsem kedvező változtatás nélkül a 
modellbe illeszteni. Adott a keskeny folyóvölgy, ahol völgyirányú szivárgás van, 
ugyanakkor a völgyre merőleges szelvényben hirtelen szivárgási tényező-változások 
vannak. Ahol az áramlási keresztmetszettel együtt a szivárgási tényező is ugrássze-
rűen lecsökken, ott hirtelen nyomásszint-változások következnek be a számítás so-
rán, ami kedvezőbb esetben oszcillációhoz, de kedvezőtlenebb helyzetben instabili-
táshoz vezetnek (133. ábra). 
Ugyancsak numerikus hibákhoz vezetnek a modell belső ellentmondásai, például, ha 
a maradó beszivárgást olyan területrészen érvényesítjük, ahonnan a kis szivárgási 
tényező miatt oldalirányú vízmozgás csak kismértékben lehetséges, ennek a követ-
kezménye az adott területen messze a terepszintet meghaladó, akár több 10 000 m 
magasságban stabilizálódó nyomásszint lehet, ami egyrészt irrealitás, másrészt egyéb 
tényezőkkel együtt akár a modell instabilitását is okozhatja. 
Ugyancsak problémát jelenthet, ha egy-egy zónához hozzárendelt különböző vízföld-
tani paraméterek nincsenek összhangban egymással. Például egy kavicsos homokré-
teg szivárgási tényezőjéhez egy iszapra jellemző szabad hézagtérfogatot rendelünk 
stb. Ezek a hibák önmagukban általában nem vezetnek instabilitáshoz, de más 
modelladat-hibákkal együtt már sok kellemetlenséget okozhatnak. 
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133. ábra 

A Siroki Vízbázis talajvízadó rétegének szivárgási tényező-eloszlása (koncepció) 
(ENGEO, 1999) 

 
Összefoglalva az iteratív megoldás instabilitásának legfontosabb oka, hogy 
– vagy túl kevés anyag (víz vagy szennyezőanyag) lesz a rendszerben vagy annak 

egy kis részén, 
– vagy túlságosan sok anyag (víz vagy szennyezőanyag) tárolódik egy térségben, és 

onnan nincs mód annak eltávozására. 
 
A két lehetőség közül az első biztosan, a második csak egyéb tényezőkkel együttesen 
okozza az instabilitást. Amikor tehát a stabil modellrendszer kialakítására törek-
szünk, feltétlenül eldöntendő, hogy vajon az anyagmérlegben fennálló hiány vagy 
bőség vezet a számítás eredménytelenségéhez. 
Amennyiben nincs más mód az első stabil rendszer elérésére, akkor akár a valósá-
gostól eltérő adatokkal is próbálkozhatunk. A következő intézkedések a rendszer rep-
rezentativitásának csökkenését, ugyanakkor a stabilitásra való hajlam erősödését 
okozzák: 
– peremfeltételek lecserélése állandó nyomásszintű vagy koncentrációjú cellákra, 
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– GHB jellegű peremfeltételek esetén a CHGB arányossági tényező növelése, 
– pontszerű források és nyelők hozamának csökkentése, 
– szabad hézagtérfogat növelése, 
– konstans vízföldtani és szennyezőanyag-terjedési jellemzők felvétele, vagy az 

éles anyagi tulajdonságbeli ugrások átmeneti zónákkal való elsimítása, 
– maradó beszivárgás csökkentése vagy növelése a vízmérleg-egyensúly megbom-

lási irányától függően. 
 
Ha elkészült a kevésbé reprezentatív, legelső stabil verzió, akkor célszerű a koncep-
cionálisan indokolt változtatásokat lépésenként visszaépíteni a rendszerbe. Célszerű 
mindig lépésről lépésre haladni, azaz egyszerre csak egy tényező módosítását elvé-
gezni. Minden lépés után érdemes újrafuttatni a számítást, hogy kiderüljön, hogy mi 
az instabilitás okozója.  
Az itt felsoroltakat gyakorlott modellező csak igen ritkán alkalmazza, mert döntései 
során már az első modelladat-rendszer felépítésénél a legstabilabb numerikus megol-
dást eredményező lehetőségeket választja. Tudomásul kell ugyanakkor venni, hogy 
vannak olyan földtani környezetek, amelyeknél gyakrabban előfordul az instabilitás. 
Ilyenek: 
– a keskeny folyóvölgyek, 
– vékony vízadók, 
– kis szabad hézagtérfogattal rendelkező képződmények, 
– nagy hozammal termelő kutak és kútcsoportok. 
 
A felsorolt esetekben kicsi a rendszerben tárolt vízmennyiség, aminek következtében 
hamarabb borul fel a víz- vagy szennyezőanyag-mérleg egyensúlya. 
A numerikus oszcilláció esetén a numerikus megoldás oszcillál a valós megoldás 
körül, tehát a numerikus megoldás lépésenként váltakozva egyszer a valós megol-
dásnál kisebb, másszor annál nagyobb értéket ad anélkül, hogy a két megoldás közöt-
ti különbség csökkenne.  

Mellőzve a bizonyítást, az oszcilláció megszűnik, amennyiben ∆t és ω változókra 

(4.56. és 4.57. egyenletek) a 
ω

α
−

<∆
1

t  egyenlőtlenség teljesül, ahol α az a legkisebb 

szám, amelyet az alábbi egyenletbe behelyettesítve és a determinánst kifejtve a 
( )[ ] ( )[ ] 0=− ee DA α  egyenlőség bármely elemre teljesül. (FRIED, 1979). 

A transzportmodellek esetében a Neumann-kritériumnak is teljesülnie kell (5.63):  
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Amennyiben a megoldás oszcillál, akkor az időintegrálás során használt differencia-
képzéssel lehet a helyzeten változtatni. A középponti differenciák módszere (Crank-
Nicholson-módszer) erősen hajlamos az oszcillációra, ugyanakkor az előre és hátra-
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lépéses differenciák módszere kevésbé. Szinte valamennyi ismertebb programban 
van lehetőség a differencia-képzési mód megváltoztatására, próbáljuk ki! 
KÖNIG (1993) megállapította a SICK100 végeselemes, szuper-számítógépes, szi-
várgáshidraulikai és transzport-modell számításokra kifejlesztett programrendszer 
stabilitás-vizsgálata során, hogy a numerikus oszcilláció annál nagyobb mértékű, 
minél nagyobb az advektív transzportfolyamat jelentősége a diszperzív transzporthoz 
viszonyítva. Az erősebb oszcillációt a koncentrációcsúcsok elmosódása kíséri. Kü-

lönböző 
D

lvPe ∆
= , Peclet-számok mellett elvégezve azt a modellkísérletet, amikor a 

konstans sebességgel jellemezhető áramlási térben egy haranggörbe alakú koncentrá-
ció-impulzus terjed tova, jól látható volt, hogy a Peclet-szám növekedése mellett 
egyre nagyobb negatív koncentráció-értékeket kaptak a numerikus oszcilláció követ-
keztében, ami természetesen a valós rendszerben irreális (134. ábra).  
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134. ábra 

A végeselem módszer numerikus hibái a SICK100 programrendszeren: a koncentrá-
ció-eloszlás t=1000 s elteltével, harang alakú kiindulási koncentráció-impulzus, ál-

landó szivárgási sebesség esetén (a, különböző Peclet-számok , b, különböző 
Courant-számok esetén) 

(KÖNIG, 1993) 
 
Tekintve egy v szivárgási sebességű homogén teret, ahol az egyes elemekre eső 
áramvonal maximális ∆l hossza konstans (azonos elemekre való bontás) a ∆t időlép-
cső változtatása egyben a Courant-számok változtatását is jelenti. A növekvő 
Courant-számok esetén a valóságban éles határvonal egyre erősebben elmosódik, 
azaz a numerikus diszperzió fokozódik. 
FRIND (1982) szerint mind a numerikus diszperzió, mind az alálövés-fölélövés hiba 
megszüntethető, ha a Peclet-szám nem nagyobb, mint 2 (5.65.): 
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A numerikus (longitudinális és transzverzális) diszperzió jelenségének kiszűrésére  
több megoldás létezik. Magyarországon a pusztán advektív COMAD transzportmo-
dell esetén SZÉKELY (1986) alkalmazta az úgynevezett osztott blokkos (Method of 
divided blocks) eljárást. Az eljárás lényege, hogy az adott elem mentén a kémiai 
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anyagáramokat két részre osztjuk: egyfelől az egyik blokkba, a kiáramlási cellába 
összegezzük a kiáramló hozamokat, melynek Cki koncentrációja határozza meg az 
adott elemből elszivárgó oldat koncentrációját. Másfelől egy ún. beáramlási cellába 
gyűjtjük a laterális, keresztirányú és külső beszivárgásból eredő V víztérfogatokat és 
az azokhoz kapcsolódó W kémiai anyagmennyiséget. Amikor a V víztérfogat eléri az 
adott elem adszorpcióval korrigált effektív pórustérfogatát, akkor a kiáramlási cella 
Cki értéke felveszi W kémiai anyagmennyiségből és az effektív pórustérfogatból szá-
mított új koncentrációértéket, miközben a V és W regiszterek nullázódnak, és a fo-
lyamat kezdődik elölről.  
Teljesen általánosan tehát megállapítható, hogy a numerikus módszerrel végzett 
számítások pontosságának növelése érdekében az elemek számát növelni kell, 
ugyanakkor a numerikus hibák gyakorisága és nagysága is nő (KOVÁCS, 1998). A 
numerikus hibák megjelenése nem kerülhető el, mert általában egy hibatípus elimi-
nálása egy másik hibatípus megjelenését vonja maga után, ezért a numerikus hibák 
terén is meg kell találni azt az optimális szintet, amikor valamennyi numerikus hiba 
az elfogadható nagyságon belül van, amikor azok még a számítási eredményeket 
nem befolyásolják. 
A numerikus hibák megjelenítésének és számszerűsítésének a térinformatikában je-
lentős hagyományai vannak, melyeket TAMÁS és LÉNÁRT (2002) foglal össze. A 
paraméterhibák kiküszöbölése érdekében használandó mintavételezési stratégia 
meghatározási metodikáját TAMÁS (1999), TAMÁS és KOVÁCS (2002) ismerteti. 

15.1. táblázat 
Az egyes paraméterek megváltoztatásának hatása a modellnél fellépő numerikus hibákra 

Numerikus hibára való hajlam 
Paraméter változtatás 

instabilitás oszcilláció diszperzió alálövés-
fölélövés 

Előre- vagy hátralépéses 
differenciák alkalmazása nő csökken nem befolyásolja nem 

befolyásolja 
Középponti differenciák 

alkalmazása csökken nő nem befolyásolja nem 
befolyásolja 

Cella- vagy elemméret 
csökkentése nő nő nő nő 

Időlépcső növelése nő nő nem befolyásolja nem 
befolyásolja 

Szivárgási sebesség, 
transzmisszivitás növelése nő nő nő nő 

Források és nyelők 
hozamának növelése nő nő nem változik nem változik 

Tárolási tényező növelése csökken csökken nem befolyásolja nem 
befolyásolja 

Diszperzió-állandó, 
diszperzivitás növelése nő nő csökken csökken 
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16. Determinisztikus és sztochasztikus modellezés 

A sztochasztikus modellezés önmagában megérdemelne egy könyvnyi terjedelmet, 
ezért ebben a fejezetben csak a sztochasztikus megközelítés lényegével, illetve a 
Processing MODFLOW kezdetleges, de mégiscsak létező sztochasztikus modellezési 
képességeivel foglalkozunk. 
A kőzettestek hidrogeológiai jellemzői (porozitás, szivárgási tényező, talajvízszint, 
stb.) változóknak tekintendők: az adott tulajdonság térbeli változása teljes mértékben 
nem véletlenszerű, de nem is determinisztikus. Azaz a tanulmányozott paraméter 
értéke a tér adott pontjában nem független a környezetétől, hanem környezete vala-
milyen „térbeli szabályszerűség” szerint befolyásolja azt (DE MARSILY 1986). Ezt a 
fajta függőséget sztochasztikus kapcsolatnak, a jelenséget sztochasztikus folyamat-
nak nevezzük. 
A sztochasztikus modellezés statisztikai alapon kezeli a hidrodinamikai és transz-
portfolyamatokat. Tudjuk, hogy valamennyi mért paraméter változásának is van bi-
zonytalansága, sőt sokszor használunk olyan felvett paramétereket, melyek pontos 
eloszlását nem ismerjük, mégis „hisszük”, hogy az értéke szinte bizonyosan egy álta-
lunk feltételezett intervallumba esik. Például egy homokösszlet esetén, ha ismerjük 
annak a képződését, feltételezhetjük, hogy a szivárgási tényezője jellemzően a 0,2-
3,5 m/d tartományba esik, ugyanakkor pontról pontra nem ismerjük, nem ismerhet-
jük annak nagyságát. Ebben az esetben segít, ha a különböző hidraulikai, vízföldtani 
és transzportjellemzőket vagy azok egy részét olyan statisztikai változóknak tekint-
jük, amelyeknek valamilyen ismert diszkrét matematikai eloszlásuk van. Ilyenkor a 
paraméter vagy paraméterek eloszlását függvényekkel írhatjuk le. Sztochasztikus 
modellezés során a számítást ugyanakkor nem a függvényekkel végezzük el, hanem 
a függvények segítségével generált nagyszámú adathalmazon. Egy-egy a felvett 
függvények eloszlásai alapján számított adathalmazt realizációnak szoktak nevezni, 
és a számításokat 100, 500, vagy akár 1000 realizációval végzik el. Az eredményként 
kapott 100, 500 vagy 1000 eredményt statisztikai alapon dolgozzák fel: meghatároz-
zák, hogy pl. egy-egy elemben a kialakuló koncentráció mekkora valószínűséggel 
nagyobb egy adott (határ)értéknél, vagy milyen valószínűséggel ér pl. 50 éven belül 
a víz adott elemből egy kiválasztott kútig, stb. A sztochasztikus modellezés eredmé-
nye ezért nemcsak a legvalószínűbb koncentráció-eloszlást adja meg, hanem egyben 
jellemzi a rendszer bizonytalanságait is. 
Példaként vizsgáljuk pontszerű mérések eredményeit (pl. kutakban mért talajvíz-
szint).  
A sztochasztikus szimuláció során a paraméter mért értékeit normál eloszlású való-
színűségi változóknak tekintjük (k db mért talajvízszint esetén k db valószínűségi 
változó). A valószínűségi változók eloszlását egyértelműen meghatározza szórásuk 
és várható értékük. A szimuláció során ezen eloszlások várható értékeinek környeze-
tét véletlenszerűen jellemzi, azaz nem a mért érték, hanem annak eloszlása a megha-
tározó. Ezen eloszlások (mint valószínűségi változók) halmaza alkotja Z(x) valószí-
nűségi függvényt, ahol Z(x):={z(x1), z(x2),…,z(xk)}. 
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A Z(x) k db valószínűségi változóját egy k változós eloszlásfüggvény egyértelműen 
leírja:  
Fx1,x2,…,xk(z1,z2,…,zk)=P{Z(x1)<z1,Z(X2)<z2,…,Z(xk)<zk}    (16.1.) 
A Z(x) valószínűségi függvény térbeli törvénye tartalmazza az összes ilyen  eloszlás-
függvény halmazát. A térbeli törvény ismeretében terjeszthetjük ki a mintázott tulaj-
donságot a vizsgált térrészre (a térbeli törvény teljeskörű ismerete nem szükséges az 
adott szimulációs eljáráshoz) (GEIGER - MUCSI, 2005). 
A sztochasztikus szimuláció menete a következő (GEIGER, 2006): 
A gridháló generálását követően a mért értékek, mint valószínűségi változók egy-egy 
normáleloszlást generálnak, ezen eloszlásokból véletlenszerűen egy-egy értéket vá-
lasztunk ki. A mérési pontokkal szomszédos gridpontok közül egyet véletlenszerűen 
kijelöl a program és a valószínűségi függvény ismeretében meghatározza az adott 
pontban a vizsgált paraméter értékét. 
A következő lépésben a kapott értéket hozzáveszi az alapsokasághoz (k db), így már 
k+1 valószínűségi változó van, és az eljárást addig folytatja, míg az összes 
gridpontot be nem járta. Az egész eljárás annyiszor ismétlődik ahány realizációt létre 
akarunk hozni (általában 100-1000 közötti érték).  
Az egyes realizációk közötti különbség egyrészt a pontok mint valószínűségi válto-
zók eloszlásainak véletlen mintázásából, másrészt a gridháló eltérő bejárási útjából 
adódik.  
Ezzel szemben az eddig bemutatott determinisztikus modelleknél minden értéket 
meghatároztunk, vélelmeztük, hogy az adott helyeket a felvett értékek jól jellemzik, 
és ennek alapján az egyetlen, „igaz” eredményhez jutottunk. Kis túlzással azt lehet 
mondani, hogy a determinisztikus modell megfelel egy olyan egy-realizációs szto-
chasztikus modellezésnek, ahol a számítást valamennyi paraméter-eloszlás legvaló-
színűbb értékével végeztük el. A determinisztikus modell kevés információt ad a 
modell bizonytalanságaira, ezért szokás a 14. fejezetben bemutatott alapadat-
érzékenységi vizsgálatokat elvégezni. Ennek ellenére az eredmény bizonytalanságait 
a sztochasztikus modellezéssel jobban meg lehet jeleníteni. 
Egy további probléma lehet a modellek eredményeinek értelmezése. A jelenlegi mű-
szaki és jogi szemlélet a determinisztikus modellezést részesíti előnyben; nem tud a 
jelenlegi jogrend egy olyan állítással mit kezdeni: hogy egy pontban a koncentráció 
85%-os valószínűségi szinten kisebb lesz a szennyezettségi határértéknél. Függetle-
nül attól, hogy ez a megközelítés sokkal jobban írja le a valóságot, mégis a követel-
mény – egyelőre – az, hogy mondjuk meg: meghaladja-e vagy nem a kialakuló kon-
centráció a határértéket. Természetes, hogy attól a modell reprezentativitása nem vál-
tozik, hogy áttértünk a sztochasztikus rendszerről a determinisztikusra, ennek megfe-
lelően egy determinisztikus modell ugyanúgy tartalmazza a bizonytalanságokat, mint 
a sztochasztikus csak itt „elhallgatjuk” azokat. A jövő mindenképpen a sztochaszti-
kus modellezésé, a kérdés, hogy megtaláljuk-e a bizonytalanságok közvetlen jogi 
kezelésének módját, vagy megkapják-e a földtani és vízföldtani szakemberek azt a 
lehetőséget, hogy valószínűség-elméleti alapon számított eredmények értékelésével a 
hatályos jogszabályok szellemében járjanak el. 
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A Processing MODFLOW a sztochasztikus modell-adatrendszerek építését a Field 
Generator nevű eszközzel támogatja (135. ábra), ami a Tools menüből érhető el. A 
Field Generator egy adott modellhez a felhasználó által megadott számú szivárgási 
tényezőt vagy transzmisszivitás-adatrendszert állít elő (realizációk!). Ehhez szüksé-
ges megadni a kimeneti állományok nevét pl. FIELD, és akkor a rendszer az egyes 
realizációkat a FIELD.1, FIELD.2, …, FIELD.N névre menti el, ahol n a realizáci-
ók száma (Number of Realizations [1 to 999]). Az állomány neve ne legyen azonos 
a PM modell nevével, mert akkor a készített állományok némelyike fontos modell 
állományt írhat felül! 
A Field Generator feltételezi, hogy a keresett paraméter eloszlása lognormális, azaz 
az értékek tízes alapú logaritmusai normál-eloszlásúak. A generálandó adatok átlag-
értékét a Mean Value (log10)[-30 to +30] mezőben, szórását a Standard Deviation 
(log10) [0 to 30] mezőben állíthatjuk be. 
A generálandó sorok (Number of Rows [2 to 500]) és oszlopok (Number of 
Coloumns [2 to 500]) számát a futó modellből a program átveszi, de a megfelelő 
mezőkben be is állítható. A Correlation Length/Field Width mezőben adhatjuk meg 
az adatok sor- és oszlopirányú változékonyságát, a krigelésnél bemutatott hatástávol-
ság (Correlation Length) és a modellezett térrész nagyságának (Field Width) hánya-
dosaként.  
 

 
135. ábra 

A Field Generator dialógusablak 
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17. Modellezési praktikum (példamodellek) 

A következőkben néhány egyszerűbb probléma modellezéssel való megoldását mu-
tatjuk be. 

17.1. Az első modell (\app\perm_mdl) 

A feladat legyen egy két vízadó szinttel jellemzett területrész permanens állapotú 
hidrodinamikai modelljének elkészítése. A két vízadó szint (felső homok és alsó ho-
mokos kavics) között iszapos féligáteresztő összlet található. A területet a 136. ábra 
mutatja be, a képződmények geometriai adatait az ALAPADATOK.XLS állomány 
tartalmazza. Az Excel állományban megtalálhatók a fúrások EOV koordinátái, a te-
repszintek-magasságok, illetve a fúrásokban észlelt réteghatárok, azaz a felső homo-
kos összlet, a köztes, féligáteresztő iszapos képződmények, illetve az az alatt találha-
tó kavicsos összlet feküszintjeinek terepszint alatti mélysége. 
Először célszerű az adatállományt kicsit átalakítani. Számítsuk ki az egyes réteghatá-
rok tengerszinthez viszonyított magasságát! Ehhez értelemszerűen a terepszintből 
kivonandók a feküszintek megadott értékei. A feladatot elvégezhetjük bármilyen táb-
lázatkezelőben, pl. az Excelben is, vagy használhatjuk a Surfer Data → Transform 
parancsát is. Előbb nyissuk meg az alapadat-állományt a File → Open paranccsal, 
majd használjuk az említett Data → Transform utasítást, jelöljük ki az egyik oszlo-
pot, majd pl. a homokok réteghatárainak tszf. magasságának meghatározásához a 
Transform Equation mezőbe írjuk be, hogy I=D-E, ekkor az I oszlopban megjelen-
nek a számított értékek. Hasonlóképpen számítsuk a többi réteghatár tengerszint fe-
letti magasságait is! A kész állományt mentsük el ALAPADATOK2.XLS névre! 
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136. ábra 

A vizsgált terület térképe 
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Két jó tanács! Egyrészt az alapadat-állományt célszerű megtartani abban a formában, 
ahogy azt kaptuk. Lehet, hogy a munka során tévedésből elrontunk valamit, és akkor 
mindig jó visszatérni az eredeti állományhoz. Másrészt bizonyos esetekben nem cél-
szerű áttérni tengerszint feletti magasságokra, mert ha kevés az adat, akkor a rétege-
ket elválasztó, általunk számított térfelületek metszhetik egymást (76. ábra és 77. 
ábra). Ennek elkerülésére célszerű lehet a rétegek vastagsági térképeit előállítani, 
majd azokat az aktuális fedőszintből kivonva meghatározni a feküszinteket. Ameny-
nyiben a vastagsági térkép csak pozitív értékeket tartalmaz, akkor a képzett elválasz-
tó felületek sem fogják metszeni egymást! 
Ezután használjuk a Surfert a térfelületek előállítására, majd ezt követően a térfelüle-
teket a Surfer grid állományból vigyük át a PM modellezési környezetbe a 12.4.5. 
fejezetben leírt módszerrel. 
A grid állományok létrehozásához használjuk a Surfer Grid → Data parancsát, úgy, 
hogy az EOV Y=550000-553500 és EOV X= 150000-152500 koordinátákkal hatá-
rolt területre 25x25 m-es rácshálót illesztünk. A paraméterek térbeli eloszlásának 
meghatározásához használjuk a radiális bázisfüggvény módszert (Gridding Method: 
Radial Basis Function) az alapbeállításokkal (137. ábra). A készített állományok 
nevei legyenek: TEREP.GRD, HOMOKFEKU_MBF.GRD, ISZAPFEKU_-
MBF.GRD és KAVICSFEKU_MBF.GRD. A talajvízdomborzatot számítsuk a mi-
nimális görbület módszerével ugyanerre a területre a 25 m-es osztású rácshálóval 
(TVSZ.GRD). 
 

 
137. ábra 

A Grid → Data parancs beállításai 
 
A Surfer grid állományoknak a modellben történő felhasználásához először konver-
táljuk a GRD állományokat azonos nevű DAT állományokká a Grid → Convert 
paranccsal! Ezután keverjük őket véletlenszerűen össze. Nyissuk meg a DAT állo-
mányokat egyesével, a D oszlophoz rendeljünk egy véletlenszámot (Data → 
Transform parancs), rendezzük sorba a D oszlop szerint a sorokat (Data → Sort 
parancs), töröljük az adatokat a 2001. sortól (Edit → Delete parancs) majd szúrjunk 
be egy üres sort az elejére (Edit → Insert parancs), és írjuk az A1 mezőbe az adatok 
számát: 2000. Mentsük az állományokat egy új névre: PM_TEREP.DAT, 
PM_HOMOKFEKU_MBF.DAT, PM_ISZAPFEKU_MBF.DAT, PM_KAVICS-
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FEKU_MBF.DAT és PM_TVSZ.DAT. Mivel a lépéseket a 12.4.5. fejezetben rész-
letesen leírtuk, ezért itt csak röviden foglaltuk össze a tennivalókat. 
Az adatrendszer előkészítése után lássunk hozzá a modellépítéshez. Implicit módon 
már az első döntést meghoztuk, hiszen eldöntöttük, hogy a modell az EOV 
Y=550000-553500 és EOV X= 150000-152500 koordinátákkal határolt területen 
belül lesz, mivel erről a területről állnak rendelkezésre ismeretek. Az egyszerűség 
kedvéért legyen a modellezett terület a teljes ismert térrész, azaz a modell legyen 
3.5x2.5 km méretű.  
Mielőtt létrehoznánk a modellt, készítsünk egy alkönyvtárat részére 
(\APP\PERM_MDL\MDL), majd itt hozzunk létre egy új modellt ELSO.PM5 néven 
a File → New Modell… paranccsal (138. ábra) 
 

 
138. ábra 

Az elso.pm5 modell létrehozása 
 
Ezután fedjük le a területet 25x25 m-es elemekkel, amihez definiáljunk elemeket 100 
sorban, 140 oszlopban és 3 rétegben a Grid → Mesh Size paranccsal. Azonnal állít-
suk be a modellezési koordinátarendszert is úgy, hogy a képernyőn a modellezett 
térrészen kívüli 100 m széles sáv is látható legyen (139. ábra) 
A beállításokat ellenőrzendő hívjuk be a DXF alaptérképet (ALAPTERK.DXF) a 
modellbe az Options → Maps paranccsal. (A DXF állományt a 12.4.2. fejezetben 
leírtak szerint készítettük el). Ekkor a képernyőn megjelennek a fúrások, a kutak, a 
folyó és a szivárgó nyomvonala (140. ábra). 
Lépjünk ki a Grid Editor ablakból a File → Leave Editor paranccsal, majd sűrítsük 
a rácshálót a kutak környezetében. A kutak helyét és hozamát a KUTAK.DAT állo-
mány tartalmazza. A sűrítéshez ismét válasszuk a Grid → Mesh Size parancsot, vá-
lasszuk ki a kutat tartalmazó elemeket, és a jobb egérgombbal adjuk meg a sűrítés 
(Refinement) mértékét. Legyenek a sűrített helyen az elemek 5x5 m-esek és közvet-
lenül mellettük 12.5x12.5 m-es elemeket alkalmazzunk. Lépjünk ki a Grid Editor 
ablakból a File → Leave Editor paranccsal, közben mentve a rácshálót. 
A File → Layer Properties menüben a felső réteget nyílt tükrűnek (Unconfined) a 
másik két réteget zárt tükrűnek (Confined) definiáljuk. 
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139. ábra 

A rácsháló és a koordinátarendszer beállításai 
 

 
140. ábra 

A modell elemosztása az alaptérképpel 
Ezt követően adjuk meg a peremfeltételeket a Grid → Boundary Conditions  → 
IBOUND (MODFLOW) paranccsal. Az egyszerűség kedvéért alkalmazzunk állan-
dó nyomású peremeket a modell határain. Mivel a területen egy a felső vízadóval 
kapcsolatban álló folyó halad keresztül, ezért a folyó környezetében nem használunk 
peremfeltételeket, ezen a területrészen ugyanis a folyó határozza majd meg az ele-
mek vízmérlegét. A második rétegben a szivárgás uralkodóan vertikális, azaz a hori-
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zontális szivárgás elhanyagolható, ezért itt sincs értelme állandó nyomású cellákat 
definiálni. A harmadik rétegben a modell peremein viszont célszerű és egyben szük-
séges is a peremfeltételeket megadni. Az egyes cellák állandó nyomásúvá változtatá-
sa érdekében a cella értékét 1-ről változtassuk -1-re a jobb egérgomb segítségével, 
majd a megadott értéket a másológomb segítségével célszerű a többi, korábban felso-
rolt peremi cellába is átmásolni (142. ábra). 

 

 
141. ábra 

A rácsháló sűrítése 
 

  
142. ábra 

Az állandó nyomású cellák helye az 1. és a 3. rétegben 
 
Ezután adjuk meg az egyes modellrétegek elválasztó felületeit. A korábban készített 
PM_*.DAT állományokból a Field Interpolator segítségével határozzuk meg a ké-
szített rácsháló elemei helyén a legvalószínűbb értékeket. Mivel sok, pontosan 2000 
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pont áll rendelkezésünkre, ezért gyakorlatilag mindegy, hogy melyik módszerrel tör-
ténik a számítás. Célszerű azonban valamennyi felületet azonos módon generálni. Mi 
a példában a Renka-módszert alkalmaztuk, kvadráns kereséssel a legközelebbi szek-
toronkénti 1 pontból (Gridding Method: Renka Triangulation, Search method: 
Quadrant, Data per Sector: 1). Amennyiben a Renka-módszer – általában memória-
hiány miatt nem indulna el – nyugodtan használjuk az Akima-módszert (Gridding 
Method: Akima’s Bivariate). 
Jó tanács! Célszerű mindenkinek a saját maga állomány-elnevezési rendszerét kita-
lálnia. A modellezés során rengeteg állomány készül, és ezek között csak „szigorú 
rendet tartva” lehet majd később is eligazodni. Mi a példánkban és az életben is az 
interpolálásra előkészített állományokat PM*.DAT néven, az interpolálás révén ka-
pott mátrixokat PMX*.DAT néven neveztük el. Ez azért fontos, mert ha véletlenül 
szükségessé válik az elemosztás későbbi megváltoztatása, pl. az elemek sűrítése, ak-
kor a korábbi mátrixok hasznavehetetlenné válnak (így az összes PMX*.DAT töröl-
hető és törlendő), miközben a PM*.DAT állományok minden új hálónál a számítások 
kiindulópontjai lehetnek. Főképpen akkor nagy segítség az értelmes állománynév-
rendszer, ha hónapok vagy évek múltán kell egy korábbi modellhez visszatérni, mert 
addigra szinte minden más „kapaszkodó” feledésbe merül…  
Indítsuk el a programot a Tools → Field Interpolator paranccsal, majd ellenőrizzük 
a modell nevét és adjuk meg a korábban említett beállításokat (143. ábra). 

  
143. ábra 

A Field Interpolator beállításai 
 

Az elkészült állományokat a Grid → Aquifer Top és a Grid → Aquifer Bottom 
menüvel elérhető mátrixokba kell beolvasni. A PMX_TEREP.DAT állomány az 1. 
réteg fedője, a PMX_HOMOKFEKU_MBF.DAT állomány a 2. réteg fedője, egyben 
az 1. réteg feküje, stb. (17.1. táblázat). 
A beolvasást a Grid Editor Value → Matrix parancsával tehetjük meg (144. ábra). 
Ezzel a modell geometriáját meghatároztuk, a következőkben a vízföldtani tulajdon-
ságok megadásával foglalkozunk. A vízföldtani tulajdonságok megadásához szükség 
van az idő dimenziójának megadására, amit a Parameters → Time paranccsal tehe-
tünk meg. Legyen az idő dimenziója nap [d], ennek megfelelően a szivárgási ténye-
zőt és a maradó beszivárgást m/d, a kutak hozamait m3/d dimenzióban kell megadni. 
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Válasszuk hát ki a Simulation Time Unit mezőben a Days opciót, továbbá perma-
nens modellről lévén szó a Simulation Flow Type mezőben válasszuk a Steady-State 
opciót. Az OK gombbal hagyjuk el a Time Parameters dialógusablakot. 

17.1. táblázat 
A fedő és feküállományok megadása 

Réteg Aquifer Top (fedő) Aquifer Bottom (fekü) 
1. réteg: homok PMX_TEREP.DAT PMX_HOMOKFEKU_MBF.DAT
2. réteg: iszap PMX_HOMOKFEKU_MBF.DAT PMX_ISZAPFEKU_MBF.DAT 

3. réteg: homo-
kos kavics PMX_ISZAPFEKU_MBF.DAT PMX_KAVICSFEKU_MBF.DAT 

 

 
144. ábra 

A réteghatár magassági adatokat tartalmazó mátrixok beolvasása 
 
Ezután olvassuk be a kezdeti feltételként szolgáló talajvízszint-értékeket a 
Parameters → Initial Hydraulic Heads menü segítségével. Valamennyi rétegben 
tételezzük fel, hogy azonos a nyomásszint-eloszlás, ezért mindhárom mátrixba olvas-
suk be a TVSZ.GRD átalakításával készített PM_TVSZ.DAT állományból a Field 
Interpolatorral számított PMX_TVSZ.DAT mátrixot! Amennyiben az állományokat 
izovonalas térképen ábrázoljuk (Options → Environment menü Contours lap 
Visible mező, 145. ábra) látható, hogy a talajvíz áramlása KÉK-NyDNy-i, a horizon-
tális hidraulikus gradiens kb. 0.6 m/4300 m= 0,14 m/km. Ne felejtsük el, mindhárom 
rétegbe behívni a mátrixot a Value → Matrix parancsot követően a Load gomb 
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megnyomásával, majd ha végeztünk, akkor a File → Leave Editor paranccsal tér-
jünk vissza a főmenübe. 
Ezt követik a szivárgási tényezők. A területről információ a folyótól délre eső terület 
kútjaiból áll rendelkezésre próbaszivattyúzási adatok formájában, illetve a kutatás 
során a folyótól északra is történt három kútban próbaszivattyúzás. A kapott adatok 
alapján a folyótól É-ra kissé iszaposabb kifejlődésűek a vízadók, ezért célszerűen a 
folyótól É-ra és D-re eső területeket eltérő hidraulikai paraméterekkel jellemezhetjük 
(17.2. táblázat). 

 
145. ábra 

A nyugalmi nyomásszintek [mBf.] beolvasása és térképe 
 

17.2. táblázat 
A modellben alkalmazott vízföldtani paraméterek 

Szivárgási tényező [m/d]  Réteg 
horizontális vertikális 

Szabad 
hézagtérfogat [-] 

Folyótól északra eső területrész 
1. homok 0,8 0,4 0,11 
2. iszap 0,02 0,01 0,07 

3. homokos kavics 15 5 0,22 
Folyótól délre eső területrész 

1. homok 2,5 0,8 0,13 
2. iszap 0,02 0,01 0,07 

3. homokos kavics 25 8 0,25 
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A vízföldtani paramétereket zónák segítségével adjuk meg. Ehhez először nyissuk 
meg bármelyik paraméter Grid Editorát (mi a horizontális szivárgási tényező ablakát 
választottuk erre a célra: Parameters → Horizontal Hydraulic Conductivity)! Az 
egyszerűbb rajzolás érdekében váltsunk a „ValóVilág” üzemmódba: Options → 
Display Mode → Real-World. Ennek az az előnye, hogy a zónákat nyugodtan a 
modell határán túl is kijelölhetjük, így biztosítva, hogy minden cella a két zóna terü-
letére essék. (Alapvető és nehezen észrevehető hiba, amikor a zónák nem fedik le 
teljesen a modellezett területet, ami miatt egyes, a zónákon kívül található cellákban 
a szivárgási tényező zérus marad. A hiba elkerülése végett javasoltuk a környezet 
beállításakor, hogy a képernyőn maradjon körben egy szabad, 100 m széles sáv, amit 
ilyenkor jól lehet használni!) Ezután váltsunk a zóna üzemmódba (Options → Input 
Method → Zones) és a 8.3. fejezetben leírtak szerint rajzoljuk meg a két zónát. A 
zónákhoz rendeljük hozzá az értéket az 1. modellrétegben a „>>” feltöltőgomb segít-
ségével (146. ábra). Végül a készített zónákat mentsük el a Value → Zones → Save 
As paranccsal VIZFOLDTAN.ZON néven. 

 
146. ábra 

A vízföldtani paraméterek zónái és értékadás a zónákhoz 
 
A második rétegben állandó minden vízföldtani paraméter, ezért ezeket a Value → 
Reset Matrix paranccsal adjuk meg, a homokos kavics rétegbe előbb hívjuk be a 
korábbi zónákat a Value → Zones → Load paranccsal, majd rendeljük hozzá a 17.2. 
táblázatban felsorolt értékeket. Ezután a Grid Editorból lépjünk ki a File → Leave 
Editor paranccsal, majd ugyanígy járjunk el a függőleges szivárgási tényezők 
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(Vertical Hydraulic Conductivity) és a szabad hézagtérfogat (Effective Porosity) 
megadásánál. 
A szivárgó modellbe illesztéséhez futtassuk a Models → MODFLOW → Drain 
parancsot (lásd 8.2.2.fejezet). A területen található T-alakú szivárgót 97.5 mBf. 
magasságban képezték ki. A drén körül kavicsos homok szivárgótestet képeztek ki, 
aminek szivárgási tényezője 5 m/d. A szivárgót két paraméterrel jellemezzük a 
MODFLOWban, a drén fektetési magasságával (Elevation of the Drain) és az ekvi-
valens szivárgási tényezővel, ami a drén elembeli hosszának és a szivárgótest szivár-
gási tényezőjének a szorzata. Az egyszerűsítés kedvéért most tételezzük fel, hogy a 
normál méretű elemekben 25 m, sűrített elemeknél 12.5, illetve 5 m a szivárgó ele-
men belüli hossza, ennek megfelelően az ekvivalens szivárgási tényező 125, 62.5, 
illetve 25 m2/d. Az első rétegben található, a szivárgó területére eső, egyes elemek-
hez rendeljük hozzá a megfelelő értékeket, kihasználva a Grid Editor értékmásoló 
gombját! Az értékadás után lépjünk ki a File → Leave Editor paranccsal. 
A maradó beszivárgás becsült értéke a területen 20 mm/év, ami átszámítva 5.5·10-5 
m/d értéknek felel meg. Futtassuk a Models → MODFLOW → Recharge paran-
csot (lásd 8.2.5.fejezet). A beszivárgás teljes területen történő megadásához használ-
juk a Reset matrix parancsot, és adjuk meg, hogy a beszivárgás 5.5·10-5 m/d értékű 
(Recharge Flux [L/T]: 5.5e-5), illetve válasszuk ki, hogy a beszivárgás az első mo-
dellréteget érinti (Recharge is only applied to the top grid layer). Az értékadás után 
lépjünk ki a File → Leave Editor paranccsal. 
A folyó modellbe illesztéséhez futtassuk a Models → MODFLOW → River paran-
csot (lásd 8.2.3.fejezet). A folyó vizsgálatával megállapították, hogy a területen a 
folyó vízállása jellemzően az átlagos talajvízszint alatt 25 cm-rel van, az átlagos 
vízmélység 2 m. A paraméterek alapján a folyó a felső, homokos összlettel van hid-
raulikai kapcsolatban. A mederfenék vizsgálatok alapján a kolmatált zóna vastagsága 
0,8 m szivárgási tényezője 0.04 m/d. Ennek alapján a mederkapcsolati hatásfokot 
jellemző b=k/m átszivárgási tényező 0.04 m/d / 0.8m = 0.05 d-1, amit az egyes folyó-
cellák területével szorozva megkapjuk CRIV paramétert. Ennek megfelelően a cel-
lamérettől függően a CRIV értéke 31.2 és 0.25 m2/d között változik. Az eltérő mére-
tű cellákhoz rendeljük hozzá a 31.2, 15.6, 7.8, 6.2, 3.1, 0.25 m2/d értékeket a 
Hydraulic Conductance of the Riverbed mátrixban. Mentsük el a kapott mátrixot 
PMX_CRIV.DAT néven!  
Ezután állítsuk be a vízállás értékeket, amelyek 25 cm-rel alacsonyabbak a talajvíz-
szintnél. Ehhez hívjuk be a Head in the River mátrixba a talajvízszint értékeket 
(PMX_TVSZ.DAT) majd a Value → Search and Modify paranccsal (147. ábra) 
valamennyi értékből vonjunk ki 0,25 m-t (Parameter: Head in the River, Minimum: 
0, Maximum: 555, Value: -0.25, Option. Add). Mentsük el a kapott mátrixot 
PMX_HEADRIVER.DAT néven! 
Állítsuk be a mederfenék-szinteket, melyek 2 m-rel mélyebben vannak a vízállásnál. 
Ehhez hívjuk be a Elevation of the Riverbed Bottom mátrixba a vízállás értékeket 
(PMX_HEADRIVER.DAT) majd a Value → Search and Modify paranccsal vala-
mennyi értékből vonjunk ki 2 m-t (Parameter: Elevation of the Riverbed Bottom, 
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Minimum: 0, Maximum: 555, Value: -2, Option. Add). Mentsük el a kapott mátri-
xot PMX_RIVERBOTTOM.DAT néven! 
Megjegyzés: A minimum és a maximum érték bármekkora lehet, az értékek felvéte-
lével csak arra törekedtünk, hogy valamennyi cellaérték az intervallumba essék. 

 
147. ábra 

A Search and Modify parancs használata 
 

A kutak modellbe illesztéséhez futtassuk a Models → MODFLOW → Wells paran-
csot (lásd 8.2.1. fejezet). A kutak hozamát a KUTAK.DAT állomány tartalmazza. Az 
1. és 3. modellrétegbe írjuk be a megfelelő cellákba kúthozamokat (17.3. táblázat), 
figyeljünk, hogy a kitermelt vízmennyiségeket negatív számok jelzik! 

17.3. táblázat 
A vízkivételek adatai 

EOV Y EOV X Kút neve Qhomok[m3/d] Qkavics[m3/d] 
550984.67 151087.78 K-1 0 30 
551304.94 150738.39 K-2 20 20 
551953.80 150781.83 K-3 15 20 
552244.96 151054.50 K-4 0 30 
551579.46 151216.72 K-5 0 30 
551957.96 151395.57 K-6 15 20 
551492.11 151520.51 K-7 0 20 
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Ezután futtassuk a modellt a Models → MODFLOW → Run paranccsal. A bizton-
ság kedvéért az Options menüben valamennyi jelölőnégyzetet jelöljük be. Ekkor a 
rendszer elvégzi az adatállomány formai ellenőrzését, és elkészíti a MODFLOW ál-
lományokat. Ezután az \APP\PERM_MDL\MDL könyvtárban keressük meg a 
MODFLOW.BAT állományt és kétszer ráklikkelve futtassuk le a programot. 
Jelenítsük meg a kialakuló depressziós teret! A Tools → Presentation menüben 
használjuk a Result Extractort (Value → Result Extractor) és hívjuk be a számított 
potenciálértékeket előbb az első, majd a harmadik rétegbe (Result Type: Hydraulic 
Head, Layer: 1, illetve 3). A beállítás után nyomjuk meg a Read, Apply és a Close 
gombokat (a Result Extractor használatát lásd 12.4.6.2.5. fejezetnél). 
Rajzoljuk ki a depressziós teret az Options → Environment parancsban található 
Contours lap megfelelő beállításával (148. ábra)!  
Rajzoljuk meg a kutakhoz futó áramvonalakat a PMPATH programmal (Models → 
PMPATH (Pathlines and Contours)) ! Az eszköz használatát a 8.6. fejezet részle-
tesebben tárgyalta. Most minden kút szűrőzött szakaszától indítsunk 4 m sugarú hen-
gerpaláston öt mélységszintről 29-29 db vízrészecskét 1 hónapos lépésközzel az 
áramlási iránnyal szemben (149. ábra). 
A számított áramvonalakon jól látszik, hogy a szivárgórendszer által keltett depresszió 
miatt a kutak utánpótlódási területe „kikerüli” a drénezett területrészt (150. ábra). 

 
148. ábra 

A homokrétegben kialakuló potenciálfelület 
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149. ábra 

A vízrészecskék megadása 
 

 
150. ábra 

A kutakig számított 30 napos áramvonalak 
 

17.2. Az első modell finomítása (\app\perm_mdl2 könyvtár) 

Az ELSO.PM5 nevű modellünk bár működőképes mégis van még rajta mit finomí-
tani. Egy ilyen lehetőség a kemény peremfeltételek megváltoztatása úgy, hogy az 
állandó nyomású cellák helyett GHB (General Head Boundary) típusú peremeket 
alkalmazunk. A GHB cellákat a 8.2.4. fejezetben mutattuk be. A General Head 
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Boundary lényege, hogy a peremen ki- és beáramló vízmennyiség arányos az aktuá-
lis és egy előírt vízszint eltérésével, azaz: 

)( hhCQ GHBGHBGHB −⋅= ,         (17.1.) 

ahol QGHB a hozam, hGHB az előírt (Head on the Boundary), h az aktuális vízszint és 
CGHB a perem erősségét jelző mérőszám (GHB Hydraulic Conductance): 

0L
AkCGHB
⋅

= ,          (17.2.) 

ahol k a réteg vízszintes szivárgási tényezője, A a szivárgás irányára merőleges felü-
let nagysága az elemben és L0 a perem távolsága az állandó nyomásúnak feltételezett 
határtól.  
A GHB perem egy olyan cella, ami úgy működik, mint egy állandó, hGHB nyomású 
cella, ami a GHB cellától L0 távolságra van. 
Az első modellünket másoljuk egy másik könyvtárba, hogy a korábbi modell érintet-
lenül maradhasson meg. Mi az \APP\PERM_MDL2 könyvtárba másoltuk át az ösz-
szes állományt. A könyvtáron belüli MDL alkönyvtárban található a PM modell. 
Először az állandó nyomású peremeket távolítsuk el: A Grid → Boundary 
Condition → IBOUND (Modflow) menün belül valamennyi -1 értéket írjunk vissza 
1-re. Legegyszerűbben a Value → Reset Matrix paranccsal tehetjük ezt meg, mivel 
a modellben a változtatás után kizárólag aktív cellák lesznek, ezért valamennyi cella 
értéke 1. 
Ezután a Modell → MODFLOW → General Head Boundary parancsot hajtsuk 
végre. A Grid Editorban valamennyi GHB cellához hozzá kell rendelni egy tartani 
szándékolt vízszintet, ami esetünkben a kezdeti feltételnek megfelelő vízszint és a 
perem erősségét befolyásoló tényezőt. Gyengítsük a peremeket annyira, hogy azok 
megfeleljenek egy 1 km távolságra eső állandó nyomású peremnek. Az egyszerűbb 
celladefiníció érdekében használjunk átlagos szivárgási tényező értékeket: a homok 
átlagos szivárgási tényezője 1.5 m/d, a homokos kavicsé 20 m/d. A homokréteg telí-
tett vastagsága 5-6 m, a kavicsé 12-13 m. Ennek megfelelően a perem erőssége 25 m 
szélességű cella esetén a homokban kb. 0,2 m2/d, a kavicsban kb. 6 m2/d. A kisebb 
elemekben az érték elvileg kisebb, azonban könnyen belátható, hogy néhány sűrítés 
miatt kisebb elem csak a perem közvetlen közelében módosítja a nyomásszinteket, 
ezért első közelítésként nyugodtan használhatunk állandó CGHB értékeket. 
Először írjuk hát be a peremi cellákba a homokrétegre vonatkozóan 0,2 m2/d, a ka-
vicsra 6 m2/d „vezetőképesség” értékeket (GHB Hydraulic Conductance mátrix). 
Ezután rendeljük a határhoz a PMX_TVSZ.DAT mátrixban tárolt nyomásszint érté-
keket (Head on the Boundary mátrix, 151. ábra). 
Végül lépjünk ki a Grid Editor ablakból a File → Leave Editor paranccsal. 
Amennyiben lefuttatjuk a modellt (Models MODFLOW Run) akkor a 152. ábra sze-
rinti áramképet kapjuk. Bár az áramkép most nem sokat változott, az új modellben 
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pl. egy a modellperem közelébe telepített kút esetén az áramkép és a hatóterületek 
számottevően megváltoznának. 

 
151. ábra 

A GHB peremek megadása 
 

 
152. ábra 

A GHB cellákkal kiegészített modellel számított áramvonalak és a potenciálfelület 
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Bővítsük egy további elemmel a modellt. A modellezett terület középső a 
termelőkutakkal körbezárt részén a kavics feküjéig mélyített résfalas határolás ké-
szül. A résfal nyomvonalát a RESFAL.DXF állomány tartalmazza. A résfal vastag-
sága 20 cm, az elérendő szivárgási tényező 5·10-8 m/s, azaz 0,0043 m/d. A résfal k/m 
átszivárgási tényezője 0,0043 m/d /0,2 m = 0,0216 d-1.  
A résfalat a Horizontal Flow Barrier csomaggal illeszthetjük a modellbe. A HFB 
csomag jellegzetessége, hogy minden cellának egy oldalához lehet mindösszesen a 
vízszintes szivárgást csökkentő elemet rendelni, ennek megfelelően a sarokpontoknál 
a két illeszkedő vonalat két cellához kell hozzárendelni. 
A cellák résfallal határolt oldalát a Barrier Direction (1-4) mezőbe kell beírni, ahol 
az oldalak sorszámozását a dialógusablakban látható rajz szemlélteti. A fal vízzáró-
ságát a (Hydraulic conductivity / Thickness) of the Barrier mezőbe kell beírni, ami 
esetünkben 0,0216 d-1.  
A résfalat – tekintettel arra, hogy a kavics feküjébe van bekötve – mindhárom réteg-
be át kell másolni, célszerűen a rétegmásoló gomb benyomását követően a Page 
Down billentyű kétszeri megnyomásával. 
Ezután futtassuk újra a modellt a Modell → MODFLOW → Run paranccsal. A 
kapott eredményeket a 153. ábra szemlélteti.  

 
153. ábra 

A résfallal kiegészített modellben kialakuló depresszióstér és az áramvonalak 
 

17.3. Vízmérleg meghatározása (a Water Budget program használata) 

A feladat legyen a felépített modellben a drén permanens hozamának a meghatározá-
sa, majd a teljes rendszer, illetve a folyótól délre található területrész homokos víz-
adója vízmérlegének a kiszámítása. A vízmérleg elemeinek meghatározására a Water 



178 

Budget program szolgál, aminek bemutatásával az első kötet egyik jelentős mulasz-
tását is pótoljuk egyben. 
A program a Tools → Water Budget… paranccsal indul el, és egy dialógusablakot 
jelenít meg (154. ábra). Az ablakban előbb definiálni kell a Time mezőben, hogy 
melyik periódus, melyik időlépcsőjének vízforgalmát (lásd 8.1.1.3. fejezet) a szeret-
nénk vizsgálni. Esetünkben a permanens modell miatt 1 periódus van 1 időlépcsővel 
(Stress Period:1 és Time Step:1). A Zones gombbal részterületeket definiálhatunk a 
területen, ahol a számítás külön-külön is megtörténik. Nyomjuk meg hát a Zones 
gombot, és a megjelenő Grid Editor ablakba hívjuk be a Value → Zones → Load 
paranccsal a VIZFOLDTAN.ZON állományt. Váltsunk zóna üzemmódba: Options 
→ Input Method → Zones, majd a folyótól délre eső területrészt nevezzük el 1. 
zónának (Subregion Number: 1)  és rendeljünk hozzá a jobb egérgombbal 1 értéket 
nem elfelejtve a mezők „>>” gombbal való feltöltését sem! Ezután lépjünk ki az ab-
lakból a File → Leave Editor paranccsal, majd mentsük el az információkat. Ezzel a 
lépéssel visszajutunk a 154. ábra szerinti ablakhoz, ahol a számítás elindításához 
nyomjuk meg az OK gombot (155. ábra). Ha úgy vesszük észre, hogy semmi sem 
történt, akkor megint megtréfált bennünket a Windows. Ekkor a program által a mo-
dell aktuális könyvtárában előállított PMWBL.BAT nevű állományt keressük meg, 
és futtassuk (klikk kétszer!), amire ténylegesen megtörténik a számítás. A számítás 
eredményeit a WATERBDG.DAT állomány tartalmazza (156. ábra)  

 
154. ábra 

A vízforgalom számító program dialógusablaka 
 

 
155. ábra 

A Water Budget számító rutinja egy DOS ablakban fut le 
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156. ábra 

A számítás eredményeit a WATERBDG.DAT nevű szövegfájl tartalmazza 
 
A számítás eredményei a következők: 
PMWBLF (SUBREGIONAL WATER BUDGET) RUN RECORD 
 FLOWS ARE CONSIDERED "IN" IF THEY ARE ENTERING A SUBREGION 
 THE UNIT OF THE FLOWS IS [L^3/T] 
  
 TIME STEP    1 OF STRESS PERIOD    1                              Az időlépcső száma 
  
 ============================================================= 
  WATER BUDGET OF ZONES WITHIN EACH INDIVIDUAL LAYER                  Az egyes zónák 
 =============================================================         vízmérlegei rétegenként 
  
  ZONE   1  IN LAYER   1                                               1. zóna 1. réteg 
 ---------------------------------------------- 
        FLOW TERM             IN            OUT         IN-OUT 
          STORAGE  0.0000000E+00  0.0000000E+00  0.0000000E+00 
    CONSTANT HEAD  0.0000000E+00  0.0000000E+00  0.0000000E+00 
  HORIZ. EXCHANGE  9.3938923E+00  2.5076530E+00  6.8862391E+00 
 EXCHANGE (UPPER)  0.0000000E+00  0.0000000E+00  0.0000000E+00 
 EXCHANGE (LOWER)  5.5202905E+02  6.6587054E+02 -1.1384149E+02 
            WELLS  0.0000000E+00  5.0000000E+01 -5.0000000E+01 
           DRAINS  0.0000000E+00  5.4595282E+02 -5.4595282E+02 
         RECHARGE  3.2283224E+02  0.0000000E+00  3.2283224E+02 
               ET  0.0000000E+00  0.0000000E+00  0.0000000E+00 
    RIVER LEAKAGE  4.4822339E+02  6.4285614E+01  3.8393777E+02 
  HEAD DEP BOUNDS  0.0000000E+00  3.8895106E+00 -3.8895106E+00 
   STREAM LEAKAGE  0.0000000E+00  0.0000000E+00  0.0000000E+00 
 INTERBED STORAGE  0.0000000E+00  0.0000000E+00  0.0000000E+00 
 MULTI-AQIFR WELL  0.0000000E+00  0.0000000E+00  0.0000000E+00 
 SUM OF THE LAYER  1.3324786E+03  1.3325062E+03 -2.7587891E-02 
  DISCREPANCY [%]  0.00 
  
  ZONE   1  DOES NOT EXIST IN LAYER   2                                1. zóna 2. réteg 
  ZONE   1  DOES NOT EXIST IN LAYER   3                                1. zóna 3. réteg 
-------------------------------------------------------------- 
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 ============================================================ 
 WATER BUDGET OF ZONES OVER THE ENTIRE MODEL                   Az egyes zónák 
 ====================================================== vízmérlege a teljes modellben 
  
 ZONE: 1 
 ---------------------------------------------- 
                              IN            OUT         IN-OUT 
          STORAGE  0.0000000E+00  0.0000000E+00  0.0000000E+00 
    CONSTANT HEAD  0.0000000E+00  0.0000000E+00  0.0000000E+00 
  HORIZ. EXCHANGE  9.3938923E+00  2.5076530E+00  6.8862391E+00 
 EXCHANGE (UPPER)  0.0000000E+00  0.0000000E+00  0.0000000E+00 
 EXCHANGE (LOWER)  5.5202905E+02  6.6587054E+02 -1.1384149E+02 
            WELLS  0.0000000E+00  5.0000000E+01 -5.0000000E+01 
           DRAINS  0.0000000E+00  5.4595282E+02 -5.4595282E+02 
         RECHARGE  3.2283224E+02  0.0000000E+00  3.2283224E+02 
               ET  0.0000000E+00  0.0000000E+00  0.0000000E+00 
    RIVER LEAKAGE  4.4822339E+02  6.4285614E+01  3.8393777E+02 
  HEAD DEP BOUNDS  0.0000000E+00  3.8895106E+00 -3.8895106E+00 
   STREAM LEAKAGE  0.0000000E+00  0.0000000E+00  0.0000000E+00 
 INTERBED STORAGE  0.0000000E+00  0.0000000E+00  0.0000000E+00 
 MULTI-AQIFR WELL  0.0000000E+00  0.0000000E+00  0.0000000E+00 
 SUM OF ZONE(  1)  1.3324786E+03  1.3325061E+03 -2.7465820E-02 
  DISCREPANCY [%]  0.00 
  
  
 ============================================================= 
 WATER BUDGET OF THE WHOLE MODEL DOMAIN:                 A teljes modell vízmérlege 
 ============================================================= 
  
        FLOW TERM             IN            OUT         IN-OUT 
          STORAGE  0.0000000E+00  0.0000000E+00  0.0000000E+00 
    CONSTANT HEAD  0.0000000E+00  0.0000000E+00  0.0000000E+00 
            WELLS  0.0000000E+00  2.2000000E+02 -2.2000000E+02 
           DRAINS  0.0000000E+00  5.4595282E+02 -5.4595282E+02 
         RECHARGE  4.8117084E+02  0.0000000E+00  4.8117084E+02 
               ET  0.0000000E+00  0.0000000E+00  0.0000000E+00 
    RIVER LEAKAGE  8.4704047E+02  1.0925388E+02  7.3778656E+02 
  HEAD DEP BOUNDS  3.1785870E-01  4.5344470E+02 -4.5312683E+02 
   STREAM LEAKAGE  0.0000000E+00  0.0000000E+00  0.0000000E+00 
 INTERBED STORAGE  0.0000000E+00  0.0000000E+00  0.0000000E+00 
 MULTI-AQIFR WELL  0.0000000E+00  0.0000000E+00  0.0000000E+00 
-------------------------------------------------------------- 
              SUM  1.3285292E+03  1.3286514E+03 -1.2219238E-01 
  DISCREPANCY [%] -0.01  

 
Az eredmény állomány táblázatokat tartalmaz, melyben a befolyó (IN) a kifolyó 
(OUT) vízmennyiségeket és azok eredőjét (IN-OUT) láthatjuk. A vízmérleget objek-
tum csoportonként kapjuk meg a modell hosszúság (L) és idő dimenziója (T) alapján 
számított L3/T dimenzióban. Az egyes objektumok gyakorlatilag megfelelnek a 
MODFLOW csomagjainak: Tárolódás a rétegen belül (Interbed storage) az IBS cso-
mag használata esetén, az állandó nyomású peremek által szolgáltatott hozamok 
(Constant Head), a kutak (Wells), szivárgók (Drains), folyók (River Leakage), GHB 
cellák (Head Dep Bounds). A több rétegre szűrőzött kutakat csak a MODFLOW-
2000 kezeli, ezek hozamát a Multi-Aquifr Well sor tartalmazza, míg az 
evapotranszspirációs csomagét az ET, a maradó beszivárgásét a Recharge. A teljes 
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tárolt vízmennyiséget az időlépcső alatt a Storage sor adja meg, ami permanens szá-
mítás esetén értelemszerűen zérus. 
Esetünkben a szivárgó közel 546 m3/d hozamot szolgáltat, és a folyótól délre eső 
homokréteg vízmérlege a következő tényezőkből áll: 
A szivárgó 546 m3/d, a kutak 50 m3/d hozammal termelnek. A csapadék a területre 
322 m3/d, a folyó 384 m3/d hozamot juttat. A függőleges vízforgalommal 113 m3/d, a 
peremeken 4 m3/d víz távozik. A folyó alatt a homokrétegben vízszintes irányban 
mindösszesen 7 m3/d víz mozog, ennek köszönhető, hogy az áramvonalak nem fut-
nak át a folyó túlpartjára. 

17.4. Az első modell továbbfejlesztése nem permanens állapotú modellé 
(\app\nemperm könyvtár) 

A vizsgált probléma legyen a következő: Az előbbiekben felépített modellben a ku-
tak hozama időben állandó volt. A kérdés, hogy hogyan változik a depressziós tér, ha 
három egymást követő hónapban egyes kutak termelését megváltoztatják. 
Mivel 3x1 hónap vizsgálatáról van szó, ezért elvileg 3 db egymást követő 1 hónapos 
periódusból fel lehet építeni a rendszert, mert a nem permanens rendszerekben az 
időbeli változásokat állandó tulajdonságú folyamatok sorozataként kell definiálni. 
Most mégis azt javasoljuk, hogy egy később készítendő animáció miatt összesen 
9x10 napos rendszert vizsgáljunk. Ennek megfelelően 9 db periódusra bontjuk a fo-
lyamatot, ahol minden 3. eltelt periódust követően lesznek változások az adatrend-
szerben. 
Először is az előbb készített modell-adatrendszert másoljuk át az \app\nemperm 
könyvtárba. Ezt követően a modell átalakítását az új könyvtárban végezzük el, hogy 
a korábbi modell megmaradjon az eredeti formájában. 
A nem permanens modellhez a következő változtatásokat kell tenni: 
– az időbeliséget definiálni kell a Parameters → Time menüben, 
– a kezdeti feltételeket ellenőrizni kell, 
– az időben változtatható tulajdonságokat meg kell adni, 
– újra kell futtatni a modellt. 
Először tehát nyissuk meg a modellt az újonnan készített \app\nemperm könyvtárból 
a File → Open paranccsal. Ezután menjünk a Parameters → Time menübe, ahol a 
157. ábra szerinti paramétereket adjuk meg. Ezzel definiálunk 9 db 10 nap hosszú 
(Length) periódust, melyeket 10-10 db időlépcsőre (Time Steps) osztottunk. Az 
egyes időlépcsők a periódus elején – követve a gyorsabb potenciál-változásokat – 
rövidebbek, mint a periódus végén. Ezt a valamennyi periódus során alkalmazott 
1,05 időszorzóval (Multiplier (Flow)) valósítottuk meg. Természetesen a modell tí-
pusát is nem permanensre változtattuk (Simulation Flow Type: Transient). 
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157. ábra 

Az időparaméterek beállítása a nem permanens modellhez 
 

Ezt követően szükséges néhány további vízföldtani paraméter a fajlagos tárolási té-
nyező (Specific Storage) és a fajlagos hozam (Specific Yield) megadása. Ezek a pa-
raméterek azok, melyek a szivárgás egyenletének jobb oldali tagjában a potenciálvál-
tozások időbeliségét írják le. Mivel a permanens modellezésnél az egyenlet jobb ol-
dala zérus, ezért a képletben szorzótényezőként szereplő paraméterekre sem volt ak-
kor szükség. Nem permanens modell esetén azonban ezeket a tényezőket meg kell 
adni. Ismét tételezzük fel eltérő viselkedésűnek a vízadókat a folyó két partján, ennek 
megfelelően a 17.4. táblázat szerinti értékeket vettük fel. 

17.4. táblázat 
A nem permanens modell vízföldtani paraméterei 

Szivárgási tényező [m/d]  

Réteg 
horizontális vertikális 

Szabad  
hézag- 

térfogat 
[-] 

Fajlagos 
tárolási 
tényező 
[1/m] 

Fajlagos 
hozam 

[-] 

A folyótól északra eső területeken 
1. homok 0,8 0,4 0,11 0,0003 0,10 
2. iszap 0,02 0,01 0,07 0,0005 0,06 

3. homokos 
kavics 15 5 0,22 0,00007 0,20 

A folyótól délre eső területeken 
1. homok 2,5 0,8 0,13 0,0002 0,11 
2. iszap 0,02 0,01 0,07 0,0005 0,06 

3. homokos 
kavics 25 8 0,25 0,00005 0,22 
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Az értékek beállításához nyissuk meg előbb a Parameters → Specific Storage me-
nüvel a fajlagos tárolási tényezőket tartalmazó mátrixot. Az első és a harmadik mo-
dellrétegbe hívjuk be a VIZFOLDTAN.ZON zónahatárokat, majd a zónákhoz ren-
deljük hozzá a táblázatban közölt értékeket. Töltsük fel a zónák területére eső cellá-
kat a „>>” gombbal! A második rétegben az állandó nagyságú értékeket a Value → 
Reset Matrix paranccsal adjuk meg! Lépjünk ki a Grid Editor ablakból a File → 
Leave Editor paranccsal! 
Ismételjük meg a felsoroltakat a Parameters → Specific Yield menüpontnál is, de-
finiálva a fajlagos hozam értékeket! 
Ezután adjuk meg az időben változó paramétereket. A MODFLOW valamennyi 
csomagjánál van lehetőség az időben változó, de periódusonként állandó tulajdonsá-
gok megadására. Ennek megfelelően a Grid Editor ablak alsó sávjában a nem per-
manens modellezés során a rendszer kiírja az aktuálisan szerkesztett periódus szá-
mát. Értelemszerűen minden periódushoz tartozhat egy-egy tulajdonságmátrix, azon-
ban, ha a tulajdonság két egymást követő időlépcsőben nem változik, akkor azt nem 
szükséges többször megadni. 
Esetünkben a szivárgó, a beszivárgás, a résfal és a GHB peremek tulajdonságai ne 
változzanak, de változzanak a kutak hozamai a 17.5. táblázat szerint. A táblázatban a 
0-30 napos hozamok az első három periódushoz, a 30-60 naposak a 4-6. periódusok-
hoz, a 60-90 naposak a 7-9. periódusokhoz tartoznak. 

17.5. táblázat 
A vízkivételek adatai 

Qhomok[m3/d] Qkavics[m3/d] 
EOV Y EOV X Kút 

neve 0-30 
nap 

30-60 
nap 

60-90 
nap 

0-30 
nap 

30-60 
nap 

60-90 
nap 

550984.67 151087.78 K-1 0 15 0 30 25 35 
551304.94 150738.39 K-2 20 15 10 20 15 20 
551953.80 150781.83 K-3 15 15 15 20 15 35 
552244.96 151054.50 K-4 0 15 0 30 25 40 
551579.46 151216.72 K-5 0 15 0 30 25 40 
551957.96 151395.57 K-6 15 15 15 20 15 20 
551492.11 151520.51 K-7 0 15 0 20 15 25 
 
Használjuk a Models → MODFLOW → Well parancsot! A megjelenő ablakban 
válasszuk az Edit gombot, mert szerkeszteni szeretnénk az adatokat. (Amennyiben a 
csomag kikapcsolása volna a célunk, akkor a Deactivate gombot használnánk.) 
Ekkor megnyílik az 1. periódushoz tartozó kúthozam-mátrix. Mivel az első harminc 
napban a hozamok megfelelnek a korábban modellezett helyzetnek, ezért ezen nem 
kell változtatnunk. 
Adjuk ki a File → Leave Editor parancsot! Ekkor a rendszer nem lép ki azonnal, 
hanem lehetőséget ad a periódusok közötti váltásra, továbbá egyes adat-mátrixok 
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periódusok közötti másolására is. Tegyük most ezt. Az első periódus adatait másol-
juk át a 4. periódusba a Copy Data gomb megnyomásával és a megfelelő periódusok 
definiálásával (From Stress Period: 1, To Stress Period: 4, 158. ábra) 

 
158. ábra 

A kúthozam adatok másolása az időlépcsők között 
 

Ezután jelöljük ki a táblázatban a 4. periódust és nyomjuk meg az Edit Data gombot, 
ezzel szerkeszthetővé és módosíthatóvá válik a 4. periódushoz tartozó kúthozam 
adatrendszer. Adjuk meg a 17.5. táblázat szerinti értékeket az 1. és 3. modellréteg-
ben! 
Majd ismét adjuk ki a File → Leave Editor parancsot! Másoljuk át a 4. periódus 
adatait a 7. periódusba a Copy Data gomb megnyomásával és a megfelelő periódu-
sok definiálásával (From Stress Period: 4, To Stress Period: 7). Jelöljük ki a táblá-
zatban a 7. periódust, és nyomjuk meg az Edit Data gombot, majd módosítsuk a 7. 
periódushoz tartozó kúthozam adatrendszert a 17.5. táblázat szerint. 
Adjuk ki utoljára is a File → Leave Editor parancsot, majd a Leave Editor gomb-
bal az adatok mentése után lépjünk ki a főmenübe! 
Bizonyos esetekben célszerű lehet még a kezdeti feltételek megváltoztatása. Ameny-
nyiben a kutak tartósan üzemeltek és ezt követően indítjuk a számítást, akkor a per-
manens modellel számított kezdeti nyomásszinteket érdemes a modellbe importálni. 
Esetünkben ezt nem tesszük, mert az első három periódusban a permanens helyzet-
nek megfelelő termelést szimulálunk, azaz azt tételezzük fel, hogy a 0. napon indul a 
rendszer. Amennyiben nem ez lenne a helyzet a számított permanens állapotú poten-
ciálértékek importálásához a Parameters → Initial Hydraulic Heads menüben ad-
juk ki a Value → Result Extractor parancsot. A MODFLOW lapon a megfelelő 
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réteget (Layer) kiválasztva a Read, Apply és a Close gombok megnyomásával az 
aktuális rétegbe hívhatók a permanens állapotú modell számítási eredményei, feltéve, 
hogy az utolsó számítás a permanens modellhez tartozott, azaz azóta nem adtuk ki a 
Models → MODFLOW → Run parancsot! 
Ezután futtassuk a nem permanens modellt (Models → MODFLOW → Run)! 
A modell gyorsan, de sokáig fut, tekintettel arra, hogy a 9 periódus összesen 90 idő-
lépcsőjét kell kiszámolnia. 
A számítási eredmények bemutatásához készítsünk az időben változó depressziós 
térről egy animációt! 
Nyissuk ki a Tools → Presentation ablakot! Ekkor egy hagyományosnak tűnő Grid 
Editor ablak nyílik meg. A számítási eredmények ismeretében úgy gondoljuk, hogy 
az üzemi vízszintek 95 és 100 mBf szint között változnak, amiket 5 cm gyakoriság-
gal rajzoltassunk ki. Állítsuk be az Options → Environment parancs Contours lap-
ján a megjelenítést, legyenek az izovonalak láthatók (Visible mező). 
Ezután adjuk ki a File → Animation parancsot. Az animáció parancs képfájlok szá-
zait gyártja, ezért azokat kötelező külön könyvtárba menteni. Ennek megfelelően 
készítsünk egy ANIM nevű alkönyvtárat és legyen az állományok neve ANIMACIO. 
A gép ezek után elkészíti a képeket az egyes számított állapotokból és elnevezi őket 
ANIMACIO.1, ANIMACIO.2, …, ANIMACIO.90 névre abban az esetben, ha az 
animációs parancsnál a Frames mezőben a Create New Frames mezőt bejelöltük. 
Amennyiben később az elkészített animációt csak lejátszani akarjuk, akkor a Create 
New Frames mező kijelölését meg kell szüntetni, és máris lejátszhatjuk a korábbi 
animációt. 

17.5. A modell transzportmodellé bővítése: egy csőtörés következtében bekövet-
kező szennyeződés szimulációja (\app\transzp könyvtár) 

A transzportmodellt a permanens állapotú, első modell kiegészítéseképpen építjük 
fel, ezért másoljuk az összes állományt át az \APP\PERM_MDL könyvtárból egy 
újonnan létrehozott \APP\TRANSZP könyvtárba.  
Tételezzük fel, hogy a területen létezik egy telephely, melynek körvonalát a TE-
LEPHELY.BLN állomány tartalmazza. A telephelyen csőtörés következik be, ami-
nek következtében a kavicsos összletbe szennyezőanyag jut, melynek terjedését kí-
vánjuk a modellszámításokkal vizsgálni. 
 
Először állítsuk be a transzportmodell peremfeltételeit a Grid → Boundary 
Condition → ICBUND (MT3D/MT3DMS) menüpont alatt. A négy cella területén 
feltételezett szennyezőforrás a területen belül helyezkedik el, és a területen más 
szennyezőforrás nem található. A csőtörés következtében elemenként 1 m3/d, 200 
mg/l cink-koncentrációjú víz terheli a réteget. Mivel a háttérkoncentráció zérusnak 
tekinthető, ezért feltételezzük, hogy a modellezett területen kívülről szennyezőanyag 
nem érkezik a vizsgált területre. Feltételezhetjük, hogy valamennyi elemben a kon-
centráció szabadon, megkötések nélkül változhat. Ezt a transzport szempontjából 
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aktívnak tekintett cellákkal valósíthatjuk meg, azaz valamennyi cella ICBUND érté-
két válasszuk 1-re. Mivel ez az alapértelmezett beállítás, ezért egyszerűen a Grid → 
Boundary Condition → ICBUND (MT3D/MT3DMS) parancs végrehajtása után 
lépjünk ki a File → Leave Editor paranccsal, elmentve a beállításokat. 
Illesszük a „csőtörést” a hidrodinamikai modellbe! A telephely területére eső 4 db 
cellához, a 3. modellrétegben injektálókutanként +1 m3/d hozamot rendelve a csőtö-
rés hatására a kavicsrétegbe szivárgó szennyeződést szimulálhatjuk. Alkalmazzuk a 
Models  →  MODFLOW → Wells parancsot és a 3. réteg megfelelő elemeihez ren-
deljünk +1 értéket! 
A Parameters → Time menüben adjuk meg a probléma időbeliségét: szimuláljunk 
egy összesen 10 éves időszakot, 5 db periódus segítségével. Az egyenként 2 éves 
periódusokat osszuk 8 időlépcsőre 1,05 szorzótényező felhasználásával (159. ábra). 

 
159. ábra 

A transzportszámítás igényeihez alakított időbeosztás 
 
Ezután ellenőrizzük le, hogy a Models → MODFLOW → Output Control menü-
ben az Interface file to MT3D jelölőnégyzet ki volt-e választva. Ha igen, akkor az 
MT3D.FLO állomány már a MODFLOW korábbi futtatásaikor is készült, ha nem, 
akkor be kell jelölni a mezőt. Mivel esetünkben a hidrodinamikai adatrendszer meg-
változott, ezért mindenképpen szükséges a MODFLOW újrafuttatása (Models → 
MODFLOW → Run). 
Ezután adjuk meg a számítás kezdeti feltételeit (Models → MT3D → Initial 
Concentrations). Mivel a szennyezést a csőtörés okozza, a kezdeti koncentráció le-
gyen mindenhol zérus. Mivel az alapértelmezett kezdeti koncentráció zérus, ezért 
lépjünk ki egyszerűen a Grid Editorból (File → Leave Editor parancs), és mentsük 
az alapértelmezett értékeket. 
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Ezután állítsuk be az advektív transzport-csomag jellemzőit (Models → MT3D → 
Advection). Válasszuk a HMOC megoldást (Solution Scheme: Hybrid 
MOC/MMOC (HMOC)) a hibrid algoritmussal (Particle Tracking Algorithm: 
Hybrid 1st Order Euler and 4th Order Runge-Kutta). A beállításokat, amíg nem 
szükséges, ne változtassuk meg… 
A szennyezőanyag szóródását definiáljuk a Models → MT3D → Dispersion menü-
ben. A cink effektív diffúzióállandója a vízadóban 2.6·10-5 m2/d, a köztes iszapos 
összletben 1.3·10-5 m2/d. A longitudinális diszperzivitás legyen a homokrétegben 15 
m, az iszapban 5 m, a kavicsban 50 m. A horizontális transzverzális diszperzivitás a 
longitudinális 15%-a, a vertikális pedig 10%-a legyen (160. ábra). 

 
160. ábra 

A szennyezőanyag diszperziójának beállításai 
 
Ezután adjuk meg a szorpció és a bomlás paramétereit (Models → MT3D → 
Chemical Reaction → Layer-by-Layer). A szorpciót kövessük lineáris adszorpció-
val, a bomlás szimulációjától most tekintsünk el (161. ábra). A homokban R=5, az 
iszapban R=15, a kavicsos rétegben R=3 késleltetést tételezzünk fel, ami alapján 
számítottuk (13.19. egyenlet) a Kd megoszlási együttható értékét. 
Végül adjuk meg a szennyeződés forrását (Models → MT3D → Sink/Source 
Concentration → Wells). A TELEPHELY.DXF állomány tartalmazza a telephely 
határait, amit az Options → Maps paranccsal jelenítsünk meg, majd a korábban in-
jektáló kútként megadott cellákhoz rendeljünk 200 mg/l értéket. Mivel a térfogategy-
ség m3, ezért  200 000 mg/m3 értéket kell az érintett cellákba beírni (162. ábra). 
Ezután indítsuk el az MT3D modell futtatását! A Models → MT3D → Run paran-
csot hajtsuk végre, és ha nem indul el a futás, hanem hibaüzenetet kapnánk, akkor a 
modell könyvtárban található MT3D.BAT állományt futtassuk le, és a következő 
alkalomtól jelöljük be a Generate Input Files Only Don’t Start MT3D mezőt! 
A modell egy DOS ablakban futni kezd… Sajnos a futás közepesen gyors, több per-
cet is igénybe vehet, mert a rendszerben a kutaknál található kis méretű cellák miatt a 
stabilitási kritérium következtében csak kis, 1-2 napos időlépcsővel halad az iteráció.  
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161. ábra 

A szorpció és a bomlás beállításai 
 

 
162. ábra 

A koncentrációértékek megadása 
 
A kapott eredményeket (pl. koncentrációk a 3. rétegben) jelenítsük meg ismét ani-
mációval az \APP\TRANSZP\TPANIM könyvtárba TPANIMACIO néven. A mód-
szer legyen teljesen hasonló a 17.4. fejezetben bemutatottakhoz. A Tools → 
Presentation menüben készítsük el a 10 éves időhöz tartozó feltételezhetően legna-
gyobb koncentrációk eloszlásának izovonalas térképét. Ehhez hívjuk be a 3650 nap-
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hoz tartozó, 3. modellrétegbeli koncentráció-értékeket a Result Extractor MT3D 
lapjának segítségével. 
Majd rajzoljuk meg az izovonalakat! Célszerű az izovonalakat nem 0-nál kezdeni, 
mert a modell a korábban leírtak miatt mindig terhelt numerikus hibákkal, ezért kis 
0.1 - 0.2 mg/l nagyságrendű „negatív koncentrációk” a területen sok helyen előfor-
dulhatnak (163. ábra). (Amennyiben a hibákat akarjuk szemléltetni, nyugodtan raj-
zoljuk ki a zérus izovonalat és az alálövés-fölélövéses típusú hibák (164. ábra) nagy-
szerűen ki fognak rajzolódni!) Ha a térkép készen van, akkor az animáció paranccsal 
hozzuk létre a korábban leírt könyvtárba az első modellrétegben a TPANIMACIO 
nevű frame-eket, és nézzük is meg egyúttal az animációt. Ezután gyártsuk le az 
iszaprétegbeli koncentrációk animációját TPANIM_2, a kavicsra számított koncent-
rációk animációját TPANIM_3 néven. Az animáció parancs mindig az aktuális ré-
tegre vonatkozó térképeket készíti el, ezért az állományok gyártása közben a Page 
Down gombbal mindig váltsunk réteget! A három állomány közötti különbség jól 
látható. 
 

 
163. ábra 

A koncentráció-térkép beállítása és az animációs parancsok 
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164. ábra 

Az alálövés-fölélövés jellegű hibák megjelenítése 
 

17.6. 1D oszlopmodell transzportszámításokhoz (\app\clm könyvtár) 

Gyakori feladat, hogy arra vagyunk kíváncsiak, egy adott összletben a szennyező-
anyag a forrásától adott észlelési pontba mekkora koncentrációval jut el, és ez a 
szennyezési csóva hogyan halad át ismert észlelési pontokon. Ez tipikusan egydi-
menziós probléma (OGATA és BANKS, 1961, OGATA, 1970), attól függetlenül, 
hogy horizontális vagy vertikális szivárgást vizsgálunk. Ha a hidrodinamikai viszo-
nyokat ismertnek tekintjük, a feladat alkalmas a közeg diszperzivitásának vagy akár 
a szennyezőanyag lebomlásának, megkötődésének érzékenység vizsgálatára is. 
Legyen a feladat a következő: 5 m vastag nyomás alatti homokos összlet 1 m-es 
mélységébe 10 mg/m3 szennyezőanyag jut egy földalatti tartály sérülése következté-
ben. A vízadó összlet vertikális szivárgási tényezője legyen 1 m/d; a hidraulikus gra-
diens 0,03 m/m; a szabad hézagtérfogat 0,25.  
Vizsgáljuk meg – permanens áramlási viszonyok esetén – 100 nap alatt hogyan vál-
tozik a koncentráció az áramlás irányában a szennyezőforrástól 2 és 3 méterre, illetve 
az áramlással ellentétes irányban, ha a longitudinális diszperzivitást 1 m-nek, illetve 
3 m-nek választjuk. 
Második esetként vizsgáljuk meg, ugyanebben a földtani környezetben, a vízadó ré-
teg felszínére ömlő szennyezés hogyan halad keresztül a telített közegen. 
Bár a feladat oszlop modellre vonatkozik, célszerűbb vízszintes réteg modellel dol-
goznunk, mert a horizontális szivárgási paraméterek direkt módon meghatározhatók, 
míg a függőlegesek (pl. szivárgási tényező) csak közvetetten, az adott vízszintes pa-
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raméterhez viszonyítva. Ebben az esetben csak arra kell vigyázni, hogy ugyanaz a 
potenciál teret „definiáljunk” horizontálisan, mint amit az oszlop modellben előír-
tunk. 
Indulásként – az első modellhez hasonlóan – hozzunk létre egy alkönyvtárat 
(\APP\CLM) ahová az új modellt COLUM.PM5 mentjük. Ezt követően ki kell alakí-
tanunk a modell geometriáját, meg kell adnunk a paramétereket, majd meghatároz-
nunk az induló értékeket.  
A feladat alapján modellünk egy rétegű, 50 oszlopot és 1 sort tartalmaz, melyek egy-
aránt 0,1 m szélesek. (Kevesebb oszloppal is megoldalható a feladat, de 50 oszlop 
esetében kevésbé vagyunk korlátozva a „figyelőkutak” elhelyezésében.). 
Legyen a vízadó réteg telített (File → Layer Properties: confined), továbbá az első 
és az utolsó cella állandó nyomású (Grid → Boundary Conditions → IBOUND 
(MODFLOW): -1). Adjuk meg a rétegek tetejének és aljának a magasságát a Grid 
→ Aquifer Top:0,1 és a Grid → Aquifer Bottom:0 paranccsal. A szimuláció idő-
egysége legyen nap (Parameters → Time: day). Aktiváljuk az első peridódust, 
melynek hossza legyen 100 nap (Length), az időlépcsők száma 10 (Time Steps) és a 
szorzótényező 1,05 (Multiplier (Flow)). 
A modell típusa – feltételeknek megfeleően – permanens (Simulation Flow Type: 
Steady-State). Az induló vízszint (Initial Hydraulic Heads) az egész rétegben le-
gyen 1 m, a modell „nyugati” végében lévő cellában 1,15 m (mert 0,15/5 = 0,03). 
Helyezzünk el 3 db figyelőkutat (Boreholes and Observations → Boreholes) a 
17.6. táblázat szerinti koordinátákkal, így modellünk a 165. ábra szerinti elrendezésű. 

17.6. táblázat 
A 3 db figyelőkút koordinátái 

No. X (easting) Y (northing) 

1 2,95 0,05 

2 3,95 0,05 

3 0,25 0,05 
 

 
165. ábra 

Oszlop modell geometriája a figyelőkutakkal 
 
Meg kell még adnunk a szivárgási tényező (Horizontal Hydraulic Conductivity: 
1 m/d) és az effektív porozitás (Effective Porosity: 0,25) értékét. Ezzel a 
MODFLOW modell futtatásához mindent előkészítettünk.  
Mivel transzport számítást is akarunk végezni, amihez az MT3D/MS programoknak 
szükségük van az MT3D.FLO interfész állomány kiíratására, ezért ezt aktiválni kell 
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a Models → MODFLOW → Output Control... paranccsal (a 11.2. fejezetben leír-
tak szerint). Ezt követően futtathatjuk a MODFLOW-t (Models → MODFLOW → 
Run)!  
Ha a hidrodinamikai modellünk sikeresen lefutott, beállíthatjuk a transzportmodell 
peremfeltételét (Grid → Boundary Condition → ICBUND (MT3D/MT3DMS). 
Mivel egyik cellánk sem fix koncentrációjú, valamennyi cella ICBUND értékét vá-
lasszuk 1-re.  
Ezután adjuk meg a kezdeti koncentrációt (Models → MT3D → Initial 
Concentrations). Mivel a szennyezés az első m-ben történt ezért a 10. cellába írjunk 
10 mg/m3 értéket.  
Ezután kapcsoljuk be az advektív transzport-csomagot (Models → MT3D → 
Advection), és fogadjuk el az alapbeállításokat. 
Elérkeztünk az első célfeladatunkhoz, meg kell adnunk a szennyezőanyag szóródá-
sának mértékét (Models → MT3D → Dispersion). (A diszperzivitásról az 5.1. feje-
zetben részletes leírás található.) A horizontális és transzverzális diszperzivitást 
hagyjuk változatlanul 0,1 értékűnek, míg a longitudinális diszperzivitás legyen 1 m.  
Végül meg kell határoznunk, milyen gyakorisággal írassuk ki a transzport paraméte-
reket (Output control (MT3D/MT3DMS) → Output Times). Jelen esetben az Out-
put Frequency, NPRS = 101 legyen, így az induló 0. napot követően mind a 100 
naphoz tartozó koncentráció értéket kiírja a program (lásd 14.6. fejezet). 
Ezután indítsuk el az MT3D modell futtatását! (Models → MT3D → Run). Ha a 
futás eredményes volt, nézzük meg a koncentráció változásának görbéjét mindhárom 
figyelőkútban!  
Erre a Tools → Graphs → Concentration → Time → MT3D ablakok megnyitása 
után van lehetőségünk. A megjelenő ablakban lehetőségünk van a grafikon léptéké-
nek szerkesztésére, az adatok (*.DAT) fájlként, vagy a grafikon képfájlként (*.BMP)  
való mentésére. Mentsük el a kapott eredményeket! 
Ezután változtassuk meg a longitudinális diszperzivitás értékét 3 m-re (Models → 
MT3D → Dispersion) és az MT3D programot futtassuk le újra (Models → MT3D 
→ Run). Ismét megrajzolva a grafikont, a két eset különbségei jól kirajzolódnak 
(166. ábra). 
Összehasonlítva az eredményeket megfigyelhető, hogy áramlási irányban ugyanab-
ban a kútban, nagyobb diszperzivitás esetén hamarabb éri el a szennyezés centruma a 
kutat, de kisebb koncentrációval, és a görbe is laposabb. Az áramlással ellentétes 
irányban fekvő kutat – nagyobb diszperzivitás esetén – ugyancsak hamarabb éri el a 
szennyezés centruma ám az értéke magasabb! 
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166. ábra 

Koncentráció értékek (mg/m3) a 3 db figyelőkútban 1 m (bal oldali ábra) ill. 3 m 
(jobb oldali ábra) longitudinális diszperzivitás esetén (folytonos vonal: áramlási 

irányban 2 m-re; apró szaggatott vonal: 3 m-re lévő figyelőkútban; hosszú szaggatott 
az áramlással ellentétes irányban a szennyezéstől 0,7 m-re lévő kútban) 

 
A második feladat megoldásához hozzunk létre egy új alkönyvtárat (\APP\CLM2), 
és másoljuk bele a CLM könyvtár tartalmát.  
Először az első cellát kell állandó koncentrációjú elemmé alakítani (Grid → 
Boundary Condition → ICBUND (MT3D/MT3DMS :-1), majd a kezdeti 10 
mg/m3 koncentráció értéket írjuk be az első cellába, miután a 10. cellából töröltük ezt 
az értéket (Models → MT3D → Initial Concentrations). 
Állítsuk a longitudinális diszperzivitás értékét – az előbbi esethez hasonlóan – előbb 
1, majd 3 m-re (Models → MT3D → Dispersion), majd ezt követően mindkét eset-
ben futtassuk az MTD3 programot (Models → MT3D → Run) a koncentrációk 
számítása érdekében. A koncentrációk időbeni lefutását a 167. ábra mutatja. 
 

  
167. ábra 

Koncentráció értékek utánpótlódó szennyezés esetén (mg/m3) a 3 db figyelőkútban, 
ha a longitudinális diszperzivitás 1 m (bal oldali ábra) ill. 3 m (jobb oldali ábra); 
(hosszú szaggatott vonal: szennyezéstől 0,7 m-re, folytonos vonal: 3 m-re; apró 

szaggatott vonal: 4 m-re lévő figyelőkútban) 
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Az előző esethez hasonlóan, nagyobb diszperzivitás esetén gyorsabban nőnek a kon-
centrációk a figyelőkutakban (jobb oldali ábra), de az utánpótlódás miatt a csúcskon-
centráció értéke megegyezik a kisebb diszperzivitású összleteben elhelyezett figye-
lőkutakéval (bal oldali ábra). Azt is megállapíthatjuk: minél nagyobb a 
diszperzivitás, annál hasonlóbb a koncentráció idősora a szennyezéstől különböző 
távolságban elhelyezett figyelőkutakban.  
Érdemes kipróbálni – eltérő diszperzivitású közegben – hogyan változnak a koncent-
rációk, ha a szennyeződés megkötődését és lebomlását is lehetővé tesszük (Models 
→ MT3D → Chemical Reaction csomag)!! 
 

17.7. 2D vertikális síkmodell használata hidrodinamikai számításokhoz: gát 
alatti szivárgás számítása (\app\2Dgat könyvtár) 

Egy egyréteges horizontális síkmodell kedvező esetben alkalmazható lehet vertikális 
szelvénymodellként is. Ennek feltétele, hogy a potenciálokat a szelvény határai men-
tén ismerjük. Mivel a szivárgást meghatározzák a potenciál-különbségek, ezért való-
jában a modellezés szempontjából mindegy, hogy a réteg „fekszik” vagy függőlege-
sen áll, ha a peremfeltételek meghatározzák a hidrodinamikai folyamatokat a rend-
szeren belül.  
Hasonló ez a helyzet ahhoz, mint amikor egy zárt tükrű vízadóban a szivárgás sebes-
sége – ha minden egyéb paraméter (pl. a hézagtérfogat és szabad hézagtérfogat) ál-
landó - független attól, hogy a réteg 20, 50 vagy 200 m-rel van a föld felszíne alatt, 
vagy hogy milyen a réteg dőlése. A szivárgást kizárólag a nyomásszintek eloszlása 
miatt kialakuló hidraulikus gradiens határozza meg, függetlenül a vízadó dőlésétől 
vagy mélységétől. 
Építsünk hát a szelvénymenti szivárgás vizsgálatára egy horizontális síkmodellt! A 
vizsgált szelvény legyen 50 m mély és 400 m hosszú, a vastagsága legyen 10 m. Eh-
hez készítsünk egy rácshálót, melynek 50 sora 1 m széles, 160 db oszlopa 2,5 m vas-
tag (50x400 m), továbbá 1 rétegből áll (Grid → Mesh Size). Hogy jobban látható 
legyen a modell az Options → Environment paranccsal állítsuk át a képernyő hatá-
roló koordinátáit: X1=-5, Y1=-5, X2=405 és Y2=65, így egy 5-15 m széles keret ma-
rad a háló körül. 
Állítsuk be a szelvény vastagságát a Reset → Matrix paranccsal 10 m-re (Grid → 
Top of Layer: 0 és Grid → Bottom of Layer :-10 ) 
A vízadó típusát állítsuk át zárt tükrűvé: (Grid → Layer Type, Type: 0, Confined). 
A peremfeltételekkel képezzük le a problémát. Legyen a terület középső részén egy 
agyagmagos gát, melynek talpa a terepszint alatt 5 m-re van, szélessége 25 m, koro-
naszélessége 8 m magasban 12,5 m. A gátat tekintsük inaktívnak a szivárgás szem-
pontjából! 
A gát felvízi oldalán legyen a vízoszlop nyomása a terepszint felett 5 m, míg a men-
tett oldalon a vízszint éppen a terepszint magasságában legyen. A modell oldalsó 
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határán korlátlan oldalról történő utánpótlódás van. Ebben a helyzetben határozzuk 
meg a rendszerben az áramlási viszonyokat.  
Legyen a gát területe inaktív zóna, majd gondolkodjunk egy kicsit: a gát felvízi olda-
lán a felszínen mindenhol 5 m a nyomásszint, az alvízi oldalon pedig épp a terep-
szinttel megegyező, azaz 0. Mivel az utánpótlódás korlátlan, ezért a modell szélein 
(ami a fektetett helyzetben a bal és a jobb oldal) a nyomásszint szintén állandó, mert 
így biztosítható az, hogy a szivárgás iránya a határon oldalirányú legyen, azaz a szi-
várgási sebességvektornak ne legyen „vertikális” komponense. A modell alját tekint-
sük vízzárónak, ezért ott nincs szükség peremfeltételekre! A gondolatmenet alapján a 
modell „északi, keleti és nyugati” oldalain állandó nyomásszintű határokat kell fel-
venni, a „déli” oldalon nincs szükség peremfeltételekre. 
A modell legyen permanens állapotú, és használjuk a nap értéket az idő dimenziója-
ként (Parameters → Time). 
A területen a 15 m vastag homok alatt egy 2 m vastag iszapos homokréteg található, 
ami alatt 50 m mélységig homokok települnek.  
A rétegek vízföldtani jellemzőit a 17.7. táblázat tartalmazza. határoljuk le a három 
képződményt zónákkal és a zónákhoz rendeljük hozzá a horizontális szivárgási té-
nyező értékeket.  
Itt azonban rögtön egy újabb problémával szembesülünk, hiszen a modellben x és y 
irányú, de a valóságban vízszintes és függőleges szivárgási tényezők megadására 
nincs lehetőségünk. A MODFLOW-96 és azt megelőző verziók ugyanis cellánként 
nem tudnak irányfüggő anizotrópiát, illetve irányfüggő szivárgási tényezőket alkal-
mazni. Megjegyezzük, hogy a MODFLOW-2000 verzióban már van lehetőség mind 
a három térbeli irány szerinti szivárgási tényezők megadására. Ebben az esetben ér-
jük be annyival, hogy a modellezett 1. modellrétegben a rétegtípus megadásánál pl. 
0,5 értékű anizotrópiát is be lehet állítani (Grid → Layer Type, Anisotropy 
factor:0,5). 

17.7. táblázat 
A gát alatti szivárgásnál alkalmazott paraméterek 

Képződmény 
Horizontális szi-
várgási tényező 

[m/d] 

Vertikális szivár-
gási tényező [m/d]

Szabad hézagtér-
fogat [-] 

Homok 1 0,5 0,12 

Iszapos homok 0,1 0,05 0,08 

Homok 3 1,5 0,13 

 
Futtassuk le a számítást, és jelenítsük meg az eredményeket! 
Most szimuláljuk azt a helyzetet is, amikor a gát alatt az iszaprétegig egy függőleges 
határolást (rés- vagy függönyfalat), vagy jet grouting technológiával készített beton-
falat építenek. Legyen ez egy függönyfal, aminek vastagsága 5 cm, szivárgási ténye-
zője 10-11 m/s. Ebben az esetben a k/m átszivárgási tényező 5·10-9 m/s, azaz 
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0,000432 m/d. Készítsük el a függönyfalat HFB elemekkel a 17.2. fejezetben bemu-
tatottak szerint, majd ismét végezzük el a számítást, és ábrázoljuk az eredményeket! 

 

 
168. ábra 

A gát alatti szivárgás számítási eredményei függönyfallal és anélkül 
 

17.8. A Tóth-féle megoldás szimulációja (\app\2Dtoth könyvtár) 

A 4.2.1. fejezetben bemutattuk a Tóth-féle megoldást (TÓTH, 1963). A 17.7. feje-
zetben bemutatott módszer alkalmas a megoldás bemutatására, illetve az egyes szer-
zők által fészkes vagy egymásba ágyazott áramlási rendszereknek nevezett jelenség 
szimulációjára. 
Legyen a félmedence 5000 m széles és 1000 m mély, amit 100 db 50 m széles osz-
loppal és 100 db 10 m-es sorral állítsunk elő. A vízadó legyen zárttükrű és most a 
jobb láthatóság érdekében ne alkalmazzunk anizotrópiát. Legyen a teljes térrész ho-
mogén: k= 0,5 m/d, n0=0,08.  
A terület felső részén jelöljünk ki egy háromszög alakú inaktív térrészt. Esetünkben a 
medence bal oldalán legyen a teljes rétegvastagság 1000 m, a jobb oldalon 850 m.  
Az inaktív zóna mellett a modell felső részén 1 sor szélesen definiáljunk állandó 
nyomású cellákat.  
Ezután határozzuk meg a potenciál értékét a 4.47. egyenlet segítségével, legyen a 
képletben szereplő z0=850, a=20, b=1000, tg α=150/1000. Az általunk számított ér-
tékeket a FELMEDENCE.XLS állomány tartalmazza. Mivel a horizontális felbontás 
kicsi, ezért a számított értékek nem pontosan adják vissza az I. kötet 14. ábrája sze-
rinti hullámvonalat. 
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169. ábra 

A számított potenciál-eloszlás a medencében 
 
A számított értékek alapján gyártottunk egy PM_TOTH.DAT nevű állományt, ami-
ből a Field Interpolatorral meghatároztuk a kezdeti feltételeket. 
Ezután a számítást elvégezve megkaptuk a megoldásnak megfelelő áramrendszer 
ekvipotenciális vonalainak képét (170. ábra). 

 
170. ábra 

A Tóth-féle egységmedence szimulációja 
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18. Utószó 

Hát ennyi fért a jegyzetbe…  
Gondolom, akik végigolvasták a két kötetet, látják, hogy rengeteg dologgal foglal-
koztunk, és valószínűleg ennél is több maradt ki belőle. Célunk mindvégig az volt, 
hogy olyan problémákat tárgyaljunk és oldjunk meg elsősorban, ami a modellezés 
mindennapi gyakorlatát segíti. Kerültük, vagy helyesebben kerülni szándékoztunk 
minden olyat, ami a témához nem, vagy csak alig kapcsolódik, mindent, ami bonyo-
lult levezetés, és mindent, amiről magunk is úgy gondoljuk, hogy a gyakorlatban 
szükségtelen. 
A példákat megkíséreltük úgy összeválogatni, hogy azokkal a modellezés legtöbb 
lehetőségét bemutassuk, és arra is törekedtünk, hogy minden apró, sokszor pofon-
egyszerű, de mégis sok időt és fáradtságot megspóroló ötletet megosszunk az olva-
sókkal. 
Akármennyire is törekedtünk arra, hogy mindent leírjunk, a modellezés soha sem 
lehet meg az egyéni ötletek, saját megfontolások, és persze tévedések nélkül. Ahhoz, 
hogy valaki alkotó módon tudja használni a hidrodinamikai és transzportmodelleket, 
kell egy kis tehetség, de sok szorgalom szerencse és kitartás is… 
Nem kell félni felrúgni a hagyományokat, a járatlan út különösen szép lehet, persze 
veszélyes is, de bátraké a szerencse! 
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HIDROGEOLÓGIA FÓRUM 
 

Vannak kérdések a hidrogeológiában, amelyeket érdemes volna megvitatni. Például: 

- Effektív (dinamikai? gravitációs?) porozitás nagysága, mérési lehetőségei. 

- A felszín alatti víz kora. 

- Agyagos fedőréteg védőképessége.  

- Mi történt a Duna-Tisza közi hátság és a Szigetköz talajvizével? 

- Felszín alatti páramozgás szerepe a talajvízháztartásban. 

- Hol vannak eltemetett folyómedrek? Hol nincsenek? stb., stb., még sok minden. 

 

Erre szolgál az alábbi honlap: 

 

www.hidrogeol.atw.hu 

 

Itt olvasni és látni lehet: 

- kisebb-nagyobb tanulmányokat, 

- reflexiókat a szaksajtóban megjelent furcsaságokról, 

- beszámolókat a Hidrológiai Társaságnál, a Földtani Társulatnál és máshol elhangzott  

  előadásokról, 

- fényképeket szakmai eseményekről, 

- vendégkönyvet (amibe írni lehet), 

- egy FÓRUM rovatot, ahol mindenki hosszabban is kifejtheti véleményét, 

- és mindig valamilyen szavazási lehetőséget szakmai kérdésekről. 

 

Továbbá: bárki megjelentetheti Internetre szánt tanulmányát vagy szakmai önéletrajzát a 

„Who’s Who ? Ki kicsoda a magyar hidrogeológiában?”  rovatban. 

 

A honlap – sokak közreműködésével – akár Internetes szakfolyóirattá is válhat. 

 

Tájékoztatás:     hidrogeol@atw.hu 



 
 
 

 KÖRNYEZETVÉDELMI ÉS KUTATÁSFEJLESZTÉSI KFT. 
A Környezetvédelmi  Szolgál tatók és  Gyártók Szövetségének rendes  tagja  

 

 

Környezetvédelmi állapotfelmérés, 
tényfeltárás 
• Szennyező források felderítése, 

szennyezések környezeti hatásainak 
vizsgálata 

• Tényfeltárás, szennyezések lehatárolása 
• Hidrogeológiai vizsgálatok 
• GIS alapú térinformatikai megjelenítés 
• Egészségügyi és környezeti 

kockázatelemzés 
• Hidrodinamikai és szennyezés terjedés 

modellezés 
• Költséghaszon és költséghatékonyság 

elemzés 
• Kármentesítési célállapot határérték (D) 

meghatározás 
• Monitoring rendszerek tervezése, kialakítása 

és üzemeltetése 
 

Hatástanulmány, környezetvédelmi 
felülvizsgálat, audit 
• I. és II. fázisú audit termelő egységek 

(gyárak) esetében adásvétellel, 
privatizációval és felszámolással 
kapcsolatosan  

• Teljes körű EBK (HSE) auditok és vállalati 
felülvizsgálatok készítése, revitalizációs 
stratégiák kidolgozása, nemzetközi, 
multinacionális cégek számára is.  

• Részleges és teljes körű környezetvédelmi 
felülvizsgálatok elvégzése  

• Előzetes és részletes környezeti 
hatástanulmányok készítése és az egységes 
környezethasználati engedélyezési eljárás 
lefolytatása (IPPC)  

 

Remediáció 
• Műszaki beavatkozások tervezése és 

kivitelezése, vízjogi engedélyek beszerzése 
vízi létesítmények létesítéséhez és 
üzemeltetéshez  

• A legjobb elérhető technológia (BAT) 
meghatározása műszaki beavatkozásokhoz 
technikai és költséghaszon elemzésekkel  

• Konzultáció és projekt irányítás  
• Nemzeti és uniós pályázatok készítése  
• Környezetvédelmi beruházások 

finanszírozási lehetőségeinek elemzése, 
irányítása  

• Környezetvédelmi és hulladékgazdálkodási 
programok, tervek készítése települési 
önkormányzatok és régiók számára  

 
 

Kármentesítések és barnamezős 
beruházások műszaki ellenőri feladatok 
ellátása 
 
 

Illegális hulladéklerakók vizsgálata, 
felszámolása, kármentesítése, 
hulladéklerakók felülvizsgálata, 
rekultivációja 
 
 

Környezetvédelmi kutatás és 
technológia fejlesztés, kivitelezés 
 
 

Környezeti elemek 
akkreditált mintavétele 
 

 
 

Cím: 2100 Gödöllő, Ganz Ábrahám u. 2. 
Postacím: 2100 Gödöllő, Pf. 56. 

Telefon: 28/ 417-463, 28/512-080 Telefax: 28/ 415-964 
E-mail: holding@agruniverholding.hu 

Honlap: http://www.agruniverholding.hu,  http://www.kszgysz.hu/agrunive.htm 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

BGT Hungaria Környezettechnológiai Kft. 
1119 Budapest, Keveháza u. 1-3. 
Tel.: 204-1961; 204-1962 
Fax: 204-1988 

 

BGT Hungaria Környezettechnológiai Kft. magas szintű környezetvédelmi és környezettechnológiai 
feladatok elvégzésére alakult 1992-ben.  
BGT Hungaria Kft. az ALSTOM Power Environmental Consult GmbH. iroda hálózatának tagjaként a 
nemzetközi standardot képviseli a környezetvédelmi és környezet technológiai szolgáltatások területén. 
Az iroda ISO 9001:2000 minőségirányítási tanúsítással rendelkezik 
 
SZOLGÁLTATÁSAINK KÖRE: 

Környezeti auditálás 
 ingatlanok tulajdonosváltozásához, illetve privatizációhoz kapcsolódó I. és II. fázisú 

    auditáló vizsgálatok 
 
Tényfeltárások, utóellenőrzések, állapotfelmérések 

 Talaj- és talajvíz vizsgálatok 
 Hidrogeológiai vizsgálatok 
 Innovatív vizsgálati módszerek alkalmazása  
 A vizsgálatokhoz kapcsolódó teljes körű szakértői támogatás    

 
Mennyiségi kockázatfelmérés 

 Tényfeltárásokhoz kapcsolódó egyszerű és részletes kockázatelemzés készítése 
 Kockázati alapon kármentesítési célérték (D) meghatározása  
 Humán és ökológiai kockázat meghatározása 

 
Kármentesítés 

 Kárelhárítási tervezés 
 Mentesítő berendezések forgalmazása, bérbeadása 
 Monitoring vizsgálatok 

 
JOGOSULTSÁGAINK ÉS ENGEDÉLYEINK: 

BGT Hungaria Kft. a NAT által NAT-1-1365/2004 számon akkreditált mintavevő szervezet 
 
Vízügyi szakértői engedélyek 

 Vízanalitika és vízminőség-védelem 
 Vízfeltárás, kútfúrás 
 Vízgépészet 

 
Környezetvédelmi felülvizsgálat 

 Talajvédelem 
 Vízminőség-védelem 
 Levegőtisztaság-védelem 
 Zaj- és rezgésvédelem 
 Hulladék 

 
Vezető tervezői jogosultságok 

 Hidrogeológia 
 Környezetvédelem geotechnikai kérdései 
 Geológia, mérnökgeológia 
 Szennyvíztisztító telepek gépészete 

 
BGT Hungaria. 

Tapasztalt partner a környezetvédelmi problémák megoldására. 
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Telephely: 3527 Miskolc, József A. u. 59. Postacím: 3501 Miskolc, Pf. 90. Telefon/fax: 46/355-045 

 

Már elolvasta a könyvet? Már van modellező programja? 
És még mindig nincs belevaló adata? 

 
Próbálja ki a tényadatokon nyugvó modellezés izgalmas, semmihez nem hasonlítható, 
fantasztikus, új világát! 
 
 

Térjen be MODELLELLÁTÓ Áruházunkba! 
 
 
FÖLDSZINT  Modellgeometria Osztály 
 

• Régi és új földtani-geofizikai adatok begyűjtése, kritikai feldolgozása, 
homogenizálása. 

• Új adatok felvételezése (régi kutakban nukleáris karotázzsal), földtani-geofizikai 
korrelációs szelvények szerkesztése, kívánság szerinti méret-és fazonigazítás. Az 
utóbbi intim helyeken is. 

• Elemek és differenciák végszámra. 
• Felszínközeli viszonyok feltárása fúrással, felszíni geofizikával (VESZ,HESZ, MT, 

termika, radiometria). 
• Digitális eredményközlés, térinformatika. 

 
I. EMELET:  Szivásgáshidraulikai Osztály 
 
Számítások új és archív adatokból, kiképzett kutak teljes körű hidraulikai-kémiai vizsgálata, 
rejtélyes jelenségek kibogozása. 
Rozsdás lakatok levágása, nervózus kútgépészek szakszerű helyszíni ellátása. 
 
II. EMELET  Modellezés 
 
Vízbázisvédelem, új kút létesítése, geotermikus erőmű, transzportmodellezés. 
 
III.EMELET  Tapasztalat Osztály 
 
Elődünknek (Országos Földtani Kutató és Fúró Vállalat) köszönhetően 1955 óta a 
szakmában. Kínálatunkat folyamatosan bővítjük. 
 
IV. EMELET  Szervízrészleg 
 
Instabil modellek aládúcolása, lemerülő vízbázisok utántöltése, gyenge peremek utólagos 
bekeményítése, tizedesvesszők pontosítása, stb. - mindez pótlólagos mérések révén. 
 
ALAGSOR  Számlázás 
 
Mélyfagyasztott árak! 
 
PARK, PARKOLÓ Eszközök, járművek 
 
Teljes körű karotázs és kútvizsgálati eszközpark, digitális mérési, feldolgozási és 
adatszolgáltatási technikák. 
 
 
3 napos visszavásárlási garancia, korlátlan idejű jótállás (a ”B” zónán belül)! 
 
Világszínvonal ónos esőben is! 
 
Nálunk a végeselem is Duracell! 



 
Magyar Mérnöki Kamara 
Geotechnikai Tagozata 
1094 Budapest, Angyal u. 1-3. 

Tel/Fax: +36-1-455-3696 
 

 

A Magyar Mérnöki Kamara építő-, vízépítő-, geotechnikai és földtudományi 
mérnököket összefogó szakmai szervezete a Geotechnikai Tagozat. 
 
A tagozat fontosabb feladatai és tevékenységei: 

 a geotechnikai szakterületen dolgozó mérnökök szakmai minősítési 
rendjének kidolgozása és a rendszer folyamatos aktualizálása, 

 a szakterületre vonatkozó szabványosítási munka elősegítése, Nemzeti 
Alkalmazási Dokumentumok készítése, új szabványok előkészítése, 

 szakmai rendezvények szervezése (pl. Ráckevei geotechnikai 
konferencia, Széchy emlékülés, „Laza” szakmai fórum, előadóülések, 
vitafórumok stb.), 

 a középfokú és felsőfokú geotechnikai szakmai oktatás támogatása, az 
egyetemi oktatási formák véleményezése és fejlesztési javaslatok 
készítése, fúrómester képzés szervezése, 

 geotechnikai szakmai továbbképzések rendezésének elősegítése, az 
oktatási anyagok összeállítása és véleményezése, 

 geotechnikai szolgáltatások tartalmi követelményrendszerének és a 
geotechnikai díjszabás kidolgozása, 

 kiváló mérnökök elismerése (Széchy Károly emlékdíj és emlékplakett), 

 szakmai érdekképviselet ellátása különböző szakmai és egyéb 
fórumokon, 

 jogszabályok véleményezése, módosítási javaslatok kidolgozása. 
 

További információk a kamara és a tagozat honlapján: 
http://www.geot.ini.hu és 

http://www.mmk.hu 
 
 



 

 

 
 

PÓRUSVÍZ MÉRNÖKI IRODA 
Vízgazdálkodási és Vízvédelmi Tervező és Szolgáltató  
Betéti Társaság  
1039 Budapest, Jendrassik György utca 4. 
Tel./fax: (1) 380-62-85 

 
 
A PÓRUSVÍZ Mérnöki Iroda felszín alatti vízgazdálkodási és vízvédelmi, valamint 
kúthidraulikai feladatokkal foglalkozó, tervező és szolgáltató betéti társaság.  
 
A PÓRUSVÍZ Mérnöki Iroda tagjai a szakmai és üzleti tisztesség szellemében dolgoznak, a 
Magyar Mérnöki Kamara Etikai-fegyelmi Kódexében foglaltakat magukra nézve kötelezőnek 
ismerik el. 
 
A PÓRUSVÍZ Mérnöki Iroda az alábbi szakterületeken vállal megbízást, végez munkát, 
illetve nyújt szolgáltatást: 
 

• Vízkutatással, vízbeszerzéssel (parti szűrésű víz, talajvíz, rétegvíz, hasadékvíz, 
termálvíz, ásványvíz) kapcsolatos tervek, szakvélemények készítése; 

 
• Kutak és egyéb vízbeszerző művek tervezése; 

 
• A kútépítés során tervezői művezetés biztosítása, illetve műszaki ellenőri 

tevékenység ellátása; 
 

• Kúthidraulikai feladatok megoldása, a kutak egymásra való hatásának 
meghatározása, a fúrt kutak állapotának, víztermelési hatékonyságának értékelése; 

 
• Felszíni és felszín alatti vízháztartás vizsgálat, vízforgalom meghatározás, 

vízkészletbecslés; 
 

• Vízbázisok sérülékenységének, veszélyeztetettségének vizsgálata 
szivárgáshidraulikai modellezéssel; 

 
• Hidrogeológiai védőidom- és védőterület-rendszer meghatározása a felszín alatti 

vízkészletek mennyiségi, minőségi védelme érdekében; 
 

• Felszín alatti vízvédelmi monitoring rendszer tervezése; 
 

• Mederbeni in situ beszivárgás mérések elvégzése és azok kiértékelése a mederfenék 
szivárgáshidraulikai paramétereinek, és a parti szűrésű járulékos készletek 
meghatározása céljából; 

 
• Földtani, vízföldtani, építéshidrológiai szakértés, szaktanácsadás; 

 
• Bírósági peres ügyekben vízügyi műszaki szakértői vélemény készítése; 

 
• Vízellátással kapcsolatos hatósági (elvi vízjogi, vízjogi létesítési, üzemeltetési, 

fennmaradási) engedélyezési tervek készítése és az engedélyeztetés lebonyolítása. 
 
 

Várjuk szíves megrendelésüket. 



 



 

Válassza a HT-Hydrotechnik  
kíváló minőségű termékeit! 

Innovatív megoldások – precíz német kivitelezés – elérhető ár! 

Folyamatos vízszint-, 
nyomás-, hőmérséklet- és 

fajlagos vezetőképesség 
regisztrálók hagyományos ki-
képzésű és pozitív kutakhoz. 

Kiolvasás kézi kiolvasóval 
vagy laptoppal. GSM adat-

átviteli lehetőség! 

Speciális kulccsal nyitható 
„vandálbiztos” kútsapkák. 

Forgalmazza: 
GÁMA-GEO Kft. 

3519 Miskolc, Bencések útja 111. 
3529 Miskolc, Ifjúság útja 12. fszt3. 

/ : 46-431-857 
http://www.gama-geo.hu 

Kézi vízszint és 
vízhőmérsékletmérők 



GÁMA-GEO Kft., 3529 Miskolc, Ifjúság útja 12. fszt.3. 
e-mail: info@gama-geo.hu, FAX: 46-431-857 
 

Megrendelés 

 
Megrendelem a GÁMA-GEO Kft-től az alábbi termékeket. A kedvezményes árú könyveket csak szakirányú 
egyetemi hallgatók rendelhetnek. Ebben az esetben a megrendeléshez a hallgató diákigazolványának 
másolatát kérjük mellékelni, a számlát a hallgató nevére állítjuk ki. Egyéb személyek, cégek és intézmények 
részére kedvezményt nem tudunk adni. Az árak 5% ÁFÁ-t tartalmaznak. Postaköltség 400 Ft/megrendelés. 
Az adatállományokat a www.gama-geo.hu honlapról ingyenesen le lehet tölteni! 

Megnevezés db Egységár Összesen 
Hidrodinamikai és transzportmodellezés I. (Processing MODFLOW környezetben) 
Kedvezményes árú könyv  1200 Ft/db  
Teljes árú könyv  2400 Ft/db  

Hidrodinamikai és transzportmodellezés II. (Processing MODFLOW és Surfer for Windows környezetben) 
Kedvezményes árú könyv  1300 Ft/db  
Teljes árú könyv  2600 Ft/db  
DVD lemez a példák adatállományaival  500 Ft/lemez  
Postaköltség  400 Ft/rendelés  
Összesen  
 
Számlázási cím: 

Megrendelő neve: ..........................................................................................................................  

Megrendelő címe: ..........................................................................................................................  

Ügyintézőjük neve: ........................................................................................................................  

Telefonszám/e-mail:* .....................................................................................................................  
*A kitöltése nem kötelező. Csak abban az esetben hívjuk fel, ha a megrendeléssel vagy a postázással bármilyen 
probléma merülne fel. Az adatokat harmadik félnek ki nem adjuk és egyéb célra sem használjuk fel. 

Postacím (amennyiben nem azonos a számlázási címmel): 

Megrendelő neve: ..........................................................................................................................  

Megrendelő címe: ..........................................................................................................................  

 
Fizetési mód (a számlát a könyvvel együtt postázzuk vagy adjuk át): 

 előre történő átutalással (Szükség esetén előlegszámlát biztosítunk, számlaszám: CIB 10700086-
27451605-51100005, az utalásnál kérjük jelezni, hogy „Modellezés tankönyv” és az átutaló nevét.) 

 „sárga” csekk (A megrendelő vállalja, hogy a könyv árát a mellékelt átutalási megbízás 
felhasználásával postai úton megtéríti. A könyv az ár megtérítéséig a GÁMA-GEO tulajdonát képezi. 
Elsősorban magánszemélyek részére!) 

 készpénz (Készpénzes vásárlás a Szegedi Tudományegyetemen és a GÁMA-GEO Kft. miskolci 
irodájában lehetséges.) 

Személyes átvétel Szegeden és Miskolcon előre egyeztetett időpontban és helyen történhet (ekkor 
postaköltséget nem számítunk fel). 

Kelt: ................................................., 200   . ................................................. 

 

 

............................................................................ 

aláírás 




